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1 PRESENTATION GENERALE DE L’INTERFACE 
 

 

 

1-  Menu Principal : il contient tous les sous-menus pour paramétrer le logiciel et les outils à 

usage ponctuel 

2- Menu " ruban " : ici se trouvent les fonctions les plus souvent utilisées en navigation. Certains menus 

apparaissent en fonction du contexte, par exemple pendant un replay de trace ou pour télécharger des 

prévisions météo. 

3- Toolbar : c’est un ensemble de raccourcis pour accéder rapidement aux outils courants (zoom, 

création rapide de parcours, etc…) 

4- Données numériques : elles contiennent toutes les données reçues et calculées par le logiciel. C’est 

le tableau de bord. Pour plus de facilité, les données numériques sont pré-paramétrées et le contenu 

peut être modifié et viennent s’afficher tout autour de l’écran (Gamme Pro) pour répondre aux besoins 

de l’utilisateur. 

5- Ecran principal : cette zone est utilisée pour afficher la cartographie, les polaires, les Sailect, des 

histo-graphes et des données numériques en plein écran.  

6- Onglets : les onglets permettent de créer une nouvelle vue de l’écran principal. Les onglets sont 

mobiles et peuvent diviser l’écran principal horizontalement ou verticalement. Il est également possible 

de les extraire de la fenêtre du logiciel pour créer une fenêtre indépendante. 
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7- Sélection des données numériques : permet d’afficher ou de masquer les colonnes et les lignes de 

données numériques 

8- Phases : les phases de parcours correspondent à un profil d’affichage de l’écran évolutif en fonction 

des phases de navigation (départ, près, portant, route directe…) 

9- Thèmes : deux thèmes contrastés sont disponibles pour adapter la couleur de l’affichage aux 

conditions extérieures (plein soleil, mode nuit…).  

1.1 Manipulation des onglets 
L’onglet " Carte Maitre " est le seul onglet que l’on ne peut pas fermer, il a pour rôle d’afficher une carte en 

permanence.  

Le bouton " Nouvel onglet " permet d’ouvrir une nouvelle vue dans l’écran principal sous forme d’onglet. 

Cliquez sur le bouton pour ouvrir la " start page " proposant les différentes vues possibles : 

• Carte vectorielle (C-Map) 

• Carte raster 

• Polaire 

• Sailect 

• Histo-graphe 

• Données numériques 

1.1.1 Changer l’ordre des onglets 
L’ordre des onglets peut-être simplement modifié en " glissant " un onglet avec le clic gauche maintenu 

vers l’emplacement souhaité. 

 

 

 

 

 

 

1.1.2 Partager l’écran 
L’écran principal peut être séparé en plusieurs parties horizontales ou verticales dans lesquelles les onglets 

peuvent être déplacés. Pour cela glissez l’onglet sur la partie droite de l’écran pour un partage vertical ou 

sur la partie basse pour un partage horizontal. 
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1.1.3 Détacher un onglet de la fenêtre principale 
Les onglets peuvent être extraits de la fenêtre principale pour devenir une fenêtre autonome pouvant être 

déplacée, par exemple, sur un deuxième écran. Pour cela glissez un onglet vers la partie supérieur de 

l’écran. 
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1.1.4 Toolbar d'outils 
Toolbar verticale sur la gauche de l'écran. Elle comporte les principaux icones. Il n'est pas recommandé 

de la désactiver. 

 

 fonction homme à la mer. Voir LA FONCTION " HOMME A LA MER ", 

 choix des options d'affichage de la cartographie, 

 mesure d'une distance et d'un cap à l'écran, 

 mesure d'une distance entre plusieurs points à l'écran, 

 création rapide de parcours, 

 saisie d'une annotation sur la trace en cours, 

 recentrage de l'écran sur la situation en cours. Voir Se déplacer sur le plan d'eau. 

 recentrage de l'écran sur l'ensemble du parcours. Voir Se déplacer sur le plan d'eau. 

 recentrage de l'écran autour du bateau. Voir Se déplacer sur le plan d'eau. 

 zoom par sélection d'un rectangle. Voir Se déplacer sur le plan d'eau. 

 diminue le zoom. Voir Se déplacer sur le plan d'eau. 

 augmente le zoom. Voir Se déplacer sur le plan d'eau. 
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1.2 Choisir les éléments apparaissant sur la carte 
 

Il est possible de choisir les éléments apparaissant sur la carte en cliquant sur l’icône de paramétrage 

d’affichage de carte ou en faisant un clic droit dans l’onglet concerné puis " option de la carte :  

 

 

Type de carte (raccourci F2) :  

L’affichage des différentes cartes peut être sélectionné ici ou à l’aide de la touche F2 qui permet 

successivement d’afficher : 

_ une carte vectorielle (C-Map) 

_ une carte raster (Snmap, BSB, …) 

_ le trait de côte C-Map 

_ le trait de côte SHOM 

_ le profil de côte avec fond transparent qui s’affiche par-dessus les autres éléments de la carte (coloration, 

imagerie, etc…) 

La coloration de la mer peut être spécifiée (blanche, bleue ou selon la profondeur). 
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Tous waypoints 

Affiche l'ensemble des waypoints que vous avez saisis dans la " gestion des waypoints " (ou avec un clic 

droit sur la carte) 

 

 

Grille latitude / longitude 

Cette option affiche les parallèles et les méridiens avec leur valeur. 
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L'échelle de la carte se situe en haut à droite de l'écran 

 

 

Contour des cartes 

Affiche le contour des cartes disponibles sur votre PC. Pour les cartes C-Map, les lettres sur fond gris 

indiquent la résolution de chacune d'entre elles (de A, les moins précises à G, les plus précises) 

 

 

Isochrone 

Cette option permet d'afficher un isochrone autour de la position du bateau, c'est à dire l'ensemble des 

points où vous pouvez être en un temps donné, compte tenu de la vitesse actuelle du vent, de vos polaires 

et du courant estimé. 

La durée qui suit permet de spécifier la durée de cet isochrone : si vous mettez une heure, l'isochrone 

dessiné autour du bateau représentera les points où vous pouvez être dans une heure. 
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On peut également valider cette option en effectuant un clic droit sur le bateau et en choisissant 

"Isochrone" 

 

Colorer isochrone selon voiles 

Option disponible si vous disposez des Sailect décrivant les plages d'utilisation de vos voiles. 

En activant cette option, vous colorerez l'isochrone en fonction des voiles à utiliser dans chaque 

secteur. Vous pouvez approcher la souris de chaque secteur pour lire le libellé de la voile 

correspondante. 

 

 

On peut également valider cette option en effectuant un clic droit sur le bateau et en choisissant 

"Colorer isochrone selon voiles" 

Note : cette fonction de coloration est rafraichie en permanence et est généralement gourmande en 

calcul. Il est déconseillé de la laisser affichée en permanence. 

Roadbook  

Affiche ou masque l’ensemble des roadbooks. Il est également possible de faire apparaitre tous les 

commentaires inclus dans les roadbooks en cochant " Toutes annotations Roadbook " 

Prévisions (raccourci F9) 

Affiche et masque l’ensemble des prévisions (vent, vagues, courant, etc.…) 

Navire AIS 

Affiche et masque l’ensemble des cibles AIS 

Concurrents 

Affiche et masque l’ensemble des concurrents de la course active 

Routages 

Affiche et masque l‘ensemble des routages à l’écran 

Fichiers géo-référencés 

Affiche et masque l’ensemble des fichiers géo-référencés par catégories 
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Tous éléments C-Map 

Affiche tous les éléments présents dans les cartes C-Map 

 

Lorsque cette option est cochée, les autres options C-Map sont grisées 

 

Couches de cartographies C-Map 

Différentes couches de cartographie C-Map peuvent être sélectionnées :  

noms des éléments,  

bouées, phares et amers 

feux, réflecteurs radar 

épaves 

sondes des fonds 

rails maritimes, routes, relèvements, 

zones de danger, zone règlementées, limites des eaux internationales, câbles,  

zones de tir 

mouillages interdits 

ports 

réseaux routiers 

 

Lorsque l'on passe le curseur sur une marque de balisage ou un phare de la cartographie C-Map, des 

informations apparaissent sur la nature de l'objet. 
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1.2.1 Profils de cartographie 
Les paramètres de la cartographie peuvent être sauvés dans un profil afin de les rappeler facilement. Pour 

cela, modifiez les paramètres comme vous le souhaitez et cliquez sur " sauver profil <nouveau> " pour créer 

un nouveau profil ou " sauver sous <nom d’un profil existant> " pour modifier un profil. 

Il suffit ensuite de choisir dans la liste de gauche le profil à afficher pour retrouver toutes les préférences 

sauvegardées de la cartographie. 

 

 

 

1.3 Chargement du dernier environnement au démarrage 
Au démarrage du logiciel une partie de la dernière configuration est automatiquement rétablie, il s'agit de : 

_ l'emplacement des différents onglets 

_ la position et le niveau de zoom de la carte 

_ le choix du thème 

 

Afin de récupérer l'interface du logiciel identique à ce quelle était la dernière fois que vous l'avez fermé, le 

logiciel propose de recharger le dernier environnement au démarrage. Cela concerne : 

_ les routages 

_ les prévisions 

_les traces 

_ les traces chargées pour le calcul de polaires _les roadbook en cours de modification 

_ les polaires en cours de modification et/ou en comparaison 

 

1.4 Le plan d'eau 
Le plan d'eau affiche le bateau, la ligne de départ, les différentes marques du parcours, la trace du parcours 

effectué et les laylines. Il peut également faire apparaître la carte de la région ou le trait des côtes mondial, 

les prévisions météo (vents, pressions et courants), les différents waypoints que vous avez saisis, le routage 

calculé et les bateaux émetteurs AIS. 
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1.4.1 Laylines 
Affiche les angles de meilleur VMG depuis la bouée au vent sur les bords de près et de portant. 

 

 
 

1.4.2 Rose des vents 
Une rose des vents s'affiche en haut à droite de l'écran lorsque la carte n'est pas orientée au nord 

(généralement sur les départs et parcours banane).  

 

 

1.4.3 Route fond 
La route fond (mesurée sur le GPS) est affichée sous forme de trait pointillé (même couleur que le bateau) 

devant le bateau. 

 

 

1.4.4 Trace 
La trace du bateau est enregistrée en permanence pendant l'utilisation d'Adrena et inclut toutes les 

données reçues depuis la centrale et le GPS. Cela permet d'utiliser ces traces, a posteriori, pour générer des 

fichiers de polaire en lançant un calcul. 

Au démarrage d'Adrena si une trace a déjà été enregistrée le même jour, elle est automatiquement 

affichée à l'écran.  
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1.4.5 Se déplacer sur le plan d'eau 
 

Au clavier 

Vous pouvez déplacer l'écran sur le plan d'eau avec les flèches de direction haut / bas / gauche et 

droite. Pour des déplacements plus importants pressez la touche " Ctrl " en même temps que les 

flèches de direction, pour des déplacements plus fins, pressez la touche " Shift " (majuscule). 

 

Le scroll (grossissement) peut se contrôler avec les touches page-haut et page-bas du clavier.  

Il est possible d'augmenter l'effet du zoom en pressant sur la touche " Ctrl " tout en cliquant et d'en 

diminuer l'effet en pressant sur la touche " Shift ". 

 

La touche " Home" recentre l'écran sur la situation en cours, c'est à dire : 

En mode " hors course " : recentrage sur une zone de 10 milles de côté autour du bateau  

En mode départ : recentrage sur le bateau et la ligne de départ 

En course : le bateau et le waypoint en cours 

 

La combinaison de touches ctrl-F1 permet de recentrer l'écran sur l'ensemble du globe. 

 

Avec la souris 

Vous pouvez cliquer dans la carte et la déplacer en la tirant avec la souris tout en maintenant le bouton 

de la souris enfoncé. 

Vous pouvez utiliser la roulette de votre souris si elle en est pourvue pour régler le niveau de zoom. 

Vous pouvez également utiliser la Toolbar générale située à gauche de l'écran : 

 

 Recentre l'écran sur le bateau et le waypoint en cours (prochaine marque). Sur un départ, le 

centrage se fait sur le bateau et la ligne de départ. 

 Recentre l'écran sur le bateau et l'ensemble du parcours. 

 Recentre l'écran autour du bateau (le niveau de zoom est inchangé). 

 Permet de sélectionner un rectangle à l'écran pour localiser la zone à zoomer. Cliquez sur le 

bouton, cliquez ensuite sur la partie haute gauche du rectangle à sélectionner puis faites glisser la 

souris tout en maintenant le bouton enfoncé, relâchez lorsque vous avez dessiné le rectangle voulu. 
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  Les deux derniers boutons permettent d'intervenir sur le niveau de zoom. 

Comme pour la gestion du zoom par le clavier, la touche Ctrl maintenue pendant que vous cliquez sur 

le bouton permet d'augmenter l'effet de zoom et la touche shift permet d'en diminuer l'effet. 

Il est possible de maintenir la touche enfoncée pour modifier le niveau de zoom en continu. 

 

Avec un clic droit 

 

Pour faire un zoom autour d'un point de la carte, faites un clic-droit sur le point souhaité puis choisissez 

" Zoom+ ", la carte va zoomer automatiquement jusqu'à ce que vous cliquiez à nouveau ou que vous 

appuyiez sur une touche du clavier. 

Vous pouvez effectuer un " Zoom- " de la même façon. 

Pour recentrer la carte autour d'un point de la carte, faites un clic-droit sur le point souhaité puis 

choisissez " Centrer ". 

Pour recentrer la carte entre un point de la carte et le bateau, faites un clic droit sur le point souhaité 

et choisissez " Centrer ici + bateau " 
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1.4.6 La zone de départ 
 

Sur un départ, l'écran se présente de la façon suivante : 

 

 

 

L'écran n'est pas orienté au nord mais sur l'axe de la ligne. 

Dans le haut de l'écran une flèche vous indique la direction du vent ainsi qu'une rose des vents pour 

rappeler la direction du nord. 

Un certain nombre de laylines tribord et bâbord quadrillent la zone de départ pour anticiper le 

positionnement du bateau en fonction de votre stratégie (départ à la bouée, au bateau, en milieu de 

ligne, ...). Ces laylines prennent en compte la vitesse et la direction du vent, les polaires du bateau (si 

vous avez spécifié une polaire spécifique pour le départ, c'est celle-ci qui est utilisée) et le courant. Le 

vent et le courant sont mesurés sur la centrale ; vous avez cependant la possibilité d'en forcer la valeur 

(voir le chapitre Course). 

 

Si vous souhaitez visualiser rapidement l'ensemble du plan d'eau, vous pouvez le faire en cliquant sur le 

bouton  de la Toolbar de gauche. Le bouton  permet de revenir à la visualisation de la zone 

de départ. 
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Le chronomètre peut être topé au signal d'avertissement , au signal préparatoire  ou à 

tout autre moment   . Voir le chapitre Course. 

 

Safe starting area  

La " Safe starting area" ou " zone de sécurité sur le départ " désigne l'ensemble des zones depuis 

lesquelles il est possible de rejoindre la ligne à temps pour le départ. Elle dépend du vent, du courant, 

de votre polaire, et de la valeur du chrono. Elle est maximum au moment du signal d'attention et 

diminue jusqu'au signal de départ. La surface verte désigne les zones d'où on peut rejoindre le départ 

tribord amure, la surface rouge désigne les zones d'où on peut rejoindre le départ bâbord amure. 

 

 

Safe starting line 

Comme la " Safe starting area ", la " Safe starting line " (ou " Lignes de sécurité sur le départ ") met en 

évidence les zones depuis lesquelles on peut atteindre la ligne à temps. Au lieu de colorer l'ensemble 

de la zone, la Safe starting line se contente de dessiner deux traits horizontaux entre les deux laylines 

extrêmes : 
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Safe starting line et Safe starting area doivent être actives dans le menu Course  

1.5 Quadrillage de la zone de navigation 
Lorsque vous approchez d'une marque, Adrena " quadrille " la zone avec un hachurage correspondant aux 

targets de vent avec un pas d'une longueur. Lorsque cela est le cas, le bateau est représenté à une échelle 

de 1 par rapport au plan d'eau. Cela vous permet de mieux appréhender la situation de passage de la 

marque. Le cercle des 2 longueurs autour des marques de parcours est également représenté.  
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1.6 Le suivi du parcours 

  

 

La fenêtre de suivi du parcours apparait sur le bas de l'écran. Cette fenêtre affiche les différents 

segments du parcours avec, pour chacun d'entre eux : 

La marque de début, 

La marque de fin, 

Le type de la marque de fin (bouée latérale, cardinale, rocher, phare, ...), 

Le coté à laisser s'il a été précisé, 

La longueur du segment, 

Le cap fond (cap géographique entre les deux marques), 

Le cap surface (cap fond corrigé du courant). C'est le cap à suivre sur le segment. 

L'angle du vent réel estimé, 

L'angle du vent apparent estimé, 

Les voiles les plus adaptées, 

La durée estimée pour parcourir le segment, 

L'heure estimée de passage à la marque. 

 

La fenêtre s’affiche automatiquement lorsqu’on active un parcours. Pour afficher la fenêtre 

manuellement, lancez le menu " Affichage→ suivi du parcours". Pour la fermer, cliquez sur le bouton en 

forme de croix en haut à gauche de la fenêtre.  
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Si l'option " Forçage vent " est cochée, c'est la valeur saisie à coté qui est prise en compte, pour la 

vitesse, pour la direction ou pour les deux. 

Sinon, si un vent a été forcé dans la barre de forçage c'est ce dernier qui est pris en compte. 

Sinon, c'est le vent mesuré sur la centrale qui est pris en compte. 

 

 

 

Les courants sont calculés à partir des atlas de courant (ou grib) si vous en disposez ; sinon, ils sont 

ignorés.  

 

1.6.1 Recaler le suivi de parcours 
Un double clic sur une ligne du tableau de suivi de parcours permet de se recaler sur le segment choisi. On 

peut également utiliser les boutons  et  pour avancer ou reculer segment par segment. 

 

1.7 Thèmes et mode nuit 
L’interface propose deux thèmes un foncé (carbon) et un clair (classique) pour s’adapter aux conditions 

de luminosité. Ils sont accessibles par le menu " Thème " 

Si vous utilisez le logiciel de nuit, il est possible d'atténuer les couleurs de l'écran et de les remplacer 

par des couleurs plus proches du rouge afin de ne pas vous éblouir. 

 

Pour cela, ouvrez le menu " Thème → Mode nuit sur Adrena " pour affecter les couleurs du logiciel 

Adrena ou " Thème→ Mode nuit sur tout le PC " pour affecter les couleurs de tous les logiciels ouverts 

sur le PC. 

 

Il est possible de régler l’intensité du mode nuit en jouant sur le curseur " mode nuit " dans l’onglet " 

Affichage " dans Paramètres → Paramètres généraux : 
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1.8 Les données numériques 
Affichage de données numériques 

 

 

 

Les données numériques présentent un certain nombre d'informations issues de la centrale, du GPS ou 

calculées par le logiciel. La taille, la disposition ainsi que le contenu des fenêtres numériques est 

paramétrable.  

Pour modifier le contenu d'une fenêtre numérique, double cliquez sur la case à modifier. Une boite de 

dialogue s'ouvre pour vous proposer l'ensemble des informations disponibles dans le logiciel. 
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1.8.1 Disposition des données de navigation 
Adrena permet de disposer des données numériques tout autour de l'écran : en haut, en bas, à droite et à 

gauche. Utiliser le bouton " Données numériques puis choisissez l'emplacement où faire apparaitre les 

données. 

 

 

 

 

1.8.2 Phases 
Le nombre de barres de données numériques ainsi que leur contenu peut être sauvé dans des " phases ". 

Après avoir paramétré les données numériques, utilisez le menu " Phase > sauver l'écran en cours sous > et 

choisissez la phase souhaitée. Ainsi à chaque fois que vous sélectionnerez une phase le contenu des 

données numériques sera rappelé. 

NB : la phase par défaut est automatiquement sauvegardée à chaque modification des données 

numériques. 

NB : la commutation des phases peut -être automatique si vous l'activez dans le menu Paramètres → 

Paramètres généraux → Divers 
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1.8.3 Choix des données 
Le contenu des données numériques peut être modifié en faisant un double clic sur la case correspondante 

Ces informations sont regroupées en onze catégories chacune accessible sous un onglet particulier : 

 

Les informations de vent 

 

 

 

Les informations de vent sont décrites dans l'Annexe - Les informations de vent  
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Les informations de performances 

 

 

 

Les informations de performance sont décrites dans l'annexe - Les informations de performance 
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Les informations de recherche de meilleurs VMG et CMG 

 

 

 

Les informations de recherche de meilleurs VMG et CMG sont décrites dans l'annexe - Les informations 

recherche de meilleurs VMG et CMG  
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Les informations de Navigation  

 

 

 

Les informations de Navigation sont décrites dans l'annexe - Les données de navigation  
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Les informations liées au départ 

 

 

 

Les informations liées au départ sont décrites dans l'annexe - Les informations liées au départ  
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Les informations liées aux laylines 

 

 

 

Les informations liées aux laylines sont décrites dans l'annexe - Les informations liées aux laylines  
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Les informations relatives au bord en cours 

 

 

 

Les informations relatives au bord en cours sont décrites dans l'annexe - Les informations relatives au 

bord en cours  
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Les informations relatives au bord suivant 

 

 

 

Les informations relatives au bord suivant sont décrites dans l'annexe - Les informations relatives au 

bord suivant  
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Les informations diverses 

 

 

 

Les informations diverses sont décrites dans l'annexe - Les informations diverses  
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Les informations sur la configuration du bateau 

 

 

 

Les informations sur la configuration du bateau sont décrites dans l'annexe - Les informations de 

configuration du bateau 
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Les informations curseur 

 

 

 

Les informations de curseur sont décrites dans l'annexe - Les informations curseur  
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Les informations liées au routage 

 

 

 

Les informations de routage sont décrites dans l'annexe - Les informations relatives au routage  
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Les informations liées au bateaux trackés 

 

 

 

Les informations de routage sont décrites dans l'annexe - Les informations relatives au bateaux trackés  

 

1.8.4 Coloration des données numériques 
Pour chaque donnée numérique il est possible de choisir la couleur des textes et la couleur du fond. Pour 

cela double cliquez sur la case de donnée concernée et choisissez la couleur souhaitée avec les boutons 

correspondants : 
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1.8.5 Afficher un cadran 
 

La case " afficher un cadran " permet, pour certaines données, d'afficher la donnée sous forme d’un 

cadran analogique.  

 

Cette icône peut être une rose des vents pour les données relatives au nord (direction du vent, …) ou 

un bateau pour les données relatives à l'axe du bateau (vent réel, …) 

 

 

 

 

1.8.6 Informations comparatives (jauges) 
Un certain nombre d'informations offre un comparatif entre deux valeurs, soit un ratio en pourcentage 

(vitesse bateau par rapport à la vitesse cible), soit une différence entre deux valeurs (différence entre 

l'angle de vent réel du bateau et l'angle de vent réel cible pour obtenir le meilleur VMG). 

Les informations comparatives sont présentées sous forme de chiffres (valeur mesurée et ratio ou 

différence) et de curseur graphique permettant une visualisation immédiate. 

       

1.8.7 Loupe de près ou portant 
Les angles de vent peuvent être affiché sous forme de loupe de près ou portant pour en améliorer la 

précision. Pour cela double cliquez sur une case de donnée d'angle de vent et sélectionnez "Afficher la 

loupe" : 
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1.8.8 Affichage taille "max" 
Pour augmenter la lisibilité de la valeur des données numériques, il est possible de basculer l'affichage en 

taille maximum. Ce mode d'affichage ne permet pas d'afficher les cadrans, les jauges et les loupes. Pour 

l'activer cliquer sur le bouton  pour entrer en mode édition puis sur le bouton . 

 

   

 

 

1.8.9 Information sur les bateaux trackés 
Dans le cas spécifique des données comparatives de bateaux trackés (Voir Tracking) le nom du bateau 

tracké ou son numéro MMSI et une cible apparaissent dans le titre : 

 

 

 

1.8.10 Disposition en miroir 
Afin de comparer un bateau tracké avec son propre bateau sur des données similaires, il est possible 

d’ajouter une colonne de données numériques qui deviendra le miroir de la colonne de droite. Dans cette 

configuration les données du bateau tracké sont à gauche et celles de son propre bateau sont à droite. 

Pour activer le mode miroir, cliquer sur Phase → Activer mode miroir bateau  

 

Dans ce mode, chaque donnée paramétrée d’un côté est directement dupliquée de l’autre côté de l’écran. 

La modification d’une donnée dans la colonne de gauche permet également de choisir le bateau à suivre : 
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1.8.11 Organiser les données numériques 
Les cases de données numériques sont " attachées " sur la grille qui apparait en dessous par le coin 

supérieur gauche. Pour les déplacer, entrez en mode édition à l’aide du bouton  placé en haut à droite 

de chaque fenêtre. 

 

 

Vous pouvez alors : 

• Supprimer les cases avec le bouton  

• Ajouter des cases avec le bouton  

• Doubler la taille de la case avec le bouton  ou revenir à la taille standard avec le bouton 

 

• Déplacer les cases sur la grille 

• Sélectionner plusieurs cases avec le bouton . Dans ce cas les actions suivantes s’appliqueront à 

toutes les cases sélectionnées (supprimer, doubler, déplacer) 

NB: Vous pouvez sélectionner plusieurs cases simultanément en utilisant un rectangle de sélection 

avec le clic droit de la souris 

Le mode édition se désactive automatiquement au bout de quelques secondes ou en appuyant à nouveau 

sur le bouton  
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1.8.11.1 Déplacer les données numériques 

Pour modifier l’emplacement d’une donnée numérique, entrez en mode édition ( ) et glissez la case sur 

l’emplacement souhaité : 

  →  

 

 

Dans le cas où une case serait déposée sur une ou plusieurs autres cases, celles-ci seront automatiquement 

déplacées vers la droite pour laisser la place à la case déplacée : 

  →  

 

 

NB: En maintenant la touche "Ctrl" enfoncée, la case est dupliquée  
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De la même façon si une case est doublée, toutes les cases adjacentes sont déplacées vers la droite pour 

laisser la place au nouvel emplacement de la case doublée : 

  →   

 

 

Les données numériques d'une barre peuvent ête déplacées dans un un onglet et vice versa:  
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1.8.12 Famille de données numériques 
Adrena propose six familles de données numériques entièrement paramétrable dans un onglet. Pour y 

accéder cliquer sur " Nouvel onglet → Données numériques " et choisissez la famille. 

 

 

La fenêtre est alors affichée. Chaque case peut être modifiée comme pour les données numériques 

classiques (voir Afficher les données numériques) 

 

 

Les modifications sont automatiquement sauvées dans la famille de données correspondante. 
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1.8.13 Données moyennées 
Lorsque vous sélectionnez une donnée, vous pouvez cocher " Dumping " et choisir la durée de moyennage 

(10 mn par exemple). Dans ce cas, la donnée affichée sera la moyenne des 10 dernières minutes de 

navigation. 

Cette fonction est disponible lors de l'affichage d'une donnée dans une case numérique, dans les histo-

graphes et pour les données remontées vers la centrale.  

 

 

 

Le nom de la donnée est alors suivi de la durée de moyennage. 

 

 

 

 

 

 



61 
 

1.9 LES HISTO-GRAPHES 
Adrena permet de visualiser l'historique des informations enregistrées pendant la navigation. 

Ces histo-graphes peuvent s'afficher horizontalement, verticalement ou sous forme de " tiroirs ". 

 

1.9.1 Familles d'histo-graphes 
 

Pour accéder rapidement à des histo-graphes, Adrena propose plusieurs familles d'histo-graphes 

auxquelles on accède par le menu " Nouvel onglet→ Histographe ". 

 

Chaque famille modifiée est automatiquement sauvegardée 

 

1.9.2 Paramétrer un histo-graphes 

Pour modifier un histo-graphe cliquez sur l'icône  pour faire apparaître la fenêtre de réglages. 

 

  



62 
 

 Permet d'ajouter une courbe dans le graphe (on peut en placer jusqu'à dix 

simultanément mais il n'est pas recommandé de dépasser 2 ou 3 pour une question de lisibilité). 

 

 Ouvre un menu dans lequel vous pourrez choisir la période de temps sur laquelle 

recentrer la fenêtre. 

 

Les durées proposées dépendent de la durée de la trace. 

Ex :  " Derniers " "2 minutes " recentrent la fenêtre sur les 2 dernières minutes de trace. 

 

" Derniers " "1 heure " recentre la fenêtre sur la dernière heure de trace. 

 

 Recentre la fenêtre sur l'ensemble de la trace. 

 

 Recentre la fenêtre sur l'ensemble du speed test 1 (s'il a été défini) 

 

 Recentre la fenêtre sur l'ensemble du speed test 2 (s'il a été défini) 

 

 Ouvre un menu proposant l'ensemble des segments présents dans la trace. Vous pouvez 

recentrer la fenêtre sur le segment de votre choix. 
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Scroll et zoom 

Horizontalement : 

 Augmente le zoom horizontal (pour mieux voir les détails), 

 Diminue le zoom horizontal (pour voir plus de données), 

 Déplace la fenêtre vers les informations plus anciennes, 

 Pause : interrompt (ou reprend) le défilement, 

 Déplace la fenêtre vers les informations plus récentes, 

 Recale la fenêtre sur les dernières informations. 

 

 

Verticalement : 

 Déplace la fenêtre vers le haut, 

 Déplace la fenêtre vers le bas, 

 Augmente le zoom vertical (pour mieux voir les détails), 

 Diminue le zoom vertical (pour voir plus de données), 

 Recentre automatiquement les courbes par rapport aux plus petites et plus grandes données 

rencontrées. 

 

Comme dans toutes les fonctions de scroll et de zoom des logiciels Adrena, vous pouvez diminuer 

l'effet de la fonction en maintenant la touche shift enfoncée lorsque vous cliquez et augmenter son 

effet en maintenant la touche ctrl enfoncée. 

 

Dans le cas d'un histo-graphe vertical, les boutons sont transposés et le fonctionnement est le même 
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Ouvrir ou fermer tous les histo-graphes simultanément 

Pour ouvrir simultanément tous les histo-graphes tiroirs, maintenez la touche CTRL enfoncée pendant 

que vous cliquez sur la flèche bleue 

Pour refermer simultanément tous les histo-graphes, maintenez la touche CTRL enfoncée pendant que 

vous cliquez sur le bouton permettant de les fermer. 

 

1.9.3 Paramétrage de l’affichage 
Ouvrez un nouvel onglet " Histographes " et choisissez une famille à paramétrer. La fenêtre s’ouvre par 

défaut sur 4 histographes horizontaux, vous pouvez modifier la présentation de la façon suivante : 

 

 

 

 Ce bouton permet de basculer d’un affichage horizontal à un affichage vertical 

 Ce bouton permet de rajouter un histographe dans la fenêtre 

 Ce bouton permet de supprimer un histographe dans la fenêtre 

 

1.9.4 Tendance du vent 
La tendance du vent est un type particulier d'histo-graphe vertical qui présente les variations de 

direction du vent par rapport à une référence que vous choisissez. 

Choisissez l’onglet " Histo-graphes→ Tendance vent ".  

 

A la première ouverture, il vous sera demandé de choisir la référence vent (voir chapitre Recalage de la 

tendance du vent) 
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En vert : les zones dans lesquelles le vent était orienté sur la droite de la référence 

 

En rouge, les zones dans lesquelles le vent était orienté sur la gauche. 
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1.9.4.1 Recalage de la tendance du vent 

Pour recaler la référence de la tendance du vent, lancez le menu " → Recalage tendance vent ". 

 

Référence : saisissez la direction à la main ou sélectionnez l'icône  pour reprendre le vent 

instantané sur la centrale. 

 

Sur vent moyen : choisissez dans la liste la durée du vent moyen à prendre en compte. Ex : si vous 

choisissez 15 mn, la référence sera calculée sur le vent moyen au cours des dernières 15 minutes. 

 

Axe du parcours : si vous êtes sur un parcours (côtier, banane) : fixe la référence sur l'axe du parcours 

en cours. 
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Perpendiculaire ligne : sur un départ. Recale la référence sur la ligne de départ. La courbe apparaitra 

en vert lorsque le vent est sur la droite de la ligne (favorable au bateau) et en rouge lorsque le vent est 

sur la gauche de la ligne (favorable à la bouée). 

 

Afficher TWS : affiche également la tendance pour la vitesse du vent dans les mêmes conditions 

 

1.9.5 Tiroirs 
Vous pouvez ouvrir un tiroir " histo-graphe " sur chaque information numérique présente à l'écran dès 

lors que cette information fait l'objet d'une historisation. 

En déplaçant la souris sur cette information, une flèche apparaît,  

 

 

Cliquez sur la flèche pour ouvrir le tiroir. 

 

 

 

 

Les histo-graphes " tiroirs " se referment en cliquant sur la croix en haut à gauche de la fenêtre ou en 

recliquant sur la flèche qui apparaît en approchant la souris de la donnée numérique correspondante... 
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2 WAYPOINT ET PARCOURS 
 

 

 

2.1 Les waypoints 
 

Les waypoints ont deux utilités : ils servent de marques dans les parcours côtiers et permettent de 

mieux situer les dangers et caractéristiques du plan d'eau à l'écran. 

Chaque waypoint se caractérise par son type, son nom, sa position, et le commentaire associé. 

Pour gérer les waypoints, lancez le menu " Waypoints et parcours→ Gestion des waypoints " 
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2.1.1 Créer un waypoint 
Cliquez sur le bouton " Créer" 

 

 

Saisissez le nom du waypoint le commentaire (facultatif) et choisissez le type de bouée dans la liste en 

cliquant sur le bouton correspondant. 

 

La position peut être saisie de plusieurs façons : 

Saisie manuelle dans les zones " Latitude " et " Longitude "  

Par pointage sur la carte : cliquez sur le bouton " Pointer", la fenêtre va disparaître pour laisser la place à 

la carte et vous pourrez positionner le waypoint avec la souris. Les touches de déplacement et de zoom 

sont disponibles pour mieux se positionner. Cliquez à l'emplacement où vous souhaitez positionner le 

waypoint. 

Par topage de la position actuelle du bateau : bouton " Ici" 

 

En positionnant le waypoint par rapport à un autre existant : cliquez " Positionner " et entrez la distance, 

la direction ainsi que le waypoint de référence. 
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Choisissez ensuite le type de bouée en cliquant sur le bouton " Type de bouée " puis en choisissant 

parmi les différents types de marque proposés. 

 

 

 

 

Interdire modification sur la carte 

Cette option interdit toute modification, suppression ou déplacement du waypoint directement sur la 

carte (par clic droit). Lorsqu'elle est active, la seule manière de modifier, supprimer ou déplacer le 

waypoint est de passer par le menu waypoints. 

 

Terminez en cliquant sur le bouton " Valider ". 

 

2.1.1.1 Création d'un waypoint sur un objet C-Map 

Il est possible de créer un waypoint à partir d'un clic droit sur une marque de balisage ou un phare C-Map. 

Le waypoint sera alors automatiquement représenté par l'icône correspondante et placé aux coordonnées 

géographiques de la marque. 

 

2.1.2 Modifier un waypoint  
Sélectionnez le waypoint à modifier dans la liste et cliquez sur " Modifier " ou double-cliquez 

directement sur le waypoint dans la liste. Vous pouvez ensuite modifier les différents éléments comme 

indiqué pour la création d'un waypoint. 

 

2.1.3 Supprimer un waypoint 
Sélectionnez un ou plusieurs waypoints à supprimer puis cliquez sur " Supprimer " 

 

2.1.4 Activer un waypoint 
L'activation d'un waypoint sert à indiquer au logiciel qu'il s'agit de la prochaine destination. L'activation  

peut se faire de plusieurs façons: 
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• Par un clic droit sur le waypoint concerné puis dans le menu portant le nom du waypoint, choisir 

"Activer le waypoint" 

• Par le menu "Waypoint et Parcours → Activer" puis sélectionner le waypoint dans la liste 

• Par le menu "Waypoint et Parcours → Gestionnaire de waypoint" puis sélectionner le waypoint et 

cliquez sur le bouton "Activer" 

 

2.1.5 Gestion des fichiers de waypoints 
Les waypoints sont stockés dans des fichiers spécifiques.  

Vous pouvez l'utiliser sans en créer d'autres et ne pas vous préoccuper de ces fichiers. 

Vous pouvez également créer différents fichiers (un par région de navigation par exemple). 

Pour créer un nouveau fichier, cliquez sur le bouton " Nouveau " de la zone " Fichiers ", créez les 

waypoints, cliquez sur " Sauver " et indiquez le nom du nouveau fichier. 

Ce fichier deviendra le fichier par défaut à chaque démarrage du logiciel. 

 

2.1.6 Fusionner plusieurs fichiers de waypoints 
Si vous souhaitez fusionner plusieurs fichiers de waypoints (pour pouvoir charger plusieurs régions 

simultanément par exemple), procédez de la manière suivante : 

Cliquez sur bouton " Nouveau " de la zone " Fichiers " (la liste de waypoints va se vider).  

Cliquez sur fusionner et choisissez le 1er fichier à fusionner 

Cliquez sur " fusionner " autant de fois que vous avez de fichiers à fusionner, 

Vous pouvez ensuite sauver le fichier total en cliquant sur " sauver " et en indiquant le nom du nouveau 

fichier. 

Ce fichier deviendra le fichier par défaut à chaque démarrage du logiciel. 
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2.1.7 Travailler les waypoints directement sur le plan d'eau 
Il est possible d'effectuer un certain nombre d'opérations sur les waypoints sans passer par le menu 

décrit ci-dessus.  

 

Création  

Faites un clic-droit sur la carte à la position du waypoint et choisissez le menu Waypoint → " Créer 

waypoint ici ". 

 

 

 

Déplacement 

Faites un clic-droit sur le waypoint à déplacer et choisissez le menu Waypoint → "Déplacer le 

waypoint". 

 

Duplication 

Faites un clic-droit sur le waypoint à déplacer et choisissez le menu Waypoint → "Dupliquer le 

waypoint". 

 

Modification 

Faites un clic-droit sur le waypoint à modifier et choisissez le menu Waypoint → "Modifier le 

waypoint". Vous pouvez également accéder à la modification du waypoint en double-cliquant dessus. 
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Suppression 

Faites un clic-droit sur le waypoint à modifier et choisissez le menu Waypoint → " Supprimer le 

waypoint ". 

 

Activation 

Faites un clic-droit sur le waypoint à activer et choisissez le menu Waypoint → " Activer le waypoint ". 

 

Désactivation 

Faites un clic-droit sur le waypoint actif et choisissez le menu Waypoint → " Désactiver le waypoint ". 

 

Verrouillage d'un waypoint 

Si vous souhaitez verrouiller un waypoint pour en interdire toute modification, suppression ou 

déplacement sur la carte, allez en modification du waypoint et cochez la case " Interdire modification 

sur la carte ". 

 

2.1.8 Envoyer les waypoints sur le GPS 
Après avoir saisi les waypoints dans Adrena, vous pouvez les envoyer sur votre GPS si celui-ci est 

connecté directement au PC (il est peu probable que cela fonctionne si le GPS est vu à travers la 

centrale). 

Pour envoyer les waypoints vers le GPS, appelez la fenêtre de gestion des waypoints (menu "Waypoints 

et parcours→ Gestion des waypoints" puis cliquez sur GPS : "Envoyer". 

Note : la taille des noms de waypoints est limitée à 6 lors de l'envoi vers le GPS. Ces noms seront donc 

éventuellement tronqués. 

 

2.1.9 Recevoir les waypoints du GPS 
Pour récupérer les waypoints que vous avez saisis dans votre GPS, commencez par demander au GPS 

de les envoyer sur la liaison NMEA (la procédure dépend de la marque de votre GPS) puis appelez la 

fenêtre de gestion des waypoints (menu " Waypoints et parcours→ Gestion des waypoints ") puis 

cliquez sur GPS : " Recevoir ". 
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2.1.10 Import /Export d'un fichier GPX 
GPX (GPS eXchange Format) est un format de fichier permettant l'échange de coordonnées GPS. Ce 

format permet de décrire une suite de points utilisables sous forme de waypoint, parcours ou route. Il 

est utilisé dans un certain nombre de GPS.  

 

2.1.11 Import 
Il est possible de convertir un fichier GPX contenant que des waypoints en fichier de waypoint lisible 

dans Adrena en utilisant le menu WP et parcours → Convertir un fichier GPX (Waypoints). Après la 

conversion, le logiciel vous propose de l’enregistrer sous le nom de votre choix dans le dossier " 

Waypoint " du répertoire Adrena. 

 

2.1.12 Export 
Un fichier de waypoints chargé dans Adrena peut être exporté au format GPX en utilisant le bouton " 

sauver GPX " dans la fenêtre de gestion des waypoints (WP et parcours → Gestion des waypoints) 

 

 

 

Une fenêtre vous proposera alors de choisir l'emplacement et le nom d'enregistrement de ce nouveau 

fichier GPX. 
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2.2 Les parcours 
 

Les parcours sont utilisés pour les navigations comportant un certain nombre de waypoints (côtier ou 

au large). On les saisit en général dès réception des instructions de course. Pour cela, lancez le menu " 

Waypoints et parcoursgestion des parcours " 

 

 

 

 

2.2.1 Créer un parcours 
Cliquez sur " Créer ", Vous obtenez une fenêtre dans laquelle vous allez pouvoir saisir la liste des 

marques constituant le parcours. La liste des waypoints que vous avez préalablement saisis apparaît à 

gauche. La liste des marques du parcours apparaîtra à droite au fur et à mesure de leur sélection. 
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La liste des waypoints peut être triée par nom, latitude, longitude ou par le commentaire. Pour cela, 

cliquez sur le titre de la colonne correspondante. 

Saisissez le nom du parcours si vous ne souhaitez pas conserver celui qui est proposé par le logiciel puis 

choisissez successivement chaque marque du parcours. Pour cela, sélectionnez la marque souhaitée en 

cliquant dessus et cliquez sur " A contourner " (bouée à bâbord ou à tribord), ou " A laisser " (à bâbord 

ou à tribord) selon le cas. Le waypoint sélectionné apparaîtra en fin de liste du parcours. 

Si l'une des marques du parcours n'a pas été saisie dans les waypoints, cliquez sur " Nouveau waypoints 

". Vous accéderez à la fenêtre de création d'un waypoint (voir chapitre "Créer un waypoint"). Après 

saisie de ses caractéristiques, il sera intégré à la liste des marques du parcours. 

 

Pour supprimer une marque du parcours, sélectionnez la marque en cliquant dessus (fenêtre de droite) 

puis cliquez sur " Retirer ". 

 

Pour changer l'ordre des marques, sélectionnez la marque à déplacer en cliquant dessus puis cliquez 

sur " Monter " ou " Descendre " selon le cas. 
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Pour changer le coter à laisser d'une marque déjà dans la liste, sélectionnez la marque concernée dans 

la liste de droite puis cliquez selon le cas sur " A contourner " (bouée à bâbord ou à tribord), ou " A 

laisser " (à bâbord ou à tribord) sous la liste de droite. 

 

Ne saisissez ni le départ ni la bouée de dégagement, vous le ferez sur l'eau au moment du départ. 

Lorsque toutes les marques du parcours ont été sélectionnées, cliquez sur " Valider ". 

 

2.2.2 Créer le retour 
Pour créer le parcours de retour, sélectionnez le parcours aller puis cliquez sur " Créer retour ". Le 

parcours retour sera automatiquement créé : ordre inverse des marques ; les marques à laisser à 

tribord passent à bâbord et inversement. 

 

2.2.3 Pointer les marques du parcours 
2.2.3.1 Cas d'un parcours banane 

La phase préparatoire à votre course consiste à placer les différentes marques sur le plan d'eau. 
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La ligne (bateau comité et bouée de ligne) est généralement pointée en amenant l'étrave du bateau le 

plus près possible de la marque et en " topant " la position donnée par le GPS. 

 

La marque à toper en tant que comité doit toujours être la marque située à droite de la ligne dans le 

sens du départ (même si le comité se trouve en réalité de l'autre côté). 

 

La bouée au vent est positionnée par rapport aux données fournies par le comité (distance et 

direction). Ces données sont généralement approximatives, vous pourrez la repositionner après le 1er 

bord de près. 

Si la bouée sous le vent est distincte de la bouée de ligne, vous pourrez la toper si vous avez l'occasion 

de passer à proximité. Si vous n'en avez pas l'occasion, elle sera provisoirement positionnée sur la 

bouée de ligne, vous pourrez la repositionner après le 1er tour du parcours. 

 

Pour pointer les marques, lancez le menu " WP et parcours→ Pointage marques "  

 

 

 

Il existe différentes manières de saisir chaque marque : 

Position GPS.  Positionnez l'étrave du bateau à proximité de la marque puis cliquez sur le bouton " Ici " 

correspondant à la marque concernée. Le logiciel calculera la position de la marque à partir des 
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informations du GPS et de la centrale. C'est la méthode classique pour saisir la position de la ligne de 

départ. 

La " pointer". Permet de positionner la marque sur le dessin du plan d'eau. Cliquez sur le bouton " 

Pointer " de la marque concernée, la fenêtre va disparaître pour laisser la place à la représentation du 

plan d'eau (ainsi que la trace de la route déjà effectuée) ; vous pouvez positionner la marque avec la 

souris. Les touches de déplacement et de zoom sont disponibles pour mieux se positionner. Cliquez à 

l'emplacement où vous souhaitez positionner la marque. 

Saisir sa position. Si vous connaissez la position géographique des marques (souvent donnée par le 

comité en multicoque), vous pouvez double-cliquer dans la zone correspondante (latitude puis 

longitude) puis la saisir dans le clavier numérique qui apparaît (au clavier ou avec la souris). 

La " positionner". Chaque bouée peut être positionnée par rapport à une autre : la bouée au vent par 

rapport au comité (sur le départ) ou par rapport à la bouée sous le vent (ensuite), la bouée sous le vent 

par rapport à la bouée au vent, la bouée ligne par rapport au bateau comité et le bateau comité par 

rapport à la bouée ligne. Cliquez sur le bouton " positionner " de la marque concernée puis saisissez la 

distance et la direction de la marque. La bouée au vent est généralement positionnée avant le départ à 

partir des informations données par le comité. Pendant la course, Les bouées au vent et sous le vent 

peuvent être positionnées dans le cas d'un changement de parcours avec indication d'un nouveau cap 

par le comité. 

Note : lorsque vous positionnez la bouée ligne ou le bateau comité, la distance est exprimée en mètres et 

non pas en milles nautiques. 

 

 

Note : Topage des marques 

Vous ne pouvez évidemment pas positionner l'étrave sur la marque elle-même mais seulement à 

proximité : il en résulte une erreur de quelques mètres. Pour minimiser l'incidence de cette erreur, 

pointez la marque lorsque l'étrave se trouve dans le prolongement de la ligne ; de la sorte la distance à 

la ligne affichée par la suite restera correcte. 
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2.2.3.2 Cas d'un parcours côtier 

Le pointage des marques se fait comme dans le cas du parcours banane. Il n'y a pas de bouée sous le 

vent et vous avez la possibilité d'indiquer la présence d'une bouée de dégagement. 

 

 

 

Si une bouée de dégagement est présente, cochez la case " dégagement " et positionnez la bouée 

comme pour la bouée au vent d'un parcours banane, sinon décochez la case. 

Recalage " + " et " - " des marques 

Chaque marque peut être recalée dans l'axe du vent à l'aide des boutons " + " (plus haut dans le vent) et " - 

" (plus bas dans le vent). Lorsque vous cliquez sur l'un de ces boutons, une fenêtre vous demande le 

nombre de mètres dont il faut remonter ou redescendre la marque. 

Décalage entre l'étrave et la marque pointée 
Lorsque vous vous approchez d'une marque (comité ou bouée) pour la pointer, l'étrave n'est évidemment 

pas exactement sur la marque. Cela peut conduire à pointer une ligne trop large (si on passe à l'extérieur) 

ou trop courte (si on passe à l'intérieur). Pour compenser cette erreur, vous pouvez indiquer l'écart dans 

l'axe de la ligne entre l'étrave et la position réelle de la marque. 

Cette valeur peut être saisie dans le menu " Paramètres→ Paramètres généraux ", onglet " Tactique Pro", 
zones " offset pointage Bouée " et " offset pointage Comité ". 
La valeur est définie en nombre de longueurs. Entrez une valeur positive si vous passez par l'intérieur de la 

ligne lorsque vous pointez la marque (+0.5 par exemple), entrez une valeur négative si vous passez à 

l'extérieur de la ligne. 
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2.2.3.3 Pointage avec les touches de fonction 

Un moyen rapide de pointage de la ligne de départ consiste à utiliser les touches de fonction. Placez le 

bateau à proximité du bateau comité et pressez la touche F9 pour le pointer. Pour la bouée de ligne, 

pressez la touche F8 ; pour la bouée sous le vent, pressez la touche F7. 

Ceci peut être fait même si vous n'avez pas ouvert la boite de pointage des marques auparavant. 

 

2.2.3.4 Départ au vent arrière 

Si le départ a lieu au vent arrière, Adrena le gérera automatiquement. Rappelez-vous simplement que 

la marque à toper en tant que comité est la marque située à droite de la ligne que le départ se fasse au 

près, au portant ou au rechigne. 

 

2.2.3.5 Départ au rechigne 

Si le départ a lieu au rechigne, Adrena le gère automatiquement. Lors d'un départ au rechigne, Deux 

types de données sont calculées différemment : 

Le temps au plus court est calculé selon la vitesse polaire et perpendiculairement à la ligne, 

Le temps en direct est calculé selon la route fond du bateau, c'est à dire dans l'axe de sa route et selon 

sa vitesse instantanée. 

 

2.2.3.6 La porte sous le vent 

Dans le cas d'un parcours banane, vous pouvez gérer la porte sous le vent s'il en existe une. 

  

2.2.3.7 Spécifications de la porte. 

Vous pouvez indiquer la présence d'une porte et sa largeur dans le menu " Paramètres→ paramètres 

généraux ", onglet Tactique Pro, zones " présence et largeur porte ". Vous pouvez aussi indiquer si la 

référence (marque pointée à la bouée sous le vent) sera le milieu de la porte ou le côté droit de la porte 

(zone " référence sur porte droite ").  

 

2.2.3.8 Choix du côté de la porte 

 

Au début de chaque bord de portant, Tactique Pro se dirige vers le milieu de la porte (affichage des laylines, 

calcul du waypoint, durée sur chaque bord, ...). 

 

Vous pouvez à tout instant changer ce but en cliquant sur l'extrémité de la porte vers laquelle vous 

souhaitez vous diriger. 

 

Si vous souhaitez à nouveau vous diriger sur le milieu de la porte, recliquez sur l'extrémité sur laquelle vous 

venez de cliquer. 
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2.2.4 Modifier un parcours dans un tableau 
Dans la gestion des parcours, sélectionnez le parcours à modifier dans la liste et cliquez sur " Modifier " 

ou double-cliquez directement sur la route dans la liste. Vous pouvez ensuite modifier la liste des 

marques dans un tableau comme indiqué pour la création d'un parcours. 

 

2.2.5 Editer un parcours sur la carte 
Sélectionnez le parcours à modifier dans la liste et cliquez sur " Modif.Graph." ou dans le menu 

Waypoint et Parcours cliquez sur " Modifier " et sélectionnez le parcours 

Vous pourrez alors modifier directement le parcours sur la carte en cliquant sur les waypoints le 

constituant. 

 

2.2.6 Supprimer un parcours 
 

Sélectionnez le parcours à supprimer puis cliquez sur " Supprimer " ou dans le menu Waypoint et 

Parcours cliquez sur " Supprimer " et sélectionnez le parcours. 

 

2.2.7 Activer un parcours 
Sélectionnez le parcours à activer dans la liste et cliquez sur " Activer " ou dans le menu Waypoint et 

Parcours cliquez sur " Activer " et sélectionnez le parcours. 

Lorsqu'un parcours est activé, le suivi de parcours est automatiquement lancé. 
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2.2.8 Simuler un parcours 
La simulation de parcours permet d'envisager à l'avance un scénario type pour un parcours à venir. 

Vous pouvez, en indiquant la date et lieu prévu pour le départ ainsi que les caractéristiques du vent 

attendu, visualiser pour chaque segment du parcours : 

La marque de début 

La marque de fin, 

Le type de la marque de fin (cardinale ouest, latérale bâbord, ...) 

La distance entre les deux marques 

Le cap fond entre les deux marques 

Le cap surface entre les deux marques (cap fond corrigé du courant prévu) 

L'angle de vent réel moyen entre les deux marques 

L'angle de vent apparent entre les deux marques (c'est l'angle correspondant au meilleur VMG qui sera 

affiché s'il s'agit de louvoyage ou de vent arrière) 

La durée prévue pour effectuer le segment 

L'heure de passage à la marque de fin 

 

Lancez le menu " Waypoints et parcours→ Simulation d'un parcours " et sélectionnez le parcours à 

simuler. 

 

 

Saisissez la date et l'heure prévues pour le départ, la position approximative du départ (vous pouvez la 

positionner directement sur la carte en cliquant sur le point d'interrogation). Si vous prévoyez une 

bouée de dégagement, cliquez sur " présence dégagement " et indiquez ses distance et direction par 

rapport au départ. 

Validez les informations. 
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Saisissez les informations relatives au vent, le logiciel présente les informations relatives au parcours et 

au vent saisi. Si vous êtes en navigation, vous pouvez cliquer sur  pour prendre en compte le vent 

sur la centrale. 

Vous pouvez également modifier l'heure de départ et imprimer les informations avec le bouton " 

imprimer ". 

 

Pour simuler un parcours banane, commencez par saisir la position du parcours avant de lancer la 

simulation (voir chapitre Cas d'un parcours banane), puis sélectionner le parcours " banane ". 
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2.2.9 Affichage des parcours dédié aux organisations de courses 
En utilisant le menu " Waypoint et Parcours → Détails d’un parcours " on peut afficher les détails et le 

tracé d’un parcours en le sélectionnant dans la liste des parcours enregistrés. 

 

 

 

Il est ensuite possible d’ajuster et de redimensionner la fenêtre pour pouvoir faire des copies d’écran 

affichant à la fois le parcours sur la carte et le tableau récapitulatif. 

 

2.2.10 Gestion des fichiers de parcours 
Les parcours sont stockés dans des fichiers spécifiques. Le fichier des parcours par défaut est " 

parcours. WP ". Vous pouvez l'utiliser sans en créer d'autres et ne pas vous préoccuper de ces fichiers. 

Vous pouvez également créer différents fichiers (un par région de navigation par exemple). 

Pour créer un nouveau fichier, cliquez sur le bouton " Nouveau " de la zone " Fichiers ", créez les 

parcours, cliquez sur " Sauver " et indiquez le nom du nouveau fichier. 

Ce fichier deviendra le fichier par défaut à chaque démarrage du logiciel. 

 

2.2.11 Créer un parcours " à la volée " 
Il est possible de créer un parcours directement sur la carte, même si tous les waypoints n'ont pas été 

encore créés. Pour cela, cliquez sur le bouton raccourci : . 

Le curseur prend la forme d'une punaise pour épingler les waypoints sur la carte. 

Vous pouvez ensuite sélectionner les différents waypoints constituant le parcours. 

Si le waypoint à insérer existe déjà, approchez le curseur de celui-ci (le waypoint prend un aspect 

ombré) et cliquez dessus. 
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Si le waypoint n'existe pas encore, cliquez à l'emplacement désiré, le waypoint sera automatiquement 

créé. 

Si vous avez créé ou sélectionné un mauvais waypoint, vous pouvez cliquer à nouveau dessus pour le 

retirer du parcours (uniquement le dernier saisi). 

Pour terminer la saisie du parcours double cliquez sur le dernier waypoint. Si vous avez déjà pointé le 

dernier waypoint, vous pouvez effectuer un clic droit n'importe où sur la carte, cela mettra fin à la 

saisie du parcours sans créer de nouveau waypoint. 

Après la fin de la saisie, le logiciel propose de saisir le nom du parcours et de la valider. 

 

Un nom est automatiquement proposé pour le parcours. Modifiez-le si vous le souhaitez puis validez 

l'ensemble (avec ou sans activation immédiate). 

Vous pouvez également " reprendre le pointage " si vous avez oublié de saisir des waypoints ou " Editer 

le parcours " pour le modifier graphiquement (changement du nom des waypoints, choix des cotés à 

laisser, ...). Voir le chapitre Editer un parcours sur la carte. 

Après validation, la route est automatiquement activée. 

 

 

2.2.12 Envoyer les parcours vers le GPS 
Après avoir saisi les parcours dans Adrena, vous pouvez les envoyer sur votre GPS si celui-ci est 

connecté directement au PC (il est peu probable que cela fonctionne si le GPS est vu à travers la 

centrale). 

Pour envoyer les parcours vers le GPS, appelez la fenêtre de gestion des parcours (menu " Waypoints et 

parcours→ Gestion des parcours ") puis cliquez sur GPS : " Envoyer ". 

Note : beaucoup de GPS ne peuvent nommer les parcours autrement que par leur numéro. Les 

parcours seront donc envoyés avec les noms "01, "02 ", "03 ", etc...  

Si votre GPS est de marque Furon, veillez à le spécifier dans la gestion des liaisons (Liaisons avec les 

instruments), sinon, les parcours seront envoyés au format standard NMEA et ne seront pas reconnus. 

 

2.2.13 Recevoir les parcours du GPS 
Pour récupérer les parcours que vous avez saisis dans votre GPS, commencez par demander au GPS de 

les envoyer sur la liaison NMEA (la procédure dépend de la marque de votre GPS) puis appelez la 
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fenêtre de gestion des parcours (menu " WP et parcours→ Gestion des parcours " puis cliquez sur GPS : 

" Recevoir ". 

 

2.2.14 Editer un parcours sur la carte 
L'édition du parcours sur la carte permet d'effectuer un certain nombre d'opérations sur le parcours 

directement sur la carte : 

- retirer ou ajouter un waypoint du parcours, 
- spécifier la façon de contourner les waypoints, 
- déplacer un waypoint, 
- renommer un waypoint, 
- spécifier de quel côté laisser un waypoint. 

 

Pour éditer un parcours, lancez le menu " WP et parcours→ Edition d'un parcours sur la carte " ou 

cliquez sur " Editer le parcours " à l'issue de la création rapide d'un parcours. 

Pour ressortir du mode d'édition d'un parcours, ouvrez le menu " WP et parcours " et décochez le 

menu " Edition d'un parcours sur la carte " 

 

Note : lorsque vous avez activé un parcours, il est directement éditable. 

 

2.2.14.1 Ajouter un waypoint dans le parcours 
Faites un clic droit sur l'un des waypoints du parcours et choisissez " Insérer un waypoint avant " ou " 

Insérer un waypoint après " selon le cas. Vous pouvez ensuite choisir la position du nouveau waypoint 

en cliquant sur un point de la carte (ou attraper un waypoint existant). 



88 
 

2.2.14.2 Spécifier ou modifier la façon de contourner un waypoint 
Faites un clic droit sur le waypoint et choisissez " modifier le waypoint " (ou double-cliquez sur le 

waypoint). Choisissez ensuite la façon de le contourner. 

 

 

 

 

2.2.14.3 Retirer un waypoint du parcours 
Faites un clic droit sur le waypoint et choisissez " retirer le waypoint du parcours " 

 

2.2.14.4 Déplacer ou renommer un waypoint 
Pour déplacer ou renommer un waypoint effectuez de manière classique (clic-droit sur le waypoint). 

 

 

2.2.15 Import /Export d'un fichier GPX 
GPX (GPS échange Format) est un format de fichier permettant l'échange de coordonnées GPS. Ce 

format permet de décrire une suite de points utilisables sous forme de waypoint, parcours ou route. Il 

est utilisé dans un certain nombre de GPS.  
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2.2.15.1 Import 
Il est possible de convertir un fichier GPX contenant des parcours et des waypoints en fichier de 

parcours lisible dans Adrena en utilisant le menu WP et parcours → Convertir un fichier GPX 

(Waypoints et parcours). Après la conversion, le logiciel vous propose de l’enregistrer sous le nom de 

votre choix dans le dossier " Parcours " du répertoire Adrena. 

 

2.2.15.2 Export 
Un fichier de parcours chargé dans Adrena peut être exporté au format GPX en utilisant le bouton " 

sauver GPX " dans la fenêtre de gestion des waypoints (WP et parcours → Gestion des parcours) ou 

dans le menu " Waypoint et parcours → GPX ". 

Une fenêtre vous proposera alors de choisir l'emplacement et le nom d'enregistrement de ce nouveau 

fichier GPX. 
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3 COURSES 
 

 

 

3.1 Le départ 
 

3.1.1 Pointage des marques 
Les marques sont pointées par le menu " WP et parcours → Pointage marques " 

3.1.1.1 Zoom automatique 

Le logiciel peut zoomer l'écran en permanence sur le bateau et la prochaine marque pendant la phase de 

départ et sur les parcours banane. Pour cela choisissez l'option " Paramètres→ Paramètres généraux ", 

onglet " Affichage ", zone " Zoom auto sur départ et parcours banane " 

3.1.1.2 Paramètres permettant au logiciel de calculer les trajectoires 

Vitesse de rotation (loffing). Ce tableau concerne les vitesses de rotation du bateau lorsqu'il loffe (en 

degrés par seconde). 

 

 

 

Entrez, pour chaque force et angle de vent, la vitesse de rotation moyenne du bateau pour les conditions 

considérées. Il est possible d'ajouter ou de supprimer des forces de vent avec le bouton " Forces vent " ainsi 

que des angles de vent (bouton " angles vent ").  
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Vous pouvez ajuster une cellule en entrant directement la valeur au clavier. Vous pouvez également ajuster 

un ensemble de cellules en les sélectionnant puis en cliquant sur le pourcentage désiré (ex : appuyer 3 fois 

sur + 1% pour augmenter de 3%). 

Adrena possède un outil d'étalonnage pour calculer ces valeurs à partir de Speed Tests que vous effectuez 

en navigation voir Outils de calcul des paramètres de relance et de rotation. 

 

Vitesse de rotation (abattée). Ce tableau concerne les vitesses de rotation du bateau lorsqu'il abat et est 

paramétré comme le tableau de vitesse de rotation (loffing). 

 

Coefficient d'inertie. Ce tableau concerne les paramètres d'inertie du bateau. 

Plus le bateau atteint rapidement sa vitesse cible, plus les valeurs indiquées doivent être élevées. L'ordre 

de grandeur est 0.01 à 0.50. 

Tactique Pro possède un outil d'étalonnage pour calculer ces valeurs à partir de Speed Tests que vous 

effectuez en navigation voir Outils de calcul des paramètres de relance et de rotation. 

 

Coef. d'altération de polaires. Caractérise le fait qu'on ne peut prétendre atteindre le max des vitesses 

polaire pendant les manœuvres (rotations). Valeur comprise entre 0.5 et 1. 

 

Coef. polaire face au vent. Mettre 0.25 

 

3.2 L'arrivée 
 

Il est rare que l'on connaisse la position précise de la ligne d'arrivée (on n'en connait au mieux que l'une des 

extrémités). Cependant, dans le cas où la ligne d'arrivée est confondue avec la ligne de départ, Adrena peut 

vous donner des informations sur la meilleure façon de l'aborder. 

 

3.2.1 Gestion du nombre de tours. 
Sur un parcours banane, Adrena doit connaître le nombre de tours à effectuer pour déterminer si le bateau 

se dirige vers la ligne d'arrivée. Ce paramètre peut être précisé dans le menu " Paramètres→ paramètres 

généraux " onglet " TactiquePro ", zone " Nombre de tours des parcours banane". 

 

3.2.2 Coté favorable de la ligne 
Comme pour le départ, le côté favorable de la ligne est accessible dans les données numériques, onglet " 

départ et arrivée", zones " coté favorable ligne " et " Avantage ligne ". 
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3.2.3 Choix du coté à aborder 
Au début du bord de portant, Adrena se dirige vers le milieu de la ligne d'arrivée (affichage des laylines, 

calcul du waypoint, durée sur chaque bord, ...) 

 

Vous pouvez à tout instant changer ce but en cliquant sur l'extrémité de la ligne vers lequel vous souhaitez 

vous diriger. 

Si vous souhaitez à nouveau vous diriger sur le milieu de la ligne, recliquez sur l'extrémité sur laquelle vous 

venez de cliquer. 
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3.3 Laylines moyennées 
A l'instar du vent moyenné, les laylines moyennées permettent de connaitre les valeurs moyennes et 

extrêmes des laylines sur une période paramétrée. La représentation se fait sous forme graphique sur 

l'écran. 

 

 

Le cône rouge représente l'ensemble des valeurs couvertes par la layline bâbord pendant la période 

considérée. Le trait rouge soutenu représente la valeur instantanée de la layline et le trait rouge clair 

représente la valeur moyenne. 

Les laylines tribord sont représentées de la même façon en vert. 

 

3.3.1 Remise à 0 des vents et laylines moyennées  
 

Les valeurs moyennes de vent et de laylines peuvent être remises recalées sur la valeur instantanée en 

cliquant sur l'icône représentant des laylines : 
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3.4 Contrôle du chronomètre : 

 

 

Permet de toper le signal d'attention selon la durée paramétrée 

 

Permet de toper le signal d'avertissement selon la durée paramétrée 

 

Modifie la durée des signaux d'attention. Vous pouvez également modifier 
cette durée dans les paramétrages généraux (voir le chapitre Paramétrages 
divers). 
 

 

Sert à indiquer la fin d'une course, soit après avoir franchi la ligne d'arrivée, 
soit après un rappel général. Ce bouton a plusieurs effets :  

• Arrêt et figeage du chrono 

• Indication la fin de la manche (permettra de différencier les manches 
lors de l'affichage des traces), 

• Arrêt de l'enregistrement " marche sous voiles " utile au logiciel pour 
le calcul des polaires. 

 

 
Permet de recaler le chronomètre sur la minute la plus proche 

 

Permet de saisir une valeur quelconque du chronomètre pour vous recaler 
en cours de procédure. La valeur saisie doit être négative avant le départ. 

 

Safe starting area  

La " Safe starting area" ou " zone de sécurité sur le départ " désigne l'ensemble des zones depuis 

lesquelles il est possible de rejoindre la ligne à temps pour le départ. Elle dépend du vent, du courant, 

de votre polaire, et de la valeur du chrono. Elle est maximum au moment du signal d'attention et 

diminue jusqu'au signal de départ. La surface verte désigne les zones d'où on peut rejoindre le départ 

tribord amure, la surface rouge désigne les zones d'où on peut rejoindre le départ bâbord amure. 
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Safe starting line 

Comme la " Safe starting area ", la " Safe starting line " (ou " Lignes de sécurité sur le départ ") met en 

évidence les zones depuis lesquelles on peut atteindre la ligne à temps. Au lieu de colorer l'ensemble 

de la zone, la Safe starting line se contente de dessiner deux traits horizontaux entre les deux laylines 

extrêmes : 

 

 

 

3.5 Forçage de données 
 

 

 

Certaines valeurs mesurées par la centrale sont parfois perturbées et il peut être nécessaire de les 

forcer à la main. C'est le cas de la direction du vent pendant le départ ainsi que celle du courant. L’outil 

de forçage permet de forcer ces valeurs.  

Par défaut, le vent est pris sur la centrale ; pour forcer une valeur, cliquez dans la zone de direction du 

vent et saisissez la valeur souhaitée. 
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Pour repasser sur le vent mesuré sur la centrale, décochez la case à gauche de la zone de forçage. 

Lorsque le vent a été forcé la zone correspondant passe sur fond rouge pour attirer votre attention car 

les évolutions suivantes du vent ne seront plus prises en compte.  

Généralement, le vent est forcé pendant la procédure de départ. Pour cela, le bateau est mis bout au 

vent et la direction du vent topée sur le compas 

Vous pouvez également " toper" automatiquement cette valeur en plaçant le bateau bout au vent 

(meilleur moyen de stabiliser et de fiabiliser la lecture du vent) et en cliquant sur la case à cocher située 

à gauche de la zone (cliquez deux fois s'il était déjà validé). Le logiciel se calera alors sur la mesure de 

vent faite à cet instant. Si vous saisissez la valeur du vent mesuré sur le compas, n'oubliez pas d'y 

ajouter la déclinaison 

La procédure est la même pour le courant. 

 

3.6 Modification des polaires pendant la navigation 
 

Les polaires de navigation peuvent être ajustées pendant la course. Pendant la phase de départ, la 

correction porte sur la polaire de navigation de départ. Après le départ, la correction porte sur la polaire de 

navigation. 

Pour cela, allez dans le menu " Course → Correction de polaire " 

 

 

3.6.1 Correction des polaires par valeur corrective 
Pour ajuster les vitesses, modifiez la zone en pourcentage du groupe " Correction polaire ". 100% indique 

de ne pas altérer la polaire de base, 110% demande à augmenter les vitesses cible de 10%.  

Si vous considérez être à la bonne vitesse cible, vous pouvez demander au logiciel de calculer 

automatiquement le pourcentage à appliquer pour recaler la polaire sur la vitesse actuelle du bateau en 

cliquant sur la baguette magique située à droite de la zone. Attention, la correction s'appliquera à toutes 

les forces et à tous les angles de vent. 

 

Pour ajuster les angles de target, modifier la valeur d'angle Up (target au près) ou Down (Target au 

portant). Une valeur de 0° indique qu'aucune correction n'est à effectuer, une valeur de 5° par exemple 

indique d'augmenter l'angle target de 5° par rapport à la polaire de base. Une valeur positive augmente 

l'angle target et spécifie donc des target plus abattus, une valeur négative diminue l'angle target et spécifie 

donc un target plus près du vent. 

 

Comme pour les vitesses, il est possible de faire calculer la correction par le logiciel si vous pensez être au 

bon angle target. Pour cela, cliquez sur la baguette magique située à gauche de la zone concernée. 
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3.6.2 Correction graphique des polaires 
 

Pour corriger graphiquement les polaires, cliquez sur l'icône de la Tools barre de forçage représentant une 

polaire. 

 

 

 

 

La polaire du bateau correspondant au vent actuel apparaît. La polaire originale est en trait fin, la polaire 

corrigée en trait épais. Le positionnement du bateau par rapport à la polaire (vitesse et direction) est 

matérialisé par le bateau en bleu. 

Pour corriger la polaire en vitesse, " attrapez " la courbe de polaire avec la souris et faites-la glisser à la 

vitesse désirée. 

Pour corriger la polaire en angle de target, " attrapez " avec la souris le target de meilleur vmg (up ou 

down) et représenté par un petit rond et faites-la glisser sur l'angle désiré. L'ensemble de la polaire est 

recalculé pour rester cohérent et homogène. 

 

Après chaque correction les zones de correction numériques (pourcentage pour les vitesses, degrés pour 

les angles) sont mises à jour pour refléter les nouvelles valeurs de corrections. 
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3.6.3 Revenir à la polaire d'origine 
 

Pour revenir à la polaire d'origine, saisir 100% dans la correction de polaire et 0° dans les corrections 

d'angle. 

 

3.6.4 Sauver la polaire corrigée 
 

Lorsque vous effectuez des corrections sur les polaires de navigation, celles-ci ne sont effectives que pour la 

session en cours du programme. Si vous souhaitez les rendre définitives, cliquez sur l'icône. 

  

Les polaires corrigées seront sauvées dans le fichier correspondant et deviendront effectives les prochaines 

fois que vous utiliserez Adrena. 

Attention : si vous utilisez cette fonctionnalité, il peut être prudent de sauver les fichiers de polaire avant 

chaque navigation afin de pouvoir revenir en arrière en cas d'erreur. 
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4 LES PREVISIONS METEO 
Les prévisions météo permettent de lire des données météo au format GRIB, de les afficher à l'écran 

(vents, pressions, vagues) et de les utiliser pour effectuer un routage. 

 

4.1 Intégration d'un fichier GRIB 
Il existe plusieurs façons d'intégrer un fichier GRIB 

• En le téléchargeant avec vos outils habituels (Web, abonnement mail, ...) puis en intégrant le 

fichier obtenu 

• À l’aide de l’une des interfaces avec les fournisseurs de données météo proposées dans Adrena 

 

4.1.1 Lire un fichier GRIB 
 

Appelez le menu " Prévisions→ Charger/décharger→ Charger GRIB". Choisissez le fichier à charger 

(extension de fichier .grb). Si le fichier avait été téléchargé dans le répertoire GRIB d'Adrena 

(généralement C:\ProgramData\Adrena\GRIB), il vous sera proposé directement sans devoir naviguer 

dans l'arborescence du PC. 

Note : Vous pouvez charger plusieurs GRIB simultanément en utilisant la touche ctrl pendant que vous 

sélectionnez les différents GRIBs. 

 

Après chargement du fichier, une fenêtre indique le résumé des informations trouvées dans le fichier : 

 

 

 

Il vous est proposé d'afficher le ruban qui permettra de choisir les éléments à afficher et de naviguer 

dans le GRIB ainsi que la barre de statut qui permet de visualiser les valeurs des différentes grandeurs 

chargées (vent, pression, vagues) lorsque vous déplacez le curseur sur la carte. La dernière option 

permet de centrer la carte sur la zone du Grib chargé 

NB : Le résumé du contenu du fichier peut être rappelé à tout instant en sélectionnant le fichier 

concerné dans le menu " Prévisions → Synthèse Grib " 
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4.1.2 Rappel des derniers GRIBs 
En ouvrant le menu " Prévisions ", vous pouvez accéder directement aux 4 derniers Gribs chargés. 

 

 

4.1.3 Décharger un GRIB 
Pour décharger un GRIB, lancez le menu " Prévisions→ Charger/décharger fichier GRIB " et choisissez-le 

(ou les) GRIB à décharger. 

4.1.4 Listes des GRIB chargés 
Les fichiers grib chargés dans le logiciel apparaissent dans deux listes distinctes. A droite pour les grib de 

courant et à gauche pour les autres grib. 

Les cases à cocher permettent de sélectionner le ou les grib à afficher à l’écran. 

 

Un des fichiers grib sert toujours de référence pour afficher des données au curseur dans les cases de 

données numériques, il s’agit du grib maitre représenté par une étoile devant le nom. Le choix du grib 

maitre peut être modifié avec le bouton dédié. 

4.2 Télécharger un fichier grib gratuitement depuis le site de la NOAA  
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Le menu " Prévisions → NOAA →gribs " donne accès à l’outil de téléchargement de fichiers gribs gratuit 

fournit par le service hydrographique américain : la NOAA 

Les données disponibles sont les suivantes : 

_ Vent à 10 mètres 

_ Vent à 80 mètres * 

_ Vent à 850 hpa * 

_ Vent à 950 hpa * 

_ Les rafales 

_ Pression atmosphérique 

_ Température de l’air 

_ Précipitation 

_ Courant océan Atlantique nord 

_ Mer totale  

_ Mer du vent  

_ Houle  

 

 

 Ce bouton permet de sélectionner la zone pour laquelle on souhaite obtenir des données. 

 

L’utilisateur choisi ensuite la précision du grib en fonction des fichiers disponibles (par ex : 1°, 0.5° ou 

0.25°), la durée, le pas de temps et le type de donnée(s) à télécharger 

 

 Ce bouton lance le téléchargement des données et l’enregistrement du fichier grib. 

 

Pour contrôler la taille du fichier à télécharger en fonction des données sélectionnées, une valeur 

approximative apparait à droite du ruban.  
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Afin de vérifier la disponibilité d’un nouveau fichier grib, il est possible d’afficher la date de dernière 

publication en cliquant sur le bouton   

(Les fichiers sont établis à 0h, 6h, 12h et 18h chaque jour et disponible quelques instants après)  

 

NB : Les données de courant océanique disponibles sur l’Atlantique nord ne peuvent pas être 

téléchargées simultanément aux autres données.  

 

4.2.1 Téléchargement de prévision d’ensemble 
 

Le téléchargement des gribs de prévisions d’ensemble s’opère de la même façon que les gribs NOAA 

classiques (menu Prévisions → NOAA – Prévisions d’ensemble). L’enregistrement du jeu de fichiers est 

effectué dans un dossier séparé dans le répertoire Grib Adrena. 

 

  Ce bouton permet de lancer directement un routage sur les fichiers de prévisions 

d’ensemble téléchargés en paramétrant automatiquement le balayage multi-gribs sur le répertoire 

concerné. 

 

Voir le chapitre Routage sur prévisions d’ensemble 
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4.2.2 Téléchargement de fichiers grib historiques 
 

Cet outil permet de télécharger un jeu de fichiers de grib historique sur une plage de temps définie par 

l’utilisateur. (Menu Prévisions → NOAA – Grib Historiques) 

 

   

 

Historique : fichiers grib archivés et délivrés tels qu’ils étaient proposés à leur date d’émission 

 

Réanalyse : Fichiers grib recalculés à partir des données archivées mais avec les modèles de prévisions 

les plus récents. Ce type de fichiers permet de charger des gribs plus anciens (à partir de 1979) mais ne 

contenant que le vent à 10 mètre. 

 

Mois : défini le mois de l’année pour lequel les données seront chargées. 

 

Années : période sur laquelle les données du ou des mois choisi(s) seront chargées. 

 

Pas de temps : écart de temps entre les échéances des prévisions. 
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Durée : donne la possibilité de charger les données du mois suivant ou des deux mois à suivre en plus 

de celui sélectionné. 

 

Les fichiers téléchargés sont enregistrés dans un dossier à part dans le répertoire Grib Adrena. Un 

routage sur ces fichiers peut être lancé directement en cliquant sur le bouton " Router ". 

 

Voir le chapitre Routage sur gribs historiques 

 

4.2.3 Chargement automatique de GRIB 
Pour télécharger à intervalles réguliers les fichiers grib d'une zone définie, utiliser le menu " Prévisions 

→ NOAA Chargements automatiques" 

 

 

 

Cet outil permet de créer plusieurs programmations de chargement de fichier fonctionnant 

simultanément. Cliquer d'abord sur " Créer " 
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Nom: Nom de la programmation en cours de création 

 

Données à charger: selection des données qui seront inclues dans les fichiers grib chargés. (Voir 

chapitre Télécharger un fichier grib gratuitement depuis le site de la NOAA). 

 

Téléchargement: défini si la programmation est récurente ou ponctuelle 

 

Publication: choix du nombre de fichiers à rapatrier chaque jour parmi les quatre publications de la 

NOAA 

Pendant le téléchargement des fichiers gribs il est possible de suivre la progression dans la fenêtre 

principale: 
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Visualiser à l'écran: affiche automatiquement  un nouveau fichier grib téléchargé 

 

Alerte: déclenche un message sonore et lumineux à la réception d'un nouveau fichier Grib 

 

Les fichiers ainsi téléchargés seront enregistrés dans le dossier GRIB du répertoire par défaut. 

 

 

4.3 Requête de fichier grib par email avec Saildoc 
Saildoc est un service automatisé d'envoi de fichier grib par email. Le menu " Prévision → Saildoc " 

permet d'accéder à l'outil de requête de fichier grib par email. Pour obtenir le message à envoyer au 

serveur de Saildoc, procédez de la manière suivante : 

 

 

 

_ Ouvrez le menu et sélectionnez le pas, la durée et les données à inclure dans le fichier grib 

_ Définissez une zone géographique en utilisant le bouton  
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_ Cliquez sur le bouton  pour envoyer la requête 

 

 

 

Le texte à envoyer apparait dans une fenêtre, il est alors possible de le copier pour l'envoyer par email 

à query@saildocs.com.  

Si un client de messagerie est installé sur le PC (skyfile, Outlook,), il suffit de cliquer sur " messagerie " 

pour générer ce mail automatiquement. 

Le serveur Saildoc renvoi à l'expéditeur un email contenant le fichier grib demandé en pièce jointe. 

 

4.4 Requête de fichier grib par email et téléchargement direct avec Great Circle 
Great Circle est un service automatisé d'envoi de fichier grib par email ou en téléchargement direct. Le 

menu " Prévision → Great Circle " permet d'accéder au service du serveur Great Circle. 

 

Le service de Great Circle contient une partie de données gratuite et une autre payante. Dans les deux 

cas il est nécessaire de s'inscrire sur le site www.greatcircle.be et de renseigner votre abonnement 

dans Adrena en suivant ces deux étapes : 

 

_ Entrez votre identifiant et mot de passe utilisé sur le site Great Circle ou dans Squid en utilisant le 

bouton  

_ Télécharger les zones de modèles de fichier grib correspondant à votre abonnement en cliquant sur 

 

 

4.4.1 Requête par email 
Pour obtenir le message à envoyer au serveur de Great Circle, procédez de la manière suivante : 
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_ Ouvrez le menu et choisissez le modèle de fichier grib à télécharger 

_ Sélectionnez le pas, la durée et les données à inclure 

_ Définissez une zone géographique en utilisant le bouton  

_ Cliquez sur le bouton  pour envoyer la requête 

 

 

 

Le texte à envoyer apparait dans une fenêtre, il est alors possible de le copier pour l'envoyer par email 

à squidmail@greatcircle.be.  

Si un client de messagerie est installé sur le PC (skyfile, Outlook,), il suffit de cliquer sur " messagerie " 

pour générer ce mail automatiquement. 

Le serveur Great Circle renvoi à l'expéditeur un email contenant le fichier grib demandé en pièce jointe. 

 

4.4.2 Téléchargement direct 
Pour obtenir un fichier grib en le téléchargeant directement depuis le serveur de Great Circle, procédez 

de la manière suivante : 
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_ Ouvrez le menu et sélectionnez le pas, la durée et les données à inclure dans le fichier grib 

_ Définissez une zone géographique en utilisant le bouton  

_ Cliquez sur le bouton  pour envoyer la requête 

 

4.5 Télécharger directement depuis le site web Météo-France (Navimail2) 
 

Cette fonction suppose que le programme Navimail2 soit installé sur votre PC.  

L'accès aux gribs Navimail2 suppose que vous ayez souscrit un abonnement ou effectué un 

prépaiement auprès de Météo-France. Connectez-vous sur le site www.meteoFrance.fr pour en 

connaître les modalités. 

 

Appelez le menu " Prévisions→ Navimail 2" 

 

 

 

Choisissez la zone et les différents paramètres concernant les prévisions à télécharger (voir la 

documentation intégrée au produit). Après téléchargement et fermeture du programme, le GRIB sera 

directement intégré dans Adrena. 
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4.6 Télécharger directement depuis le site web PredictWind 
 

L'interface de téléchargements des Gribs Predictwind est intégrée à Adrena. 

 

Pour télécharger les fichiers Grib de résolution large (50km et 100km global), il vous suffit de vous 

enregistrer gratuitement sur le site de PredictWind : 

http://forecast.predictwind.com/register/free/yourDetails 

 

Pour utiliser les fichiers Grib de résolution fine (1km et 8km), vous devrez vous acquitter d’un 

abonnement Professionnel sur le site de PredictWind :  

http://forecast.predictwind.com/register/buy/package . 

Les abonnements existent à la journée, au trimestre ou encore à l’année. Les téléchargements sont 

illimités sur la durée de l’abonnement. 

 

Pour plus d’informations, visitez : www.predictwind.com 

Détails et tarifs disponibles sur : http://www.predictwind.com/Pricing.html  

 

Appelez le menu " Prévisions→ PredictWind" 

 

 

 

Les données Predictwind sont de 4 types : 

Grib fins de résolution 1km GFS et PWE (disponibles sur certaines zones) 

Grib fins de résolution 8km GFS et PWE (disponibles sur certaines zones) 

Grib larges de résolution 50 km PWE, CMCF et GFSF (disponibles sur tout le globe) 

Grib larges de résolution 60 km GFS et PWE (disponibles sur certaines zones) 

Grib larges de résolution 100 km PWE, CMCF et GFSF (disponibles sur tout le globe) 
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4.6.1 Sélection d'une zone 1, 8 ou 60 km. 
 

Pour afficher les zones disponibles en résolutions 1, 8 et 60 km, sélectionnez un modèle correspondant. 

Des rectangles s'afficheront sur chacune de ces zones du monde. 

 

Après avoir affiché les zones du ou des résolutions souhaitées, déplacez la souris au-dessus de la zone 

choisie. Celle-ci apparaîtra en jaune ainsi que son nom dans la zone de téléchargement du menu. 

 

Une fois la zone affichée, effectuez un clic (gauche) dessus ; elle apparaitra alors en orange. 

 

Après avoir choisi la zone, spécifiez les paramètres désirés dans le menu PredictWind : pas de temps, 

durée et les données à télécharger. Les valeurs possibles dépendent de la résolution ; en résolution 

1km, par exemple, le pas de temps est forcément d'une heure et la durée d'un jour. 

 

Cliquez sur l'icône . Si vous n'avez pas encore indiqué votre nom d'utilisateur et votre mot de 

passe chez Predictwind, ceux-ci vous seront demandés. 

Le fichier est ensuite téléchargé, la menu Predictwind est remplacée par le menu " Affichage météo " et 

le grib est affiché à l'écran. 

 

4.6.2 Sélection d'une zone 100 km. 
 

Cliquez sur l'icône  puis sélectionnez le rectangle souhaité à l'aide de la souris. La zone qui 

sera alors sélectionnée n'aura pas exactement l'emplacement que vous avez choisi car elle se recale sur 

des valeurs entières de degrés (latitude et longitude). 

 

Après avoir choisi la zone, spécifiez les paramètres désirés dans le menu PredictWind : pas de temps, 

durée et les données à télécharger. 
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Cliquez sur l'icône . Si vous n'avez pas encore indiqué votre nom d'utilisateur et votre mot de 

passe chez Predictwind, ceux-ci vous seront demandés. 

Le fichier est ensuite téléchargé, le menu Predictwind est remplacée par le menu " Affichage météo " et 

le grib est affiché à l'écran. 

 

4.7 Intégrer un atlas de courants 
 

" Adrena " gère les atlas de courants du Shom (côtes de France : Atlantique, Manche et Mer du Nord), 

de Proudman (Iles Britanniques) et de Winning Tides (Solent). Pour valider un atlas, saisissez la clef 

d'enregistrement qui vous a été délivrée lors de son achat. Vous pouvez également charger des Gribs 

de courants (notamment avec l'interface Tidetech ci-dessous). 

 

4.8 Intégrer un atlas de marée externe 
 

Adrena peut lire des atlas de marée externe à partir de fichiers importés depuis le dossier " Custom " 

du répertoire " C:\Program Data\Adrena\Courant ".  

Pour activer la lecture de ces atlas, activez le menu " Prévisions → Atlas de Courants → Custom ".  

La mise en forme de ces fichiers est décrite dans l’annexe "FORMAT DES DONNEES DE COURANT DE 

MAREE". 

 

4.9 Charger un grib de courant 
 

Si vous disposez de gribs de courant préalablement téléchargés, vous pouvez les charger dans Adrena 

par le menu " Prévisions→ Charger un grib " 
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4.10 Télécharger des gribs Tidetech 
 

L'interface de téléchargement des Gribs Tidetech est intégrée à Adrena. 

 

Pour pouvoir utiliser les fichiers Grib de courant Tidetech, souscrivez d'abord un abonnement sur le site 

de Tidetech : https://www.tidetech.org/sailing/subscription/. 

 

Les abonnements existent pour deux jours, au mois, au semestre ou encore à l’année. Les 

téléchargements sont illimités sur la durée de l’abonnement. 

 

Pour plus d’informations, visitez : http://www.tidetech.org 

Détails et tarifs disponibles sur : https://www.tidetech.org/sailing/subscription/. 

 

Pour accéder à l'interface Tidetech, appelez le menu " Prévisions→ Tidetech " 

 

 

 

4.10.1 Sélection d'une zone prédéfinie. 
 

Des rectangles s'affichent sur chacune des zones du monde disponibles. Les zones disponibles 

dépendent de l'abonnement que vous avez souscrit. Déplacez la souris au-dessus de la zone choisie. 

Celle-ci apparait en jaune ainsi que son nom dans la zone jaune du ruban. 

Une fois la zone affichée, effectuez un clic (gauche) dessus ; elle apparait alors en orange et est prête à 

charger. 

 

4.10.2 Sélection d'une zone par rectangle. 
 

La sélection d'une zone par rectangle permet de sélectionner une partie de zone (si vous avez 

sélectionné une zone auparavant) ou plusieurs zones simultanément (si vous n'avez sélectionné aucune 

zone auparavant). 

Cliquez sur l'icône  puis étirez un rectangle sur la ou les zones souhaitées à l'aide de la souris. 
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4.10.3 Limitation de la durée du grib 
 

Après avoir choisi la zone, vous pouvez spécifier la durée des fichiers à télécharger. Si vous ne spécifiez 

rien tout le fichier sera chargé depuis l'heure actuelle jusqu'à la fin du fichier. Attention, lorsque la 

sélection s’étend sur plusieurs zones ou portion de zones, il est possible que la durée de chaque fichier 

puisse être différente ; les durées proposées se calent sur le fichier ayant la plus longue durée. 

 

4.10.4 Téléchargement de la ou des zones sélectionnées 

Cliquez sur l'icône . Si vous n'avez pas encore indiqué votre nom d'utilisateur et votre mot de 

passe chez Tidetech, ceux-ci vous seront demandés. 

Si plusieurs zones sont concernées par le téléchargement, une boite de dialogue apparait avec 

l'ensemble des zones concernées. Vous pouvez alors limiter le téléchargement à certaines zones 

seulement en décochant les zones non souhaitées. 

 

 

Les fichiers sont ensuite téléchargés, le ruban Tidetech est remplacée par le ruban des prévisions et les 

gribs sont affichés à l'écran. 

 

 

4.10.5 Changement du nom d'utilisateur et du mot de passe. 

Si vous souhaitez changer votre nom d'utilisateur et votre mot de passe, cliquez sur l'icône   

et saisissez les nouvelles informations. 
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4.11 Visualiser / cacher les courants 
 

Les courants peuvent être affichés ou cachés à l'aide du menu " Affichage météo ". La touche F3 

permet également d'afficher ou de cacher globalement l'ensemble des prévisions (courants, vent, 

pressions, …). 

Les courants affichés sont une interpolation horaire des atlas (Si vous êtes en mode replay, 

l'interpolation se fait sur l'heure de la trace en cours) 

La densité d'affichage des courants peut être ajustée, comme les barbules de vent, avec le curseur " 

Densité barbules " du ruban de prévisions. 

 

La position tout en bas affiche en " réel ", c'est à dire que tous les vecteurs de courants disponibles sont 

affichés. La valeur suivante (x1) affiche environ une flèche tous les 1 cm à l'écran et ainsi de suite... 

 

4.12 Anticiper les courants à venir 
 

Vous pouvez anticiper les variations de courant à l'aide de la touche F6 qui affiche les courants ¼ 

d'heure plus tard chaque fois que vous pressez dessus. Pour revenir en arrière, appuyez sur F5.  

 

4.13 Visualiser la valeur du courant sur un point de l'écran 
 

Effectuez un clic-droit sur le point du plan d'eau dont vous souhaitez connaître le courant. Un menu 

contextuel s'affiche : 

  

 

La partie haute du menu permet de lancer diverses fonctions, la partie basse donne des informations 

sur la position pointée. Le courant y est indiqué dans le sous-menu " infos ici " (Courant : 1.2nd au 
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203°). Il s'agit d'une interpolation horaire et géographique (informations des quatre points de courants 

les plus proches fournis par l'Atlas). 

 

Vous pouvez également faire apparaitre la valeur du courant au curseur de la souris en permanence 

dans une des informations numériques sur la droite de l'écran. Voir le chapitre Les données 

numériques et l'annexe - Les informations curseur  

 

4.14 Recaler l'heure des courants 
 

Il peut arriver que les courants soient décalés par rapport aux prévisions de Marées. Vous pouvez alors 

les recaler, pour cela, lancez le menu " Prévisions→ Courants→ recaler". 

 

 

 

Saisissez la valeur du décalage, en minutes (touche 'M') ou en heures (touche 'H'). Une valeur positive 

va avancer les prévisions de courant, une valeur négative va les retarder. 

Attention : cette opération ne recale pas l'heure d'affichage (comme dans le menu " Affichage météo ") 

mais affecte tous les calculs relatifs aux courants (notamment dans les routages). 
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4.15 Décharger un grib de courants 
 

Pour décharger un grib de courants, lancez le menu " Prévisions→ Courants→ Décharger un grib " 

 

4.16 Désactiver une famille de courant 
 

Il est possible de désactiver globalement toute une famille de courant (Shom, Proudman, Winning Tides 

ou Grib). Cela présente plusieurs intérêts : 

• Accélérer le rafraichissement de l'écran 

• Lever toute ambiguïté sur les zones ou plusieurs familles de courant se superposent. 

 

Rappel : lorsque 2 familles de courant actives se chevauchent : le logiciel superpose les 2 familles à 

l'écran et effectue ses calculs sur la famille dont la densité est la plus élevée. 

Pour activer ou désactiver une famille de courant, sélectionnez le menu " Prévisions→ Atlas de 

Courants " puis cochez ou décochez les familles concernées. 

 

4.17 Marée 
 

" Adrena " intègre un outil de calcul permanent des marées permettant de connaître, en tout point du 

globe et à tout moment : le coefficient de la marée, la hauteur et la tendance. 

Ces données peuvent être consultées par l'utilisateur. Elles sont également utilisées pour le calcul de 

certains courants. 

 

4.17.1 Courbe de marée à la position du bateau 
 

Lancez le menu " Prévisions→ Marée ". Le logiciel recherche le port de référence le plus proche de la 

position du bateau et affiche la courbe de marée du jour considéré (dans le cas du mode replay, la 

courbe est celle du jour de la navigation rejouée). 
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Les différentes informations présentes sur l'écran sont : 

Port de référence : port le plus proche géographiquement qui sert de référence pour le calcul de la 

courbe. Date dont la courbe de marée est affichée : par défaut c'est la date du jour (ou la date de la 

navigation lors d'un replay). Vous pouvez modifier cette date pour visualiser la courbe de marée d'un 

jour quelconque. Pour cela, ouvrez le calendrier à l'aide de la flèche située à droite de la date ou 

saisissez directement la date dans la zone. 

Vous pouvez également avancer d'un jour (icone ), d'une semaine (icone ) ou reculer d'autant 

(icones  et ). 

 

Bouton " maintenant". Recentre la courbe sur la date d'aujourd'hui et le curseur sur l'heure courante. 

 

Courbe : la courbe donne la hauteur d'eau tout au long de la journée au port de référence considéré. Le 

curseur horaire est positionné par défaut sur l'heure courante, il peut être déplacé en cliquant 

directement sur la courbe. La ligne horizontale rouge indique la hauteur d'eau à l'heure pointée par le 

curseur, La ligne verticale rouge indique l'heure pointée. 

 

Coef. /marnage : coefficient de la marée et hauteur du marnage (différence entre marée basse et 

marée haute), 

Pleine mer : hauteurs et heures des marées haute de la journée, 
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Basse mer : hauteurs et heures des marées basse de la journée, 

Curseur : rappelle l'heure à laquelle est positionné le curseur (heure courante par défaut), 
indique la hauteur d'eau correspondant et combien il reste à descendre (en, pourcentage et en 
hauteur), 
TU : rappel de la référence d'heure utilisée (par rapport à l'heure TU). Vous pouvez choisir une 

référence en heure universelle (TU) ou en heure locale. 

 

4.17.2 Courbe de marée à un point précis du plan d'eau 
 

Effectuez un clic-droit sur le point dont vous voulez connaître la marée et choisissez le menu " Marée à 

XXX ". 

 

 

Le logiciel recherche le port de référence le plus proche de la position pointée et affiche la courbe de 

marée du jour considéré (dans le cas du mode replay, la courbe est celle du jour de la navigation). 

 

4.17.3 Marées issues de SHOMAR 
 

Depuis la version 12 du logiciel et en souscrivant à un abonnement annuel, le calcul des marées 

effectué par Adrena utilise le moteur de calcul SHOMAR issue du SHOM. Cela augmente la précision et 

offre la possibilité de choisir directement le port de référence pour lequel on veut afficher la marée par 

le menu déroulant. 
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4.18 Affichage d’images géo-référencées 
 

Certains fichiers, disponibles auprès des centres de météorologie et de certains sites web, contiennent des 

images géo-référencées comme des prises de vues satellite ou des données météo. Généralement proposé 

au format KMZ ou KML 

Le menu Prévision→ Images → afficher permet de sélectionner l’image à superposer sur la carte 
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4.18.1.1 Synchronisation du timing de l'affichage météo 

Si les fichiers importés sont datés, le timing d'affichage de la météo est synchronisé sur le fichier. 

4.18.1.2 Gestionnaires d'images géoréférencées 

Trois gestionnaires de fichier se trouvent dans le menu carte afin de conserver ces images superposées et 

de les classer par type : 

_ Cartes météo 

_ Fichier de glace 

_ Photos satellites 

 

Importer : bouton de chargement permettant de choisir un fichier. Kml, .kmz où .sat (Squid) 

NOAA : accès au téléchargement direct de carte d’analyse ou de fichiers de glace en provenance de la 

NOAA. Il est possible de choisir entre plusieurs zones :  

• Cartes d’analyse 

o Hémisphère nord 

o Atlantique nord 

o Pacifique nord 

• Fichiers de glace 

o Arctique 

o Antarctique 
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Modifier : Ouvre la fenêtre d’édition de l’image. Vous pouvez modifier le nom du fichier, gérer la 

transparence et la couleur du polygone quand le fichier en contient un. Cette fenêtre s’ouvre également au 

chargement du fichier. 
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5 AFFICHAGE METEO 
 

5.1 Sélection des données à afficher 

Pour chaque donnée disponible dans un fichier météo chargé, vous pouvez activer ou désactiver son 

affichage en utilisant la case à cocher qui se trouve à sa gauche 

 

 

 

5.2 Propriétés d’affichage 

Les paramètres d'affichage des données se trouve dans le bouton  à la gauche de chaque donnée 

 

5.2.1 Coloration de donnée 
Certaines données météo comme le vent, la pression ou la hauteur des vagues peuvent être représentées à 

l'écran par un spectre de couleurs réparti selon un échelle de valeurs.  

Les valeurs minimales et maximales de cette échelle sont réglées manuellement ou automatiquement en 

fonction du fichier météo affiché à l'écran. 

Pour accéder à ce réglage cliquez sur le bouton des paramètres d'affichage  de la donnée à colorer et 

cliquez sur la case correspondante.   

 

 

 

L'option "en continu" affiche un dégradé de couleur de la valeur la plus basse à la plus haute. Il est 

également possible de délimiter les zones de couleurs en choisissant l'incrément dans la liste.  
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Exemple : en sélectionnant 5 nœuds pour la coloration du vent on obtiendra une couleur différente pour 

les valeurs de 0 à 5 nœuds puis de 5 à 10, etc… 

 

  

 

L'échelle défini la valeur la plus basse et la valeur la plus haute du spectre de couleurs. En appuyant sur 

"Auto" on règle automatiquement la valeur haute et/ou basse en fonction des valeurs affichées à l'écran 

 

Exemple pour une échelle de 0 à 50 nœuds: 
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Affichage du même fichier avec réglage automatique de l'échelle de 0,2 à 29,1 nœuds (valeur min/max 

présentes à l'écran) : 

 

 

Pour ne pas altérer la lisibilité sur l'écran, il n'est pas possible de colorer simultanément le vent, les 

pressions ou toute autre donnée. Si vous cochez la coloration des pressions, la coloration du vent et des 

vagues sera automatiquement dévalidée. 

 

5.2.2 Ligne d'égale valeur 
Les lignes d'égale valeur relie tous les points de même valeur d'une donnée météo.  

Exemple : affichage des lignes d'égale valeur sur la donnée "pression atmosphérique" (isobares) 
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Vous pouvez afficher des lignes d'égale valeur en spécifiant le pas entre chaque ligne : 

 

 

 

5.2.3 Vent 
 

 

 

Vous pouvez afficher les barbules : case à cocher " Barbules ".  

 

La case " Légende sur barbules " permet d'afficher la valeur du vent sur chaque barbule en approchant 

la souris de la barbule. 
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Pour comparer les valeurs des différents Gribs à la position du curseur, sélectionnez l'option " 

Infobulles vent ". 

La valeur du vent au curseur pour chacun des gribs présents à l'écran sera affichée en haut à gauche de 

la carte : 

 

 

 

 

5.2.4 Pressions 
 

 

 

Pour afficher les pressions sous forme d'isobares, cochez la case " isobares " et sélectionnez le pas 

désiré. Pour colorer les pressions, cochez la case " colorer " et sélectionnez le pas désiré. 
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5.2.5 Pluie / Humidité 
 

L'affichage de la pluie ou de l'humidité en altitude (selon le contenu du grib) se fait en cochant la case " 

Pluie ". Elle apparaît alors sous forme de nuage qui permet de visualiser les fronts. 

 

 

 

 

5.2.6 Courants 
 

 

 

 

Note : Les paramètres " Lignes d'égales vitesses " et " Colorer " ne sont disponibles que pour les gribs de 

courants (et pas pour les atlas). 
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Les courants sont affichés sous forme de flèche (sauf si vous décochez la case " Flèches : Afficher "). La 

valeur de chaque point de courant peut être affichée à coté de chaque flèche. 

 

Vous pouvez choisir d'afficher cette valeur soit " Toujours ", soit " selon zoom ", c'est à dire lorsque les 

flèches ne sont pas trop serrées à l'écran, soit " Jamais ". 

Les flèches peuvent être colorées en fonction de la valeur du courant. Cochez, pour cela, la case " 

Colorer ". 

La valeur des courants pouvant être très variable d'une région à l'autre ou selon la période de l'année, 

vous pouvez ajuster la plage de coloration. Pour cela saisissez, dans " valeur max. " la valeur de courant 

pour laquelle la coloration sera maximum (rouge soutenu).  

Si vous saisissez 2 nds en valeur max et 0.1 nds en valeur min, par exemple, les courants seront colorés 

de bleu foncé (0.1 nd) à rouge soutenu (2 nds et plus). 

La valeur min fait également disparaître toutes les flèches de courant dont la vitesse est inférieure à 

cette valeur. 

Le bouton " Auto " permet d'ajuster automatiquement les valeurs min et max en fonction des courants 

présents à l'écran. 

Lorsque les flèches ne sont pas colorées en fonction de la vitesse du courant, elles peuvent prendre 2 

couleurs : jaune lorsque la flèche correspond à un point de courant décrit dans l'atlas ou le grib, blanc 

lorsque cette valeur est interpolée à partir des informations de l'atlas ou du grib. 

5.2.7 Vagues  
 

Différents types de vagues 

Les fichiers GRIB décrivent différents types de vague : 

 

Mer du vent : c'est la mer soulevée par le vent en cours sur la zone. Sauf effet de côte particulier, elle 

est de même direction que le vent ou avec un écart très faible.  
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Houle : mer levée par un vent qui ne souffle pas ou plus sur la zone. On peut distinguer plusieurs trains 

de houle qui se superposent entre eux et avec la mer du vent. Adrena ne prend en compte que le 1er 

train de houle (le plus important). 

 

 

 

Mer totale : c'est le descriptif de la combinaison de la mer du vent et des différents trains de houle. Par 

définition, la mer totale n'a pas de direction (puisqu'issue d'une combinaison de vagues de directions 

différentes). On ne décrit donc que sa hauteur significative qui est généralement calculée comme la 

moyenne du tiers des vagues les plus hautes (H 1/3). 

 

 

Mer croisée : le descriptif de la mer croisée est une notion spécifique au logiciel Adrena. Elle est très 

relative et dépend beaucoup de votre bateau (longueur, monocoque ou multicoque). 

La mer croisée est calculée en comparant la mer du vent et le 1er train de houle. Vous décrivez vous 

même ce que vous considérez comme de la mer croisée en fonction de l'angle minimum entre les 2 et 

de leur hauteur respective. Voir  Etat de la mer 

 

 

La mer croisée peut être affichée de différentes façons : 
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Contour ou coloration de la zone concernée : cocher la case correspondante.  

 

 

Hauteur relative de la houle par rapport à la mer du vent : cochez la case " lignes d'égale hauteur " ou " 

colorer delta hauteur " et spécifiez le pas. 

 

 

 

Écart de direction entre la houle et la mer du vent cochez la case " L. d'égal delta direction " ou " colorer 

delta direction " et spécifiez le pas. 
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5.2.8  Vent en altitude  
 

Les vents en altitude peuvent être des vents isobariques (à 850 ou 950 hPa par exemple) ou à une 

altitude définie (1000 m, par exemple). Le logiciel s'adapte au contenu du GRIB et affiche dans le ruban 

le type de vent rencontré (" Vt 850 hPa " par exemple). 

Vous pouvez afficher les vents en altitude sous forme de barbules : case à cocher " Barbules ". 

 

 

La coloration peut se faire sur l'écart entre les vents à 10m et les vents en altitude. Pour cela, cliquez sur 

" Delta vent Altitude " dans les options d'affichage du vent en altitude. 

 

 

 

5.2.9  Rafales 
Les rafales sont exprimées par une vitesse sans notion de direction. Elles sont donc le mieux 

représentées par une coloration en fonction de la vitesse. Pour cela activer la case à cocher " Rafales ". 
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5.2.10 Delta Rafales 
Dans un grib comprenant du vent et des rafales il est possible de représenter la différence entre les 

deux par une coloration. Pour cela cliquez sur les options d'affichage des rafales et sélectionnez " Delta 

Rafale " :  

 

 

5.2.11 Interpolation des barbules 
La densité des barbules peut être réglée avec le curseur de réglage située à l'extrémité du ruban. 

 

 

La position basse du curseur correspond à une taille " réelle " : une barbule sera affichée pour chaque 

information présente dans le fichier.  

 

Attention ! : à un certain niveau de zoom large, la densité élevée d’informations présente dans certains 

fichiers rend la lisibilité impossible en mode réel. Le logiciel remplace alors les barbules et les flèches par 

des points. 
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Les autres positions (1 à 5) permettent de régler la densité. La densité 1 correspond à une barbule tous 

les cm environ (selon taille et résolution de l'écran), la densité 5 correspond à une barbule tous les 2mm 

environ. 

5.3 Timing 
 

 

Pour avancer ou reculer l’ensemble des prévisions dans le temps, utilisez les boutons moins et plus du 

panneau de timing ou déplacez le curseur de gauche à droite. 

Le pas de temps peut être modifié en cliquant sous les boutons plus et moins. Pour revenir à l’heure 

actuelle cliquez sur le bouton maintenant. 

 

5.4 Les météogrammes 
 

Les météogrammes permettent de visualiser l'évolution prévue du vent et de la pression en un point 

donné. 

Pour afficher un météogramme, faites un clic droit sur la carte au point désiré et choisissez " 

Météogramme ". 
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Vous pouvez choisir les informations à afficher : 

• Vitesse du vent 

• Direction du vent 

• Vitesse et direction du vent sous forme de barbules 

• Pression 

• Rafales 

 

Les icones permettent respectivement : 

 Zoom + : affiche plus de détails, 

 Zoom - : affiche une plus grande plage de données, 

 Scroll droit : visualise les données plus proches dans le temps, 

 Scroll gauche : visualise les données plus lointaines dans le temps, 

 Recentre le timing sur l'ensemble du grib, 

 Effectue une copie écran du météogramme et le place dans le presse-papiers, 

 Exporte l'ensemble des données du ou des grib au point considéré dans un tableau de type Excel 

ou Open Office. 
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5.4.1 Météogramme multi-gribs 
 

Si plusieurs fichiers grib sont affichés sur la zone pour laquelle on affiche le météogramme, les données 

sont superposées sur le graphique. 
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6 ROUTAGE 
 

Le module routage d'Adrena est un outil puissant pour le calcul de la meilleure trajectoire à suivre en 

fonction des possibilités de votre bateau et des conditions prévues de météo (vent et courants 

notamment). 

 

L'utilisation d'un routage est assez simple : on définit un point de départ, un point d'arrivée, on précise 

les prévisions météo (fichier GRIB) et les performances du bateau (fichier Polaire). Le logiciel calcule 

ensuite la route à suivre pour aller le plus rapidement possible du départ à la destination. 

 

Dans la pratique, il est cependant nécessaire de faire intervenir quelques paramètres supplémentaires 

pour être sûr d'obtenir les meilleures trajectoires : 

 

Éviter les côtes : le bateau ne pourrait évidemment pas suivre un routage qui le conduirait au milieu 

des terres, 

Faire des hypothèses sur les prévisions : que se passera-t-il si le vent est moins fort (plus fort) que 

prévu ? 

Corriger les polaires. L'équipage commence à être fatigué / une voile est hors d'usage : il convient de 

minimiser les performances du bateau 

Placer des marques intermédiaires si les instructions de course le prévoient ; il convient alors de 

préciser si la marque est à laisser à bâbord ou à tribord afin que le routage explore toutes les 

possibilités passant du côté requis de la marque. 

 

Le routage d'Adrena permet de prendre en compte tous ces paramètres, d'explorer différentes 

hypothèses et de les comparer entre elles. 
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6.1 Préparer un routage  
 

Lancez le menu " Routage→ calculer un routage " 

 

 

La boite de calcul de routage comporte beaucoup de paramètres et tous ne vous sont pas forcément 

nécessaires. Afin de ne pas surcharger l'écran, les différentes options sont rangées dans des onglets de 

la boite de dialogue. Lorsque la valeur de certains paramètres est forcée (par ex : % grib) ou certaines 

options activées (par ex : balayage, …), cela vous est signalé par un liseré rouge sur l’onglet. 

 

6.2 Départ - Destination 
 

6.2.1 Nom du routage 
Vous pouvez donner un nom au routage calculé. Par défaut, les routages prennent les noms " routage 1 

", " routage 2 ", etc. 

Génération automatique du nom : En cliquant sur l'icône , le nom sera automatiquement généré 

à partir des paramètres de calcul : 

Nom du 1er Grib avec son pourcentage 

Nom et pourcentages des 2ème et 3ème grib s'ils sont présents 

% de polaire 

Date et heure de départ 
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Il est possible de paramétrer vous-même le contenu de ce nom à partir des différents paramètres de 

calcul, voir ANNEXE - NOMMAGE AUTOMATIQUE DES ROUTAGES 

 

6.2.2 Choix de la couleur du routage 
Le choix de la couleur du routage est modifiable par le bouton à l'extrémité de ligne de nommage : 

 

 

Il est également possible de modifier le nom d’un routage déjà affiché en utilisant le menu obtenu par un 

clic-droit sur la légende du routage " Changer le nom et la couleur du routage ". 

 

   

 

6.2.3 Rappel d'un routage : 
Lorsque vous aurez effectué plusieurs routages, vous pourrez les rappeler dans la liste déroulant 

proposant le nom du routage, cela vous permettra d'en modifier les paramètres ou de les utiliser 

comme modèle pour explorer une nouvelle hypothèse. 

Après avoir rappelé un routage et modifié les paramètres, vous pouvez le relancer sans en changer le 

nom, auquel cas cela remplacera l'ancien routage ; soit modifier son nom, auquel cas cela créera un 

nouveau routage sans supprimer l'ancien. 

 

6.2.4 Heure de départ 
L'heure de départ peut être définie en saisissant la date et l'heure dans la case située en face de la zone 

" Date ". 

Pour un départ immédiat (notamment pendant la course), cliquez sur " maintenant ". 
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6.2.5 Lieu de départ 
Le lieu de départ peut être défini en pointant directement un point sur la carte (cliquez sur " Pointer ") 

ou en choisissant un waypoint préalablement saisi (cliquez sur " Waypoint "). Si vous êtes en mer et 

souhaitez router depuis la position du bateau, cliquez sur " ici ". 

 

 

6.2.6 Destination 
La destination peut être définie en pointant directement un point sur la carte (cliquez sur " Pointer "), 

en choisissant un waypoint préalablement saisi (cliquez sur " Waypoint ") ou en choisissant un parcours 

dans lequel vous aurez indiqué les marques à passer et le coté où les laisser. 

Pour créer un parcours, voir le chapitre Créer un parcours. 

Lorsque vous choisissez un parcours, le logiciel affiche la liste des waypoint le composant afin que vous 

puissiez choisir le 1er waypoint à passer. 

 

Lorsque vous naviguez et que le parcours du routage est aussi le parcours actif, le logiciel sélectionne 

automatiquement le waypoint en cours. 

Lorsque vous relancez un routage sur un parcours qui a été modifié entre temps ou dont un waypoint a 

été modifié, le logiciel le détecte automatiquement et vous propose de réutiliser l’ancienne ou la 

nouvelle configuration.  

6.2.7 Actualisation rapide du routage 
L'utilisation du bouton " Ici, maintenant et prochain WP" permet d'actualiser en un clic la position de 

départ, la date et le prochain waypoint de destination du routage lorsque l'on suit un parcours. Ceci est 

utile en navigation lorsque l'on souhaite remettre à jour un routage. 
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6.3 Paramètres de calcul 
Différents paramètres permettent d'affecter la précision des calculs effectués par le routage. 

 

6.3.1 Angle de balayage 
C'est l'angle des routes explorées par le routage. Il s'agit de l'angle total balayé : 120° conduira le 

logiciel à explorer 60° de part et d'autre de la route directe. 

 

6.3.2 Durée isochrones 
C'est la durée de chaque pas calculé. On prend généralement la moitié du pas de temps fourni par le 

GRIB. Pour un routage côtier où le courant a une grande importance et où les segments entre deux 

côtes peuvent être assez courts, il peut être judicieux de diminuer ce temps. Vous pouvez saisir cette 

valeur en heures ou en minutes. 

 

Attention : diminuer la durée de chaque pas, permet d'obtenir un routage plus précis et plus fin mais 

allonge les temps de calcul. Si un calcul s'avère trop long, interrompez-le (c'est possible en cours de 

calcul) et modifiez ces paramètres pour ramener le calcul à un temps raisonnable. 

 

6.3.3 Durée max 
C'est le temps maximum que l'on se donne pour la durée du parcours. 3 J par exemple va permettre 

d'arrêter les calculs lorsque le trajet estimé sera de trois jours parce qu'on estime que les prévisions ne 

sont plus suffisamment fiables au-delà. Vous pouvez saisir cette valeur en jours ou en heures. 

Note : il est inutile de spécifier une durée max supérieure à celle du GRIB car le routage s'arrête en fin de 

GRIB si besoin. 

 

6.3.4 Polaire 
La polaire à prendre en compte peut être choisie parmi l'ensemble des polaires disponibles dans la liste 

des polaires. Les fichiers correspondants doivent impérativement être situés dans le répertoire " 

polaires " d'Adrena (généralement " C:\Program files\Adrena\polaires " sous XP, " C:\Program Data 

\Adrena\polaires ", sous Vista et Seven). 

 

Vous pouvez altérer la polaire en saisissant une valeur autre que supérieure ou inférieure à 100% dans 

la zone correspondante. 

 

6.3.5 Limite d’angle de vent 
 

Pour pallier à certaines contraintes non intégrées dans la polaire (vagues, équipage réduit…), il est possible 

de fixer un angle minimum de remontée au vent ou maximum de descente dans le vent. 
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Indiquer les valeurs à respecter dans les champs correspondants, elles seront prises en compte par le 

routage si la polaire indique que l’angle cible se situe au-delà de ces limites. 

 

 

6.3.6 Balayer selon la loxodromie 
Cette option permet de balayer le plan d'eau autour de la loxodromie au lieu de l'orthodromie. Cela est 

utile dans le grand sud où un balayage orthodromique irait tester inutilement les routes situées trop 

près du pôle. Cela permet dans ce cas de limiter l'angle de balayage. 

 

 

6.3.7 Routage mixte 
 

Le routage mixte (voile / moteur) est destiné à effectuer des routages dans le cadre des croisières et 

des convoyages lorsque l'usage du moteur est possible. 

Ce routage va évaluer l'utilisation du moteur chaque fois que cela est pertinent. 

6.3.7.1 Paramétrage 

Pour effectuer un routage mixte, commencez par décrire dans les paramètres généraux, les 

caractéristiques du bateau : 
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Indiquez " Mixte " comme type de propulsion et renseignez la vitesse du bateau en régime de croisière 

au moteur ainsi que la consommation de carburant (en litres / heure) à ce régime. 

 

6.3.7.2 Lancement d'un routage mixte 

Un routage mixte se lance comme les routages classiques, par le menu " Routage→ Calculer un routage 

" 

 

 

Saisissez l'ensemble des paramètres comme pour un routage à la voile puis cochez " Utiliser moteur si 

besoin ". Précisez ensuite la vitesse minimum que vous acceptez à la voile.  

Si vous indiquez 4 nœuds de vitesse mini à la voile, le routage utilisera le moteur chaque fois que le 

vent est insuffisant pour obtenir cette vitesse. 
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Lancez ensuite le calcul. 

 

 

 

A l'issue du calcul, la route optimum apparait à l'écran ; en trait continu, les segments sur lesquels la 

navigation se fait à la voile, en traits pointillés, les segments où la navigation se fait au moteur. 
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6.3.7.3 Tableau de marche 

 

Vous accédez au tableau de marche par le menu " Routage→ Tableau de marche ". 

 

 

La colonne " voiles " indique les voiles à utiliser (si vous avez intégré des Sailect) ou la notion " Au 

moteur " chaque fois que cela est le cas. 

 

La colonne 'Conso. Cumulée " indique le cumul de consommation de carburant. Vous pouvez de la 

sorte connaitre la quantité de carburant nécessaire pour effectuer votre route. 

 

Si cette consommation vous semble trop élevée, relancez un routage en diminuant la vitesse mini à la 

voile. Vous obtiendrez alors une route un peu plus longue en durée mais plus économe en carburant. 

 

 

6.4 Gribs - Vents 
6.4.1 GRIB 

Les prévisions de vent peuvent être choisies parmi les GRIB que vous avez préalablement chargés. Si 

vous n'en avez encore pas chargé, cliquez sur le dossier ouvert pour choisir le fichier GRIB à charger. 

Vous pouvez altérer les forces de vent prévues par le GRIB (en plus ou en moins) en spécifiant un 

pourcentage dans la zone prévue à cet effet (100% : pas d'altération, 120% = augmentation de 20% des 

forces de vent). 

 

GRIB supplémentaires 
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Les GRIB supplémentaires permettent de charger des GRIBS de vagues ou des GRIBS de vents (si vous 

disposez de GRIB de courants, chargez les dans " Prévisions→ Courants→ Charger un GRIB de courants 

").  

 

Il peut être intéressant d'utiliser plusieurs GRIB de vent au cours d'un même routage, par exemple 

lorsqu'on dispose de GRIB fins près des côtes et de GRIB plus généraux au large. 

Pour spécifier plusieurs GRIB, saisissez le GRIB principal dans la première zone, la deuxième zone 

permettra ensuite d'en saisir un deuxième et ainsi de suite jusqu'à 10 GRIB maximum. 

 

Lorsque vous utilisez plusieurs GRIB de vent, le routage sélectionne à tout instant et en tout lieu, les 

GRIB couvrant le point concerné à l'instant donné et privilégie dans l'ordre : 

 

Le GRIB le plus fin (résolution géographique) 

Le GRIB dont le pas de temps est le plus serré 

Le GRIB le plus récent 

Le GRIB de rang le plus élevé dans la liste 

 

 

6.4.2 Vent 
 

Il est également possible de forcer une force et une direction de vent en cliquant sur " forcer " et en 

remplissant les zones correspondantes. Cela peut être utile pour faire un routage côtier qui détermine 

la meilleure trajectoire compte tenu des courants. 

Le bouton  permet de forcer le vent sur le vent mesuré sur la centrale. 

 

Décaler le GRIB 

Si vous constatez que le phénomène météo est en avance ou en retard sur les prévisions, vous pouvez 

décaler l'ensemble du GRIB (ou des GRIBs) de vent de la durée que vous souhaitez. Vous pouvez saisir 

le décalage en minutes ou en heures. 

Saisissez une valeur négative si la réalité est en avance sur les prévisions ou positive dans le cas inverse 

 

Tendre vers le GRIB 

Si en naviguant, vous constatez que les conditions de vent ne sont pas en phase avec les prévisions, il 

est possible de forcer le vent sur le début du routage et de " glisser " progressivement vers les 

prévisions du GRIB. 
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Pour cela, cochez la case " Tendre vers GRIB depuis :" et saisissez le vent pour le début du routage 

(vous pouvez cliquer sur  pour récupérer directement le vent sur la centrale). Spécifiez ensuite la 

durée de ce forçage. 

Au début du GRIB, le vent sera celui que vous avez forcé ; après le temps spécifié le vent sera celui du 

GRIB ; entre les deux, le vent passera progressivement du vent forcé au vent du GRIB (en vitesse et en 

direction). 

 

 

6.4.3 Vent minimum et maximum 
Si vous voulez éviter les zones où le vent est trop faible, saisissez les valeurs minimums de vent 

souhaitées dans zones " vent mini au près " (0 à 90° du vent) et " vent min au portant " (90 à 180° du 

vent). 

Si vous ne souhaitez pas être conduit sur des zones où le vent est trop fort, saisissez les valeurs 

maximums de vent souhaitées dans zones " vent max au près " (0 à 90° du vent) et " vent max au 

portant " (90 à 180° du vent). 

 

6.5 Courants - Vagues 
6.5.1 Courants 

Vous pouvez demander au routage de prendre en compte les courants définis par les atlas de courant 

(ou les fichiers grib chargés) ou bien de forcer la valeur du courant. 

Le bouton  permet de forcer le courant sur le courant mesuré sur la centrale. 

La zone de pourcentage permet d'affecter une correction aux vitesses des courants : 80% par exemple 

si vous pensez que la vitesse réelle des courants est inférieure aux prévisions. 

 

6.5.2 Vagues 
 

Le module Routage propose plusieurs paramètres permettant la prise en compte de l'état de la mer 

dans les calculs. 

 

Fichier GRIB de vagues. 

Si l'un des fichiers GRIB de vent que vous avez spécifié contient des informations de vagues, Adrena 

utilisera ces informations. Sinon, spécifiez un GRIB spécifique de vagues dans l'une des zones GRIB. 
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Corriger vitesses cibles 

Vous pouvez demander au logiciel de prendre en compte l'état de la mer (hauteur et direction de la 

houle) dans ses calculs de vitesse cible. De cette façon, le calcul de routage effectué sera plus réaliste. 

Pour cela, cochez la case " Corriger vitesses cibles par tableaux de correction ". 

Les tableaux de correction décrivent comment la houle influe sur les performances du bateau. Il faut les 

avoir définis au préalable, voir le chapitre Etat de la mer - tableaux correctifs de houle. 

 

Efficacité dans mer croisée 

La mer croisée peut être particulièrement gênante pour la bonne marche du bateau. Après avoir défini 

les paramètres de mer croisée (voir le chapitre Etat de la mer – définition de la mer croisée), spécifiez la 

correction à apporter lorsque le routage rencontre de telles conditions. Si vous indiquez 0%, le routage 

évitera systématiquement ces zones ; si vous indiquez 100%, la mer croisée n'aura pas d'effet sur le 

routage. 

 

Mer totale max. 

Vous pouvez spécifier une hauteur maximum pour la mer totale. 

Si vous spécifiez cette limitation, le routage éliminera les routes qui croiseraient une telle mer. 

 

 

6.5.3 Dangers à éviter 
Eviter les côtes 

Si vous souhaitez que le logiciel n'explore pas les routes passant dans les terres, cochez sur la case " 

Eviter les côtes". Le test est fait sur un trait des côtes mondial livré en standard avec le logiciel. Ce trait 

des côtes, fourni par le Shom, a une résolution d'une centaine de mètres environ. 

La case " Côtes par C-Map " va conduire le logiciel à utiliser les cartes C-Map dans les régions où vous 

en disposez, cela permettra d'affiner la précision du calcul et de trouver des parcours très proches des 

côtes mais cela ralentit quelque peu les calculs. C'est une fonction qui trouve son utilité lors des 

routages côtiers. 

 

Eviter les zones interdites 

Cette option permet d'éviter de traverser les zones interdites que vous avez dessinées dans le 

Roadbook. 

Pour qu'une zone soit évitée, il faut : 

Que l'option de routage " Eviter les zones interdites" soit cochée 

Que le RoadBook comportant la zone soit actif 

Que la zone dessinée ait été déclarée " interdite " 
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Voir le chapitre LES ROADBOOKS. 

 

Latitudes min et max 

En spécifiant des latitudes min et max, vous interdisez au routage de passer trop au nord ou trop au 

sud. 

 

6.5.4 Balayage 
Lorsqu'on effectue un routage, on ne se contente généralement pas d'étudier une seule hypothèse. On 

envisage les différentes situations qui peuvent différer de la solution idéale ou des prévisions fournies : 

 Le bateau va moins vite que l'optimum, 

Le vent est plus faible ou plus fort que prévu, 

Le phénomène météo est en avance ou en retard, 

... 

Pour simuler ces hypothèses, on effectue généralement plusieurs routages successifs en faisant varier 

certaines variables. 

 

Le routage Adrena permet d'effectuer ces différentes simulations de façon très simple en paramétrant 

les plages à balayer pour les différentes hypothèses puis en lançant d'un seul clic les différents routages 

correspondants. 

Les variables que vous pouvez balayer sont : 

La vitesse polaire du bateau 

La vitesse du vent 

Le décalage du GRIB 

L'heure de départ (pour les records, les convoyages ou la croisière) 

 

Les valeurs à balayer peuvent être spécifiées dans les colonnes " min ", " max " et " pas ", vous pouvez 

par exemple faire varier la vitesse du vent de 80 à 120 % des valeurs du GRIB par pas de 5%. 

Lorsque ces paramètres ont été spécifiés, il suffit de cocher la case correspondante de la fenêtre de 

calcul de routage pour que le logiciel calcul successivement les routages optimums correspondant à 

chaque variable balayée. 
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6.5.5 Options Diverses 
 

" Recentrer l'écran sur la route " : permet de recentrer l'écran sur l'ensemble du parcours avant de 

lancer les calculs et de suivre son avancement pendant les calculs. 

 

" Eviter coloration des Grib ". Si vous avez défini une coloration des vents ou des pressions sur 

l'affichage des GRIB, cette coloration ralentit l'affichage au cours du calcul. Il est par conséquent 

recommandé de laisser cette case cochée, ce qui aura pour effet de supprimer la coloration pendant le 

calcul. Si vous souhaitez visualiser ces couleurs pendant que le calcul s'effectue, décochez la case. 

 

" Cacher autres routages pendant le calcul ". Cette option permet de n'afficher que le routage en cours 

pendant les calculs. 

 

6.5.6 Suite de couleur 
La suite de couleur définit l’ordre dans lequel les couleurs sont attribuées aux routages au fur et à mesure 

où ils sont créés. 

En plus de la suite par défaut, on peut personnaliser les couleurs en cliquant dans le carré de couleur et en 

choisissant une couleur dans la palette proposée. 

 

 

 

Il est également possible de modifier la couleur d’un routage déjà affiché en utilisant le menu obtenu par 

un clic-droit sur la légende du routage " Changer le nom et la couleur du routage " 

En cliquant dans la case à la couleur du routage on peut accéder à une palette de choix de couleurs. 
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6.6  Lancer le calcul 
 

Lorsque tous les paramètres ont été définis, cliquez sur " Calculer " 

 

 

 

Le routage s'effectue pas à pas et vous pouvez suivre les différentes routes explorées à l'écran. Au 

cours du calcul, vous pouvez (fenêtre en haut à droite) : 

Suspendre provisoirement le calcul : cliquez sur " Suspendre ". Lorsque le calcul est suspendu, vous 

pouvez déplacer la carte, en modifier le zoom ou modifier les paramètres d'affichage. Vous ne pouvez 

pas accéder aux menus. Après avoir effectué les ajustements, cliquez sur " Reprendre " pour relancer 

les calculs. 

Terminer les calculs à l'échéance atteinte : cliquez sur " Terminer ". Le calcul s'arrêtera et le routage 

proposé s'interrompra sur le dernier isochrone calculé. 

Interrompre les calculs, cliquez sur " Annuler ". Les calculs sont abandonnés et la fenêtre de calcul est 

proposée à nouveau. Vous pouvez alors modifier un paramètre et relancer le calcul. 

 

Lorsque le calcul est terminé, un message indique le temps estimé du trajet et la route optimum 

apparaît à l'écran. 
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Les points présents sur la trace de la route représentent chacun un isochrone. 

Dans certains cas, la route effectue 2 bords pour joindre deux isochrones. Cela est dû au fait que 

lorsque la meilleure route sur un isochrone se trouve dans l'axe du vent (au près ou au louvoyage) et 

que le bateau ne peut suivre cette route en direct, le logiciel découpe l'isochrone en 2 bords de près ou 

de portant en suivant les targets de la polaire. 

En bas à droite de l'écran, une information vous rappelle la durée du trajet calculé pour ce routage, si le 

routage est arrivé au but ou pas et l'écart par rapport au premier routage de la liste. Lorsque vous 

aurez fait plusieurs routages, vous pourrez facilement comparer les différentes hypothèses entre elles. 

Pour connaître le nom des routages concernés, approchez la souris de la zone : 
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Vous pouvez également parcourir un routage en approchant la souris de chaque isochrone, le logiciel 

indiquera alors l'heure à laquelle le bateau atteindra cet isochrone, la distance au but correspondant, la 

direction du vent (TWD), l'angle du vent réel (TWA) et sa vitesse (TWS). 

 

 

En cliquant sur un point du routage le timing des prévisions sera synchronisé pour afficher l'échéance 

du grib concerné. 

 

6.7 Routage en 2 clics  
Dans certaines situations, il n'est pas nécessaire d'ajuster beaucoup de paramètres pour lancer un 

routage : 

Vous êtes sur l'eau : le moment et le lieu du départ sont connus 

Vous n'avez pas de grib et c'est le vent immédiat qu'il faut prendre en compte 

OU vous avez un grib mais il est déjà chargé 

 

Dans ces cas-là, vous pouvez lancer très facilement un routage. Faites un clic droit sur le lieu de 

destination (cela peut être un waypoint) et choisissez " Router jusqu'au curseur ". 

La boite de calcul de routage s'ouvre avec tous les paramètres positionnés : 

Date et lieu de départ, 

Lieu d'arrivée, 

Grib, si un grib couvrant la zone a déjà été chargé, 

Vent forcé (centrale) sinon 

 

Les autres paramètres sont les mêmes que lors du précédent routage. Bien entendu, vous pouvez 

encore ajuster certains paramètres mais ce n'est généralement pas nécessaire. 

 

Il ne vous reste plus qu'à lancer le calcul en cliquant sur " calculer ". 
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6.8  Tableau de marche  
Vous pouvez accéder au tableau de marche du routage calculé par le menu 'Routage→ Tableau de 

marche " 

 

Ce tableau indique, pour chaque segment calculé, la date et l'heure de début, la durée du segment, 

ainsi qu'un certain nombre d'informations paramétrables. 

Une coloration des segments en vert ou en rouge selon l'amure prévue permet d'évaluer rapidement 

les phases de virement ou d'empannage.  

Il peut arriver qu'un segment apparaisse en noir : c'est le cas si le segment ne peut être effectué en 

route directe et que le logiciel n'a pu déterminer les bords permettant d'arriver au but (présence de côte 

des deux côtés par exemple). C'est également le cas pour les bords à effectuer au moteur, voir le 

chapitre LE ROUTAGE MIXTE 

Chaque isochrone est représenté avec une même couleur de fond (blanc ou jaune). Il peut être 

composé d'un segment (route directe) ou de 2 segments lorsqu'il est composé de 2 bords. Dans le 2ème 

cas l'un des segments apparait en vert (tribord amure) et l'autre en rouge (bâbord amure). 

Avec le module Sailect et les descriptifs associés de vos voiles, le tableau vous indiquera également les 

voiles qui seront à utiliser sur le segment. 

Si vous avez calculé plusieurs routages, la liste " Routage " vous permet de sélectionner le routage à 

visualiser. 

Dans la partie gauche de l'écran, vous pouvez visualiser l'heure de fin prévue, la durée du routage, la 

distance parcourue, la distance au but, le GRIB utilisé (avec le pourcentage correctif) ainsi que la polaire 

(avec son pourcentage correctif). 

Les boutons " Exporter" et " Envoyer par mail" permettent de faire un export de la route pour l'envoyer 

sur un autre PC. Le format d'export accessible ici est compressé et n'est lisible que par Adrena. Voir le 

chapitre EXPORTER DES JOURNAUX A TERRE. 
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Paramétrage du Tableau de marche 

Il est possible de paramétrer les données apparaissant dans le tableau de marche. Cliquez sur " 

Paramétrer " puis cochez les informations que vous souhaitez voire apparaître dans le tableau. 

 

 

 

6.9 Forcer des points de passage sur un routage (pivots) 
Après avoir effectué un routage, vous souhaitez peut-être explorer d'autres routes que celle choisie par 

le logiciel. Pour rappel, la route choisie par Adrena comme la meilleure est celle qui conduit au temps 

de trajet le plus court pour les routages parvenus à destination et celle qui conduit au plus proche de la 

destination pour les routages qui n'ont pu parvenir à destination (fin du fichier GRIB ou temps 

maximum imposé atteint). 

Pour forcer un point de passage sur un routage préalablement calculé, lancez le menu " Routage→ 

Pivot " et sélectionnez le routage concerné. 

 

Le logiciel affiche ensuite la route conduisant au point visé par la souris. 
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Vous pouvez approcher la souris de chaque tronçon de route afin de connaître l'heure et la distance 

correspondant à cette échéance ainsi que la route menant à ce point. Pour synchroniser le GRIB sur un 

isochrone, cliquez sur l'isochrone souhaité. 

Double-cliquez ensuite sur le point à retenir. Adrena crée alors un nouveau routage passant par le point 

choisi, vous demande le nom de ce routage et termine le calcul de route entre le point choisi et la 

destination. 

 

 

 

L'endroit où a été positionné le pivot est matérialisé par une punaise. Les deux routes peuvent être 

comparées : information en bas à droite de l'écran ou par le tableau de marche. 
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Si vous souhaitez positionner un second pivot, lancez à nouveau le menu " Routage→ Pivot ", 

sélectionnez le routage possédant déjà un pivot et positionnez le 2ème pivot. Ce 2ème pivot ne peut être 

positionné qu'après le 1er. 

Vous pouvez positionner autant de pivots successifs que vous le souhaitez. 
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6.10 Isochrones inverses 
Le calcul des isochrones inverse consiste à partir du point d'arrivée d'un routage et de simuler un retour 

arrière à partir de ce point. On obtient un ensemble de courbes (isochrones inverses) qui relient tous 

les points situés à iso-temps (au sens routage) du point d'arrivée. 

De même que les isochrones sont l'ensemble des points qui peuvent être rejoints en un même temps 

depuis le point de départ, les isochrones inverses sont l'ensemble des points qui peuvent rejoindre le 

point d'arrivée en un même temps. 

Ils présentent deux intérêts : 

En navigation en flotte monotype et lorsque vous disposez des positions de vos concurrents, les 

isochrones inverses vous permettent de voir d'un seul coup d'œil les bateaux potentiellement en 

avance ou en retard sur vous. 

Par rapport à votre routage, l'observation des tangentes entre les isochrones directs et inverses vous 

permet de mesurer de quelle latitude vous disposez et quel risque vous prenez en vous écartant de la 

route optimum. 

 

Pour effectuer un calcul d'isochrones inverses, appelez le menu " Routages→ Options→ Calculer 

isochrones inverses " puis choisissez le routage sur lequel portera le calcul. 
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6.11 Isoroutes 
L'un des intérêts des isochrones inverses est l'observation de la latitude que l'on a à s'écarter de part et 

d'autre de la route optimale. 

Les isoroutes vous permettent de la faire de façon très visuelle. Ils comparent les isochrones et les 

isochrones inverses pour colorer la zone permettant d'arriver à la destination avec un minimum de 

retard par rapport à la route optimum. 

 

Commencez par définir le retard maximum à la route optimum avec le menu " Routage→ Option 

d’affichage→ Durée Isoroutes". 

Lancez ensuite le calcul sur le routage souhaité en lançant le menu " Routage→ Option → Afficher 

Isoroutes " ou en faisant un clic droit sur la légende du routage et en choisissant " Afficher les Isoroutes 

". 

Adrena calcule les isochrones inverses si cela n'a pas encore été fait puis les isoroutes sont calculées et 

affichées. 
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6.12 Affichage des routages à l'écran 
Après avoir calculé plusieurs routages, il est possible de choisir ceux que vous souhaitez voir apparaître 

à l'écran. Pour cela faites un clic-droit sur le routage ou sur sa légende en bas à droite de l'écran et 

choisissez " Cacher le routage ". 

 

6.13 Mise en évidence d'un routage 
Pour mettre un routage en évidence par rapport aux autres, approchez la souris de celui-ci ou de sa 

légende. 

 

6.14 Rappel d'un routage 
Tant que vous n'avez pas fermé Adrena, vous pouvez revenir à tout moment sur un routage (pour 

conserver un routage lorsque vous fermez Adrena, voir Sauvegarde d'un routage ci-dessous). Pour cela, 

rappelez la fenêtre de calcul de routage (Menu " Routage→ Calculer ") et ouvrez la liste des routages 

calculés (zone " nom "). L'ensemble des routages déjà calculés est proposée et vous pouvez en rappeler 

un. Vous pouvez alors changer les paramètres de calcul et relancer le calcul soit en conservant le même 

nom (vous remplacez alors le calcul précédant), soit en lui donnant un nouveau nom (ce qui permet de 

conserver le calcul précédant). 

 

6.15 Sauvegarde et chargement d'un routage 
Après avoir créé un routage, vous pouvez le sauvegarder afin de le retrouver ultérieurement. Pour cela, 

lancez le menu " Routage→ Sauver" et choisissez le routage à sauver ou faites un clic droit sur le 

routage ou sa légende et choisissez " Sauver ". 

 

Format de fichier : 

. erz10 : L’intégralité du routage sera alors sauvegardé (paramètres, calculs et balayages)  

.erz : Format de la version 9, seules la trace et les paramètres sont sauvegardés 

.rou : Sauvegarde de la trace seule 

.csv : Lisible en clair dans un tableur comme Excel 

 

Après avoir sauvé un routage, vous pouvez le recharger en lançant le menu " Routage→ 

Charger/décharger→ Charger routage ". 

Les paramètres du routage seront rechargés (ainsi que le GRIB associé si nécessaire) et le routage sera 

affiché directement à l’écran. 
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6.16 Déchargement d'un routage 
Vous pouvez décharger un ou plusieurs routages calculés par le menu " Routage→ Charger/Décharger " 

et sélectionner le routage dans la liste ou en faisant un clic-droit sur le routage ou sur sa légende. Cette 

fonction supprime un routage qui vient d'être calculé mais pas les routages que vous avez sauvés sur 

disque avec la fonction " Sauver un routage ". 

6.17 Animation d'un routage 
La simulation de routage est une fonction permettant d'anticiper et de comparer les routages entre eux 

à tout moment du trajet. 

Pour Animer des routages, lancez le menu " Routage→ Animation " et sélectionner le routage maître. 

Tous les routages calculés (et affichés) sont simulés ; le maître sert à contrôler le timing de la 

simulation. 

 

Le menu de replay apparaît et vous pouvez vous en servir pour guider le timing 

 

 

 

La vitesse de simulation est de 1 par défaut. Vous pouvez la changer avec le curseur " Vitesse " 

Les autres boutons permettent respectivement : 

  De reculer à l'isochrone précédant 

 D'avancer jusqu'au prochain isochrone 

 D'avancer jusqu'au prochain virement de bord ou empannage 

 De vous positionner directement sur un point de la simulation 

 De revenir en début de simulation 
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 De repartir en arrière 

 D'arrêter le mode simulation 

 De faire une pause 

 De partir en avant 

 De régler la vitesse à laquelle la trace est rejouée 

 

 Positionner directement à une heure précise de la simulation  

 

Vous pouvez vous positionner directement sur un point de la trace faisant un clic droit sur le point 

souhaité et en choisissant " Replay :  se placer ici ". 
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Pendant la simulation, vous pouvez visualiser la position respective de chacun des routages (le routage 

maître est légèrement surligné). Vous pouvez choisir les routages à afficher (Menu routage→ Options→ 

Affichage le routage). 

Les prévisions et les données affichées dans les données numériques (vent, courant pression 

atmosphérique, vitesses cibles, target, voiles à porter ...) sont relatives au routage maître. Vous pouvez 

sélectionner les données que vous souhaitez comme lors d'un replay classique. 

 

Pour changer de routage maître, double-cliquez sur le bateau du routage souhaité. 

Note : si vous avez affecté le fichier GRIB d'un coefficient d'altération, cette altération sera prise en 

compte dans l'affichage du vent des données numériques mais pas dans la représentation graphique 

des barbules ni dans la barre de statut qui reflète toujours le fichier GRIB original. 

 

6.18 Classer les routages 
Il peut être pratique de classer les routages entre eux du plus rapide au moins rapide. Pour cela, lancez 

le menu " Routage→ Classer les routages " ou faites un clic droit dans la légende de l'un des routages 

(en bas à droite) et choisissez " Classer les routages ". 

Le classement porte sur l'ordre des légendes en bas à droite (le plus rapide en haut). 
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6.19 Options 
Un certain nombre d'options d'affichage permettent d'affiner l'analyse des routages effectués. Elles 

sont accessibles par le menu " Routage→ Options " 

 

 

 

Certaines de ces options sont communes à tous les routages calculés (groupe " Tous routages "), 

d'autres sont propres à chaque routage (groupe " Par routage "). Pour modifier une option propre à un 

routage, sélectionnez d'abord le routage concerné (liste " Routage concerné ") puis précisez les options 

souhaitées. 

La boite des options d'affichage de routages peut être redimensionnée ou réduite pour visualiser et 

travailler sur les routages. Lorsqu'elle est réduite, une icône apparaît dans la barre de taches de 

Windows. Cliquez sur cet icone pour accéder à nouveau à la boite d'options. 
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6.19.1 Afficher prévisions le long de la route 
 

L'affichage des prévisions le long de la route offre une visibilité globale sur les conditions à rencontrer 

pendant le routage. Un symbole représente une prévision sur chaque isochrone du routage. Les 

prévisions disponibles sont : 

_ le vent fond prévu 

 

 

 

_ le courant prévu 

 

 

 

 

_ la marée 
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_ la direction et la hauteur des vagues (mer du vent et houle) 

 

 

 

_ la hauteur de mer totale 
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L’affichage des prévisions le long de la route peut être superposé sur un même routage 

 

6.19.2 Afficher les positions extrapolées 
L'affichage des positions extrapolées est utilisé en mer pour suivre l'avancée d'un ou plusieurs routages 

au fur et à mesure de votre navigation. Cela permet de comparer votre navigation effective avec les 

routages théoriques. 

Pour afficher les positions extrapolées, cochez le menu " Routage→ Options→ Afficher les positions 

extrapolées ".  
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6.19.3 Afficher les segments avec les isochrones 
Lorsqu'on affiche les isochrones d'un routage, les segments constituant la route calculée sont affichés 

également par défaut. Si vous souhaitez n'afficher que les isochrones, décochez la case. 

 

Affichage avec les segments    affichage sans les segments 
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6.19.4 Coloration des segments 
 

La coloration des segments est un outil puissant pour analyser les caractéristiques d'un routage. 

Elle concerne la route optimum qui a été calculée ainsi que toutes les routes explorées par le routage. 

Attention : les isochrones ne sont pas concernés par la coloration. Si vous souhaitez observer la 

coloration sur l'ensemble des routes explorées par le routage, la case " Afficher les segments avec les 

isochrones " doit être cochée. 

 

Il est possible de colorer les segments sur plusieurs critères : 

 

TWS : vitesse du vent réel (vent prévu par le grib et affecté du % de correction GRIB), 

TWA : angle du vent réel. Du rouge (près) eu bleu (portant), 

Amure : rouge pour bâbord amure, vert pour tribord amure, 

Vitesse bateau : du bleu pour une vitesse faible au rouge pour les vitesses les plus élevées, 

Voiles : la couleur est la couleur de remplissage de la Sailect de la voile d'avant retenue. Le type de trait 

est celui du contour de la Sailect de la GV retenue. 

Pression atmosphérique : du bleu pour les hautes pressions au rouge pour les basses pressions, 

Vitesse courant : du bleu pour les courants les plus faibles au rouge pour les courants les plus forts, 

Hauteur mer total : du bleu pour la mer là moins élevée au rouge pour la mer la plus élevée, 

Hauteur houle : du bleu pour la houle la moins élevée au rouge pour la houle la plus élevée. 

Stabilité du vent : (voir chapitre : Stabilité du vent) 

 

6.19.5 Exemple de coloration :  
Angle de vent réel 
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6.19.6 Afficher le routage 
Affiche ou cache le routage correspondant et tous les éléments associés (route optimum, légende, 

isochrones, ...) 

 

6.19.7 Afficher les isochrones 
Visualise à posteriori l'ensemble des isochrones qui ont été calculés pour le routage 

Si la case " Afficher les segments avec les isochrones " est cochée, cette option affichera également 

l'ensemble des routes qui ont été explorées par le routage. 

Vous pouvez afficher les isochrones de plusieurs routages simultanément en maintenant la touche 

<ctrl→ enfoncée pendant que vous coche la case. 

 

6.19.8 Afficher les isochrones inverses 
Affiche ou non les isochrones inverses liés au routage voir le chapitre Isochrones inverses 
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6.19.9 Afficher les balayages 
Si vous avez effectué des balayages autour du routage (voir le chapitre Balayer des variables), vous 

pouvez les afficher ou les cacher globalement en cochant ou en décochant la case correspondante. 

Si vous décochez " Polaires ", par exemple, vous cachez tous les balayages ayant été calculés en faisant 

varier le pourcentage de vitesse polaire. Le routage principal reste affiché. 

 

L'affichage des balayages se fait avec la même couleur que le routage principal associé mais en 

pointillé. Ils portent le même nom que ce dernier avec une indication de la variable balayée (par 

exemple " Routage 1 - pol80% " pour le balayage sur une vitesse polaire à 80%). 

Ils suivent les mêmes règles que le routage principal (cachés si vous cachez le routage principal, 

déchargés avec lui, ...). Ils n'apparaissent pas dans le tableau de marche et ne peuvent être sauvés ni 

exportés isolément. 

 

Si vous souhaitez travailler sur l'un des balayages d'un routage, vous pouvez le transformer en routage 

indépendant. Pour cela, faites un clic-droit sur le balayage ou sur sa légende et choisissez " Extraire le 

balayage ". 

 

 

 

 

6.20 Statistiques sur les vents rencontrés 
Cette fonction permet d'analyser les vents que vous allez rencontrer au cours des routages. 
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6.21 Statistiques sur les vents par angle ou par vitesse 
 

Lancez le menu " Routage→ Statistiques de vent → Comparatif " 

 

 

 

Un tableau propose les temps passés par tranche de vitesse de vent et par routage. 

 

Choisissez " Vent réel " ou " Vent apparent " selon le type d'analyse souhaitée. 

 

Il est possible d'afficher les données en durée, en pourcentage ou les deux cumulés : cochez ou 

décochez les cases correspondantes. 

 

L'analyse peut se faire par vitesse ou par angle de vent. 
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Analyse par vitesse de vent 

 

L'analyse fait par défaut sur les vitesses de vent affichées (0 à 4nds, 4 à 8, ...). Pour changer les vitesses 

de vent à analyser, cliquez sur le bouton " modifier vitesses " et choisissez les vitesses à analyser. 

 

 
Analyse par angle de vent 

 

Pour analyser les vents rencontrés par angles, cochez " Angles ". 

 

L'analyse fait par défaut sur les angles de vent affichées (0 à 30°, 30 à 35, ...). Pour changer les angles de 

vent, cliquez sur le bouton " modifier angles " et choisissez les angles à analyser. 

 

 

 

Différencier les amures 

Pour différencier les amures, cliquez sur Tribord + bâbord. Des colonnes seront créées pour chacune 

des amures 

 

Analyse par vitesse et angle de vent 

 

Lancez le menu " Routage→ Statistiques de vent → Tableau " puis choisissez l'un des routages ou " 

<Tous routages→ " pour analyser le cumul. 
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Comme pour les analyses par angle ou vitesse, vous pouvez analyser en vent réel ou apparent, en 

durée et/ou en pourcentage, différencier les amures et spécifier les tranches de vitesses et d'angles. 

Pour analyser une portion du tableau, sélectionner les cases souhaitées, le cumul de temps s'affichera 

alors dans la zone " sélection (en durée et en pourcentage). Ci-dessous le portant à partir de 0 à 12 nds 

: 6h37 h et 19%. 
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6.21.1 Analyse sur un graphe 
 

Sélectionnez le menu " Routage→ Statistiques de vent→ Graphe ".  
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Choisissez les routages à analyser. 

Un nuage de points d'une couleur différente pour chaque routage vous donnera une vision des vents 

rencontrés au cours de chacun d'entre eux. 

Vous pouvez visualiser le graphe en vent apparent ou en vent réel, en représentation polaire ou 

cartésienne. 

Il est également possible de " répartir les amures " pour différencier l'utilisation bâbord amure de 

l'utilisation tribord amure. 

 

6.22 Synthèses des routages 
Le tableau de synthèse des routages permet de visualiser un tableau synthétique des différents 

routages calculés. 

Lancez le menu " Routage→ Synthèse ". 

 

 

 

Vous pouvez classer les routages selon l'ordre que vous souhaitez en cliquant sur l'en-tête de la 

colonne considérée. 

En sélectionnant un routage, il est également possible de changer sa couleur ou de relancer un calcul 

de ce routage 
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6.23 Fonctions avancées de routage 
 

6.23.1 Balayage multi-grib 
Pour balayer des fichiers Grib, placez l'ensemble des fichiers à balayer dans un répertoire que vous 

créerez pour l'occasion. Choisissez l'un de ces fichiers (et un seul) dans le premier des fichiers Grib à 

utiliser pour le routage. Le calcul se fera ensuite pour chacun des fichiers Grib présents dans le 

répertoire. 

 

 

 

  Ouvre la boite de dialogue permettant de sélectionner le dossier contenant les gribs à balayer 

 

Vous pouvez altérer les forces de vent prévues par les fichiers GRIB (en plus ou en moins) en spécifiant 

un pourcentage dans la zone prévue à cet effet (100% : pas d'altération, 120% = augmentation de 20% 

des forces de vent). 

 

6.23.2 Création de vidéos 
A partir d’un routage, il est possible de créer un fichier vidéo (.AVI) de la simulation de ce routage. 

Ouvrez le menu " Routage → Vidéo " et sélectionnez le routage pour lequel vous souhaitez créer une 

vidéo. Le logiciel vous propose alors de paramétrer la durée et le nombre d’images de la vidéo. 
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Note : plus le nombre d’images est élevé meilleure sera la fluidité de la vidéo. Cependant cela augmente 

considérablement le poids du fichier vidéo. Si vous manquez de place dans votre disque dur, créez des 

vidéos avec moins d’images. 

 

On peut lire les vidéos ainsi créées en utilisant le menu "Routage → Jouer une vidéo". Par défaut les 

videos sont enregistrées dans le dossier "Routage" du répertoire Adrena. 

 

Note : pour pouvoire lire les vidéos, assurez vous que votre ordinateur dispose d’un lecteur compatible 

avec les fichier .AVI. 

 

6.23.3 Correction des données de vent 
Il est possible sur un routage de corriger le cap et la direction du vent prévu dans un grib quand on 

pense que les prévisions seront différentes de celles annoncées. Les données ainsi modifiées seront 

progressivement ramenées à la situation prévue au terme du délai indiqué. Pour cela dans l’onglet " 

Gribs – Vent " de la fenêtre de routage cochez la case : 

 

" Corriger cap vent de" pour modifier la direction du vent en entrant une valeur en degré (positif pour 

indiquer une rotation vers la droite) et la durée sur laquelle effectuer ce changement. La correction se 

fera progressivement depuis le début du routage jusqu'à la fin de la durée spécifiée. 

 

" Corriger vitesse vent de" pour modifier la force du vent en entrant le pourcentage d’augmentation ou 

de diminution et la durée sur laquelle effectuer ce changement. La correction se fera progressivement 

depuis le début du routage jusqu'à la fin de la durée spécifiée. 
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6.23.4 Diminution de l’occupation de la mémoire de l’ordinateur 
Si vous êtes amené à calculer et afficher de nombreux routages simultanément (plus de 30), il est 

possible d’alléger l’occupation de la mémoire de l’ordinateur en éliminant les routes non retenues lors 

du calcul. Pour cela cochez la case "Ne pas conserver les routes non retenues" dans l’onglet "Options 

diverses" de la fenêtre de routage. 

Dans le cas de balayage de gribs (ou de gribs historiques), il est également possible de décharger les 

gribs au fur et à mesure des calculs. Pour cela cochez la case "Décharger le grib après chaque balayage 

multi-grib" (respectivement "Décharger le grib après chaque balayage de grib historique") dans l’onglet 

"Options diverses" de la fenêtre de routage. 

 

Note : l’activation de cette option supprime la possibilité de créer des points de pivots sur le routage 

calculé. 
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6.23.5 Micro routage sur cadre 
Le routage sur cadre permet de mesurer l’écart, entre la route à gauche ou à droite du plan d’eau, d’un 

point à atteindre au vent ou sous le vent. Pour cela on utilise les cases à cocher " cadre ", " côté droit " 

ou " côté gauche " de l’onglet " Paramètres de calcul " de la fenêtre de routage. 
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Cas n°1 : seule la case "cadre" est cochée 
Dans ce cas le logiciel teste les routes à gauche et à droite et affiche la plus rapide 

 

Cas n°2 : la case " côté droit " ou " côté gauche " est cochée 

Dans ce cas le logiciel affiche la route la plus rapide pour le côté droit ou le côté gauche 

 

Cas n°3 : la case " côté droit " et " côté gauche " sont cochées 

Dans ce cas le logiciel affiche la route côté droit et côté gauche et détermine la différence de temps 

entre les deux parcours dans la légende de routage. 

 

 

Note : Le micro routage sur cadre ne s’applique que sur des petites distances (bananes, parcours 

côtier…) et dans l’axe du vent. Il convient donc de supprimer les contraintes du types "éviter les côtes" et 

de diminuer le pas des isochrones entre 1 et 10 minutes en fonction de la longueur du bord. 

 

6.23.6 Gribs historiques 
Afin d’analyser les situations météo passée sur une même zone ou sur un même parcours, il est 

possible de calculer plusieurs routages automatiquement à partir de fichiers gribs " historiques ".  

Dans la fenêtre de routage sous l’onglet " Balayages" on peut activer la lecture de gribs historiques en 

cochant la case correspondante. Ensuite on indique le répertoire où se trouvent ces gribs. Le routage va 

" balayer " le répertoire et calculer une route sur la même période à partir des données de chacun des 

gribs. 
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6.23.7 Prévisons d’ensemble 
Afin d’évaluer la fiabilité des prévisons météo, il est possible de calculer plusieurs routages 

automatiquement sur un jeu de gribs de prévisions d’ensemble. Chaque grib est généré par  le même 

modèle et défini sur la même zone mais une de ses variables (pression, vent, humidité…)  est 

volontairement modifiée.Cela permet de mesurer l’incidence sur le routage, d’un écart entre ce qui est 

prévu et les différentes hypothèses qui peuvent conduire à une modification des prévisions. 
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En comparant les différentes routes générées, si on constate des trajectoires très proches les unes des 

autres, on peut en conclure que la situation météorologique est stable et il y a peu de probabilité de 

s’écarter des prévisions. A l’inverse si les trajectoires sont très différentes, on peut considérer que 

l’évolution de la situation peut facilement être très différente de celle prévue. 
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6.23.8 Stabilité du vent  
La stabilité du vent est un indice sur la variation du vent surface entre le début et la fin d’un isochrone. 

Plus le pourcentage est proche de 100, plus le vent est stable en force et direction. 

Cette fonction permet de visualiser la stabilité des conditions météorologiques et de voir rapidement si 

le routage traverse des phénomènes météo instables.  

En ayant une vue d’ensemble des transitions météo rencontrées le long de la route, le skipper va 

pouvoir les anticiper et augmenter sa vigilance à l’approche de celles-ci. 

 

Le menu Routage → Option permet de visualiser la stabilité du vent en colorant les segments. Du noir 

pour un vent stable en force et en direction (100%) au rouge pour un vent changeant (0%). 
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Exemple : 
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7 PERFORMANCES 
 

Adrena gère trois polaires différentes : 

 
La polaire de navigation avant le départ. Elle est utilisée pendant la phase de départ pour les calculs de 

trajectoire, d'angles target et des laylines. 

 

La polaire de navigation après le départ. Elle est utilisée après la phase de départ pour les calculs d'angles 

target et des laylines. 

 

La polaire de performance. C'est le max que vous puissiez attendre de votre bateau. Elle est utilisée sur le 

départ et pendant le parcours pour calculer les vitesses cibles et le pourcentage de vitesse cible. 

7.1 Activation de polaire 
Pour paramétrer ces trois polaires, lancez le menu " Performance → Activation de polaires→ <polaire 

souhaitée> puis choisissez le fichier adéquat. 

7.2 Création de polaire dans un tableau 
En l’absence de polaire ou pour créer une polaire de référence, il est possible d’alimenter manuellement un 

tableau croisé pour créer une polaire. 

Lancer le menu " Performance → Créer / Modifier → Créer / Modifier polaire dans un tableau" 

 

 

 

  Permet de modifier les colonnes de vitesses retenues 
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 Permet de modifier les lignes d’angle de vent 

 

 Permet d’activer la polaire pour l’exploiter dans le logiciel 

 

Il est également possible de charger un fichier de polaire (.pol) afin de le modifier et de l’enregistrer à 

nouveau. Pour cela utiliser les boutons prévus à cet effet. 

7.3 Calcul de polaire par VPP 
 

Le calcul de polaire par VPP (Velocity Prediction Program)  permet d’établir une polaire théorique basée sur 

certaines caractéristiques d’un voilier. Cette polaire pourra servir de référence pour le calcul de polaire 

effectué sur l’acquisition de données. Voir chapitre "Calcul des polaires " 

 

 

 

Dimensions : Renseigner la longueur et le poids du voilier 

 

Voiles : Rentrer les surfaces des voiles présentes à bord  
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 NB : Il est possible d’indiquer la présence de deux types de spi différents à bord  

 

Type de VPP : Indiquer si le calcul des VPP doit être orienté vers la performance ou une vitesse moyenne 

(Course ou Croisière) 

 

(les champs marqués * sont obligatoires).  

 

Lancer le calcul avec le bouton prévu à cet effet pour enregistrer le fichier et obtenir le tableau des VPP 

calculées : 

 

 

 

 

 

 

 Permet d’activer la polaire pour l’exploiter dans le logiciel 
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7.4 Calcul des polaires 
 Le calcul des polaires se fait en trois temps :  

_ sélection des données sources parmi les enregistrements effectués, 

_ calculs sur les données chargées, 

_ Exploitation des polaires. 

 

Lancer la fenêtre de calcul par le menu " Performance → Calcul→ Lancer un calcul " 

 

 

7.4.1 Sélection des données source  
 

Vous pouvez soit intégrer toutes les données acquises par le logiciel, soit les sélectionner (un fichier par 

jour). 

Pour toutes les sélectionner, cliquez sur le bouton " Traces à charger pour les calculs → Charger toutes les 

traces ". Le logiciel charge alors tous les fichiers en mémoire (le nombre de fichiers traités défile à l'écran). 

 

Pour sélectionner une partie des données seulement, cliquez sur le bouton " Traces à charger pour les 

calculs→ Charger trace(s) " puis choisissez les fichiers qui vous intéressent (une saison particulière par 

exemple). Pour sélectionner plusieurs fichiers cliquez successivement sur chacun d'entre eux en 

maintenant la touche Ctrl enfoncée. 
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Si vous souhaitez charger des traces ne se trouvant pas dans le répertoire par défaut, cliquez sur " Parcourir 

", vous pourrez alors parcourir les fichiers Windows. 

 

Si vous souhaitez charger des traces ne se trouvant pas dans le répertoire par défaut et les ramener dans le 

répertoire par défaut, cliquez sur " Importer ", vous pourrez alors parcourir les fichiers Windows. 

 

Vous pouvez relancer plusieurs fois le menu si vous n'avez pas sélectionné suffisamment de fichiers la 

première fois. Les fichiers chargés viennent chaque fois enrichir les données sur lesquelles travaillera le 

logiciel. 

 

Adrena affiche les fichiers chargés au fur et à mesure de leur lecture : Dans la première zone, apparaît le 

nom du fichier chargé suivi du rang de ce fichier et du nombre de fichiers à charger au total (ci-dessous, le 

fichier en cours de chargement est 14_09_08_a.trz et c'est le 3ème des 5 fichiers à charger. 

Dans la 2ème zone, défilent la date et l'heure de la mesure en cours de chargement. 
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7.4.2 Calcul 
 

 

 

Le calcul se fait par le bouton  

 

Un certain nombre de paramètres sont ajustables. Ceux qui sont présents ci-dessus sont d'utilisation 

courante. D'autres permettent d'affiner d'avantage les calculs, nous les verrons plus loin. 

 

-          Etat de la mer. Les performances de votre bateau dépendent évidemment de l'état de la mer. Le 
logiciel Adrena peut établir les polaires de votre bateau pour une mer plate, dans le clapot et dans 
une mer agitée. Pour cela, il faut avoir spécifié l'état de la mer lors de chacune de vos sorties. Lors du 
calcul des polaires, cliquez sur l'état de mer désiré pour établir les polaires correspondantes. Si vous 
ne souhaitez pas différencier les polaires, choisissez "Indifférent", le logiciel prendra en compte toutes 
les valeurs enregistrées. 

 
- Type de polaire. Deux types de polaires peuvent être calculés : 

Les polaires de performance correspondent aux meilleures performances dont est capable votre 
bateau. 
Les polaires de routage correspondent aux performances moyennes de votre bateau. 
Attention : si vous avez dans vos enregistrements des informations enregistrées dans de mauvaises 
conditions (navigation sous grand voie seule, convoyage sans recherche de performance, ...), n'utilisez 
pas la fonction de polaires de routage car les données obtenues seraient affectées (à la baisse) par ces 
médiocres valeurs. Préférez alors les polaires de performance. 
Si vous traitez des données de "bonne qualité" (enregistrement systématique en régate par exemple), 
vous pouvez calculer l'une et l'autre selon l'usage que vous voulez en faire. 

 
-  Par interpolation. Cochez cette case si vous souhaitez que Adrena reconstitue, dans la mesure du 

possible, les données manquantes par interpolation des valeurs calculées pour la même force de vent 
aux angles de vent supérieurs et inférieurs les plus proches. 

 
- Remplacer données manquantes par polaires théoriques. Tant que vous n'avez pas suffisamment 

enregistré de données (vous n'avez peut-être pas encore rencontré de vents supérieurs à 30 nds, ou 
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de vents faibles, ...), il est possible de compléter les polaires à partir de polaires de référence (fournies 
par le chantier ou par l'architecte par exemple). Si vous n'avez pas chargé de polaires de référence, le 
logiciel demandera de le faire lorsque vous cochez la case.  

Si vous souhaitez changer de polaire de référence cliquez sur le bouton   . Les 

fichiers chargés peuvent être de type .pol  .ims, .d  ou .csv  (à choisir dans la zone "Type"). Les 

fichiers ims sont les fichiers fournis par la jauge ims. Avant de les lire, vous devez changer si 

besoin leur extension en ".ims". 

 

Si vous n'exploitez pas cette possibilité, le logiciel reconstituera, dans la mesure du possible, les 

données manquantes par interpolation des valeurs calculées pour la même force de vent aux angles de 

vent supérieurs et inférieurs les plus proches. 

 
-          Valeurs conseillées. Cliquez sur ce bouton pour retrouver les valeurs conseillées par Adrena  et 

définies à la livraison du logiciel. Ce bouton ne restaure les valeurs conseillées que pour le calcul en 
cours. Si vous souhaitez restaurer les valeurs conseillées pour les calculs suivants, cliquez ensuite sur 
"Définir par défaut". 
 

-          Définir par défaut. Cliquez sur ce bouton si vous souhaitez que les paramètres que vous venez de 
sélectionner vous soient proposés par défaut lors des prochains calculs. 

 
-          Options avancées. Voir le chapitre Calculs - options avancées.  
 
-          Calcul. Lance le calcul des polaires à partir des fichiers chargés et des paramètres spécifiés. 

Si vous avez préalablement chargé des données source ("Sélection de données source"), le logiciel 
travaillera avec, sinon il charge automatiquement l'intégralité de vos fichiers de donnée. 
Le résultat des calculs est ensuite présenté sous formes de courbes de polaire dans un graphique. Des 

options de modifications et de visualisation sont alors disponibles. Voir le chapitre "Visualisation des 

courbes de polaires" 
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Les données manquantes sont remplacées par la polaires de référence si cette option a été choisie ou par 
interpolation linéaire dans l'autre cas. Si l'option "calculer les VMG" a été retenue (recommandé), il 
complète les lignes avec les angles correspondant aux VMG calculés (upwind et downwind). 
 

 

En cliquant sur " Modification numérique ", vous pouvez visualiser les données prises dans la polaire de 
référence, le nombre de points pris en compte pour chaque cellule de calcul en cliquant sur 'Nombres', 
ainsi que la valeur max, la moyenne et l'écart type de chacune d'entre elles. 
Vous pouvez également imprimer ou exporter le tableau vers Excel. 
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7.4.2.1 Enregistrement de la polaire calculée 

Le bouton  "Sauver la polaire" ouvre la fenêtre de création de fichier  pour sauvegarder la polaire au format 

souhaité.  Il est possible de sauver le fichier de polaire a posteriori dans la même session en utilisant le 

menu Performances > Sauver  Polaire  

 

7.4.2.2 Activer la polaire calculée 

Le bouton "Activer la polaire" permet d’utiliser la polaire sauvegardée, dans le logiciel. Voir le chapitre 

"Suivi des performances du bateau (activation de polaires)" 

 

 

7.4.3 Calcul - options avancées 
 
Un certain nombre d'options ne sont pas proposées par défaut dans la boite de calcul des polaires 
mais peuvent être accédées en cliquant sur le bouton "Options avancées". Lorsque vous cliquez sur ce 
bouton, la boite de dialogue s'étend vers le bas et vous permet d'accéder aux options avancées. Si 
vous souhaitez restreindre à nouveau l'accès aux paramètres de base, cliquez à nouveau sur "Options 
avancées" 
 

 
 

-          Calculer les meilleurs VMG. Si cette option est retenue (conseillée), le logiciel effectuera un calcul 
pour déterminer les angles de vent donnant les meilleurs VMG au près et au portant. 
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- Calculer sur SOG : Cette option permet d’utiliser la vitesse fournie par le GPS (SOG) plutôt que la 

vitesse fournie par le capteur de la centrale de navigation (Vitesse surface).  
 

-          Favoriser les données privilégiées. Dans l'hypothèse où vous avez topé des données "privilégiées" 

celles-ci doivent être prises en compte sans subir les filtrages précédents. 

 

-          Ignorer les données non privilégiées. Cochez cette case si vous ne souhaitez prendre en compte que 

les données que vous avez explicitement topées comme privilégiées. 

 

-          Mesures à écarter (vitesse) permet de ne pas prendre en compte les valeurs trop élevées 

enregistrées. En effet, les valeurs trop élevées sont généralement erronées (valeur incohérente de la 

centrale) ou non significatives (surf). "5%" indique qu'il faut retirer les 5% de valeurs les plus élevées. 

Indiquez 0% si vous ne souhaitez pas retirer ces valeurs. 5% est la valeur conseillée. 

 

-          Mesures à écarter (angles) permet de ne pas prendre en compte les valeurs trop serrées d'angles 

(bateau proche du vent debout). En effet, les valeurs trop serrées peuvent être erronées. "5%" indique 

qu'il faut retirer les 5% de valeurs les plus élevées. Indiquez 0% si vous ne souhaitez pas retirer ces 

valeurs. 5% est la valeur conseillée. 

 

-          Stabilité minimum du vent. Compte tenu de l'inertie du bateau, sa vitesse ne suit pas immédiatement 

les changements de vent (en force ou en direction). Ne pas tenir compte de cet élément conduirait à 

enregistrer des valeurs erronées (vitesse de 6 nds face au vent, par exemple, lors d'un virement de 

bord). Le logiciel ne prend par conséquent en compte que les valeurs enregistrées après une période 

minimum de stabilité du vent et de direction du bateau. Indiquez dans ce paramètre la durée 

nécessaire à votre bateau pour stabiliser sa vitesse après un changement de vent ou de direction. Plus 

le rapport poids / voilure est important, plus cette durée est longue. 10s est la valeur moyenne 

conseillée. 

 

-          Nombre mini de mesures par point. Lorsque le logiciel  ne trouve pas suffisamment de mesures 
enregistrées pour un point de mesure, il considère que ces données ne sont pas significatives. Il les 
écarte donc et effectue une interpolation ou utilise les polaires théoriques selon l'option choisie. Le 
paramètre "Nombre mini de mesures par point" permet de spécifier le nombre minimum de mesures 
pour valider un point de mesure. 

 
-          Amortissement des mesures. Les données enregistrées sont directement issues des données reçues 

des liaisons NMEA. Elles peuvent être très instables et le logiciel risque d'avoir du mal à trouver des 
données stables pour le vent. De même les données issues du speedo peuvent ne pas être 
suffisamment fiables. Pour éviter cela, le logiciel amortit les mesures sur un certain temps (10secondes 
par défaut). Le paramètre "Amortissement des mesures" permet de modifier cette valeur. 

 
-          Bâbord ou Tribord amure. Cochez l'une de ces cases si vous souhaitez calculer les polaires 

enregistrées spécifiquement sur l'une des deux amures.  
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-          Modifier forces de vent. Le logiciel calcule par défaut des polaires pour des forces de vent de 4, 8, 12, 
16, 20, 25, 30 et 35 nds. Il est possible de modifier ces valeurs, pour diminuer le pas entre deux valeurs 
ou pour en ajouter au-delà de 35 nds par exemple. Ce bouton permet d'accéder à la boite de définition 
des forces de vent à retenir. 
 
Attention : si vous paramétrez beaucoup de forces de vent différentes sans avoir suffisamment 
enregistré de données, le nombre de points de mesure enregistrés pour chaque maille sera insuffisant 
pour faire des calculs corrects et vous risquez d'obtenir des polaires en "marguerite". Si cela se produit 
revenez aux forces de vent proposées par défaut. 
 

-          Modifier angles de vent. Le logiciel calcule par défaut des polaires pour des angles de vent de 30°, 35°, 
40°,  50°, ... et 180°. Il est possible de modifier ces valeurs, par exemple pour affiner les polaires autour 
des valeurs de près (30°, 33°, 35°,...). Ce bouton permet d'accéder à la boite de définition des angles à 
retenir. Ces valeurs seront cependant automatiquement enrichies par le logiciel par les angles de VMG 
du bateau si vous choisissez "calculer les VMG" (voir ci-dessus). 
 
Attention : si vous paramétrez beaucoup d'angles de vent différents sans avoir suffisamment 
enregistré de données, le nombre de points de mesure enregistrés pour chaque maille sera insuffisant 
pour faire des calculs corrects et vous risquez d'obtenir des polaires en "marguerite". Si cela se produit 
revenez aux angles de vent proposés par défaut. 
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7.4.4 Visualisation du tableau de valeurs 
 

Lancez le menu "Performance→ Tableaux→ Tableau des polaires calculées".  

 

Les valeurs d'angles en rouge correspondent à des angles qui ont été ajoutés par Adrena pour prendre en 

compte les valeurs des meilleurs VMG calculés (dans le cas où vous avez choisi l'option "calculer les 

meilleurs vmg" lors du calcul). 

Les vitesses en rouge correspondent aux meilleurs VMG calculés au près et au portant pour la force de vent 

considérée 

Les données manquantes qui ont été interpolées ou remplacées par les polaires théoriques sont affichées 

en gris. 

 

Impression du tableau 

 

Vous pouvez imprimer le tableau obtenu en cliquant sur le bouton "impression". 

 
Export du tableau dans Excel 

 

Vous pouvez visualiser le contenu du tableau en cliquant sur le bouton "Export Excel" 

 
Autres données 
Vous pouvez visualiser le nombre de points pris en compte pour chaque cellule de calcul en 
cliquant sur 'Nombres', ainsi que la valeur max, la moyenne et l'écart type de chacune d'entre 
elles. 



198 
 

 

7.4.5 Visualisation des courbes de polaires 
 

Cliquez sur le bouton " Nouvel onglet "  et choisissez dans le menu "Polaire > Calculées" 

 

 

La fenêtre présente les courbes de polaires pour les différentes forces de vent retenues. Les ronds 
apparaissant sur chacune des courbes indiquent les meilleurs VMG pour le près et pour le portant.  
 

Vous pouvez ajuster l'affichage des courbes : 

• scroll de la courbe à l'aide des flèches haut/bas/gauche/droite du clavier, 
• zoom par les touches "page avant" / "page après" du clavier ou avec la molette de la souris. 
• La touche "home" du clavier permet de revenir au format standard d'origine. 
• déplacement des courbes en cliquant sur un point quelconque du graphique et en "tirant" 

l'ensemble (sauf si vous êtes en mode "modification graphique"). 
• il est possible de centrer l'écran sur un point du graphique en double-cliquant sur ce point. 
• La combinaison de touches ctrl-shift-"flèche droite" permet de recentrer l'écran sur la moitié droite 

de la courbe. De même pour les combinaisons ctrl-shift "flèche gauche", ctrl-shift "flèche en haut" 
et ctrl-shift "flèche en bas". 

• En mode "vent effectif" qui permet de visualiser la polaire correspondant au vent mesuré sur la 
centrale pendant la navigation (voir le chapitre Visualisation de vos performances sur la courbe de 
polaire),  la combinaison de touches ctr-shift-home recentre l'écran sur le quadrant de la courbe 
correspondant au vent mesuré (quadrant haut droit si le bateau navigue au près bâbord amure). 

Pour obtenir une meilleure visibilité, il est possible d'isoler la courbe correspondant à un vent donné. Pour 

cela, sélectionnez la force de vent souhaitée dans la liste du menu polaire. 
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Pour lire une valeur particulière faites un clic droit dans la courbe. 

 

Meilleurs VMG 

 

Lorsque vous avez sélectionné une force de vent, les valeurs des meilleurs VMG au près (VMG UP) et au 

portant (VMG DOWN) sont affichées dans la fenêtre de gauche. Il est également possible d'afficher la 

valeur d'une vitesse cible précise en cliquant (clic droit) sur la courbe au niveau de l'angle de vent désiré 

(affichage en jaune, ici : 8.2nds à 56° du vent). 

 

 

Paramètres de calcul 

 

Vous pouvez consulter les différents paramètres ayant conduit au calcul d'une valeur donnée. Pour cela 

cliquez avec le bouton droit sur un point de mesure (intersection d'une courbe de polaire avec une ligne 

d'angle de vent retenue). 
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Une fenêtre affichera alors la plage de vent pour laquelle la vitesse cible a été calculée (force et angle du 
vent), l'origine de cette vitesse (donnée calculée, donnée interpolée ou donnée substituée par la polaire 
théorique), le nombre de mesures retenues, la vitesse cible obtenue et les vitesses maximum, moyenne et 
minimum  retenues. Les mesures "retenues" correspondent au nombre de mesures enregistrées pour la 
plage de vent considérée (force et angle de vent) après application du filtrage sur la stabilité de vent. 
 

 

Impression des courbes 

 

Vous pouvez imprimer les courbes présentes à l'écran en cliquant sur l'icône "imprimante". 

La courbe imprimée correspondra à celle que vous apercevez à l'écran. Sélectionnez la force de vent 

désirée et utilisez les fonctions de scroll et de zoom pour ajuster précisément ce que vous voulez voir 

apparaître à l'impression. 

 

Modification manuelle des courbes ("modif graphique") 

 

Voir le chapitre Ajustement graphique de la courbe  

 

Modification des données numériques ("modif numérique") 

 

Voir le chapitre Ajustement numérique de la courbe 
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Nuage de points 

 

Voir le chapitre Visualisation des points de mesures  

 

 

7.4.6 Visualisation des points de mesures 
 

Il est possible d'afficher l'ensemble des points ayant été retenus pour la (ou les) force(s) de vent affichée(s). 

Pour cela, cliquez sur la case "Nuage de points" 

 

 

 

 

Le logiciel affichera l'ensemble des points enregistrés pendant la campagne et retenus pour le calcul de la 
polaire. Cela vous permettra de visualiser les conditions réellement rencontrées par le bateau (angles de 
vent et vitesse du bateau). 
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7.4.7 Ajustement graphique de la courbe 
 

Il est possible de retoucher la courbe graphiquement, notamment pour redéfinir les portions de courbe 

pour lesquels les données enregistrées sont encore trop peu nombreuses.  

Pour cela, cliquez sur "Modif graphique" puis "attrapez" la courbe avec la souris (clic gauche) et tirez-la à la 

position souhaitée. La position préalablement calculée par le logiciel reste apparente en pointillé.  

Il convient d'attraper l'un des points de mesure de la courbe. Ces points de mesures correspondent aux 

intersections de la courbe avec les lignes d'angle de vent (plus la position du VMG, s'il ne correspond pas à 

un angle standard). Ces points se matérialisent par petit rond de couleur apparaissant sur la courbe lorsque 

le curseur s'approche de l'un d'eux. 

Pour ajuster la courbe, il est conseillé d'afficher le nuage de points pour vous aider à analyser les 

performances rencontrées par le bateau dans la zone considérée. 

Pour annuler les ajustements manuels effectués, cliquez sur le bouton "Annuler". L'annulation portera 

uniquement sur la ou sur les courbe(s) affichée(s) à l'écran et sur l'ensemble des modifications apportées 

graphiquement ou numériquement. 

 

 

7.4.8 Ajustement numérique de la courbe 
 

Il est possible de retoucher la courbe numériquement dans le tableau de polaires. Pour cela, cliquez sur le 

bouton "Modification numérique" 

 

Les données peuvent être ajustées en saisissant la nouvelle valeur directement dans le tableau ou en 

sélectionnant une ou plusieurs cellules et en cliquant sur les boutons +1%, -1%, +10% et -10% en fonction 

de l'effet souhaité. 
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Exemple. Si vous souhaitez diminuer de 12% la colonne correspondant au vent de 25 nds, sélectionnez la 

colonne 25 nds (il suffit de cliquer sur l'en-tête de la colonne) puis cliquez une fois sur -10% et 2 fois sur -

1%. 

Pour annuler les ajustements effectués, vous pouvez, soit refermer le tableau avec le bouton "Annuler", 

soit cliquer sur le bouton "Annuler" après avoir refermé le tableau. L'annulation portera uniquement sur la 

ou sur les courbe(s) affichée(s) à l'écran et sur l'ensemble des modifications apportées graphiquement ou 

numériquement. 

7.4.9 Calcul de polaires avancé 
 

 Le calcul des polaires se fait en trois temps :  

 

_ Sélection des données sources 

 

_ calculs sur les données chargées, 

 

_ Exploitation des données obtenues 

 

 

7.4.9.1 Calcul sur les enregistrements effectués 

Le calcul se fait par le menu "Calcul de polaires→ Lancer un calcul". 
 

 

 

 

 

Configuration du bateau. Cliquer sur  puis précisez les paramètres pour lesquels vous 
souhaitez effectuer les calculs. 
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"Griller" les enregistrements. Lorsque vos naviguez, la priorité est évidemment d'avantage sur 
le pont que sur le PC du bord. Il en résulte qu'après chaque changement de configuration 
(changement de voile par exemple), le logiciel continu à enregistrer quelques temps avec 
l'ancienne configuration, cela jusqu'à ce que vous ayez pu spécifier la nouvelle configuration. 
Pour éviter de fausser les calculs, vous pouvez indiquer ici un temps correspondant au temps 
maximum qu'il vous faut en navigation, pour spécifier la configuration (10 mn dans l'exemple 
ci-dessus). De ce fait, le logiciel éliminera les 10 minutes de données qui précèdent chaque 
changement de configuration. 

 
 

"Calculer les config." Ce bouton permet d'analyser toutes les configurations de voiles utilisées 
dans les enregistrements chargés. La liste des configurations trouvées par le logiciel est ensuite 
proposée à l'écran 

 

 
 

Sélectionnez les configurations dont vous souhaitez calculer la polaire puis cliquez sur Valider. Adrena 

calculera successivement chacune des polaires demandées et les affichera à l'écran. 

 
 

 

Traiter les enregistrements ... DU ... AU ... En spécifiant une fourchette de dates (ou d'heures) 
vous pouvez calculer les polaires sur une partie seulement de vos enregistrements, par 
exemple, la 1ère partie de la saison. Il vous est possible de calculer successivement les polaires 
de différentes tranches de dates pour comparer à l'écran l'évolution de vos performances. Le 
bouton "dates indifférente" permet de prendre à nouveau en compte l'ensemble des 
enregistrements chargés. 
 



205 
 

 
 

7.4.9.2 Prise en compte de la configuration du bateau dans les calculs 

Pour prendre en compte la configuration du bateau dans les calculs, cliquez sur  : 

 

 

Vous accédez à une boite de dialogue comportant 4 onglets qui vous permettent de spécifier la 

configuration du bateau pour laquelle vous souhaitez effectuer le calcul de polaires Cette définition se 

fait de la même manière que lors de l'enregistrement des données et est décrit dans les chapitres 

correspondants : 

Spécification du jeu de voiles 

Spécifications de la position des appendices 

Spécifications du remplissage des ballasts 

Spécifications diverses 

 

Revenir sur un calcul 

Permet de rappeler un calcul déjà effectué avec les mêmes paramètres que la fois précédente. Ouvre la 

fenêtre de calculs dans laquelle vous retrouvez tous les paramètres préalablement définis. Vous pouvez 

modifier ceux que vous voulez avant de relancer le calcul. 

Cliquez sur le bouton " Revenir sur un calcul" 
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Déchargement d'un calcul  

Efface un calcul préalablement effectué. 

Lancez le menu " Performance→ Calcul de polaires → Décharger un calcul" et choisissez le calcul à 

décharger. 

Déchargement de tous les calculs  

Efface tous les calculs préalablement effectués. 

Lancez le menu " Performance→ Calcul de polaires → Décharger tous les calculs" 

7.4.9.3 Calcul en temps réel 

Avec Adrena vous pouvez effectuer les calculs de polaires pendant la navigation. Cela vous permet de 

visualiser en temps réel la couverture des données enregistrées et de les enrichir en changeant l'allure 

du bateau jusqu'à avoir des données complètes. 

Vous pouvez effectuer les calculs en temps réel sur les seules données de la sortie en cours ou sur des 

données plus complètes. Si vous souhaitez prendre en compte des donnés préalablement enregistrées, 

commencez par les charger à l'aide du menu " Performance→Calcul des polaires→ Chargement traces 

pour calcul→ Chargement de toutes les traces" ou " Performance→Calcul des polaires→ Chargement 

traces pour calcul→ Chargement trace (s)". 

Lancez ensuite le menu " Performance→Calcul des polaires→ Calcul en temps réel". 

 

Vous obtenez la fenêtre de configuration des calculs (voir le chapitre Calcul des polaires). Paramétrez 

les calculs comme souhaités puis cliquez sur "Calculer". Le logiciel calcule les polaires sur les données 

déjà chargées ou sur les données du début de la navigation et affiche le tableau correspondant. Cliquez 

sur "Fermer". Le logiciel affiche ensuite la courbe des polaires calculées et la position effective du 

bateau. Les polaires sont calculées et rafraîchies en temps réel. 

Pour arrêter le calcul, lancez à nouveau le menu " Performance→ Calcul des polaires→ Calcul en temps 

réel". 
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7.4.10 Visualisation des courbes de polaires avancée 
 

Cliquez sur le bouton "Nouvel onglet > Polaires" et choisissez dans le menu la polaire que vous souhaitez 

afficher 
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La fenêtre présente les courbes de polaires pour les différentes forces de vent retenues. Le titre de 
l'onglet rappelle le type de polaires affichées (ici, les polaires performances). 

 

Les ronds apparaissant sur chacune des courbes indiquent les meilleurs VMG pour le près et pour le 

portant.  

 

7.4.10.1 Choix des courbes à afficher 

 

On peut afficher tous les vents - une seule polaire peut alors être sélectionnée - ou une force de 
vent donnée - on peut alors choisir les polaires à afficher -. 
Pour sélectionner les polaires à afficher, cliquez sur chacune d'entre elles en maintenant la touche 
ctrl enfoncée (comparaison de polaire). 
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7.4.10.2 Affichage d'un calque en arrière-plan 

Vous pouvez afficher un calque de polaire en arrière-plan pour le comparer à la polaire affichée. Pour cela, 

cliquez sur "Charger". Le logiciel vous demandera de choisir la polaire à mettre en arrière-plan. 

Si vous souhaitez changer ensuite de calque, vous pouvez le faire en cliquant sur le bouton  
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7.4.10.3 Représentation cartésienne 

 

Vous pouvez visualiser les courbes sous forme de tableau cartésien en cochant la case "Repr. cartésienne" 

 

 

7.4.10.4 Type de vent (réel ou apparent) 

Vous pouvez visualiser les courbes en fonction du vent réel (par défaut) ou du vent apparent en cliquant sur 

le bouton correspondant 
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7.4.10.5 Valeur affichée 

 

Par défaut, la valeur affichée est la vitesse cible du bateau. 

 

Pour afficher les vmg cibles, choisissez "VMG" dans la liste "Affichage :" 

 

 

7.4.10.6 Abscisse de la courbe 

 

Par défaut, les courbes de polaires sont affichées en fonction de l'angle de vent. Chaque courbe correspond 

alors à une vitesse de vent. 

Vous pouvez afficher les données en fonction de la vitesse du vent (chaque courbe correspond alors à un 

angle donné). Pour cela, choisissez "Vitesse vent" dans la zone "Affichage". La courbe s'affiche alors 

nécessairement en mode cartésien. 
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Différenciations des courbes bâbord / tribord. 

Les courbes calculées spécifiquement pour les amures bâbord sont affectées de points rouges. Les courbes 

calculées spécifiquement pour les amures tribord sont affectées de points verts. 

 

7.4.11 Calcul de polaire alteree (voiles manquantes) 
 

Si vous devez naviguer sans l'intégralité des voiles du bateau (voile endommagée, souci de ménager le 

bateau ou l'équipage, nombre de voiles limité par les règles de course,..), vous pouvez calculer la polaire 

résultant de l'absence de voiles. 

Pour cela un travail préalable est à faire à terre pour décrire l'ensemble des voiles et leur potentiel. Ce 

travail est important mais le jeu en vaut la chandelle car, une fois qu'il est fait, le calcul de la nouvelle 

polaire (sur l'eau) est extrêmement facile. 

 

7.4.11.1 Travail préalable (à terre) 

 

Décrivez le jeu de voile du bateau (chapitre Caractéristiques du bateau - Jeu de voiles). 

 

Dessiner les Sailect de chaque voile (ou de chaque configuration de voiles) (chapitre Création d'une Sailect) 

en prenant soin de définir les différentes zones d'efficacité de la voile (100%, 80%, ou autre) et en faisant 

l'association avec le jeu de voile préalablement décrit. 

 

7.4.11.2 Calcul de la polaire altérée (en mer) 

 

Lorsqu'une voile n'est plus utilisable ou que vous ne souhaitez plus l'utiliser, déclarez la "débarquée" 

(chapitre Caractéristiques du bateau - Jeu de voiles). 

 

Lancez ensuite le calcul par le menu "Performance→ Calcul des polaires→ Calcul de la polaire altérée" 
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Choisissez la polaire source (par défaut, c'est la polaire active en cours), cochez "polaire active" si vous 

souhaitez replacer l'ancienne polaire active et "Utiliser au prochain routage" (logiciel Adrena) si vous 

souhaitez qu'elle soit prise en compte lors du prochain routage. 

Cliquez sur "Calculer" puis choisissez le nom du fichier à créer. 

 

 

 

7.5 Modification de polaires 

 

La fonction de modification de polaires vous permet de modifier des polaires qu'elles aient été créées 

par Adrena ou par un autre moyen (polaires de l'architecte par exemple) 

Convertir des polaires d'un format à un autre.  

Les formats gérés sont les formats .pol (Maxsea et autres logiciels de navigation), .d (Deckman), .csv 

(Prodata), .ims (fichiers ims). Le logiciel peut lire chacun de ces formats et générer des polaires sous 

chacun d'entre eux, 

Modifier l'échantillonnage de forces et d'angles de vent.  

Le logiciel fera un calcul pour interpoler les données sur les nouvelles forces de vent et sur les 

nouveaux angles, 

Lisser les courbes de vos polaires, 

Ajuster manuellement certaines valeurs 
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Appliquer un coefficient correctif à l'ensemble des données.  

Cela peut être utile si vous souhaitez par exemple extrapoler des polaires sous une configuration 

particulière (pilote par exemple) en considérant que dans une telle configuration, les vitesses cibles 

sont altérées d'une valeur connue (- 10% par exemple), 

Pour convertir des polaires, lancez le menu "Performance→ Modifier".  

Cliquez sur "Charger" et sélectionner la polaire à modifier. Le logiciel affiche alors le menu avec les 

options de modification: 

 

Cliquez successivement sur les différentes fonctions que vous souhaitez appliquer. "Modifier angles de 

vent", par exemple, vous permet d'ajouter, de supprimer ou de modifier les angles de vent. 

Afin de bien visualiser l'effet des changements demandés, vous pouvez sélectionner un angle de vent 

parmi d'autres (cliquer sur la force de vent considéré dans la zone "Force de vent". Vous pouvez 

également scroller (flèches haut / bas / droite  gauche) et zoomer (page-up / page-down et molette de 

la souris) la fenêtre de représentation des courbes. Pour cela cliquez d'abord dans cette fenêtre puis 

effectuez les opérations désirées 

Lorsque vous avez effectué les modifications nécessaires, cliquez sur "Sauver fichier" et choisissez le 

format souhaité dans la zone "Type" : 
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7.6 Comparaison de polaires 

La fonction de comparaisons de polaires permet de comparer entre elles les polaires calculées ainsi que 

des polaires dont vous disposez sous forme de fichiers. 

Lancez le menu "Performance→ Comparer". Utilisez ensuite le bouton charger pour sélectionner les 

différentes polaires à comparer 

 

Attention : Les polaires ne peuvent être comparées que si elles sont construites avec les mêmes forces 

de vent. 

Si ce n'est pas le cas, les polaires comparées seront automatiquement ajustées sur les références de la 

première chargée. 



216 
 

7.7 Tableaux 
7.7.1 Tableau des polaires actives 
Affiche sous forme de tableau la polaire de performance 

 

7.7.2 Tableau des meilleures configurations 
 

Après avoir calculé les polaires relatives à différentes configurations (voiles, ballasts ou autres), il est 

possible de les comparer entre elles en lançant le menu "Performances→ Tableau→ Tableau des meilleures 

configurations". 

 

 

 

Le tableau indique, parmi toutes les configurations dont les polaires viennent d'être calculées, celle qui est 

la plus efficace pour chaque condition de vent. 

 

7.7.3 Tableau de l'efficacité des configurations 
 

Lancez le menu " Performance→ Tableau→ Tableau de l'efficacité des configurations". 
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Si vous avez lancé plusieurs calculs de configuration, la liste vous en est proposée dans la partie gauche de 

l'écran. Sélectionnez la configuration que vous souhaitez analyser. 

Choisissez également la polaire correspondant à la polaire de référence (généralement la polaire globale du 
bateau). 

Le tableau indique, pour chaque condition de vent, le pourcentage d'efficacité de la configuration analysée 
par rapport à l'optimum (donné par la polaire de référence). 

7.8 Correction de traces 
 

Il peut arriver que vous souhaitiez corriger vos fichiers de données à posteriori. Notamment si vous avez 

oublié de lancer l'enregistrement en début de sortie ou si vous avez oublié de l'arrêter après avoir mis le 

moteur en route. 

7.8.1 Correction dans un (ou plusieurs) fichier trace 

Pour corriger un ou plusieurs fichiers trace, lancer le menu "Performances → Correction des traces" et 

choisissez les traces à traiter, vous arrivez ensuite sur la boite de correction des enregistrements. 
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Sélectionnez la plage horaire que vous souhaitez modifier (dates et heures de début et de fin) et le type 

de correction que vous voulez apporter : 

"Forcer le mode "marche sous voile" : spécifie que le bateau marchait à la voile pendant la plage 

horaire indiquée et que les données correspondant sont à prendre en compte dans les calculs de 

polaires. 

"Forcer le mode "marche au moteur" : spécifie que le bateau marchait au moteur pendant la plage 

horaire indiquée et que les données correspondant ne sont pas à prendre en compte dans les calculs de 

polaires. 

"Effacer les topages privilégiés" : supprime tous les topages privilégiés que vous avez saisis pendant la 

plage horaire spécifiée. Attention, cette opération est irréversible. 

Forcer "mer plate", "clapot" ou "mer agitée" : spécifie l'état de la mer pendant la période indiquée. 

Modifier la configuration du bateau (voiles, foils, etc.) : cliquez sur le bouton  et modifiez les 

différents éléments souhaités. 

Une fois ces choix faits, lancez l'opération avec le bouton "lancer". Le logiciel scrute alors l'ensemble 

des fichiers de données sélectionnés et corrige les données concernées. 
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7.8.2 Correction sur une portion de trace 

Vous pouvez opérer une correction d'enregistrement directement sur une portion de trace. Pour cela, 

faites un clic droit sur la trace, au début de la portion à corriger, choisissez "Corriger enregistrement", 

cliquez sur la fin de la portion à corriger puis procédez comme ci-dessus. 

7.8.3 Correction sur un segment 

Avec Adrena, vous pouvez opérer une correction d'enregistrement directement sur un segment de la 

trace. Pour cela, faites un clic droit sur l'une des extrémités du segment, choisissez "Corriger 

enregistrement sur le segment" puis procédez comme ci-dessus. 

 

7.9 Cartographie des voiles : Sailect 
 

Sailect est une marque déposée North Sails France 

Sailect est un logiciel exclusif, totalement intégré à Adrena, qui permet de visualiser les plages d'utilisation 
de chacune de vos voiles. 

D'une utilisation très simple, il vous informe en permanence de la bonne adéquation de votre jeu de voiles 

avec les conditions de vent en cours. Il anticipe également les meilleures voiles à utiliser sur les bords 

suivants. 

7.9.1 Affichage des Sailect 

Lancer un nouvel onglet et choisissez "Sailect" 

 



220 
 

 

Le menu vous permet de contrôler l'affichage des Sailect, la fenêre présente la cartographie des voiles sous 
forme polaire. 

7.9.2 Cartographie des voiles 

La cartographie affiche les différentes voiles sélectionnées avec un code de couleur pour chacune d'entre 
elles. Cette codification est indiquée en bas à droite. 

Les valeurs de vent sont affichées en vertical (de 5nds en 5nds jusqu'à 30 nds dans l'exemple ci-dessus). Les 
angles de vent sont affichés tout autour des cercles de polaires (tous les 10° dans l'exemple ci-dessus). 

Vous pouvez zoomer, déplacer ou scroller la cartographie de la même manière que les polaire. Voir le 
chapitre "Visualisation des courbes de polaires"  

7.9.3 Choix des voiles à afficher 

L'ensemble de votre jeu de voiles est présenté dans la liste de droite (plus précisément, l'ensemble des 
voiles pour lesquelles vous disposez d'une Sailect. Voir "intégration d'une Sailect"). Vous pouvez choisir les 
voiles à afficher en cliquant sur le bouton 

 . 
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Un nœud est vert quand toutes les voiles situées dessous sont selectionnées 
Un nœud est rouge quand toutes les voiles situées dessous sont déselectionnées. 
Un nœud est gris quand seule une partie des voiles sont selectionnées mais pas toutes 
 
Vous pouvez cliquer directement sur un nœud pour selectionner ou déselectionner tout une catégorie de 
voile. 
 

7.9.4 Situation en cours 

La valeur du vent en cours est indiquée par la flèche noire pointant le bateau. Dans l'exemple ci-dessus le 
vent réel est de 10 nds à 45° du vent réel. 

Pour observer la valeur du vent apparent, cliquez sur "vent apparent". 

Note : si les radio-boutons permettant de commuter "vent réel" et "vent apparent" sont grisés, c'est que 
vous n'avez pas activé de polaire. Le logiciel ne peut donc faire les calculs de transposition et vous 
n'accédez qu'aux données de vent réel ou de vent apparent selon la façon dont ont été créées les Sailect. 
Voir le paragraphe "Suivi des performances du bateau (activation de polaires)" 

La voile à utiliser dans ces conditions est le "Exemple GENOIS" mais si le vent augmente un tant soit peu, il 
faudra passer à "Exemple trinquette". 

 

7.9.5 Situation passée. 

Vous pouvez afficher l'historique du vent en saisissant la durée de cet historique dans la zone "historique 
vent". Un trait gris formant une "traînée" derrière la position du vent apparaîtra alors pour indiquer 
l'historique de vent. 

Cette durée peut être saisie en secondes ou en minutes. Pressez la touche "m" pour saisir en minutes et la 
touche "s" pour saisir en secondes. 

 

Si vous avez choisi de colorer la trace du bateau selon un critère (vitesse du bateau, pourcentage de vitesse 
cible, ...), cette coloration apparaitra sur l'historique du vent. Il en est de même pour l'épaississement de la 
trace sur des critères multiples. 
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7.9.6 Situations futures 

Pour connaître la voile à utiliser sur l'un des prochains bords, saisissez le cap du bord correspondant dans la 
zone "Simulation cap". Une nouvelle flèche, rouge, apparaîtra qui vous indique la valeur qu'aura le vent sur 
ce bord. La voile qu'il faudra alors utiliser est celle qui se trouve sous le carré de cette flèche. 

 

Dans l'exemple ci-dessus, le bateau sera au portant bâbord amure et il conviendra d'utiliser le spi léger. 

7.9.7 Annotations 

Les annotations sont associées à une Sailect et sauvegardées avec elles. Elles permettent de vous 
renseigner sur certaines particularités de la Sailect. Elles sont constituées de pictogrammes de taille, de 
forme et de couleur variées et d'un commentaire associé. Pour visualiser le commentaire, approchez la 
souris du centre du pictogramme. 

Pour afficher l'ensemble des annotations, cochez la case "Annotations". 
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7.9.8 Trimbook 

Le Trimbook est créé avec les Sailect mais n'est attaché à aucune d'entre elles. Ce sont des remarques 
générales sur les réglages du bateau et des commentaires sur les Sailect. 

Comme pour les annotations, approchez la souris du pictogramme désiré pour en visualiser le contenu. 

Pour afficher l'ensemble du Trimbook, cochez la case " Trimbook". 

 

 

7.9.9 Import d'une Sailect 

Les Sailect de vos voiles vous sont fournies par votre voilier ou peuvent être créées (manuellement ou 
automatiquement) avec le logiciel. 

Pour importer une Sailect fournie par votre voilier par exemple), lancez le menu "Performances→ 
Sailect→Importer".  
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Ouvrez, le média sur lequel se trouve(nt) la (ou les) Sailect (CD, clef USB ou autre) et sélectionnez les Sailect 
désirées. Elles seront ensuite disponibles pour vos navigations. 

7.9.10 Impression des Sailect. 

Le bouton imprimer permet l'impression des Sailect sélectionnées. Vous pouvez ajuster auparavant le scroll 
et le zoom d'affichage. Ces ajustements seront pris en compte pour l'impression. 

 

7.9.11 Création d'une Sailect 
Les Sailect peuvent être créées ou mises à jour avec Adrena Pro en les dessinant, à partir d'un tableau excel 

ou en utilisant les données enregistrées pendant les navigations. 
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7.9.11.1 Création d'une Sailect par polygone 

Lancez le menu Sailect→ créer/modifier 

La partie gauche de l'écran propose une vue cartésienne du vent dans laquelle vous pourrez 
dessiner le polygone de la Sailect. Il est possible d'obtenir une vue polaire (radio bouton "polaire"). 
Il est possible de passer de la représentation  cartésienne à la représentation polaire à tout 
moment et vice -versa. 

Pour créer le polygone, effectuez un clic-droit sur chaque sommet à positionner. Pour fermer le 
polygone faites un clic-droit sur le 1er sommet. 

Vous pouvez ensuite modifier le polygone. Pour cela vous pouvez : 

• déplacer un sommet : faites un clic-droit sur le sommet à déplacer puis glissez le à sa nouvelle 
position 

• créer un nouveau sommet : faites un clic droit sur le bord du polygone, à l'endroit 
approximatif où vous voulez créer un sommet puis glissez  le à sa position définitive. 

• supprimer un sommet : faites un clic droit sur le sommet à supprimer puis glissez le jusqu'à 
l'un de ses voisins. Relâchez-le alors. 

Lorsque le polygone a la forme souhaitée, remplissez-le en cliquant sur le bouton "Valider 
polygone". 
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Note : le trait plein qui a servi à construire le polygone et qui relie les différents sommets 
n'apparaîtra pas sur la Sailect ultérieurement. 

Points anguleux 

Par défaut la ligne qui relie les différents points est lissée de façon former une courbe sans angle. Il 
est possible de créer des angles si vous le souhaitez. Pour cela, maintenez la touche ctrl enfoncée 
pendant que vous cliquez pour positionner un point. 

 

Pour transformer un point courbe en point anguleux, maintenez la touche ctrl enfoncée tout en 
cliquant sur le point concerné. 
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Pour transformer un point anguleux en point non anguleux, refaites la même opération. 

Pour créer une Sailect ne comportant que des points anguleux, cochez la case "Segmenter". Il sera 
alors inutile d'enfoncer la touche ctrl pour créer ou déplacer les points. 

7.9.11.1.1 Spécifier les zones d'efficacité de la voile 

Le polygone que vous venez de dessiner correspond à une efficacité de la voile de 100%, c'est à 
dire la zone dans laquelle la voile permet d'obtenir 100% de la vitesse polaire du bateau. 

Il peut être intéressant de décrire comment se comporte la voile en dehors de cette zone et quelle 
vitesse elle permet d'obtenir : 

- la voile n'est pas la plus pertinente, mais il reste peu de temps avant la prochaine marque et il 
n'est pas forcément intéressant de la changer. 

- la voile n'est pas la plus pertinente, mais vous souhaitez ménager le bateau et ne pas prendre 
de risque en mettant une voile plus grande. 

- une voile est hors service et vous souhaitez connaître le potentiel du bateau avec les voiles 
restantes ou faire un routage réaliste compte tenu du jeu de voiles réduit. 

- vous n'avez droit d'embarquer qu'un nombre retreint de voiles pour la course. Vous souhaitez 
faire des simulations pour savoir quelles voiles embarquer. 

Pour décrire l'efficacité de la voile en dehors de la zone 100%, dessinez un polygone autour du 
polygone 100%, par exemple sur la zone correspondant à 80% d'efficacité. Cliquez ensuite sur 
"Valider polygone". Un menu vous propose alors les différents pourcentages possibles. 
Choisissez 80%. 

 

Complétez ensuite les autres polygones souhaités. Les différents polygones apparaissent avec leur 
pourcentage. 
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Pour modifier l'un des polygones existants, faites un clic droit sur le polygone à modifier afin de le 
sélectionner. Les différents points ayant servi à le créer apparaissent alors, déplacez ceux qui sont à 
modifier puis cliquez sur "Valider polygone" et choisissez le pourcentage du polygone en cours de 
modification.  

7.9.11.1.2 Modifier un polygone en globalité 

Il est possible de modifier un polygone en globalité sans intervenir sur chacun des points. Pour cela, 
maintenez la touche shift (majuscule) tout en cliquant droit sur l'un des points du polygone : 

- le point cliqué se déplacera avec la souris 
- le point opposé se déplacera dans le même sens (intérieur ou extérieur) avec un ratio de 1/10 du 

déplacement de la souris 
- les points intermédiaires se déplaceront avec des ratios intermédiaires 

 

Cette fonction est particulièrement utile pour créer le polygone 80% à partir du polygone 100% par 
exemple. 
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7.9.11.1.3 Changement de résolution 

Pour changer les valeurs de forces de vent, cliquez sur "Forces vent" puis ajoutez ou enlevez les valeurs 
souhaitées.  

Pour changer les valeurs d'angles de vent, cliquez sur "Angles vent" puis ajoutez ou enlevez les valeurs 
souhaitées.  

Ces ajustements n'ont aucun effet sur la Sailect, ils modifient seulement la grille apparaissant en fond. 

 

7.9.11.1.4 Association d'une Sailect à une voile du jeu de voiles 

Vous avez sans doute déjà décrit la configuration de votre bateau (quille, foils, ballast et jeu de voiles) Voir 
Caractéristiques du bateau - Jeu de voiles. 

Vous pouvez associer chaque Sailect de type GV, Foc ou Spi à l'une des voiles du jeu de voiles. Les Sailect de 
type "Configuration de voiles" sont associées aux différentes voiles correspondantes. 

Cette association permet de gérer les voiles manquantes (débarquées) ce qui permettra au logiciel de ne 
pas proposer les Sailect non pertinentes ainsi que de recalculer la polaire résultant de l'absence de voiles 
voir Calcul de polaire altérée (voiles manquantes). 

Pour créer l'association, cliquez sur "Voiles concernées" et cochez la ou les voiles concernées. 

 

Seules les voiles de même type que la Sailect sont proposées (GV avec et sans ris, focs, spi, ...) 

 

7.9.11.1.5 Enregistrement d'une Sailect 

Saisissez le nom et le type de la voile ou de configuration puis cliquez sur "sauver" pour stocker la Sailect. 
Pour créer une nouvelle Sailect, cliquez sur "Nouveau"; 

7.9.11.1.6 Définition des couleurs 

La couleur intérieure du polygone peut être définie en cliquant sur le bouton "Remplissage" "Couleur" et en 
choisissant la couleur souhaitée. 

La couleur du trait du polygone peut être précisée en cliquant sur le bouton "Contour" "Couleur". 

L'épaisseur du trait du polygone peut être précisée dans la zone "Contour" "Epaisseur". En la laissant à 0, le 
polygone apparaîtra sans contour. 
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Le type de trait peut être défini dans la zone correspondante. Les choix sont les suivants : 

- solid : trait continu 
- dash : tirets discontinus 
- dot : pointillés 
- dashDotDot : succession de tirets et de pointillés 

7.9.11.1.7 Utilisation des "calques" 

Lorsqu'on crée une Sailect, il peut être utile de faire apparaître les Sailect des autres voiles du bateau en 
arrière plan. Pour cela, cliquez sur "Choix calques" et sélectionnez les dans l'arbre présenté. 

 

Les calques apparaissent avec une couleur de fond "floutée" pour les distinguer le la Sailect en cours de 
création ou de modification. 

Vous pouvez ensuite faire apparaître ou disparaître globalement les calques à tout moment en cochant / 
décochant la case "Afficher calques". 
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7.9.11.1.8 Annotation d'une Sailect 

Vous pouvez placer des annotations sur la Sailect. Une annotation est composée d'un pictogramme qui 
apparait sur la Sailect et d'un commentaire qui apparaît quand on approche la souris. 

Pour positionner une annotation, double-cliquez à l'endroit où vous souhaitez placer l'annotation puis 
saisissez le commentaire et les caractéristiques de l'annotation. 

 

Le paramétrage d'une annotation est décrit dans le chapitre Traces / Créer une annotation 

7.9.11.1.9 Multimédia dans une Sailect 

 

Pour placer un fichier multimédia dans une Sailect, créez une annotation et cliquez sur "Multimédia" puis 

sélectionnez le fichier à insérer parmi les fichiers de votre PC. 

Adrena demandera alors si vous souhaitez recopier le fichier dans le répertoire Adrena ou utiliser le fichier 

d'origine. A moins que vous n'ayez des problèmes de place sur votre disque, Il est conseillé de le ramener 

dans le répertoire Adrena afin de ne pas le perdre dans vos sauvegardes ou lors d'un changement de PC. 

Vous pouvez ensuite "jouer" le fichier (visualisation, écoute, ...) en cliquant sur le bouton "Test". 

 

7.9.11.1.10 Visualiser un fichier multimédia dans une Sailect 

 

Les fichiers multimédia apparaissent sur la trace sous forme de pictogrammes : 

- appareil photo pour les images 
- caméra pour les vidéos 
- haut-parleur pour les sons 
- ... 
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Pour "jouer" chacun des fichiers, faites un clic droit dessus et choisissez l'action proposée ("Voir l'image" 

par exemple). 

 

7.9.11.2 Création de Sailect par import d'un tableau Excel  

 

Si vous possédez les descriptif des voiles à utiliser sous forme de tableau Excel (ou autre), vous pouvez 

créer automatiquement vos Sailect avec.  

 

Le tableau doit se présenter sous la forme suivante : 

_ vitesse de vent en abscisse, angles de vent en ordonnées ou vice-versa. 

_  

 

chaque case du tableau précise le nom de la configuration de voiles à utiliser dans la plage de vent 

considérée. 

TWA/TWS 8 12 16 20 25 30 

40 GV+Genois GV+Genois GV + inter 1ris + inter 1ris + inter 2ris+solent 

50 GV+Genois GV+Genois GV + inter 1ris + inter 1ris + inter 2ris+solent 

60 GV+Genois GV+Genois GV + inter 1ris + inter 1ris + inter 2ris+solent 

70 GV+Léger GV+Genois GV + inter 1ris + inter 1ris + inter 2ris+solent 

75 GV+Léger GV+Genois GV+Genois GV + inter GV + inter 2ris+solent 

80 GV+Léger GV+Léger GV+Genois GV + inter GV + inter 2ris+solent 

90 GV+Léger GV+Léger GV+Léger GV + inter GV + inter 2ris+solent 

100 GV+Assymétrique GV+Assymétrique GV+Assymétrique GV+Léger GV + inter 2ris+solent 

110 GV+Assymétrique GV+Assymétrique GV+Assymétrique GV+Léger GV + inter GV + inter 

120 GV+Assymétrique GV+Assymétrique GV+Assymétrique GV+Assymétrique GV + inter GV + inter 

130 GV+Symétrique GV+Symétrique GV+Symétrique GV+Assymétrique GV + inter GV + inter 

140 GV+Symétrique GV+Symétrique GV+Symétrique GV+Assymétrique GV+Assymétrique GV+Assymétrique 

145 GV+Symétrique GV+Symétrique GV+Symétrique GV+Symétrique GV+Assymétrique GV+Assymétrique 

150 GV+Symétrique GV+Symétrique GV+Symétrique GV+Symétrique GV+Assymétrique GV+Assymétrique 

160 GV+Symétrique GV+Symétrique GV+Symétrique GV+Symétrique GV+Assymétrique GV+Assymétrique 

170 GV+Symétrique GV+Symétrique GV+Symétrique GV+Symétrique GV+Symétrique GV+Assymétrique 

180 GV+Symétrique GV+Symétrique GV+Symétrique GV+Symétrique GV+Symétrique GV+Assymétrique 
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Si les angles de vent sont en vertical, placer le sigle "TWA / TWS" dans la case en haut à gauche. S'ils sont en 
horizontal, placer le sigle "TWS / TWA". 

Si les indications de vent sont en apparent, remplacer "TWA" par "AWA" et "TWS" par "AWS". 

Une fois le tableau prêt, sélectionnez le sous Excel (ou sous un autre tableur), placez le dans le presse-
papier (ctrl-C). Lancez ensuite le menu " Performance→ Sailect→ Importer tableau". Toutes les Sailect 
décrites dans le tableau seront automatiquement créées par le logiciel. 

 

7.9.11.3 Création de Sailect par calcul sur les enregistrements 

Pour créer une Sailect à partir des enregistrements de navigation, commencez par calculer la polaire 
relative à la configuration étudiée (voir le chapitre Prise en compte de la configuration du bateau dans les 
calculs) 

Lancez ensuite le menu "Tableaux→ tableau de l'efficacité des configurations" 

 

Si vous avez lancé plusieurs calculs de configuration, la liste vous en est proposée dans la partie gauche de 
l'écran. Sélectionnez la configuration dont vous voulez calculer la Sailect. 

Choisissez également la polaire correspondant à la polaire globale du bateau. 

Cliquez ensuite sur "Créer Sailect". 

La Sailect créée est affichée sous forme de calque. Vous pouvez alors créer une Sailect de toute pièce en 
dessinant par dessus ou charger une Sailect existante pour l'ajuster par rapport au calque que vous venez 
de créer  (voir Modifier une Sailect). 
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7.9.12 Modifier une Sailect 

Pour modifier une Sailect existante, double cliquez sur la légende de la Sailect. 

 

 Vous pouvez également lancer le menu "Sailect→ Créer/modifier", cliquez sur "Charger" et choisir la 
Sailect à modifier. 

Vous pouvez ensuite la travailler avec les mêmes outils qu'en création. Une fois les ajustements effectués, 
cliquez sur "Sauver" 

7.9.13 Renommer une Sailect 

Pour renommer une Sailect, lancez le menu "Sailect→ Renommer", choisissez la Sailect à renommer et 
saisissez le nouveau nom. 

7.9.14 Suppression d'une Sailect 
Pour supprimer une Sailect, lancez le menu " Performance→ Sailect→ Supprimer" puis choisissez la Sailect à 

supprimer. 
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7.10 Les abaques 
 

Les abaques sont une fonction exclusive d'Adrena qui permet de visualiser les paramètres de réglages 

du bateau en fonction des conditions de vent. 

 

D'utilisation très simple, il vous informe en permanence des réglages optimaux théoriques avec les 

conditions de vent en cours. Il anticipe également les réglages à préparer sur les bords suivants. 

7.10.1 Affichage des abaques. 
 

Les abaques s'affichent dans la même fenêtre que les Sailect. Voir le paragraphe "Affichage des Sailect" 

Le choix des abaques à afficher se fait en cliquant sur le bouton "Choix abaques". L'abaque ci-dessous 

est représentée par les traits pointillés noir. 

 

 

 

Pour connaitre la valeur d'une abaque sur une configuration de vent donnée, déplacez la souris sur 

l'écran jusqu'à la valeur cherchée (15 nds, 60° par exemple). La valeur correspondante de l'abaque 

s'affichera à côté de sa légende (21° dans l'exemple ci-dessus). 
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7.10.2 Import d'une abaque 
 

Pour importer une abaque (fournie par l'architecte par exemple), lancez le menu 

"Performance→Abaques→ importer" et choisissez le fichier qui avait été exporté (sur une clef USB par 

exemple). 

 

 

7.10.3 Création d'une abaque 
 

Une abaque se crée en définissant le tableau des valeurs associées à la vitesse et à l'angle du vent 

 

 

 

Elle se représente à l'écran sous forme de courbe dans le même écran que les Sailect. Cette représentation 

peut s'assimiler à des "courbes de niveau" (courbes en pointillé noir ci-dessous). 
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La création d'une abaque peut se faire  

_ Manuellement en remplissant le tableau des valeurs (Création manuelle d'une abaque) 

_ Automatiquement en important un tableau Excel - souvent fourni par l'architecte -  (Création d'une 

abaque par import d'un tableau Excel) 
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7.10.3.1 Création manuelle d'une abaque 

Lancez le menu "Performance→ Abaques→ créer / modifier". 

 

La création se fait en remplissant le tableau (partie de gauche). 

Vous pouvez définir la valeur de chaque cellule  en saisissant la valeur adéquate dans celle-ci. 

Vous pouvez également forcer la valeur pour tout un groupe de cellules. Pour cela, sélectionnez les cellules 

à initialiser, saisissez la valeur à leur affecter dans la première zone "Sélection =", puis cliquez sur "Sélection 

=". 

Vous pouvez également affecter un coefficient à un groupe de cellules. Pour cela, sélectionnez les cellules à 

modifier, saisissez le coefficient dans le deuxième zone "sélection =" (celle en pourcentage), puis cliquez sur 

"sélection =". Un coefficient de 90% diminue la valeur de chaque cellule de 10%, un coefficient de 110% 

augmente la valeur de chaque cellule de 10%. 

 

7.10.4 Visualisation pendant la création 
Vous pouvez suivre l'effet de vos saisies et modification au fur et à mesure de celles-ci sur la partie centrale 

de l'écran en cochant la case "Afficher" de la zone "Graphe". 

Choisissez le type de représentation en cochant, selon le cas, "Polaire" ou "Cartésien". 

Vous pouvez afficher la courbe des VMG de la polaire active en cochant "Afficher VMG". 

Vous pouvez également afficher en calque, certaines Sailect et abaques. Pour cela, cliquez sur "Choix 

calques" et cochez les Sailect ou abaques à afficher. 

 

7.10.5 Options de présentation à l'écran 
 

True Wind 
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(par défaut) Définit l'abaque en vent réel. 

Nb décimales 

Indiquez le nombre de décimales à afficher pour chaque valeur. 

Unité 

Vous pouvez définir l'unité de l'abaque (par ex kg pour la tension d'étai). Cette unité sera reprise sur les 

valeurs affichées. 

Pas 

Le pas permet  de définir l'écart entre 2 courbes. Plus le pas est faible, plus les courbes relatives à l'abaque 

seront nombreuses. 

Contour 

Vous pouvez spécifier la couleur des courbes affichées ainsi que leur épaisseur et le type de trait 

7.10.6 Annotation d'une abaque 

Vous pouvez placer des annotations sur l'abaque comme pour les Sailect. Une annotation est composée 
d'un pictogramme qui apparait sur l'abaque et d'un commentaire qui apparaît quand on approche la souris. 

Pour positionner une annotation, double-cliquez à l'endroit où vous souhaitez placer l'annotation puis 
saisissez le commentaire et les caractéristiques de l'annotation. 

Le paramétrage d'une annotation est décrit dans le chapitre Sailect → annotation 
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7.10.7 Création d'une abaque par import d'un tableau Excel 
 

Si vous disposez du descriptif d'une abaque, fournie par l'architecte du bateau par exemple, vous pouvez 

importer le tableau correspondant. 

 

Le tableau doit se présenter sous la forme suivante : 

_ vitesse de vent en abcysse, angles de vent en ordonnées ou vice-versa. 

_ chaque case du tableau précise la valeur de l'abaque pour la plage de vent considérée. 

TWA/TWS 8 12 16 20 25 30 

40       

50       

60   15 15 15  

70 14 14 14 14 15  

75 14 14 14 14 14  

80 13 13 14 13 13  

90 12 13 14 13 12  

100 10 11 12 11 11  

110  8 9 9 8  

120   6 5   

130       

140       

145       

150       

160       

170       

180       

 

Si les angles de vent sont en vertical, placer le sigle "TWA / TWS" dans la case en haut à gauche. S'ils sont en 

horizontal, placer le sigle "TWS / TWA". 

Si les indications de vent sont en apparent, remplacez "TWA" par "AWA" et "TWS" par "AWS". 

Une fois le tableau prêt, sélectionnez le sous Excel (ou sous un autre tableur), placez le dans le presse-

papier (ctrl-C). Lancez le menu " Performance→ Abaques→ créer / modifier" et cliquez sur le bouton "Imp. 

presse-papiers". Complétez ensuite les informations de présentation comme indiqué dans le chapitre 

"Création manuelle d'une abaque" 
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7.10.8 Création automatique d’abaque de vent apparent  
 

Le menu  Performance → abaques → créer abaque AWS/AWA permet de déterminer en fonction d’une 

polaire calculée,  les abaques de vitesse de vent apparent (AWS) et/ou les abaques d’angle de vent 

apparent (AWA) correspondantes. 

 

Sélectionner dans le menu le type d’abaque à créer et choisissez la polaire utilisée dans la boite de 

dialogue. 

 

L’abaque une fois calculée s’ouvre dans l’interface de création/modification. 

 

 

 

Il est alors possible de faire des modifications avant d’utiliser l’abaque. 
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7.10.9 Sauvegarde d'une abaque 
 

Après avoir créé (manuellement ou automatiquement) ou modifié une abaque, vous pouvez la sauver en 

saisissant son nom (zone "nom de l'abaque") et en cliquant sur "Sauver". 

 

7.10.10 Modification d'une abaque 
 

Pour modifier une abaque existante, double cliquez sur la légende de l'abaque (ou lancez le menu " 

Performance→ Abaques→ Créer/modifier", cliquez sur "Charger" puis choisissez l'abaque à modifier). 

 Procédez ensuite comme pour la création ("Création manuelle d'une abaque") 
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7.10.11 Renommer une Abaque 

Pour renommer une Abaque, lancez le menu " Performance→ Abaques→ Renommer", choisissez l'abaque 
à renommer et saisissez le nouveau nom. 

7.10.12 Supprimer une abaque 

Pour supprimer une Abaque, lancez le menu " Performance→ Abaques→ Supprimer" et choisissez l'abaque 
à supprimer. 

7.10.13 Exporter une abaque 
 

Après avoir créé (manuellement ou automatiquement) ou modifié une abaque, vous pouvez l'exporter pour 

l'installer sur un autre PC. Pour cela cliquez sur "Exporter", puis spécifiez l'emplacement du fichier à sauver 

(par exemple une clef USB). 

Note 1 : Il est recommandé de conserver le nom de fichier proposé. 

Note 2 : Le bouton export n'est disponible qu'après avoir sauvé la nouvelle abaque ou l'abaque modifiée. 

 

7.10.14 Importer une abaque 
 

Pour importer une abaque préalablement exporté, lancez le menu "Performance→ Abaques→ importer" et 

choisissez le fichier qui avait été exporté (sur une clef USB par exemple).  

 

  

 

7.11 Trimbook 
 

Le trimbook est un ensemble d'annotations communes à toutes les Sailect et abaques. 

 

7.11.1 Création / modification du trimbook 
Faites apparaitre la fenêtre d'affichage des Sailect et Abaques 

Cochez la case "Trimbook" 

Pour positionner une annotation, double-cliquez à l'endroit où vous souhaitez placer l'annotation puis 

saisissez le commentaire et les caractéristiques de l'annotation. 

 

Le paramétrage d'une annotation est décrit dans le chapitre Sailect → annotation 
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7.11.2 Afficher le TrimBook 
Pour afficher le trimbook, cochez la case "Trimbook" de la fenêtre de contrôle d'affichage des Sailect et 

abaques. 

 

7.11.3 Exporter un trimbook 
Pour exporter votre trimbook, lancez le menu "Performance→ Trimbook→ exporter". Le logiciel créera 

un fichier que vous pourrez ensuite archiver ou importer sur un autre PC. 

 

7.11.4 Importer un Trimbook 
Pour importer un trimbook, lancez le menu "Performance→ Trimbook→ importer" et chargez le fichier 

du trimbook à importer. 

NB : Il est également possible d’importer ou d’exporter les Trimbook au format XML(Performance → 
Trimbook → Importer/Exporter XML) pour les échanger avec un logiciel tiers. 

 

7.12 Paramétrage de la configuration du bateau 
 

7.12.1 Caractéristiques du bateau 

Avant de prendre en compte les caractéristiques du bateau dans l'enregistrement et le calcul de vos 

polaires, vous devez commencer par les définir. Pour définir ces caractéristiques, lancez le menu 

"Performance→ Configuration bateau". La boite de dialogue proposée est constituée de 3 onglets : 

Le jeu de voiles : Jeu de voiles 

Les appendices :  Appendices 

Les ballasts : Ballasts 
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7.12.2 Jeu de voile 

 

La liste des voiles déjà définies apparaît. Vous pouvez en créer de nouvelles, en supprimer de la liste, 

modifier leurs caractéristiques, indiquer celles qui sont à bord et celles qui ne le sont pas. 

Les informations affichées pour chaque voile sont : 

• le type de la voile (GV, Foc ou Spi), 
• le nom que vous lui avez donné, 
• le nombre de ris dont dispose la voile (qui peut correspondre au nombre de tours roulés pour un 

génois enrouleur), 
• la présence ou non de la voile à bord, 
• la date de mise en service de la voile, 
• sa mise au rebut éventuelle, 
• son poids,  
• le nom du fabricant, 
• le commentaire associé à la voile. 

"Cacher voiles au rebut". Cochez ou décochez cette case selon que vous souhaitiez voir toutes les voiles ou 

seulement celles qui sont encore utilisées. 

"Poids total des voiles embarquées". C'est le poids total des voiles que vous avez déclarées à bord 

("embarquées"). Cela est utile pour suivre le chargement du bateau notamment lorsque la jauge limite le 

poids de matériel ou de voiles embarqué. 

Si vous avez omis de spécifier le poids d'une ou plusieurs voiles, le message indique "certains poids n'ont 

pas été saisis". Vérifier le poids saisi pour chaque voile et complétez ceux qui sont restés à 0. 
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Supprimer une voile. Sélectionnez la ou les voiles à supprimer puis cliquez sur le bouton "Supprimer". Une 

voile qui a déjà servi ne peut être supprimée car on pourra la rencontrer dans les enregistrements servant 

aux calculs. Une voile est vue comme ayant servi dès lors que vous l'avez déclarée "à poste" au moins une 

fois pendant l'une de vos navigations. L'information relative aux voiles ayant servi est affichée dans la boite 

de modification de la voile (cliquez sur le bouton "Modifier"). 

Modifier une voile. Sélectionnez la voile dont vous souhaitez modifier les caractéristiques puis cliquez sur 

le bouton "Modifier" ou double-cliquez sur la voile à modifier. Voir ensuite le chapitre Caractéristiques 

d'une voile. 

Créer une voile. Cliquez sur le bouton "Nouvelle voile". Voir ensuite le chapitre Caractéristiques d'une voile. 

Embarquer une voile. Pour pouvoir prendre une voile en compte dans l'enregistrement des données, la 

voile doit être déclarée "embarquée". Sélectionnez-la ou les voiles à débarquer et cliquez sur le bouton 

"Embarquer". Note : lors de la création d'une voile, celle-ci est "embarquée" par défaut.  

Débarquer une voile. Une voile peut être déclarée "débarquée". Une voile "débarquée" n'est pas proposée 

lors de l'enregistrement des données, ce qui aère l'écran de saisie correspondant. Elle sera par contre 

proposée dans la prise en compte des calculs. Pour débarquer des voiles, sélectionnez-la ou les voiles 

concernées et cliquez sur le bouton "Débarquer". 

Ordre d'affichage des voiles. L'ordre dans lequel les voiles apparaissent à l'écran (en enregistrement ou 

pour les calculs) peut être modifié en sélectionnant la voile concernée et en cliquant, selon le cas, sur le 

bouton flèche haute ou le bouton flèche basse. 

Note : les voiles apparaissent toujours dans l'ordre Grand-voiles, focs puis spis. Il n'est pas possible de 

modifier l'ordre d'affichage des voiles pour faire apparaître une GV après un foc ou un spi avant un foc par 

exemple. 
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7.12.3 Caractéristiques d'une voile 

 

Les informations que vous pouvez saisir ou modifier sont : 

• le nom de la voile. C'est celui qui vous sera proposé lors de l'enregistrement des données en 
navigation ou lors de la prise en compte des voiles lors des calculs, 

• le type de la voile (GV, Foc ou Spi), 
• pour les Grand-voile et les focs : le nombre de ris total que possède la voile. Cette donnée peut être 

utilisée pour saisir le nombre de tours ou le nombre de repères d'enroulement pour un génois 
enrouleur, 

• pour les Grand-voile et les focs : le nombre de ris min. Cette donnée est utile en cas d'avarie qui 
obligerait à garder un nombre de ris minimum et sera exploitée pour le calcul des polaires altérées 
(voir Calcul de polaire altérée (voiles manquantes), 

• le fait que la voile est à bord ("embarquée") ou pas ("débarquée"). Une voile débarquée ne sera pas 
proposée lors de l'enregistrement des données mais le sera lors des calculs, 

• un commentaire sur la voile, 
• le nom du fabricant, 
• le poids de la voile. Cette information permet au logiciel de calculer le poids total des voiles 

embarquées, 
• la date de mise en service (positionnée par défaut à la date du jour lors de la création), 
• vous pouvez également indiquer sa date de mise au rebut. Une voile "au rebut" (c'est à dire dont la 

date de mise au rebut est antérieure à la date du  jour) ne peut plus être "embarquée". Elle peut 
par contre être spécifiée dans les calculs. 

L'information "a servi" est tenue à jour automatiquement par le logiciel. Lorsqu'elle est créée, une voile est 

déclarée comme n'ayant pas servi. Elle est vue comme "ayant servi" dès lors que vous l'avez déclarée "à 

poste" pendant l'une de vos navigations. Une voile ayant servi ne peut plus être supprimée. 

Lorsque vous avez saisi ou modifié les caractéristiques de votre voile, vous pouvez cliquer "enregistrer" 

pour enregistrer cette voile et en saisir une autre ou sur "enregistrer et fermer" si vous n'avez plus de voile 

à saisir. 
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7.12.4 Appendices 

 

Les appendices gérés par le logiciel sont : 

• une dérive arrière, 
• une dérive centrale, 
• une dérive avant, 
• un foil (on ne prend en compte que la position du foil sous le vent), 
• une quille pendulaire, 
• un trimmer. 

Cochez les cases correspondantes aux appendices présents sur votre bateau 
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7.12.5 Ballasts 

 

Les ballasts disponibles dans le logiciel sont  

• trois ballasts avant (central, deux latéraux) 
• trois ballasts centraux, 
• trois ballasts arrière 

Cochez les ballasts que possède votre bateau. 

 

7.13  Enregistrement des données pour le calcul de polaire 
 

Pour rendre les traces exploitables dans le calcul de polaire, plusieurs marqueurs sont utilisés : 

7.13.1 Mode voile/moteur dans la toolbar principale 
Dans la Toolbar principale, utilisez le bouton dédié pour indiquer, en navigation es périodes à la voile ou au 

moteur. Activez le mode voile lorsque vous avez coupé le moteur et que vous naviguez à la voile. De 

même, pensez à passer en mode moteur lorsque vous lancez le moteur. Sans cela, vous enregistreriez des 

données au moteur conduisant à un mauvais calcul des polaires. 

 Indique une période de navigation au moteur 

 Indique une période de navigation à la voile 
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 Indique une période de navigation à la voile pour une durée précise que vous indiquez dans le fenêtre 

qui apparait après avoir sélectionné ce mode 

 

Si vous avez oublié de cocher ou de décocher ce bouton vous pouvez corriger les enregistrements à 

posteriori : voir le chapitre Correction de traces 

7.13.2 Marqueurs supplémentaires pour le calcul de polaire 
Dans le menu Performance :  

 

·         Ce bouton permet de spécifier les vitesses privilégiées. Cliquez dessus lorsque vous estimez que le 

bateau est à une vitesse cible pour les conditions de vent en cours (force et direction). Cela forcera le 

logiciel à prendre cette valeur en compte quels que soient les filtrages utilisés lors du calcul. 

 

 

·         Les trois icônes du menu déroulant suivant permettent de spécifier l'état de la mer : mer calme, 

clapot ou mer agitée. Vous pouvez ignorer ce paramètre et constituer vos polaires indépendamment de 

l'état de la mer ou, au contraire, établir des courbes de polaires prenant en compte l'état de la mer. 

Cliquez alors sur l'icône adéquate avant chaque sortie (vous pouvez également le modifier en cours de 

route si l'état de la mer évolue sensiblement). 
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7.13.3 Correction des enregistrements 

Il peut arriver que vous souhaitiez corriger vos fichiers de données à posteriori. Notamment si vous avez 

oublié de lancer l'enregistrement en début de sortie ou si vous avez oublié de l'arrêter après avoir mis le 

moteur en route. 

Pour cela, lancez le menu "Performance→ Correction des enregistrements". 

 

7.13.4 Spécifications de la configuration du bateau 

Note : avant d'utiliser cette fonction vous devez avoir paramétré les caractéristiques de votre bateau (voiles, 

appendices, ballasts, ...) : voir le chapitre Caractéristiques du bateau. 

Vous pouvez spécifier la configuration du bateau pendant la navigation en cliquant sur  : 

 

Vous accédez à une boite de dialogue comportant 4 onglets qui vous permettent de spécifier la 

configuration du bateau : 

Spécifications du jeu de voiles 

Spécifications de la position des appendices 

Spécifications du remplissage des ballasts 

Spécifications diverses 
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7.13.4.1 Spécifications du jeu de voiles 

  

 

Les voiles proposés sont l'ensemble des voiles paramétrées dans les caractéristiques du bateau (voir 

chapitre Jeu de voiles) et indiquées comme étant "embarquées". Pour indiquer les voiles à poste, cliquez 

sur chacune des voiles présentes. Vous pouvez porter simultanément et au maximum : une Grand-voile, 

deux focs et un spi. 

Chaque Grand-voile et chaque foc peut disposer de ris. Vous pouvez indiquer le nombre de ris pris dans la 

zone correspondant en face de la voile considérée. 

La case "Ignorer configuration voile" permet de ne pas prendre en compte le jeu de voiles à poste. Lors de 

l'enregistrement des données, cette option est globale à l'ensemble des voiles. 

Attention : lors de l'enregistrement des données, la configuration de voiles que vous venez de spécifier 

n'est prise en compte qu'après avoir cliqué sur "Valider" ou "Appliquer". 

7.13.4.2 Spécification du jeu de voiles à l’aide d’une application externe 

 

Il est possible de spécifier la configuration du jeu de voiles en temps réel à l’aide d’une application externe 

communicant par UDP. (Voir chapitre Spécification du jeu de voiles ou de segments avec une application 

extérieure)
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7.13.4.3 Spécifications de la position des appendices 

 

Seuls les appendices présents sur votre bateau  sont proposés (tels que définis dans les caractéristiques du 

bateau - voir chapitre Appendices). 

La définition de la position de chacun des appendices se fait en cliquant sur les flèches adéquates (sens 

haut / bas pour les dérives et le foil, sens droite / gauche pour la quille pendulaire et le trimmer). 

Le dessin de l'appendice représente sa position telle que vous l'avez définie. 

Les dérives avant et arrière peuvent avoir deux positions : haute et basse. La dérive centrale en a 3 : haute, 

mi-haute et basse. 

Le foil (il s'agit toujours du foil sous le vent) a 3 positions : haute, mi-haute et basse. 

La quille pendulaire possède 6 positions : sous le vent - max, sous le vent - mi, centrée, au vent - mi et au 

vent - max. 

Le trimmer possède 6 positions : sous le vent - max, sous le vent - mi, centré, au vent - mi et au vent - max. 

La case "Ignorer configuration" permet de ne pas prendre en compte la position des appendices. Lors de 

l'enregistrement des données, cette option est globale à l'ensemble des appendices. 

Attention : lors de l'enregistrement des données, la configuration que vous venez de spécifier n'est prise 

en compte qu'après avoir cliqué sur "Valider" ou "Appliquer". 
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7.13.4.4 Spécifications du remplissage des ballasts 

 

Seuls les ballasts présents sur votre bateau sont proposés (tels que définis dans les caractéristiques du 

bateau - voir chapitre Ballasts). 

La définition du remplissage de chacun des ballasts se fait en cliquant sur les flèches adéquates (sens haut 

pour remplir / sens bas pour vider). Chaque ballast possède 3 niveaux de remplissage : vide, mi-plein et 

plein. 

Le dessin de chaque ballast représente son niveau de remplissage tel que vous l'avez défini. 

La case "Ignorer configuration" permet de ne pas prendre en compte le niveau de remplissage des ballasts. 

Lors de l'enregistrement des données, cette option est globale à l'ensemble des ballasts. 

Attention : lors de l'enregistrement des données, le remplissage des ballasts que vous venez de spécifier 

n'est pris en compte qu'après avoir cliqué sur "Valider" ou "Appliquer". 
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7.13.4.5 Spécifications diverses 

 

Vous pouvez spécifier dans cette boite de dialogue si le bateau navigue sous pilote ou pas et si cette 

navigation se fait en équipage ou en solitaire. Le dessin du bateau reflète ces informations (nombre 

d'équipiers - barreur à son poste ou pas). 

Vous pouvez également préciser ici une configuration propre à votre bateau qui n'aurait pas été prévue en 

standard dans le logiciel. Par exemple, le nom de l'équipier à la barre. Pour cela, cliquez sur le bouton 

"nouvelle" de la zone "Configuration spécifique" pour créer la configuration si cela n'a pas encore été fait 

puis sélectionnez-la dans la liste des configurations spécifiques disponible. Pour dévalider cette 

configuration spécifique, cliquez sur "Ignorer" 

Attention : lors de l'enregistrement des données, les configurations que vous venez de spécifier ne sont 

prises en compte qu'après avoir cliqué sur "Valider" ou "Appliquer". 

 

7.14 Les speed tests 

Les Speed tests permettent d'analyser finement une portion de trace ou de comparer entre elles 2 

portions de trace. Pour cela, 2 speed tests peuvent être créés simultanément, chacun d'entre eux étant 

défini par son heure de début et son heure de fin. 

7.14.1 Création des Speed tests  

Les speed tests peuvent être créés soit sur la trace en cours (sur l'eau ou pendant un replay). Soit sur 

un histo-graphe. Ils sont accessible de trois façons: 
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• par un clic droit sur la trace ou sur l'histographe 

• par les raccourcis du menu "Performance" 

• par le menu "Traces" 

7.14.2 Création des Speed tests sur la trace en cours (fil de l'eau). 
 

7.14.2.1 Par les raccourcis du menu Performance 

Pour définir les débuts et fins de Speed Tests sur la trace en cours (trace réelle ou trace rejouée), 

cliquez sur les boutons correspondant de la tool barre Optima. 

 

Exemple : pour analyser un virement de bord, cliquez sur le 1er bouton juste avant le virement, 

effectuez la manœuvre puis cliquez à nouveau sur le bouton. Si vous souhaitez comparer le avec un 

autre virement, effectuez à nouveau l'opération en cliquant sur le 2ème bouton. Analysez ensuite le 

résultat avec le tableau. 

7.14.2.2 Par le menu Traces 

Vous pouvez accéder aux mêmes fonctions par le menu "Trace→ Speed tests" : 

"Trace→ Speed tests→ Débuter Speed test1" ou  "Terminer Speed test1" 

"Trace→ Speed tests→ Débuter Speed test2" ou "Terminer Speed test2" 

"Trace→ Speed tests→ Analyser Speed tests" 
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7.14.3 Création et modification des Speed test sur un histo-graphe 
 

7.14.3.1 Création 

Cette méthode est la plus commode et la plus précise pour définir les Speed Tests à posteriori. 
Ouvrez un histo-graphe sur la période à analyser et faites un clic-droit à l'endroit où vous souhaitez 

placer le Speed Test.  

 

Choisissez ensuite le Speed test à positionner et cliquez sur la fin du Speed test.  

Lorsque vous avez positionné les Speed test, les zones correspondantes sont colorées en jaune pour le 

Speed test 1 et en orange pour le Speed test 2. 

 

7.14.3.2 Déplacement 

 

Vous pouvez déplacer l'extrémité d'un Speed test en cliquant sur cette extrémité et en la tirant à la 

position désirée 

Vous pouvez également déplacer l'ensemble d'un Speed test en cliquant à l'intérieur du Speed test et 

en le tirant à la position désirée. 

 

7.14.3.3 Valeur moyenne des données incluses dans un Speed Test 

 

Lorsque vous avez défini des Speed test, la valeur moyenne de chacune des courbes sur la durée du 

Speed test est affichée sur la gauche de l'histo-graphe : sur fond jaune pour le Speed test 1, sur fond 

orange pour le Speed test2. 
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7.14.4 Définition des Speed tests par saisie de l'heure 

Vous pouvez saisir directement l'heure des débuts et fin de Speed Test dans le tableau 
d'analyse des Speed Tests (voir paragraphe ci-dessous). Lorsqu'une trace se déroule sur une 
seule journée (cas le plus fréquent), la date n'est pas modifiable ; seule l'heure peut l'être. 

7.14.5 Analyse d'un speed test 
Après avoir défini un speed Test, vous pouvez l'analyser en cliquant sur l'icone 

, en lançant le menu "Traces→ Speed tests→ Analyse " ou par un clic-droit 

(dans l'histo-graphe)→ "Analyser Speed test".  

. 

 

La partie haute du tableau reprend les éléments de définition des Speed tests : trace concernée, heure 

de début, heure de fin et durée. Vous pouvez choisir d'afficher l'un ou l'autre des Speed tests ou les 2 

simultanément en cochant les cases "Afficher". 
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La partie basse du tableau donne les valeurs de différentes données au cours du Speed Test. Pour 

chacune de ces données, vous lisez sa valeur en début de période, sa valeur en fin, la valeur mini 

rencontrée, la moyenne, la valeur maxi et l'écart type. 

Les données affichées sont, par défaut, la direction du vent, la vitesse du vent réel, l'angle de vent réel, 

la vitesse du vent apparent, l'angle de vent apparent et le cap compas. 

Vous pouvez modifier ces données, en ajouter ou en enlever. 

Pour modifier la donnée affichée sur une ligne, double-cliquez sur l'en tête de la ligne à modifier. Le 

logiciel proposera l'ensemble des données disponibles. Pour le descriptif de ces données, consultez le 

chapitre " Affichage des performances dans le tableau de bord" 

Pour ajouter une ligne, cliquez sur "ajouter une ligne". La nouvelle ligne prendra place à la fin du 

tableau. 

Pour insérer une ligne, sélectionnez la ligne au dessus de laquelle vous souhaitez insérer la nouvelle 

ligne puis cliquez sur "Insérer ligne". 
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7.14.6 Comparatif de speed tests 

 

Pour comparer les Speed tests, cochez la case "Afficher" de chacun des 2 Speed Tests. 

Les colonnes présentent les mêmes informations que lors de l'analyse d'un Speed Test (début, fin, min, 

moyenne, max et écart-type). Les lignes présentent, pour chaque donnée affichée, la valeur pour le 

Speed Test1, la valeur pour le Speed Test2 et la différence entre les 2. Cette différence s'affiche en vert 

lorsqu'elle est positive, en rouge lorsqu'elle est négative. 
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8  LES ROADBOOKS 
 

Le RoadBook permet d'annoter vos cartes sur les évènements particuliers à surveiller au cours de la 

navigation. Ces annotations sont constituées de zones ou de pictogrammes associés à un commentaire. Les 

zones peuvent faire l'objet d'alarme (lorsque vous en approchez) et d'interdiction pour le routage. 

 

8.1 Créer un RoadBook 
 

Pour créer un RoadBook, choisissez le menu "Roadbooks→ Créer". 

 

 

Saisissez le nom du RoadBook et éventuellement la famille dans laquelle il doit s'intégrer. Vous pouvez 

sélectionner une famille de Roadbook existante dans le menu déroulant ou en créer une nouvelle en 

entrant son nom dans le champ "Famille" : 

 

 

Utilisez ensuite les boutons pour dessiner : des courbes (arrondies), des polygones (anguleux), des lignes 

brisées, des disques, des rectangles et des pictogrammes. 

  

8.1.1 Créer un dessin : courbe 

Pour dessiner une courbe, cliquez sur l'icône , cliquez ensuite sur la carte sur les différents points 

constituant la courbe. 

Pour fermer et terminer la courbe, double cliquez sur le dernier point à placer. 

Le logiciel propose alors de saisir ou de modifier les caractéristiques de la courbe : 
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Apparence 

Vous pouvez choisir la couleur et l'opacité du fond. Le contour est défini par sa couleur, son opacité, le type 

de trait le constituant (plein, tirets, ...) et l'épaisseur du trait. 

 

Commentaire 

Saisissez le commentaire qui apparaitra lorsque vous approcherez la souris du dessin. 

 

Position 

Si vous connaissez la position géographique de la zone, vous pouvez en saisir les coordonnées du centre en 

cliquant sur le bouton "Position". 

Afficher le dessin 

Spécifie que le dessin doit apparaitre à l'écran. 

 

Navigation dangereuse dans cette zone (alarme) 

Une alarme sera générée lorsque le bateau approchera de la zone (selon les paramètres définis dans les 

alarmes (voir LES ALARMES). 

 

Navigation interdite dans cette zone (routages) 

Les routages éviteront la zone couverte par le dessin (voir LES ROUTAGES) 

 



265 
 

8.1.2 Créer un dessin : polygone 

Pour dessiner un polygone, cliquez sur l'icône , puis procédez comme pour une courbe. 

 

8.1.3 Créer un dessin : ligne brisée 

Pour dessiner une ligne brisée, cliquez sur l'icône , puis procédez comme pour une courbe. 

 

8.1.4 Créer un dessin : cercle 

Pour dessiner un cercle, cliquez sur l'icône , cliquez sur la carte la position du centre du cercle, puis 

tirez tout en maintenant le bouton gauche de la souris enfoncé pour définir le diamètre. Procédez ensuite 

comme pour une courbe. 

 

8.1.5 Créer un dessin : rectangle 

Pour dessiner un rectangle, cliquez sur l'icône , cliquez sur la carte la position du premier coin du 

rectangle, puis tirez tout en maintenant le bouton gauche de la souris enfoncé pour définir la taille et la 

position du rectangle. Procédez ensuite comme pour une courbe. 

 

8.1.6 Insérer une image 

Pour insérer une image, cliquez sur l’icône , cliquez sur la carte la position du premier coin de 

l’image, puis tirez tout en maintenant le bouton gauche de la souris enfoncé pour définir la taille et la 

position de l’image. Sélectionnez le fichier à insérer parmi les fichiers de votre PC. 

Adrena demandera alors si vous souhaitez recopier le fichier dans le répertoire Adrena ou utiliser le fichier 

d'origine. A moins que vous n'ayez des problèmes de place sur votre disque, Il est conseillé de le ramener 

dans le répertoire Adrena afin de ne pas le perdre dans vos sauvegardes ou lors d'un changement de PC. 

Définissez ensuite les caractéristiques de l’image comme pour les autres formes de dessin. 

 

8.1.7 Modifier un dessin 
Déplacer un point (courbes, polygones et lignes brisées) 

Pour déplacer un point, faites un clic droit sur le point puis choisissez "déplacer le point" et cliquez la 

nouvelle position du point sur la carte. 

 

Supprimer un point (courbes, polygones et lignes brisées) 
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Pour supprimer un point, faites un clic droit sur le point puis choisissez "supprimer le point". 

 

Ajouter un point  (courbes, polygones et lignes brisées) 

Pour créer un nouveau point faites un clic droit sur le bord de la courbe, choisissez "ajouter un point" et 

cliquez la position du nouveau point sur la carte. 

 

Positionner un point 

Pour positionner un point du Roadbook par ses coordonnées géographiques, faire un clic droit sur le point 

concerné et choisissez "Point → Positionner le point". Une boite de dialogue s'ouvre pour vous permettre 

d'indiquer la position en longitude et latitude. 

 

Pivoter autour du point 

Pour faire pivoter un roadbook autour d’un point, faire un clic-droit sur le point concerné et choisissez 

"Point → Pivotez le dessin autour du point". Indiquer la valeur de la rotation en degré. 

 

Agrandir ou diminuer à partir d’un point 

Pour modifier la taille d’un roadbook à partir d’un point, faire un clic-droit sur le point concerné et 

choisissez "Point → Agrandir / Diminuer le dessin autour du point". Indiquer la valeur en pourcentage. 

 

 

Modifier les caractéristiques du dessin 

Pour modifier les caractéristiques d'un dessin, faites un clic-droit sur le centre du dessin (matérialisé par un 

point rouge) et choisissez "Modifier le dessin". Vous pouvez également double-cliquer sur le centre du 

dessin. 
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Poursuivez ensuite comme lors de la création. 

 

8.1.8 Déplacer un dessin 
Pour déplacer un dessin, faites un clic-droit sur le centre du dessin (matérialisé par un point rouge) et 

choisissez "Déplacer le dessin". Cliquez ensuite la position sur la carte. 

 

Dupliquer un dessin 

Pour dupliquer un dessin, faites un clic-droit sur le centre du dessin (matérialisé par un point rouge) et 

choisissez "Dupliquer le dessin". Cliquez ensuite la position sur la carte et poursuivez comme pour une 

création. 

 

Supprimer un dessin 

Pour supprimer un dessin, faites un clic-droit sur le centre du dessin (matérialisé par un point rouge) et 

choisissez "Supprimer le dessin". 

 

Pivoter autour du point central 

Procéder comme pour un point extérieur du roadbook à partir du point central. 

 

Agrandir ou diminuer à partir du point central 

Procéder comme pour un point extérieur du roadbook à partir du point central. 

 

Créer une annotation 

Pour créer une annotation, cliquez sur l'icône  puis cliquez la position sur la carte. 
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Vous pouvez saisir un commentaire (qui apparaitra lorsque vous approchez la souris de l'annotation). 

Le pictogramme peut être choisi parmi la liste des favoris (36 livrés en standard plus ceux que vous ajoutez 

vous-même) ou personnalisé (bouton "Personnaliser"). 

 

Personnaliser un pictogramme 
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Un pictogramme est constitué de 1 ou 2 figures géométriques superposées ou adjacentes. 

 

Le pictogramme principal est décrit dans la zone supérieure gauche de l'écran 

Choisissez la forme souhaitée (rond, rectangle, triangle, cercle ou flèche), la largeur, la hauteur, la couleur 

et l'opacité. 

Le centrage de la forme peut être modifié avec les 4 flèches de direction. Le carré central permet de le 

ramener au centre du pictogramme. 

Vous pouvez également modifier l'orientation de la forme (zone "rotation"). 

 

Si vous souhaitez combiner 2 pictogrammes, cochez l'option "Pictogramme secondaire" et définissez les 

caractéristiques  du second pictogramme comme indiqué pour le premier. 

 

Au fur et à mesure que vous définissez les caractéristiques du pictogramme, son apparence se dessine dans 

la fenêtre en haut à gauche. 

 

Vous pouvez également modifier la rotation globale du picto, ainsi que sa taille. Pour modifier la taille 

globale du picto : saisissez la taille dans la zone prévue à cet effet ou cliquez sur les boutons  (divisé par 

2),  (- 10%),  (+10%) ou  (multiplié par 2). 
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Ajouter un pictogramme personnalisé aux favoris 

Si vous souhaitez ajouter un pictogramme personnalisé aux favoris, cliquez sur "Ajouter aux favoris" et 

choisissez la position de nouveau favori dans la palette. Si vous choisissez un emplacement déjà occupé, le 

nouveau pictogramme remplacera l'ancien dans la palette. 

 

 

8.1.9 Multimédia dans une annotation 
Pour placer un fichier multimédia dans un roadbook, créez une annotation et cliquez sur "Multimédia".  

La procédure de création et de lecture est décrite dans le chapitre Multimédia dans la trace. 

 

8.1.10 Modifier une annotation 
Pour déplacer une annotation, faites un clic-droit sur l'annotation et choisissez "Déplacer l'annotation" ou 

double cliquez dessus. Procédez ensuite comme lors de la création. 

 

8.1.11 Déplacer une annotation 
Pour déplacer une annotation, faites un clic-droit sur l'annotation et choisissez "Déplacer l'annotation". 

Cliquez ensuite sur la nouvelle position sur la carte. 

 

8.1.12 Dupliquer une annotation 
Pour dupliquer une annotation, faites un clic-droit sur l'annotation et choisissez "Dupliquer l'annotation". 

Cliquez ensuite la position sur la carte et poursuivez comme pour une création. 
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8.1.13 Supprimer une annotation 
Pour supprimer une annotation, faites un clic-droit sur l'annotation et choisissez "Supprimer l'annotation". 

 

8.1.14 Annuler la dernière action 

Pour annuler la dernière action effectuée au sein d'un RoadBook, cliquez sur l'icône  . Vous pouvez 

annuler successivement toutes les actions effectuées depuis le début de création ou de modification du 

RoadBook. 

 

8.1.15 Rejouer la dernière action annulée 

Pour rejouer la dernière action annulée, cliquez sur l'icône  .  

 

8.1.16 Recentrer l'écran sur le RoadBook en cours de création 

Pour recentrer l'écran sur le RoadBook en cours de création ou de modification, cliquez sur l'icône .  

 

8.1.17 Définir l'apparence par défaut des dessins 

Pour définir l'apparence par défaut des dessins que vous créez, cliquez sur l'icône  . 

 

 

Toutes les options d'apparence (couleur, opacité, ...) que vous définirez seront ensuite utilisées comme 

valeurs par défaut pour chaque dessin créé ultérieurement. 
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8.2 Modifier un RoadBook 
Pour modifier un RoadBook, lancez le menu "RoadBooks→ Modifier" et choisissez le RoadBook à modifier. 

Poursuivez ensuite comme pour la création (voir Créer un RoadBook). 

 

 

8.3 Terminer la création ou la modification d'un RoadBook 
Pour terminer la création ou la modification d'un RoadBook, cliquez sur le bouton "Modifier" et décochez le 

roadbook en cours de modification. 

 

8.4 Renommer un RoadBook 
Pour renommer un RoadBook, lancez le menu "RoadBooks→ Renommer" et choisissez le RoadBook à 

renommer. Saisissez ensuite le nouveau nom et éventuellement la famille dans laquelle il doit s'intégrer. 

Vous pouvez sélectionner une famille de Roadbook existante dans le menu déroulant ou en créer une 

nouvelle en entrant son nom dans le champ "Famille" : 

 

 

 

8.5 Supprimer un RoadBook 
Pour supprimer un RoadBook, lancez le menu "RoadBooks→ Supprimer" et choisissez le RoadBook à 

supprimer. Le RoadBook ainsi que tous les dessins et annotations qui le composent seront définitivement 

supprimés. 

 

8.6 Supprimer une famille de Roadbook 
Pour supprimer une famille entière de roadbook, allez dans le menu "Roadbook → Supprimer et choisissez 

la famille à supprimer. Si celle-ci comporte des roadbook, le logiciel vous demandera la confirmation de la 

suppression de chaque roadbook puis de la famille. 
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8.7 Activer un RoadBook 
Activer un RoadBook permet de le faire apparaître à l'écran et d'activer les zones dangereuses (alarmes) et 

interdites (routages) le composant. 

Pour activer un RoadBook lancez le menu "RoadBooks→ Activer et choisissez ensuite le ou les RoadBooks à 

activer. 

 

8.8 Afficher les annotations des RoadBooks en permanence. 
Par défaut, les annotations des RoadBooks apparaissent lorsque la souris s'en approche. 

Si vous souhaitez les faire tous apparaître en permanence, cochez la case "Toutes annotations RoadBooks" 

de la boite de définition des options de cartographie. 

 

8.9 Exporter un RoadBook 
Vous pouvez exporter un RoadBook pour le transférer sur un autre PC ou pour le sauvegarder. 

Pour exporter un RoadBook, lancez le menu "RoadBooks→ exporter". 

 

8.10 Exporter un RoadBook au format Adrena V9 
Par défaut, les roadBooks sont exportés dans un format compatible avec les versions 10 et supérieures 

d'Adrena (et V9 > 9.2.0.25). Pour exporter vos roadBooks dans un format compatible avec les versions 

antérieures d'Adrena, lancez le menu "RoadBooks→ exporter" puis choisissez "Fichiers roadBooks V9" dans 

la zone 'Type"  

 

 

 

8.11 Importer un RoadBook 

Vous pouvez importer un RoadBook (préalablement exporté sur un autre PC) en lançant le menu 

"RoadBooks→ Importer". 
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9 TRACES 
 

9.1 Charger des traces 
Pour travailler une ou plusieurs traces à posteriori (débriefing), vous pouvez faire un replay de ces traces ou 

les charger sans replay. Pour les charger sans replay, lancez le menu "Trace→ Charger/décharger→ Charger 

trace(s)". Elles apparaitront alors à l'écran et vous pourrez les travailler. 

9.2 Décharger des traces 
Pour décharger des traces, lancez le menu "Trace→ Charger/décharger→ Décharger trace(s)" et choisissez 

les traces à décharger. 

9.3 Démarrer une nouvelle trace 
Pour démarrer l’enregistrement da la trace dans un nouveau fichier, cliquez sur le bouton "Nouvelle" 

9.4 Sauver une trace 
Après avoir travaillé une trace vous pouvez la sauver. Lancez le menu "Trace→ Sauver trace" (nom 

inchangé) ou "Trace→ Sauver trace sous" (pour changer son nom), puis choisissez la trace à sauver. 

 

Après avoir sauvé une trace, celle-ci sera disponible parmi les "traces validées" chaque fois que vous 

souhaitez en choisir une pour replay, chargement sans replay, calcul de polaires , statistiques ou autre.. 
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9.5 Option d’affichage de la trace 
La trace affichée à l'écran concerne par défaut l'ensemble du parcours effectué par le bateau depuis le 

lancement du logiciel. Un certain nombre d'options permet d'en préciser les phases à afficher ainsi que la 

couleur et les éléments à y intégrer. Pour accéder à ces options, cliquez sur le bouton " Options 

d’affichage ":  

 

 

9.5.1 Général (étendue d'affichage de la trace) 
Afficher la trace : valide globalement l'affichage de la trace et de ses options. 

Toute la trace : affiche toute la trace sans limitation de durée ni avant la position actuelle du bateau ni 

après. 

Trace avant : affiche la trace avant la position courante du bateau. 

Trace avant / limitée à : durée d'affichage de la trace avant la position courante du bateau. 

Trace après : affiche la trace après la position courante du bateau (ne concerne évidemment que le 

replay). 

Trace après / limitée à : durée d'affichage de la trace après la position courante du bateau. 

 

9.5.2 Annotations et segments 
Annot. manuelles : affiche les annotations que vous avez saisies manuellement (en cours de navigation 

ou en débriefing). Voir la création d'annotation 
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Annot. automatiques : affiche les annotations calculées par le logiciel. Cela concerne les virements de 

bord, les empannages, les passages de bouée (sur parcours banane) et le timing de départ (signal 

d'avertissement, préparatoire, minute et départ). 

Chgt de configuration : affiche les changements de configurations que vous avez saisis pendant la 

navigation : voiles, ballasts, appendices, ... Voir Spécification de la configuration du bateau 

Segments : affiche les segments que vous avez saisis (en cours de navigation ou en débriefing). Voir la 

création des segments. 

Annotations et segments en permanence : par défaut, les annotations et segments sont affichés sans 

le commentaire. C'est en approchant la souris que le commentaire associé apparaît. En cochant l'option 

"Annotations et segments en permanence", les commentaires seront affichés sur tous les éléments 

simultanément.  

 

Note : Si le niveau de zoom est trop large, cela peut encombrer totalement l'écran. 

 

9.5.3 Manches et phases de parcours (parcours banane) 
Les options relatives aux manches et phases de parcours permettent de mettre en évidence les 

différentes phases (départ, près, portant) et manches (si plusieurs manches ont été enregistrées dans la 

même trace) 

 

Colorer selon phase 

En cochant cette option la trace prendra les couleurs suivantes : 

hors course : gris 

pendant le départ avant la minute : en noir (trait fin) 

pendant la minute : en noir (trait plus épais) 

1ère manche : bleu 

2ème manche : rouge 

3ème manche : vert 

sur un parcours banane, les différents tours sont différenciés par la densité de couleur, du plus clair 

pour le 1er tour au plus foncé pour le 3ème tour. 

 

Il est également possible, pour comparer les différentes phases, de choisir les phases à afficher.  

Vous pouvez choisir d'afficher ou non : 

la portion de trace effectuée "hors course" 

la portion de trace effectuée pendant le signal d'attention 

la portion de trace effectuée pendant le signal préparatoire 
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la portion de trace effectuée pendant la minute 

les bords de près et / ou les bords de portant 

le ou les tours que vous souhaitez 

la ou les manches que vous souhaitez 

 

Cela vous permet de comparer à l'écran tel tour par rapport à tel autre, la première remontée de la 1ère 

manche par rapport à la 1ère remontée de la 2ème manche, etc. 

Cochez ou décochez les différentes phases en fonction de vos souhaits. 

 

9.5.4 Mise en évidence de la trace 
Les options de mise en évidence de la trace permettent de colorer ou d'épaissir la trace selon des 

critères particuliers. 

Cela concerne les traces de votre bateau ou des replay de bateaux et les traces des concurrents. 

 

9.5.4.1 Coloration selon une donnée 

Vous pouvez, avec cette option, colorer la trace (du bleu foncé au rouge foncé) en fonction de l'une des 

données enregistrées pendant la navigation ou calculées par le logiciel. 

 

Dans l'exemple ci-dessus la trace a été colorée en fonction de la vitesse du vent. L'échelle de couleur 

est indiquée en bas à gauche de l'écran. Vous pouvez également connaître la valeur étudiée en 

approchant la souris d'un point de la trace. 

 



278 
 

Pour choisir la donnée à l'origine de la coloration, double cliquez dans la zone "Donnée" et choisissez la 

donnée adéquate. 

Les valeurs min et max permettent de définir l'étendue de la coloration. Le min correspond à la valeur 

associée au bleu foncé, le max au rouge foncé. 

Le bouton "Valeurs auto" fait un ajustement automatique du min et du max à partir des valeurs 

rencontrées dans la trace. 

 

9.5.4.2 Epaississement de la trace sur critères 

 

Navigation à la voile 

Met en évidence les portions de traces identifié par l’utilisateur comme étant effectuées à la voile et donc 

prise en compte dans le calcul de polaire 

Multi-critères 

Cette fonction permet de mettre en évidence des situations combinant plusieurs critères, par exemple les 

parties de la trace où la vitesse du vent était de plus de 15 nœuds, où la bateau naviguait au près et où la 

vitesse cible était supérieure à 90%. 

Toutes les données reçues de la centrale ou calculées par le logiciel sont utilisables et on peut cumuler 10 

conditions au maximum. 

 

Pour valider l'épaississement, cliquez sur "valider" puis sur le bouton "critères". 
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Choisissez ET ou OU selon la façon dont vous souhaitez combiner les critères. 

Double cliquez dans les zones "information" pour choisir les données adéquates. 

Choisissez le type de condition : "inférieur" ou "supérieur" pour les données numériques, "égale à" ou 

"différent de" pour les valeurs non numériques (nom du foc à poste par exemple). 

 

Lorsque vous avez saisi les critères, vous pouvez valider pour les prendre en compte. Vous pouvez 

également cliquer sur "Ajouter au favoris" pour ajouter ces critères dans la liste des favoris réutilisables 

ensuite. 

 

Rappel d'un favori 

Dans la fenêtre de paramétrage de la trace, vous pouvez sélectionner un favori parmi la liste de ceux 

que vous avez créés auparavant. 

 

Suppression d'un favori 

Pour supprimer un favori, rappelez le dans la liste des favoris et cliquez sur "Retirer des favoris". 

9.5.5 Historique des données météo le long de la trace  
L'historique de certaines données météo lues ou prévues peut être affiché le long de la trace pour les 

visualiser graphiquement. 

Pour cela il faut sélectionner et valider la ou les  donnée(s) à afficher dans la fenêtre des paramètres 

d'affichage de la trace .  
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281 
 

 

L’affichage des données le long de la trace peut-être superposé sur une même trace. 

 

9.6 Replay 
Vous pouvez rejouer vos navigations à posteriori afin d'en analyser les différentes phases, les options 

que vous avez choisies et l'évolution des conditions météo. Lors d'un replay, le logiciel propose 

l'ensemble des informations qui étaient disponibles pendant la navigation.  

Pour rejouer une navigation, lancez le menu "Traces→ replay". Le logiciel propose l'ensemble des 

traces qui ont été enregistrées auparavant. 

 

9.6.1 Choix de la trace 
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Trois types de traces peuvent être chargés : 

Les "traces brutes" sont les traces que vous avez enregistrées pendant la navigation 

Les "traces validées" sont les traces que vous avez retravaillées en débriefing et sauvées ensuite   

Les "Collect"sont des collections de traces ou de portions de traces que vous avez triées et mises de 

côté en débriefing 

 

Si vous gérez plusieurs bateaux sur votre PC, vous pouvez sélectionner le bateau concerné. 

 

9.6.2 Choix de la polaire 
 

Après le chargement de la trace une fenêtre s’ouvre pour sélectionner la polaire à utiliser pour le replay 

ainsi que le pourcentage à appliquer sur la vitesse de celle-ci. 

 

 

 

9.6.3 Navigation dans la trace 
Après avoir choisi la trace à rejouer, celle-ci est chargée, le menu contextuel de contrôle apparait et le 

replay commence.  

 

 

 

La vitesse de replay est de 1 par défaut. Vous pouvez la changer avec le curseur vertical placé à côté de 

vitesse et avancer ou reculer dans le temps avec le curseur " Timing " 

Les autres boutons vous permettent : 
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 de revenir en début de trace 

 de repartir en arrière 

 d'arrêter le mode replay 

 de faire une pause 

 de partir en avant (si le replay a été interrompu, vous pourrez alors choisir une nouvelle trace) 

de régler la vitesse à laquelle la trace est rejouée 

 positionner directement à une heure précise 

 de se positionner au signal d'attention 

 de se positionner au départ (-10 secondes) 

 de reculer jusqu’à la marque précédente 

 d'avancer jusqu'au passage de la prochaine marque 
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 d'avancer jusqu'au prochain virement de bord ou empannage 

 d'avancer jusqu'à la prochaine annotation 

 de vous positionner directement sur un point de la trace 

 de charger une autre trace 

 

Pour se placer sur un point de la trace, vous pouvez également faire un clic droit sur la trace et choisir : 

"replay : se placer ici" 

 

NB : à la fin de la lecture d’une trace, le replay bascule automatiquement sur la trace suivante si elle est 

la suite de la première. 

 

Lorsque vous rejouez une trace, tous les outils que vous utilisez lors de la navigation sont disponibles 

(choix des données numériques à afficher, histo-graphes des données, consultation de la marée, 

visualisation des courants, visualisation des prévisions météo, options d'affichage et de coloration de 

trace, etc.) 

 

 

9.6.4 Rejouer plusieurs traces simultanément 
 

Vous pouvez rejouer plusieurs traces simultanément. Notamment en débriefing d'une navigation 

concernant plusieurs bateaux. 

 

9.6.4.1 Chargement des traces 

 

Pour rejouer la trace des différents bateaux, commencez par rapatrier les différentes traces sur votre 

PC (il est recommandé de créer plusieurs bateaux et de stocker chacune des traces dans le bateau 

approprié). 

Vous pouvez rapatrier la trace de 2 manières : 
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en recopiant le fichier .../trz directement dans le répertoire "traces" du bateau considéré (répertoire 

.../Adrena/bateaux/<nom du bateau→/traces) 

en choisissant le bouton "importer" lorsque vous chargez la trace pour la première fois  

 

Lorsque les traces ont été rapatriées vous pouvez les charger soit pour replay soit en chargement 

simple. 

Pour charger plusieurs traces simultanément utilisez les touches ctrl et shift dans la liste des traces à 

charger. Pour les charger successivement, réitérez l'opération de chargement (ou de replay) autant de 

fois que nécessaire. 
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9.6.4.2 Bateau "maître" 

 

Lorsque vous faites un replay multiple, l'un des bateaux est "maître". C'est celui-ci qui définira le timing 

et ce sont les informations relatives au maître qui sont affichées dans les données numériques (vent, 

performances, ...). 

Le nom du bateau maître est affiché en tête de la fenêtre de cartographie et le bateau concerné est en 

surbrillance. Pour changer de bateau maître, vous pouvez : 

soit double cliquer sur le bateau que vous souhaitez rendre maître, 

soit lancer le menu "Traces→ Replay → Choisissez une trace maître". 

 

Ligne de gain au vent 

Afin de comparer les performances des différents bateaux au près ou au vent arrière, vous pouvez 

afficher la ligne de gain au vent qui est la perpendiculaire au vent passant par l'étrave du bateau. 

Pour cela, faites un clic-droit sur le bateau maître et choisissez  "Ligne de gain au vent". 

Pour faire disparaitre cette ligne, procédez de la même façon et décochez le menu. 

 

9.7 Export d'une trace 
Il est possible d'exporter les traces enregistrées sous un format "en clair" pour les exploiter dans un 

tableur Excel ou Open Office. 

Pour cela, lancez le menu "Traces→ Export d'une trace vers Excel" 

Le logiciel demande quelle trace exporter 
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Choisissez la trace puis cliquez sur "OK". Vous avez alors le choix des informations que vous souhaitez 

exporter. 

 

 

Exporter les données : données enregistrées au cours de la navigation 

 

Signaler données invalides : lorsqu'une donnée est invalide (absente ou en time out), un indicateur est 

ajouté derrière la donnée. 'T' pour time out, 'N' pour invalide. 

 

Afficher unités : affichage de l'unité derrière chaque donnée. Cet affichage permet une meilleure 

lisibilité du tableau mais ne permet pas de faire des calculs sur les cellules. 

 

Exporter les annotations manuelles : les annotations saisies pendant la navigation ou ajoutées lors du 

débriefing de la trace (cas des "traces validées") sont intégrées au fichier exporté. 

 

Exporter les annotations automatiques : les annotations calculées par le logiciel (virements de bord, 

empannages, passage de bouées, timing de départ) sont intégrées au fichier exporté. 

 

Exporter les changements de configuration : chaque fois que vous avez modifié la configuration du 

bateau (changement de voile, remplissage de ballast, basculement de quille, passage sous pilote, ...) un 

évènement est créé et intégré au fichier exporté. 

 

Exporter les segments : les début et fin de segments créés pendant la navigation ou ajoutés à la trace 

pendant le débriefing sont intégrés au fichier exporté. 
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La trace est chargée dans le tableur de votre PC. 

 

 

 

9.8  Intégrer des données externes dans une trace 
Il est possible d'intégrer, à posteriori, des données dans une trace. Pour cela ces données doivent être 

enregistrées dans un fichier texte de type ASCII avec séparateurs tabulation ou ';'. 

Pour intégrer un tel fichier à un ou des trace(s)s, chargez les traces dans le logiciel puis lancez le menu 

"Traces-> Intégrer un fichier de données", Sélectionnez l'une des traces proposées ou "Toutes". Choisissez 

ensuite le fichier de données à intégrer. 

Les données présentes dans le fichier seront intégrées à la trace sous fome de variables génériques. Les 

paramètres de ces données (nom, formatage, présentation, ..) sont proposés à l'écran afin que vous 

puissiez les modifier au passage. 

Format du fichier. 

La première ligne contient les noms des variables à intégrer (les nom sont séparés par des tabulation ou le 

caractère ';' 

Ex : "Tension étai; Tension écoute GV, tension écoute Génois" 

La deuxième ligne contient les unités de chaque variable. 

Ex : "T;kg;kg" 

La troisième ligne contient le nombre de décimales à afficher pour chaque variable 

Ex : "1;0;0" 

La quatrième ligne contient le coefficient à appliquer à chaque donnée avant affichage (1 par défaut). 
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Ex : "1;1;1" 

Les données suivent ensuite à raison d'une ligne par pas de temps. Chaque ligne comporte le temps (date 

et heure) puis un champ par variable. 

Ex : "09/03/2013 14:55:18;3.12;450;210" 

Exemple de fichier complet : 

" 

Tension étai; Tension écoute GV, tension écoute Génois 

T;kg;kg 

1;0;0 

1;1;1 

09/03/2013 14:55:18;3.12;450;210 

09/03/2013 14:55:19;3.13;452;210 

09/03/2013 14:55:20;3.13;452;211 

09/03/2013 14:55:22;3.12;453;213 

09/03/2013 14:55:23;3.15;454;212 

09/03/2013 14:55:24;3.16;453;212 

09/03/2013 14:55:25;3.16;452;211 

..". 

 

Répétition de la date 

On peut s'abstenir de répéter la date sur chaque ligne. Pour cela, indiquer la date sur une ligne à part 

immédiatement avant les données. Ex : 

" 

Tension étai; Tension écoute GV, tension écoute Génois 

T;kg;kg 

1;0;0 

1;1;1 

09/03/2013 

14:55:18;3.12;450;210 

14:55:19;3.13;452;210 

..". 
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9.8.1 Intégrer des données externes dans une trace à l’aide d’une application externe 
 

Des données externes comme les données enregistrées par le boitier d’aquisition PI de l’entreprise 

Cosworth sont intégrables directement dans Adrena.  

 

En utilisant le menu " Traces → Donnée externe " les données sont synchronisées dans la trace enregistrée 

par Adrena et exploitées sous la forme de données génériques. Il est ainsi possible de les visualiser en 

replay 

 

Exemple de fichier PI : 

 

  

 

Le nombre de donnée n’est pas limité, une variable générique portant le nom de chaque colonne sera 

créée dans Adrena. 

 

3 colonnes sont obligatoires (avec respect du nom dans le titre) : 

- "GPS Hours" 
- "GPS Minutes" 
- "GPS Seconds" 

 

9.9 Boite à outil 
Une boite à outil permet d'intervenir simultanément sur un ou plusieurs fichiers trace: 

• Recaler les dates de début et de fin 

• Nettoyer les positions GPS invalides 

• Rééchantillonner la trace 

• Corriger des enregistrements 

• Fusionner des traces 

• Travailler sur plusieurs traces à la fois 

Pour appeler la boite à outils, lancez le menu "Traces→ Dépannage fichiers traces→ Boite à outils" puis 

sélectionnez l’action à effectuer et la ou les fichiers trace à modifier et validez. 

 

Time Alarm Status Cpu Load Data Marker GPS Hours GPS Minutes GPS Num SatsGPS Quality GPS Seconds GPS UTC GPS UTC Corrected

0 0 100 0 3 49 11 1 38.6 349386 34938.6

1 0 100 0 3 49 11 1 39.4 349394 34939.4

2 0 100 0 3 49 11 1 40.6 349406 34940.6

3 0 100 0 3 49 11 1 41.4 349414 34941.4

4 0 100 0 3 49 11 1 42.6 349426 34942.6
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Recaler les dates butées 

Il arrive que les dates de début et la durée des traces affichées dans la fenêtre de sélection des traces 

soient erronées. Cela peut être dû à un problème de synchronisation avec le GPS, lorsque l'option 

'Recaler heure trace sur GPS" était validée lors de la création de la trace.  

L'option "Recaler les dates butée" permet de remettre ces dates en phase avec la trace. 

 

Nettoyer les positions GPS invalides 

Il arrive que les positions en provenance du GPS soient invalides. Cela se traduit par une trace qui  

fait un écart important à l'écran pour revenir ensuite à la position correcte. 

Ce problème est généralement dû à une erreur de transmission sur la liaison NMEA (vitesse trop 

élevée, câble trop long ou traversant des champs électriques perturbateurs),  

Une option permet de filtrer ces positions dès leur réception (Paramètres généraux - Divers). 

Les traces enregistrées avant la version 8 qui présenteraient ce problème peuvent être corrigées en 

validant l'option "Nettoyer les positions GPS invalides". 

 

Ré-échantillonner la trace 

Les données de trace sont stockées en fichier avec une période de 1 seconde par défaut (paramétrables 

: Paramètres généraux - Divers). Sur de longues navigations (traversée d'un océan, tour du monde), 

cela peut conduire à des fichiers volumineux longs à traiter (chargement à l'écran, calcul de 

statistiques, ...). Pour faciliter le traitement des fichiers (ou gagner de la place sur votre disque), vous 

pouvez ré-échantillonner les traces avec une période plus importante : 2 à 10 secondes en général. 

Lorsque vous ré-échantillonnez une trace, un nouveau fichier trace est créé du même nom que la trace 

originale suivi de la durée choisie. 

Ex : si vous ré-échantillonnez la trace 04_01_11a.trz  à 10 secondes, vous obtenez une nouvelle trace 

(moins volumineuse) nommée 04_01_11a_10sec.trz 

 

Attention : la trace originale n'est pas supprimée. Si le but est de gagner de  place sur le disque, il faut 

l'effacer à la main. 

Notes : 

le ré-échantillonnage ne se contente pas d'éliminer des données : il en effectue un moyennage. 

le ré-échantillonnage conserve intégralement les données saisies manuellement (segments, 

annotations, ...), les données relatives aux départs, parcours et waypoints activés ainsi que les données 

"homme à la mer" et "AIS". 
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Fusionner des traces 

Pour diminuer le nombre de fichier trace d’une journée ou travailler sur plusieurs fichier en même 

temps il peut être intéressant de grouper ces traces en une seule. Pour cela utiliser l’outil fusion de 

traces, sélectionnez les traces à fusionner et sauver la nouvelle trace ainsi obtenue. 

 

9.10 Multimédia dans la trace 
Il est possible d'insérer des fichiers multimédia dans les traces (ainsi que dans les roadBooks, les Sailect 

et le trimbook). 

Les fichiers multimédias gérés par Adrena sont : 

les photos et les images  

les films et les animations vidéo 

les sons 

les fichiers bureautiques 

de façon générale, tous les fichiers capables de réagir à un double clic sous Windows. 

 

9.10.1 Insérer un fichier multimédia manuellement 
Les fichiers multimédia sont intégrés aux annotations. Pour insérer un fichier multimédia, créer une 

annotation ou modifiez  en une existante (cela peut être fait en navigation ou à posteriori en 

débriefing). 

 

 

Cliquez sur "Multimédia" puis sélectionnez le fichier à insérer parmi les fichiers de votre PC. 

Adrena demandera alors si vous souhaitez recopier le fichier dans le répertoire Adrena ou utiliser le 

fichier d'origine. A moins que vous n'ayez des problèmes de place sur votre disque, Il est conseillé de le 

ramener dans le répertoire Adrena afin de ne pas le perdre dans vos sauvegardes ou lors d'un 

changement de PC. 
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Vous pouvez ensuite "jouer" le fichier (visualisation, écoute, ...) en cliquant sur le bouton "Test". 

 

9.10.2 Insérer un ensemble de fichiers multimédia automatiquement 
Pour éviter de charger chaque fichier individuellement, vous pouvez charger automatiquement tous les 

fichiers liés à une sortie d'entrainement par exemple. 

Avant de partir sur l'eau vérifiez que vos appareils d'enregistrement (appareil photo, caméra, 

dictaphone) sont bien à la même heure que le PC (attention notamment à la notion d'heure TU). 

Sur l'eau : enregistrez les données (photos, films, sons) sans vous préoccuper du logiciel (qui doit 

simplement enregistrer classiquement la trace pendant ce temps). 

Une fois à terre, connectez votre appareil (USB ou carte SD) au PC, charger la trace à l'écran puis lancez 

le menu "Traces→  multimédia" et sélectionnez les fichiers concernés. Chaque fichier sera analysé et 

inséré dans la trace en fonction de l'heure de l'enregistrement. 

 

9.10.3 Visualiser un fichier multimédia 
 

Les fichiers multimédia apparaissent sur la trace sous forme de pictogrammes : 

appareil photo pour les images 

caméra pour les vidéos 

haut-parleur pour les sons 

... 
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Pour "jouer" chacun des fichiers, faites un clic droit dessus et choisissez l'action proposée ("Voir 

l'image" ou "Regarder la vidéo, par exemple). 

 

Il est également possible de synchroniser le replay avec la lecture d’une vidéo ou d’un son afin de voir 

l’évolution du bateau sur la trace en même temps que la lecture du fichier multimédia. Utilisez le menu 

clic droit → annotation → "Regarder la vidéo synchro" 

 

 

9.11 Affichage de la distance parcourue 
Pour connaitre la distance parcourue sur la trace en cours ou sur l'une des traces chargées, lancez le 

menu "Traces→ Analyse→ Distance parcourue". La distance parcourue sur la trace en cours ("Trace 

bateau") ainsi que sur chaque trace chargée est affichée. 
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9.12 Meilleure performance sur 24h 
Le logiciel calcule en permanence la meilleure distance  parcourue sur 24h. Pour connaître cette 

performance, lancez le menu "Traces→ Analyse→ Meilleure performance sur 24h". 

 

 

 

 

Les informations présentées sont : 

 

distance parcourue, vitesse moyenne 

date et heure de début, date et heure de fin, durée de la performance (24h en général) 

position de début, position de fin 

 

Mettre en évidence sur la trace a pour effet de mettre en gras la portion de trace correspondant à la 

meilleure performance (si la trace est présente à l'écran évidemment). 

 

Changer la durée permet de modifier la durée calculée (12 h au lieu de 24h par exemple). 

 

Reset de la performance vide les calculs. Ils seront repris à partir de la date d'aujourd'hui. 

 

Calcul sur anciennes traces permet de sélectionner des traces pour faire les calculs dessus (par 

exemple la saison de l'année passée). 
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Rafraichir permet de relancer le calcul (pendant la navigation). 

 

9.13 Lecture d'un enregistrement datalogger 
 

 

 

      

 

Les datalogger commercialisés par Adrena permettent d'effectuer des enregistrements sur le GPS et / 

ou la centrale sur des bateaux ne disposant pas de PC, pour des raisons de poids, d'énergie ou de règles 

de jauge. 

Les minilogger enregistrent une ou 2 sources NMEA et possèdent un contact moteur (pour dévalider les 

enregistrements) ainsi qu'un contact "évènement" que l'on pourra retrouver sur la trace. 

Les datalogger, possèdent, de plus, des touches permettant de spécifier les voiles à poste. Ils sont 

destinés à être lus avec Adrena qui gère les configurations de voiles. 

 

Pour lire les données enregistrées sur un datalogger, retirez la carte SIM du datalogger après la 

navigation. Connectez là au PC puis lancez le menu "Traces → Importer log→ Convertir une trace 

datalogger". 
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Choisissez ensuite l'enregistrement à convertir (généralement "nmea.log") puis la période que vous 

souhaitez extraire (toute la trace, une journée particulière ou une fourchette de dates et heure).  

L'enregistrement du datalogger sera converti en trace au format Adrena et vous pourrez la traiter 

comme les autres traces enregistrées directement sur un PC  (replay en particulier). Les données AIS 

enregistrées pendant la navigation seront visibles pendant le replay de la trace. 

 

Compatibilité 

La conversion des fichiers log est possible à partir des données en provenance de : 

_ Logger DKI 

_ Box wifi NKE 

_ Deckman for windows 

 

9.14 Speed tests 

Les speed tests peuvent être créés soit sur la trace en cours (sur l'eau ou pendant un replay). Soit sur 

un histo-graphe. Ils sont accessible de trois façons: 

• par un clic droit sur la trace ou sur l'histographe 

• par les raccourcis du menu "Performance" 

• par le menu "Traces" 

9.14.1 Création des Speed tests sur la trace en cours (fil de l'eau) Par le menu Traces 
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Exemple : pour analyser un virement de bord, lancer le speed test 1 juste avant le virement, effectuez 

la manœuvre puis terminez le speed test 1. Si vous souhaitez comparer le avec un autre virement, 

effectuez à nouveau l'opération en lançant le deuxième speed test. Analysez ensuite le résultat avec le 

tableau. 

Vous pouvez accéder aux speed test par le menu "Trace→ Speed tests" : 

"Trace→ Speed tests→ Débuter Speed test1" ou  "Terminer Speed test1" 

"Trace→ Speed tests→ Débuter Speed test2" ou "Terminer Speed test2" 

"Trace→ Speed tests→ Analyser Speed tests" 

 

9.15 Statistiques sur les vents rencontres 
 

Adrena Pro permet de connaître les vents rencontrés au cours de vos navigations. Pour cela, 

commencez par charger les traces que vous souhaitez analyser (Menu "Traces→ Charger Trace(s)"). 

 

 

9.15.1 Statistiques sur les vents par angle ou par vitesse 
 

Lancez le menu "Traces→ Statistiques de vent → Comparatif " 

 

 

 

Un tableau propose les temps passés par tranche de vitesse de vent et par trace. 
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Choisissez "Vent réel" ou "Vent apparent" selon le type d'analyse souhaitée. 

 

Il est possible d'afficher les données en durée, en pourcentage ou les deux cumulés : cochez ou 

décochez les cases correspondantes. 

 

L'analyse peut se faire par vitesse ou par angle de vent. 

 

9.15.1.1 Analyse par vitesse de vent 

 

L'analyse fait par défaut sur les vitesses de vent affichées (0 à 4nds, 4 à 8, ...). Pour changer les vitesses 

de vent à analyser, cliquez sur le bouton "modifier vitesses" et choisissez les vitesses à analyser. 

 

 

9.15.1.2 Analyse par angle de vent 

 

Pour analyser les vents rencontrés par angles, cochez "Angles". 

 

L'analyse fait par défaut sur les angles de vent affichées (0 à 30°, 30 à 35, ...). Pour changer les angles de 

vent, cliquez sur le bouton "modifier angles" et choisissez les angles à analyser. 
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Différencier les amures 

Pour différencier les amures, cliquez sur Tribord + bâbord. Des colonnes seront créées pour chacune 

des amures 

 

9.15.2 Analyse par vitesse et angle de vent 
 

Lancez le menu "Traces→ Statistiques de vent → Tableau" puis choisissez l'une des traces ou "<Toutes 

traces>" pour analyser le cumul. 

 

 

 

Comme pour les analyses par angle ou vitesse, vous pouvez analyser en vent réel ou apparent, en 

durée et/ou en pourcentage, différencier les amures et spécifier les tranches de vitesses et d'angles. 

Pour analyser une portion du tableau, sélectionner les cases souhaitées, le cumul de temps s'affichera 

alors dans la zone "sélection (en durée et en pourcentage). Ci-dessous le près jusqu'à 12 nds : 2h54 et 

1%. 
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9.15.3 Analyse sur un graphe 
 

Sélectionnez le menu "Traces→ Statistiques de vent→ Graphe".  

 

 

 

Choisissez les traces à analyser. 

Un nuage de points d'une couleur différente pour chaque trace vous donnera une vision des vents 

rencontrés au cours de chaque navigation. 

Vous pouvez visualiser le graphe en vent apparent ou en vent réel, en représentation polaire ou 

cartésienne. 

Il est également possible de "répartir les amures" pour différencier l'utilisation bâbord amure de 

l'utilisation tribord amure. 

Le bouton "à la voile uniquement" permet de visualiser les vents rencontrés uniquement lorsque la 

cassette "navigation à la voile" était cochée pendant la navigation. 

 

Note : l'affichage du nuage de points peut prendre un certain temps ; pour l'interrompre, appuyez sur 

la touche ESC. 

 

9.16 Statistiques sur l'utilisation du jeu de voiles 
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Adrena Pro permet de connaître de façon précise comment on été utilisés les différentes voiles du jeu 

de voiles. Pour cela, commencez par charger les traces que vous souhaitez analyser (Menu "Traces→ 

Charger Trace(s)"). 

 

 

9.17 Statistiques  sur les voiles 
Lancez le menu "Traces→ Statistiques sur les voiles → Tableau" 

 

 

Un tableau propose l'ensemble des voiles paramétrées dans le jeu de voiles. 

Pour cacher les voiles qui n'ont pas été utilisées dans les enregistrements chargés, cochez la case 

'Cacher voiles non utilisées". 

 

Choisissez "Vent réel" ou "Vent apparent" selon le type d'analyse à faire 

 

Il est possible d'afficher les données en durée, en pourcentage ou les deux cumulés : cochez ou 

décochez les cases correspondantes. 

 

L'analyse peut se faire par vitesse de vent, par angle de vent ou par vitesse et angle. 
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9.17.1 Analyse par vitesse de vent 
 

L'analyse fait par défaut sur les vitesses de vent affichées (0 à 4nds, 4 à 8, ...). Pour changer les vitesses 

de vent à analyser, cliquez sur le bouton "modifier vitesses" et choisissez les vitesses à analyser. 

 

 

9.17.2 Analyse par angle de vent 
 

Pour analyser l'utilisation des voiles par angles de vent, cochez "Angles". 

 

L'analyse fait par défaut sur les angles de vent affichées (0 à 30°, 30 à 35, ...). Pour changer les angles de 

vent à analyser, cliquez sur le bouton "modifier angles" et choisissez les angles à analyser. 
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9.17.3 Analyse par vitesse et angle de vent 
 

Pour analyser l'utilisation d'une voile par vitesse et angle, choisissez la voile à analyser en cliquant sur la 

ligne correspondante puis cliquez sur "Vitesse et angle " 

L'analyse se fera sur les paramètres définis préalablement (vitesses et angles de vent, réel ou 

apparent). 
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9.17.4 Analyse sur un graphe 
 

Sélectionnez le menu "Traces→ Statistiques sur les voiles→ Graphe". L'analyse peut se faire sur un 

graphe polaire ou cartésien.  

 

 

 

Vous pouvez ensuite choisir la ou les voiles à analyser dans la liste de gauche. 

Un nuage de points d'une couleur différente pour chaque voile vous donnera une vision de la plage 

d'utilisation de chaque voile. 

Vous pouvez visualiser les voiles en vent apparent ou en vent réel, en représentation polaire ou 

cartésienne. 

Il est également possible de "répartir les amures" pour différencier l'utilisation bâbord amure de 

l'utilisation tribord amure. 

 

Note : l'affichage du nuage de points peut prendre un certain temps ; pour l'interrompre, appuyez sur 

la touche ESC. 
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9.18 Statistiques sur les configurations de voiles 
 

Une configuration de voiles est l'ensemble des voiles utilisées à un moment donné, par exemple : "GV1 

(1 ris) + trinquette" 

L'analyse des configurations de voile se fait exactement comme l'analyse des voiles. Lancez pour cela le 

menu "Traces→ Statistiques sur les configurations de voiles " puis "Tableaux" ou "graphes". 

 

Les configurations présentes sont automatiquement calculées lors de l'analyse. 

Les manipulations et les options possibles sont les même que lors de l'analyses des statistiques de 

voiles. 

 

9.19 Les segments 
Un segment est caractérisé par son heure de début, son heure de fin, son apparence (taille et couleur), son 

nom et son commentaire. Il est toujours attaché à une trace. 
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9.19.1 Créer un segment en manuel 
 

Directement sur la trace 

Pour créer un segment sur la trace, faites un clic-droit sur la trace à l'emplacement du début du segment 

puis choisissez "Insérer un segment". Cliquez ensuite sur la trace à la position de la fin du segment. Le 

logiciel demande les caractéristiques du segment. 

 

 

 

Saisissez le nom du segment (ou acceptez le nom proposé), saisissez éventuellement un commentaire et 

définissez la couleur et l'épaisseur du segment. 

 

En temps réel pendant la navigation 

Vous pouvez créer des segments en les démarrant et en les terminant pendant que vous naviguez (par 

exemple juste avant le début d'un virement puis juste après). 

 

Pour commencer un segment, lancez le menu "Traces→ Segments→ Commencer un segment" ou cliquez 

sur l'icône  du menu performance. Pour le terminer, lancez le 

menu "Traces→ Segments→ Terminer un segment" ou cliquez sur " terminer un segment " dans le menu 

segment du menu Performance et choisissez le segment à terminer (vous pouvez en avoir démarré 

plusieurs). 
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Complétez ensuite les caractéristiques du segment comme lors de la création. 

 

9.19.2 Visualiser un segment 
Pour visualiser un segment, approchez la souris du segment, il apparaitra en surbrillance avec son nom. En 

approchant la souris de l'une des extrémités vous verrez également le timing correspondant à l'extrémité 

pointée. 

 

9.19.3 Déplacer l'extrémité d'un segment 
Pour déplacer l'extrémité d'un segment, faites un clic-droit sur cette extrémité et choisissez "Déplacer le 

segment", puis cliquez sur la trace à la nouvelle position de l'extrémité. 

 

9.19.4 Modifier un segment 
Pour modifier un segment, faites un clic-droit sur l'une des extrémités et choisissez "Modifier le segment" 

(ou double-cliquez sur l'extrémité), puis procédez comme lors de la création (modification du nom, du 

commentaire et de l'aspect). 

 

9.19.5 Supprimer un segment 
Pour supprimer un segment, faites un clic-droit sur l'une des extrémités et choisissez "Supprimer le 

segment". 

 

9.19.6 Supprimer la portion de trace correspondant à un segment 
Pour supprimer la portion de trace correspondant à un segment, faites un clic-droit sur l'une des extrémités 

et choisissez "Supprimer la portion de trace correspondante".  

Attention : cette opération est irréversible (sauf à décharger la trace sans la sauver). 
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9.19.7 Supprimer la portion de trace située hors du segment 
Pour supprimer la portion de trace située hors du segment (et ne conserver que le segment lui même), 

faites un clic-droit sur l'une des extrémités et choisissez "Supprimer les portions de trace hors du segment".  

Attention : cette opération est irréversible (sauf à décharger la trace sans la sauver). 

 

9.19.8 Créer un segment en automatique (pendant la navigation) 
Lancez le menu "Traces→ Segments→ Création automatique de segment pendant la navigation". 

 

 

 

Par intervalle de temps 

Vous pouvez créer les segments à intervalle de temps régulier en choisissant "Sur timing" et en saisissant le 

timing désiré (en secondes, en minutes ou en heures). Dès lors, un nouveau segment sera créé chaque 

intervalle de temps spécifié. 

Vous pouvez limiter le nombre de segments créés en cochant l'option "Limiter nombre de fois" et en 

saisissant la valeur correspondante. 

 

Virements 

Permet d’isoler et de  créer un segment sur chaque virement de bord du parcours 

 

Empannages 

Permet d’isoler et de  créer un segment sur chaque empannages 

du parcours 
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Note : le bouton  ouvre la fenêtre de dialogue qui permet de régler le temps sur lequel on souhaite 

créer un segment avant et après un virement ou un empannage. 

 

 

 

Par critère 

Choisissez "Sur critères" et cliquez sur "Critères" pour les spécifier. 
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Vous pouvez ensuite combiner 10 conditions (ET ou OU), chacune portant sur une donnée calculée par le 

logiciel. Sélectionnez les données à évaluer en double cliquant sur l'une des zones "Information", choisissez 

la condition à évaluer ("inférieur", "supérieur" ou "varie de") et la valeur de référence. 

Dans l'exemple ci-dessus, un nouveau segment est créé chaque fois que le vent est supérieur à 15 nds et 

terminé chaque fois que le vent repasse en dessous de cette valeur. 

 

Favori 

Lorsque vous avez défini les conditions composant le critère, vous pouvez l'ajouter à vos favoris pour le 

retrouver ultérieurement. Cliquez sur "Ajouter aux favoris" puis saisissez son nom. 

 

Aspect 

Spécifiez ensuite l'aspect et le nom des segments (préfixe, couleur et épaisseur). Les différents segments 

créés porteront le nom indiqué par le préfixe, suivi d'un nombre s'incrémentant à chaque nouvelle création 

(par exemple Segment1, Segment2, Segment3 ...).  

 

9.19.9 Interrompre la création automatique de segments 
Pour arrêter la création automatique de segments, lancez le menu "Traces→ Segments→ Terminer création 

automatique de segments pendant la navigation", puis choisissez le groupe de segments à interrompre (qui 

sont énumérés par leur préfixe). 
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9.19.10 Création automatique de segments sur une trace complète (débriefing) 
 

Après avoir chargé une ou plusieurs traces (replay ou non) lancez le menu "Traces→ Segments→ Création 

automatique de segments sur une trace". Procédez ensuite comme pour la création automatique de 

segments pendant la navigation (chapitre précédant). 

Pour affiner la création de segments et éviter la création de nombreux segments trop courts.  Vous pouvez 

définir la durée sur laquelle les conditions doivent être réunies pour valider la création des segments. Pour 

cela entrez une valeur dans le champ " Durée min " du tableau des critères. 

 

 

 

  

Note : lorsque vous faites un calcul automatique de segments, ce calcul porte sur toutes les traces chargées 

(en replay ou sans replay). 

 

9.19.11 Création de segments à l’aide d’une application externe 
 

Il est possible de créer des segments sur la trace en temps réel à l’aide d’une application externe 

communicant par UDP. (Voir chapitre 50 Spécification du jeu de voiles ou de segments avec une application 

extérieure) 

 

9.19.12 Analyser et comparer les segments 
 

Après avoir créé des segments ou après avoir chargé une (des) trace(s) comportant des segments, vous 

pouvez en analyser le contenu ou les comparer entre eux. 

Pour envoyer un segment dans un des speed-test, faites un clic-droit sur l'une des extrémités du segment 

et choisissez "Envoyer dans Speed-Test" choisissez ensuite dans lequel des 2 Speed-tests vous souhaitez 

l'envoyer. 

Il est également possible d'envoyer les segments dans les Speed-Tests par l'intermédiaire du tableau des 

segments 

L'analyse des Speed-tests est décrite dans le chapitre Speed tests. 
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9.19.13 Tableau des segments 
Le tableau des segments permet gérer et de comparer les différents segments d'une trace (ou de toutes les 

traces chargées) dans un même tableau. Cliquez sur l'icône  du menu performance ou lancez le 

menu "Traces→ Segments→ Tableau des segments" 

 

 

La partie haute du tableau concerne les segments terminés. La partie basse concerne les segments en cours 

de création. Cette deuxième partie évolue en temps réel et est rafraichie une fois par seconde. 

 

L'information présente dans chaque colonne (à partir de la 6ème) la moyenne de la valeur considérée sur 

l'ensemble du segment. 

 

Tri sur une colonne 

Vous pouvez trier les segments selon chaque critère présent dans les colonnes en cliquant sur l'en-tête de 

la colonne concernée. 

 

Modifier l'information affichée dans une colonne 

Sélectionnez l'en-tête de la colonne et cliquez sur "Modifier colonne" ou double-cliquez sur l'en-tête. 

Choisissez ensuite le type d'information à afficher. 
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Ajouter une colonne 

Cliquez sur "Ajouter colonne". Une nouvelle colonne sera ajoutée au tableau.  Choisissez ensuite le type 

d'information à afficher.  

 

Insérer une colonne 

Sélectionnez la colonne à coté de laquelle vous souhaitez en insérer une. Cliquez sur "Insérer colonne". Une 

nouvelle colonne sera insérée à gauche de la colonne sélectionnée.  Choisissez ensuite le type 

d'information à afficher.  

 

Supprimer une (ou des) colonne(s) 

Sélectionnez la (ou les) colonne(s) à supprimer et cliquez sur "Supprimer colonne(s)".  

 

Modifier un segment 

Double-cliquez sur le segment à modifier ou sélectionnez le puis choisissez "Modifier segment". 

Procédez ensuite comme lors de la création. 

 

Supprimer un segment 

Sélectionnez le (ou les) segment(s) à supprimer puis choisissez "Supprimer segment(s)". 

 

Analyse fine et comparaison de segments 

Sélectionnez un ou deux segments puis cliquez sur "Analyse". 

L'analyse détaillée est décrite dans le chapitre Speed tests. 

 

Envoyer des segments dans une Collect 

Sélectionnez les segments à envoyer dans la Collect, cliquez sur "Envoyer dans Collect" puis choisissez la 

Collect (ou choisissez <nouvelle> pour en créer une). 

Voir le chapitre LES COLLECT. 

 

Recentrer l'écran sur des segments 

Sélectionnez les segments autour desquels vous souhaitez recentrer l'écran puis choisissez "Recentrer 

l'écran". 
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9.19.14 Mesurer la perte aux virements et empannages 
Afin de mesurer la perte en distance sur un virement ou un empannage, on peut analyser une ou des 

trace(s) préalablement découpée(s) en segments spécifiques. Pour cela on utilise la création automatique 

de segment avec laquelle on choisit d’isoler les portions de la trace comprenant un virement ou un 

empannage. 

 

 

 

 

L’analyse s’observe alors en ouvrant le tableau des segments (Trace > Segment > Tableau des segments) 

dans lequel on trouve une colonne concernant la perte en distance dûe à la manœuvre. 

 

 

 

Sur un segment comportant un virement ou un empannage, la perte est calculée dans l’axe du vent.  
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Dans les autres cas, la perte est calculée par rapport à l’axe de la route initiale 

 

9.20 Les collect 

Les Collect sont un moyen simple pour classifier vos navigations et/ou des portions de vos navigations 

afin d'en faciliter l'archivage et l'analyse ultérieure. Elles sont alimentées à partir de traces ou de 

portions de traces (segments). 

 La trace initiale n'est pas altérée et une trace ou une portion de trace peut alimenter plusieurs Collect 

si vous le souhaitez. 

Lorsque vous alimentez une Collect à partir d'une trace ou d'une portion de trace, tous les éléments de 

la trace sont intégrés (données enregistrées sur la centrale ou calculées par le logiciel, annotations  et 

segments). 

Exemples de Collect : 

les parcours banane de la dernière saison, 

les navigations effectuées par moins de 15 nœuds de vent, 

les phases de navigation effectuées par plus de 15 nœuds de vent et lorsque le pourcentage de vitesse 

cible était d'au moins 90%, 

tous les virements de bord effectués au cours d'un entrainement 

etc. etc. 

9.21 Alimenter les Collect 
 

9.21.1 Alimenter une Collect depuis une trace complète 
 

Lancez le menu "traces→ Collect→ Envoyer trace(s) dans une Collect" et choisissez la Collect concernée 

(ou choisissez <nouvelle> pour en créer une). 

Choisissez ensuite la ou les traces concernées. Il peut s'agir d'une trace brute (enregistrée pendant la 

navigation), d'une trace validée (après travail en débriefing), d'une Collect complète ou d'une portion 

de Collect. 

 

9.21.2 Alimenter une Collect depuis un segment 
 

Faites un clic-droit sur l'une des extrémités du segment et choisissez "Envoyer dans Collect". Choisissez 

ensuite la Collect concernée (ou choisissez <nouvelle> pour en créer une). 
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9.21.3 Alimenter une Collect depuis un ensemble de segments 
 

Après avoir chargé la ou les traces concernées, Ouvrez le tableau des segments (menu "Traces→ 

Segments→ Tableau des segments"). Triez les segments et sélectionnez ceux que vous souhaitez 

envoyer dans la Collect. Choisissez ensuite la Collect concernée (ou choisissez <nouvelle> pour en créer 

une). 

 

9.22 Editer une Collect (visualiser et/ou supprimer des portions) 
Lancez le menu "Traces→ Collect→ Editer / modifier une Collect". Choisissez ensuite la Collect 

concernée. 

 

 

L'ensemble des traces ou portions de trace composant la Collect est affiché. Vous pouvez en supprimer 

en sélectionnant les lignes concernées et en cliquant sur "Supprimer". 

 

9.23 Supprimer une Collect 
Lancez le menu ""Traces→ Collect→ Supprimer une Collect". Choisissez ensuite la Collect à supprimer 
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10 MENU PARAMETRAGE 
 

10.1 Affichage 
 

Ports : affiche une base de données mondiale de port sur la cartographie 

Afficheurs : affiche les données envoyées vers la centrale sur une simulation d’afficheur 

Position du curseur : affiche dans un cadre jaune en bas à droite de la cartographie les données suivantes : 

• Coordonnées géographiques du curseur 

• Distance et relèvement entre le bateau et le curseur 

• Temps pour rejoindre le curseur selon le SOG 

• Erreur de cap pour se rendre au curseur 

Centrage sur plan d’eau : permet d’accéder à différents niveau de zoom et de centrage de la cartographie 

Forcer orientation au nord : maintien le nord géographique vers le haut de l’écran 

Suivi de parcours : affiche / cache le tableau de suivi de parcours (automatique lorsqu’un parcours est 

activé) : 

 

 

10.2 Cartes 
 

10.2.1 Outil C-Map 
Demander/saisir une clé C-Map : permet de lancer le logiciel d’enregistrement des cartes C-Map (NTPC 

Selector) pour installer une carte. Voir notice détaillée d’installation des cartes C-Map fournie à la livraison 

de celles-ci. 

Valider des cartes C-Map :  permet de dévalider l’affichage d’une carte C-Map, notamment sur les zones de 

chevauchement 

10.2.2 Outils Raster 
10.2.2.1 Chargement auto 

Force le chargement des cartes raster en fonction du niveau de zoom de la cartographie 
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10.2.2.2 Charger des cartes 

Permet de choisir les cartes à afficher en lançant le menu "Cartes→ Outils raster→ Charger carte(s)". 

 

 

 

Sélectionnez les cartes à afficher puis cliquez sur "Valider". 

Si vous cochez "Décharger cartes actives" (défaut), les cartes préalablement présentes à l'écran seront 

déchargées. 

Par défaut, les cartes sont automatiquement affichées avec la meilleure carte disponible sur l'écran  et avec 

un niveau de précision adapté au niveau de zoom en cours. Les détails apparaissent au fur et à mesure que 

vous zoomez sur une zone. 

Si vous souhaitez charger ou décharger une carte, effectuez un clic-droit sur la zone et cliquez sur 

"Charger/décharger carte". Les différentes cartes disponibles sur la zone sont affichées par ordre de 

résolution. Les cartes cochées sont celles qui sont déjà présentes à l'écran. Vous pouvez cocher une carte 

pour en forcer l'affichage ou en décocher une pour ne plus la faire apparaître à l'écran. 
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Note : lorsque vous forcez l'affichage ou le désaffichage d'une carte, le mode de chargement automatique 

est dévalidé. 

10.2.2.3 Décharger toutes les cartes 

Décharge toutes les cartes raster actuellement chargées dans la mémoire du logiciel qu’elles soient actives 

ou non. Cela ne désinstalle pas les cartes 

10.2.2.4 Intégrer de nouvelles cartes 

Les cartes raster doivent être installées avant leur intégration au logiciel. Cette intégration peut consister 

en une simple copie sur disque (cartes BSB non protégées en provenance du NOOA, par exemple) ou 

nécessiter la validation d'une clef d'enregistrement (SNMap). Conformez-vous à la notice d'installation du 

fournisseur de la carte. 

L'intégration des cartes permet au logiciel de connaître la liste des cartes présentes, leurs caractéristiques 

et leur localisation. 

Lancez le menu "Cartes→ Outils raster→ Intégrer nouvelles cartes" 

 

 

Cliquez sur "Ajouter cartes à la liste" et sélectionnez la ou les cartes que vous voulez intégrer à Adrena.  

 

Si les cartes se trouvent sur un CD, choisissez "Les copier dans le répertoire par défaut" afin de les 

recopier sur le disque dur de votre PC. Si les cartes sont déjà sur le disque dur, vous pouvez choisir "Les 

laisser à leur emplacement actuel" pour économiser de la place sur le disque. 

Cliquez ensuite sur "Intégrer les cartes de la liste" ; le logiciel vous indique le nombre de cartes qu'il a 

intégrées. Cliquez sur "Fermer" ; les cartes sont maintenant disponibles dans Adrena. 
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10.2.2.5 Désinstallation de cartes raster 

Lorsque des cartes Raster ne sont plus utilisées par exemple en cas d'un changement de fournisseur  

(maptech → Snmap), il est conseillé de supprimer les anciennes cartes. Pour cela utiliser le menu 

"Cartes → Outil Raster → Désinstaller des cartes". 

Vous pourrez alors sélectionner les cartes à supprimer en vous basant sur leur nom ou leur origine 

indiqué dans le tableau. 

 

 

 

10.2.2.6 Gérer le cache 

Le cache permet d’accélérer le chargement des cartes à l’écran : 
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La sélection des cartes à mettre en cache s’effectue de trois façons : 

 

En cochant la ou les case(s) des cartes concernées 

En cliquant sur le bouton "Tout sélectionner" pour mettre en cache toutes les cartes de la liste 

En cliquant sur le bouton "Sur la carte" pour ajouter des cartes en les sélectionnant avec la souris sur 

l’écran (rectangle de sélection) 

 

La création du cache s’effectue en cliquant sur le bouton "Mettre les fichiers cache à jour" 

 

La ligne "dispo sur disque" permet de visualiser la quantité de mémoire disponible sur le disque dur de 

l’ordinateur. Il est possible d’interrompre la mise en cache des cartes si l’espace disque n’est pas suffisant. 

10.2.2.7 Licence SNmap 

Les cartes rasters SNmap compatibles avec Adrena doivent être enregistrées avec l'interface se trouvant 

dans le menu "Cartes > Outil Raster > License SNmap" 

Assurez-vous de connecter l'ordinateur à internet avant de démarrer la procédure et suivez les étapes 

suivantes: 

_ Vérifiez et complétez les coordonnées dans les champs du  formulaire et entrez le code produit fourni par 

Adrena au moment de l'achat de vos cartes. Ce code se trouve dans  le livret d'installation des cartes. 

 

 

 

_ cliquez sur "Effectuer l'enregistrement en ligne", un message confirme l'enregistrement de la licence: 
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_ les packages de cartes correspondant à votre achat sont proposés en téléchargement. Vous pouvez les 

télécharger tous ou une partie ou les télécharger ulterieurement en cliquant sur le bouton "Télécharger les 

cartes". 

 

 

 

A la suite du téléchargement, les cartes sont enregistrées dans le dossier "Cartes" du répertiore Adrena et 

immédiatement disponibles. 
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10.2.3 Superposition d’une image sur la carte non géo-référencée (calque) 
 

Il est possible de faire apparaitre une image en transparence sur la carte afin d’afficher des 

informations supplémentaires (cartes isobarique, vue satellite etc…).  

Cliquer d’abord sur le menu Carte → Calques → Insérer un calque, puis dimensionner l’étendu de 

l’image sur la carte avec la zone de sélection : 

 

 

 

Choisir ensuite le fichier image à insérer : 

 

 



326 
 

Régler les options d’affichage parmi celles proposées : 

 

 

 

Ajuster l’apparence du calque en modifiant son étendue avec un clic-droit sur les extrémités (points 

bleus) ou en déplaçant le calque avec un clic-droit sur le point rouge centrale : 

 

 

 

Décocher le menu Carte → Calque → Modification pour sortir du mode modification 

 

Cocher ou décocher le menu Carte → Calque → Afficher pour faire apparaitre ou disparaitre le calque 
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10.2.4 Export vers Google Earth 
 

Certains éléments affichés dans Adrena peuvent être exportés vers le logiciel Google Earth pour être 

visualisés dans un espace 3D.  

Après avoir installé Google Earth, lancer le menu Carte → exporter vers Google Earth pour afficher 

automatiquement l’ensemble des éléments exportés sur la planisphère 3D.  

La liste des données Adrena pouvant être affichées ou masquées apparait dans la partie gauche de l’écran : 

 les roadbooks 

 les concurrents 

 les parcours  

 les waypoints 

les routages 
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10.3 AIS 
Le module AIS d'Adrena, associé à un récepteur AIS permet de visualiser à l'écran la position et  

la route des navires émetteurs. Il permet également de connaître la distance à laquelle ils croiseront la 

route du bateau et d'être alerté si cette distance est trop faible. 

Vous pouvez consulter la liste des navires AIS de la zone par le menu "AIS→ Liste des navires 

émetteurs" 

 

 

Le logiciel indique, pour chaque navire à portée de réception radio : 

le nom du navire 

son type (tanker, cargo, paquebot, ...) 

son no MMSI (no unique international) 
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son statut (en route au moteur, à l'ancre, au port, ...) 

Le nombre de personnes à bord (lorsque le navire transmet l'information) 

la longueur du navire 

la largeur du navire 

La route fond 

la distance actuelle du navire 

évitement" : distance à laquelle le navire croisera lorsqu'il passera au plus proche. 

le coté ou croisera le navire : "devant" ou "derrière" vous. 

le temps depuis lequel a été reçue la dernière info en provenance du navire. 

 

Note 1 : certaines informations ne sont pas obligatoires dans la norme et peuvent manquer pour certains 

navires. 

Note 2 : certaines informations sont envoyées fréquemment (position et distance), d'autres moins souvent 

(caractéristiques du navire). Il peut parfois manquer les informations sur le nom et les caractéristiques du 

navire pendant quelques temps. 

 

10.4 Bateaux 
Créer un nouveau bateau: 

Utilisez le menu " Bateau → Créer un bateau" et renseignez le nom du nouveau bateau.  

 

 

 

Remplissez les champs des caractéristiques du nouveau bateau comme dans le chapitre précédent. 

En utilisant le menu "Performance → activation de polaire" vous pouvez lui attribuer des polaires. 

Renommer  un bateau 

Pour changer le nom d'un bateau, utilisez le menu " Bateau → renommer un bateau" et choisissez le 

bateau à renommer 

Changer de bateau 
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Le menu "Bateau → Changer de bateau" permet de sélectionner dans la liste des bateaux créés celui 

que l'on souhaite activer. Ses caractéristiques seront prises en compte ainsi que les dernières polaires 

activées pour celui-ci. 

Supprimer un bateau 

Utilisez le menu " Bateau → supprimer un bateau" 

 

10.5 Concurrents 
Le suivi des courses permet de positionner à l'écran les concurrents, de suivre leur route et de faire des 

routages les concernant. 

Il permet également calculer les résultats en temps compensé pour les courses à handicap. 

 

10.5.1 Création manuelle d'une course 
Une course peut être créée manuellement par le menu "Concurrents→ Créer une course". 

 

 

10.5.1.1 Informations communes à toutes les courses 

Saisissez le nom de la course. 

10.5.1.2 Informations propres au suivi des concurrents 

Indiquez le décalage en heure TU des informations que vous enverra l'organisation de la course ainsi que 

l'en-tête caractérisant les fichiers de position que vous recevrez (souvent "POSREPORT"). 

Spécifiez "Monotype" pour le type de classement. 

10.5.1.3 Informations propres au calcul des temps compensés 

Indiquez le type de classement  



331 
 

Monotype : pas de classement en temps compensé,  

Irc : classements avec un coefficient de proportionnalité sur le temps global,  

HN : classement selon les règles du Handicap National de la Fédération Française de Voile 

 

10.5.1.4 Saisie des concurrents 

Pour créer un concurrent, cliquez sur "ajouter un concurrent" et saisissez les informations dans la fenêtre 

dédiée. 

Pour modifier les informations relatives à un concurrent effectuez directement un double clic sur une ligne 

dans le tableau.  

Pour supprimer un concurrent, sélectionnez la ligne correspondante  puis cliquez sur "Supprimer 

concurrent(s)". 

Les informations concernent : 

- le nom du bateau 

- le nom du skipper ou le no de voile selon votre choix 

- la classe du bateau (si la course comporte plusieurs séries) 

- le type de coque (monocoque, cata ou trimaran) 

- la longueur du bateau 

- la largeur du bateau 

- la couleur du bateau à l'écran 

- Le coefficient de rating pour les courses IRC 

- Le groupe pour les courses de type HN. 

- la polaire associée au bateau si vous l'avez et son coefficient 

- le numéro affecté au bateau par l'organisation de la course pour la transmission des positions. Ce 

numéro est obligatoire et doit être unique même pour effectuer des classements sans suivi de la 

flotte.  

- le numéro MMSI pour lier un concurrent à une cible AIS 

- l'option "afficher" selon que vous souhaitiez le faire apparaître ou pas à l'écran. 

- l’option "tracking" pour activer la fenêtre de suivi du concurrent (voir le chapitre Tracking) 

- la photo à associer au concurrent 

 

Le type de coque, la longueur, la largeur et la couleur servent à la représentation du bateau à l'écran afin 

de mieux les distinguer entre eux. 

La polaire sert à router les concurrents (module routage). Comme il est rare que vous disposiez des polaires 

de vos concurrents, vous indiquerez souvent la même que celle de votre bateau que vous pourrez affecter 

d’un pourcentage pour la rendre plus réaliste. Ce fichier de polaire doit impérativement se situer dans le 

répertoire  ..\Adrena\polaires. 
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10.5.1.5 Modification un concurrent 

 

Chaque concurrent d’une course dispose de ses paramètres spécifiques éditables dans une fenêtre dédiée. 

Pour y accéder plusieurs options sont possibles : 

- Avec un clic droit sur le bateau du concurrent puis menu Concurrents → modifier le concurrent 

- Avec un clic droit sur la fenêtre de tracking si le concurrent est tracké puis menu modifier le 

concurrent 

- Avec un double clic sur la ligne correspondant dans le tableau de modification de la course 

 

10.5.2 Modifier une course 
Pour modifier une course, lancez le menu "Concurrents→ Modifier une course" puis choisissez la course à 

modifier. 

Vous pouvez également éditer directement la course active en lançant le menu "Concurrents→ Modifier la 

course active" 

La modification d'une course se fait comme indiqué pour la création. 

 

10.5.3 Activer ou changer de course active 
Pour activer ou changer de course active lancez le menu "Concurrents→ Activer une course" puis choisissez 

la course à activer. 
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10.5.4 Désactiver la course active 
Pour désactiver la course active lancez le menu "Concurrents→ Désactiver la course active". 

 

10.5.5 Supprimer une course 
Pour supprimer une course, lancez le menu "Concurrents→ Supprimer une course" puis choisissez la course 

à supprimer. 

Attention : cette opération est irréversible. 

 

10.5.6 Importer une course 
Vous pouvez créer automatiquement une course et ses concurrents à partir d'un fichier descriptif de course 

fournie par l'organisateur de la course, par Adrena ou créée sur un autre PC. 

Lancez le menu "Concurrents→ Importer une course et ses concurrents" et choisissez le fichier fourni. Le 

logiciel présente ensuite la liste des concurrents pour la compléter si besoin (couleur des bateaux, polaires 

associées et choix des bateaux à afficher). 

 

10.5.7  Exporter une course 
Après avoir créé une course, vous pouvez l'exporter sous forme de fichier pour la charger sur un autre PC. 

Pour cela, lancez le menu "Concurrents→ Exporter une course et ses concurrents". Si des positions ont été 

reçues pour cette course, Adrena proposera de les exporter ainsi que les paramètres du serveur FTP lié à la 

course 

 

Une fois le fichier créé, réimportez le sur le second PC avec la fonction d'import de course (voir "Importer 

une course") 
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10.5.8 Réception de la position des concurrents 
10.5.8.1 Fichiers de position "POSREPORT" 

La position des concurrents est émise par l'organisation de la course sous forme de fichiers texte et 

généralement transmise par mail ou disponible sur site FTP. Elle comporte : 

- le numéro du bateau concerné 

- la position du bateau 

- l'heure de la position, 

- sur certaines courses : la vitesse et la direction du vent. 

 

10.5.8.2 Manuellement 

Si le fichier de positions a été préalablement reçu par mail ou transféré manuellement depuis le site FTP de 

la course, vous pouvez le charger par le menu "Concurrents→ intégrer un fichier de positions".  

10.5.8.3 Automatiquement par mail 

Pour lire automatiquement les fichiers de positions au fur et à mesure de leur réception par mail, utilisez 

une messagerie qui les stocke "en clair" comme Easy Mail par exemple. Lancez ensuite le menu 

"Paramètres→ Paramètre généraux", onglet "Concurrents". 

 

 

 

Cochez la case "Surveiller répertoire de réception des infos" et indiquez le répertoire dans lequel sont 

stockés les mails entrants. 

 

Ce répertoire sera exploré toutes les 10 secondes par Adrena pour y détecter les messages entrants. 
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Note : si vous fermez Adrena, le répertoire sera exploré au redémarrage du logiciel et les messages arrivés 

pendant la fermeture du logiciel seront traités. 

 

10.5.8.4 Automatiquement par FTP 

Pour lire automatiquement les fichiers de positions sur le site FTP de la course, lancez le menu 

"Paramètres→ Paramètre généraux", onglet "Concurrents". 

 

 

 

Activez l'accès (case "Actif") et indiquez les paramètres d'accès qui vous ont été communiqués par 

l'organisation : adresse du site, fichiers à lire, login et mot de passe. 

Le nom de fichier peut comporter des caractères génériques. "Archives/*.txt", par exemple, va lire et traiter 

tous les fichiers se terminant pat ".txt" dans le répertoire "Archives". 

Attention :  

Respectez scrupuleusement les minuscules / majuscules dans tous les champs. 

Sur FTP, le séparateur de répertoires est le caractère '/' et non le caractère '\' comme sous Windows 

("Imoca/*.txt" et non "Imoca\*.txt"). 
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Test 

Après avoir saisi ces éléments, vous pouvez tester la connexion avec le site en cliquant sur "Test". 

La connexion est testée (Site, login, mot de passe). Si elle ne peut être établie, les messages d'erreur sont 

affichés ; si elle est établie, les fichiers concernés sont recherchés et leur liste est affichée. 

 

Lecture automatique 

Pour qu'Adrena lise automatiquement le site FTP, cochez "Lecture auto." et spécifiez la période de 

scrutation. Si vous spécifiez "30 mn" par exemple, Adrena se connectera au site FTP tous les 30 minutes, y 

cherchera la présence de nouveaux fichiers ou de fichiers ayant été mis à jour et rapatriera les fichiers 

correspondants. 

La lecture automatique suppose que la connexion Internet soit ouverte lors des scrutations. C'est le cas si 

vous êtes à terre avec une connexion ADSL par exemple ; ce n'est sans doute pas le cas si vous êtes en mer 

avec une connexion de type Irridium. 

 

Lecture manuelle 

En lecture manuelle ("Lecture auto." non coché), vous lancerez manuellement la connexion avec le menu 

"Concurrents→ Lire positions sur site FTP". Si la connexion Internet n'est pas permanente (Irridium, ou 

autre), ouvrez la connexion avant de lancer la procédure et fermez la ensuite. 

10.5.8.5 Par réception AIS 

Les positions reçues d’une cible AIS peuvent venir alimenter la trace d’un concurrent dans une course 

active. L’association d’une cible AIS à un concurrent peut être activée : 

_ par un clic droit sur la cible AIS  (Voir lier une cible AIS à un concurrent) 

_ en entrant le numéro MMSI de la cible AIS dans la fenêtre du concurrent (voir saisie des concurrents) 

_ Par le tableau des navires AIS (menu AIS → liste des navires émetteurs). Après avoir sélectionné la cible, 

cliquer sur le bouton ajouter au concurrent. 
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Si un bateau de la course active porte le même nom que la cible AIS, l’association vous sera proposée 

automatiquement. 

Dans le cas contraire, sélectionner un bateau dans la liste ou cliquer sur nouveau pour créer un nouveau 

concurrent le cas échéant. 

 

 

10.5.9 Affichage des concurrents à l'écran 
Vous accédez aux paramètres d'affichage des concurrents par le menu "Paramètres → Paramètres 

généraux", onglet "Concurrents").  

Cochez la case "Afficher les concurrents" pour qu'ils apparaissent automatiquement à l'écran au fur et à 

mesure de l'arrivée des messages. Leur trace s'affiche sur la durée que vous aurez spécifiée dans le même 

menu.  
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Vous pouvez également mettre en évidence les dernières heures de course de chaque concurrent. Pour 

cela, indiquez la durée à mettre en évidence dans la zone "Mettre la trace en évidence sur". La trace de 

chaque concurrent sera plus épaisse sur la durée spécifiée. 

Il est possible de cacher ou d'afficher rapidement l'ensemble des concurrents dans la fenêtre de réglage de 

la cartographie (voir le chapitre Choisir les éléments apparaissant sur la carte) 

Les différents paramètres d'affichage des concurrents sont également accessibles par un clic droit sur l'un 

des concurrents : 

- affichage du concurrent concerné 

- affichage de la trace des concurrents et leur durée 

- durée de la trace mise en évidence 

- modification du concurrent 

- affichage de la photo du concurrent 

 

Vous pouvez visualiser les dernières informations relatives à un concurrent en approchant la souris de 

celui-ci. Chaque position reçue est matérialisée par un point de couleur sur la trace du concurrent. Vous 

pouvez visualiser les informations relatives à cette vacation en approchant la souris du point 

correspondant. 

 

 

 

10.5.10 Positions des concurrents 
Vous pouvez afficher les positions des concurrents en lançant le menu "Concurrents→ Positions et 

classement" 
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Le tableau indique les informations les plus récentes reçues pour chaque concurrent, notamment sa 

position, l'heure de la dernière vacation reçue et les informations de vent si ces informations sont 

transmises par l'organisation de la course. 

Les bateaux comportant des colonnes en rouge sont les bateaux pour lesquels les dernières informations 

n'ont pas été reçues. Leur position n'est donc pas à jour par rapport aux autres. 

Prochaine marque 

Si vous spécifiez le nom du waypoint suivant de la course, le logiciel fera un classement et calculera le CMG 

du bateau par rapport à cette marque. 

Type à afficher 

Dans les courses comportant plusieurs types de bateaux, vous pouvez choisir ici la catégorie des bateaux à 

afficher. 

Y compris bateaux "non affichés" 

Si vous spécifiez " Y compris bateaux "non affichés"", tous les bateaux de la course seront affichés. Sinon, 

seuls apparaitront ceux pour lesquels vous avez coché "Affiché" dans le tableau de la liste des concurrents. 

Estime sur les infos anciennes 

Si vous cochez cette case, le logiciel va faire un calcul d'estime pour les bateaux dont les dernières 

informations ne sont pas arrivées. De cette manière le classement effectué sera plus réaliste. 

Centrer l'écran sur les bateaux sélectionnés 

Pour recentrer l'écran sur certains bateaux, sélectionnez les en cliquant sur chaque ligne concernée (1ère 

colonne) puis cliquez sur "Centrer l'écran sur les bateaux sélectionnés". 
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10.5.11 Suivi d’un concurrent (Tracking) 
Tous les concurrent d’une course active affichés sur Adrena peuvent être suivis afin d’afficher en 

permanence leur cap et vitesse ainsi que la distance et le relèvement par rapport à son propre bateau. 

Ce tracking se déclenche avec un clic droit sur un concurrent puis par le menu " Concurrent → activer le 

tracking" 

 

 

Le bateau suivi est alors marqué d’une cible. Une fenêtre s’ouvre en bas à gauche de l’écran pour afficher 

les informations du tracking : 

- Le nom et la couleur de la fenêtre paramétrés pour ce concurrent.  

- La vitesse fond moyenne entre les deux dernières positions reçues 

- Le cap fond moyen entre les deux dernières positions reçues 

- La distance entre le bateau tracké et son propre bateau 

- Le relèvement du bateau tracké depuis son propre bateau 

En plus des fichiers habituels de positions, la position d’un concurrent peut-être défini par une cible AIS 

quand celle-ci est à portée. (Voir Lier une cible AIS à un concurrent) 

 

La position d’un concurrent tracké est extrapolée. Sa trace s’affiche alors en pointillé. La moyenne de sa 

vitesse et de son cap entre les deux dernières positions reçues (AIS ou fichiers de position) est utilisée pour 

l’extrapolation. 

10.5.12 Rejouer la trace des concurrents 
Vous pouvez rejouer la trace des concurrents en pas à pas. Pour cela, lancez le menu "Concurrents→ 

Rejouer la trace des concurrents" et sélectionnez le bateau maître (celui sur les vacations duquel le logiciel 

se calera). 
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Le logiciel se positionne sur les premières positions reçues (début de la course). Vous pouvez ensuite 

"jouer" la course avec le ruban de replay. 

 

 

La plupart des fonctions de replay sont disponibles (avant / arrière / pause / vitesse de replay, etc.) 

 

Les boutons  et  permettent  respectivement de reculer à la position précédente 

suivante et  d'avancer à la position suivante. 

 

10.5.13 Router les concurrents 
Fonctions disponible si vous possédez le module routage. 

 

10.5.13.1 Router un seul concurrent 

Faites un clic droit sur le concurrent à router et choisissez le menu "Router le concurrent" 
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Les informations concernant le départ ne sont pas modifiables : elles sont automatiquement ajustées sur 

les dernières positions reçues. 

Spécifiez la destination ainsi que les autres paramètres, tels que décrits dans le chapitre "Préparer un 

routage" puis cliquez sur "calculer"  

Pour l'analyse du routage consultez le chapitre "LES ROUTAGES"  

 

10.5.13.2 Router plusieurs concurrents 

Le routage des concurrents permet de router chacun d'entre eux d'après la dernière position. 

Lancez le menu "Concurrents→ Router les concurrents".  

Le logiciel demande quels sont les concurrents à router. 
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Vous pouvez filtrer le type à afficher et / ou afficher tous les bateaux même ceux n'apparaissant pas sur la 

carte. 

Sélectionnez ensuite les concurrents à router et cliquez sur "Valider" 
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Ne modifiez pas les informations concernant le départ : elles sont automatiquement ajustées sur les 

dernières positions reçues. 

Spécifiez la destination ainsi que les autres paramètres, tels que décrits dans le chapitre "LES ROUTAGES" 

Le routage de chaque concurrent sélectionné est calculé et affiché à l'écran. Chacun des routages calculés 

porte le nom du concurrent concerné et a la même couleur. 

 

Pour l'analyse et la comparaison des routages consultez le chapitre "routage" 

 

10.5.14 Effectuer un classement 
Lancez le menu "Concurrents→ Classement temps compensé course active" ou "Concurrents→ Classement 

temps compensé" et choisissez la course concernée. 

 



345 
 

 

Définition de la manche 

Une course peut comporter plusieurs manches. Spécifiez le n° de la manche avant de commencer la saisie. 

 

Date et heure de départ 

Après avoir indiqué le n° de la manche, indiquez la date et l'heure du départ. 

Vous pouvez cocher "plusieurs jours" si la manche se déroule sur plus d'une journée. Cela vous permettra 

de saisir la date en plus de l'heure pour les heures de passage et d'arrivée. 

 

Définition du parcours 

Si vous ne souhaitez saisir que les temps d'arrivée, il est inutile de spécifier un parcours. Si vous souhaitez 

saisir des temps intermédiaires pour effectuer un calcul en cours de régate, vous devez indiquer le 

parcours. Pour cela vous pouvez soit indiquer le parcours effectué (s'il a été entré dans le logiciel – voir LES 

PARCOURS), soit indiquer simplement le nombre de marques. Dans ce dernier cas les marques prendront 

les noms "marque 1", marque 2", etc. 

 

Saisie des temps de passage 

Le tableau propose, pour la course et la manche sélectionnée, une colonne par marque de parcours plus 

une colonne pour l'arrivée (car elle peut être distincte de la dernière marque). Vous pouvez saisir les temps 

de passage correspondants en double cliquant sur chacune des zones concernées. 

 

 

Si la course se déroule sur une seule journée (case "Plusieurs jours" décochée), seule l'heure est à saisir ; 

sinon, vous pouvez saisir la date et l'heure. 

Si vous effectuez la saisie au moment où le concurrent (ou vous-même) passez la bouée, cliquez 

simplement sur "Maintenant". 
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Classements 

Après avoir saisi les temps de passage, vous pouvez effectuer les classements en cliquant sur "Arrivée" ou 

sur le nom de la marque désirée dans la zone "Classer par". Le logiciel fera les calculs de temps compensé, 

les affichera en avant dernière colonne et classera les concurrents en conséquence. 

 

Retrouver un classement à posteriori 

Toutes les données et les temps de passage des différentes manches avec sont stockés. Pour retrouver un 

classement, rappelez la course avec le menu "Concurrents→ Classement temps compensé" puis choisissez 

la manche. Sélectionnez ensuite  le classement ("Arrivée" ou marque de parcours) à calculer 

 

10.6 Etalonnage 
10.6.1 Alignement de la girouette 
 

Le principe de cet alignement consiste à effectuer un run au près tribord amure et un autre bâbord 

amure. Le logiciel mesure l'angle de remontée moyen sur chacun des bords, les filtre et en calcule la 

différence. 

Bien entendu, vous pouvez effectuer le run bâbord avant le run tribord si vous le souhaitez. Vous 

pouvez également effectuer plusieurs runs successifs sur chaque bord pour affiner les calculs. Il n'est 

pas nécessaire que le nombre de runs soit le même sur chaque amure, ni qu'ils durent le même temps. 

Appliquez-vous seulement à régler le bateau de façon identique sur les deux bords. 

Il est conseillé d'effectuer ces calibrages par mer calme et avec un vent suffisamment constant. En 
effet, même si le logiciel moyenne les variations de vent, les réactions d'un barreur aux changements 
de vent ne sont généralement pas les mêmes bâbord et tribord amure. Il pourrait en résulter une 
dissymétrie d'un bord sur l'autre qui affecterait le calibrage. 
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Lancez le menu " Etalonnage→ décalage girouette" 

 

 

 

Placez le bateau au près tribord amure puis cliquez sur "run tribord". Laissez le bateau acquérir un 

certain nombre de données (15 à 30s) puis cliquez sur "fin run tribord". Virez de bord, stabilisez le 

bateau au près et effectuez la même opération sur le run bâbord. 

 

 

Le logiciel indique directement la correction à apporter dans votre centrale (pas de division par deux à 

effectuer). 

Attention : si un calibrage existait déjà dans la centrale la correction à apporter doit être ajoutée ou 

soustraite de la calibration déjà paramétrée. 

Pour éviter les erreurs, il peut être judicieux de remettre le calibrage de la girouette à 0 avant de 

procéder aux runs de calibration. 

 

10.6.2 Etalonnage du speedomètre et du compas 
 

Le speedo peut être étalonné de façon extrêmement simple avec le logiciel. Cela se fait en effectuant 

un à trois run de ½ à 1 mille au moteur dans l'axe du courant. 

Le logiciel effectuant ses calculs sur les vitesses moyennes et non sur les distances, il n'est pas 
nécessaire que les distances parcourues lors des différents runs soient identiques.  
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Il est conseillé d'effectuer ces calibrages par mer calme et sans vent traversier important. Un vent de 
face n'a pas d'incidence sur les calculs. 

 

Effectuez un seul run si vous estimez qu'il n'y a pas de courant ; effectuez deux runs si vous souhaitez 

prendre le courant en compte et estimez qu'il n'évolue pas entre les deux runs ; enfin, effectuez trois 

runs si vous voulez que le logiciel prenne en compte les variations de courant. 

Il n'est pas nécessaire de disposer de repères fixes (bouées pour balises), le logiciel se cale sur la 

position du GPS. 

L'alignement du compas se fait exactement de la même façon au cours du (des) même(s) run(s). 

N'oubliez pas de le compenser auparavant si vous estimez qu'il peut être soumis à des influences 

magnétiques. La plupart des centrales permettent de le faire soit automatiquement, soit à l'issue de 

quelques tours du bateau sur lui-même. La valeur de la déclinaison magnétique, nécessaire au calcul, 

est calculée automatiquement quelle que soit votre région de navigation dans le monde. 

 

Lancez le menu " Etalonnage→ speedo et compas". 

 

 

 

 

Lancez le bateau au moteur (plus la vitesse est élevée, moins le courant a d'influence) face ou dos au 

courant s'il y en a puis cliquez sur "run1". Après avoir parcouru ½ mille environ, cliquez sur "fin run1". 

Le premier run est terminé et le logiciel indique les corrections à apporter sur l'étalonnage du speedo 

et l'alignement du compas. Si vous estimez qu''il n'y a pas de courant significatif (moins de 0.1 nds) 

l'étalonnage est terminé, sinon procéder au 2ème run : 
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Faites faire demi-tour au bateau, cliquez sur "run 2" et parcourez en sens inverse, le chemin suivi lors 

du run1. Cliquez ensuite sur "fin run2". Le logiciel indique les corrections à apporter prenant cette fois 

le courant en compte. La correction affichée est le coefficient multiplicatif à appliquer à la valeur de 

calibration déjà présente dans la centrale. Exemple : si la calibration présente dans la centrale est de 

110 et que le coefficient de correction affiché par Adrena est 1.2. La valeur de calibration à spécifier 

dans la centrale est 110 x 1.2 = 132. 

Si vous estimez que le courant n'a pas évolué entre les deux runs (moins de 0.1nds de variation) 

l'étalonnage est terminé, sinon, passez au 3ème run : 

 

Faites faire demi-tour au bateau, cliquez sur "run 3" et parcourez à nouveau le chemin suivi lors du 
run1. Cliquez ensuite sur "fin run3". Le logiciel indique les corrections à apporter prenant cette fois en 
compte les variations de courant. L'étalonnage est terminé. 
Vous pouvez maintenant reporter ces valeurs dans votre centrale. 
Attention : si un calibrage existait déjà dans la centrale la correction à apporter appliquée doit être 

appliquée à la calibration déjà paramétrée. 

Pour éviter les erreurs, il peut être judicieux de remettre le calibrage du speedomètre à la valeur 

moyenne avant de procéder aux runs de calibration. 

 

 

 

Les dernières valeurs calculées peuvent être consultées en lançant à nouveau le menu "Etalonnage→ 

speedo et compas". Ces valeurs ainsi que la date à laquelle elles ont été faites sont alors affichées dans 

la boite de dialogue. 

 

 

 

10.6.3 Interface direct avec la centrale 
Avec certaines centrales (actuellement H-Link chez B&G), il est possible de lire et d'écrire directement 

les valeurs de calibration dans la centrale. 

 

La valeur de calibration est affichée dans "Calibration actuelle". 
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Pour modifier la valeur de la calibration, positionnez la nouvelle valeur dans "Nouvelle calibration" (soit 

manuellement soit en effectuant les runs de calibration) puis cliquez sur "Set". 

 

La fonction "Raz" permet de remettre la calibration à une valeur neutre (elle n'est pas disponible sur 

toutes les centrales). 

 

Si la centrale possède deux Speedomètres, cliquez d'abord sur "Tribord" ou "Bâbord" pour spécifier 

celui dont vous souhaitez connaître ou positionner la valeur. 
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10.6.4 Outils de calcul des paramètres de relance et de rotation 
TactiquePro est doté d'un outil permettant de calculer automatiquement les paramètres de relance et de 

rotations à partir de speed tests que vous effectuez sur l'eau. 

 

10.6.4.1 Calcul des paramètres de relance et rotation sur l'eau 

 

Pour effectuer ces calculs directement sur l'eau, lancez le menu "Etalonnages→ relances et rotations" 

 

 

 

Cliquez sur "commencer analyse". Effectuez le speed test souhaité puis cliquez sur "terminer analyse". Les 

valeurs de vitesse de rotation et de coefficient de rotation pour la force de vent en cours apparaissent alors 

dans les zones correspondantes. 

 

Pour chaque force de vent analysée, effectuez des rotations dans le sens du lof et de l'abattée (à puis 

complétez les tableaux correspondants à partir des valeurs lues dans "Vitesse de rotation". 

 

Effectuez également les speed tests de relance : placez le bateau à l'arrêt au TWA désiré, cliquez sur 

"Commencez analyse", lancez le bateau en ligne droite puis cliquez sur "terminer analyse" lorsque le 

bateau a atteint environ 90% de sa vitesse cible. 

Il est conseillé d'effectuer une mesure à 45°, à 90° et à 180° du vent. 

 

10.6.4.2 Calcul des paramètres de relance et rotation à terre 

 

Il est possible de faire ces calculs à terre à partir des speed tests enregistrés sur l'eau. 

 

Effectuez sur l'eau, les différents speed tests décrits au chapitre précédant. 

Une fois à terre rejouez la trace de votre navigation, définissez les speed tests de chaque enregistrement 

(voir le chapitre sur les speed test de la documentation Adrena), lancez le menu "Etalonnages→ relances et 

rotations" et cliquez sur "Analyser speed test". 
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Note : il peut être commode de créer des segments (avec des noms explicites) lorsque vous effectuez les 

speed tests sur l'eau. Une fois à terre, vous pourrez alimenter les speed test directement à partir des 

segments créés. 

 

10.7 Paramètres 
10.7.1 Paramètres généraux 
10.7.1.1 Le bateau 

 

Vous pouvez paramétrer ces valeurs dans le menu "Paramètres→ Paramètres généraux, onglet 

"Bateau". 

 

 

 

Nom du bateau : indiquez le nom de votre bateau, 

 

Type de bateau : indiquez le type de votre bateau, 

 

Longueur de coque : indiquez la longueur de la coque. Ce paramètre est utilisé par le logiciel pour 

indiquer un certain nombre de distances en "longueurs de bateau" (distance à la ligne, distance layline). 
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Largeur de coque : indiquez la largeur de la coque. Pour un monocoque, le paramètre sert uniquement 

au dessin du bateau sur l'écran. Pour un multicoque, la largeur sert également à calculer la distance à la 

ligne en fonction du flotteur qui en est le plus proche. 

 

Ecart antenne étrave : indiquez la distance entre l'étrave du bateau et l'antenne du GPS. Cette donnée 

est nécessaire au logiciel car toutes les données de position et de distance sont référencées par rapport 

à l'étrave et non par rapport à la position donnée par le GPS qui correspond à la position de l'antenne. 

 

Nombre de coques : choisissez entre "monocoque", "catamaran" et "trimaran". Cette donnée permet 

de modifier l'aspect du bateau sur la fenêtre du plan d'eau. Dans le cas d'un multicoque, cela vous 

permettra de saisir l'écart latéral entre l'antenne et l'axe du bateau, ceci afin de permettre au logiciel 

de mieux calculer la position de l'étrave. 

 

Ecart latéral de l'antenne : indiquez le décalage de l'antenne par rapport à l'axe longitudinal du bateau. 

Saisissez un écart positif si l'antenne est décalée sur tribord et négatif si l'antenne est décalée sur 

bâbord 

 

Propulsion 

Si vous disposez du module Routage et que vous souhaitez effectuer des routages mixtes (voile / 

moteur), cochez la case "Mixte" et renseignez la vitesse du bateau en régime de croisière au moteur 

ainsi que la consommation de carburant (en litres / heure) à ce régime. 
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10.7.1.2 Divers 

 

Menu "Paramètres→ Paramètres généraux, onglet "Divers". 

 

 

Type de procédure : vous pouvez paramétrer la durée du signal d'attention et celle du signal 

préparatoire (en minutes). 

 

Rayon waypoints : concerne les parcours côtiers uniquement. Distance en dessous de laquelle le 

logiciel estime être arrivé sur le waypoint. Notez qu'il n'est pas nécessaire de passer aussi près de la 

marque, le logiciel commute sur la marque suivante dès que le bateau a franchi la perpendiculaire à 

celle-ci. 

 

Echantillonnage trace : C'est la fréquence à laquelle sont stockées les données de navigation (en 

interne et dans les fichiers. Ces données sont destinées à différents usages : 

filtrage des mesures, 

affichage de la trace à l'écran, 

replay ultérieur de votre régate 

calcul de polaires 

Sur des navigations côtières, nous vous conseillons de laisser la durée minimum (1 seconde), cela 

permettra d'obtenir les meilleurs calculs. Si vous disposez de trop peu de place sur votre disque ou 
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pour les navigations au large, vous pouvez augmenter cette valeur. Pour information, une régate 

classique de 2 heures 30 génère un fichier d'environ 200 Ko. 

 

Chercher les mises à jour sur Internet 

Recherche automatique des mises à jour. Voir le chapitre MISES A JOUR. 

 

Couleur données numériques par type de données : les données numériques  (sur la droite de l'écran) 

peuvent être colorées (texte). Cette coloration peut se faire case par case (option décochée) ou par 

type de donnée (option cochée).  

Si vous validez l'option "type de donnée", les paramètres de couleurs que vous spécifierez porteront 

systématiquement sur toutes les cases affichant la même donnée.  

 

Reset couleurs : uniquement si l'option précédente est cochée. Redéfini toutes les couleurs d'origine 

comme lors de l'installation du logiciel. 

 

GPS : filtrer position aberrantes. 

Ignore les données aberrantes en provenance du GPS (position soudain très éloignée de la position 

précédente). 

 

Durée max : durée maximum pendant laquelle le logiciel ignore les données GPS aberrantes. 

 

Afficher les heures en temps Universel : toutes les heures seront affichées en heure TU, sinon, elles 

seront affichées en heure locale. 

 

Afficher "TU" ou "lo" sur les heures : si l'option est cochée, toutes les heures seront suivie du suffixe 

"TU" ou "lo" pour préciser dans quel mode vous vous trouvez. 

 

Afficher la date sous la forme : selection de l’affiche des dates en jour/mois/année  ou anné/mois/jour 

 

Commuter automatiquement les phases du parcours. Si l'option est validée, le logiciel commutera 

automatiquement au top départ ainsi qu'à chaque passage de marque. Sinon, c'est à vous de choisir 

chaque phase manuellement pendant la course. 

Si l'option est décochée, il est toujours possible d'activer  la phase en cours en appuyant sur les touches 

CTRL-F11. 
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Recentrer l'écran sur changements de waypoint. Si l'option est validée, le logiciel recentre l'écran, à 

chaque changement de waypoint, sur le bateau et le waypoint actif (bateau + départ pendant la phase 

de départ). 

Si l'option est décochée, il est toujours possible de recentrer l'écran sur le waypoint actif en cliquant sur 

le bouton  

 

Afficher caps en "true" (géographique). Si l'option est validée, tous les caps affichés à l'écran le sont en 

cap géographique. Sinon, ils le sont en cap magnétique. 

 

Remonter caps sur centrale en "true" (géographique). Si l'option est validée, tous les caps remontés 

sur les afficheurs de la centrale le sont en cap géographique. Sinon, ils le sont en cap magnétique. 

 

10.7.1.3 Affichage 

 

 

 

 

Barre de statut 

La barre de statut est la barre horizontale située en bas de l'écran et qui affiche certaines données 

contextuelles. Vous pouvez décocher la case pour supprimer cette barre et gagner de la place pour la 

visualisation du plan d'eau. 
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Ecran tactile 

Si vous utilisez un écran tactile, il est conseillé de cocher cette case afin d'accéder au pavé numérique 

de saisie  de données avec un simple clic au lieu d'un double clic. 

 

Infos nav : polices multiples 

Permet d'agrandir la taille de certaines données numériques. 

Lorsque la case n'est pas cochée toutes les données numériques d'une même boite utilisent la même 

taille de caractère. Lorsque la case est cochée les données ne comportant qu'une ou deux lignes sont 

agrandies dans la mesure du possible. 

 

Infos nav : ne pas afficher les unités 

Lorsque la case est cochée, les données numériques n'affichent pas les unités des données, ce qui 

permet d'agrandir la taille des caractères. 

 

 

 

Couleur bateau 

La couleur du bateau principal,  de sa trace et de sa route fond  peut être modifiée en cliquant sur ce 

bouton et en choisissant la couleur désirée. 

 

Afficher le nom de waypoints 

Si l'option est cochée, le nom des waypoints est affiché en permanence, sinon, il est affiché lorsqu'on 

approche la souris du waypoint. 

 

Police de caractères 

Définit la police (type et taille) des affichages utilisés par-dessus la cartographie (noms des waypoints, 

info bulles, ...). 

Cliquez sur "Police de caractères" et choisissez les caractéristiques de la police. 
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Afficher laylines  

Affiche les angles de meilleur VMG depuis la bouée au vent sur les bords de près et de portant. 

 

 
On peut également valider cette option en effectuant un clic droit sur la marque et en choisissant 

"Laylines" 

 
Afficher targets . 
Affiche les angles de meilleur VMG devant le bateau sur les bords de près et de portant. 

 

On peut également valider cette option en effectuant un clic droit sur le bateau et en choisissant 

"Targets" 
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Afficher échelle 

Affiche l'échelle de la carte en haut à droite de l'écran 

 

 

Afficher rose des vents 

Affiche une rose des vents en haut à droite de l'écran lorsque la carte n'est pas orientée au nord 

(généralement sur les départs et parcours banane).  

 

 

Afficher vecteur courant devant le bateau. 
Le courant mesuré sur la centrale est figuré sous forme d'une flèche rouge sur l'avant du bateau. 

 

 

On peut également valider cette option en effectuant un clic droit sur le bateau et en choisissant 

"Courant" 

 

Afficher route fond devant le bateau. 
La route fond (mesurée sur le GPS) est affichée sous forme de trait pointillé (même couleur que le 

bateau) devant le bateau. 

 

On peut également valider cette option en effectuant un clic droit sur le bateau et en choisissant 

"Route fond" 
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Afficher route surface devant le bateau. 
La route surface (mesurée sur le compas) est affichée sous forme de trait continu noir devant le bateau. 

 

On peut également valider cette option en effectuant un clic droit sur le bateau et en choisissant 

"Route surface" 

 

Durée routes devant le bateau 

Définit la longueur du tracé des routes fond et surface devant le bateau. Saisir 10 mn par exemple, 

permet de savoir où sera le bateau dans 10 mn (selon sa route fond actuelle). 

On peut également valider cette option en effectuant un clic droit sur le bateau et en choisissant 

"Durée routes" 

 

Maintenir le bateau au centre de l'écran 

Si coché, le bateau restera centre de l'écran et la carte scrollera autour. Ce suivi se désactive si vous 

déplacez volontairement la carte, il reprend automatiquement lorsque vous cochez le bouton de 

recentrage autour du bateau. 

 

Scroller pour suivre le bateau  

Si coché, le logiciel scrolle pour suivre le bateau lorsque ce dernier arrive en bordure d'écran. 

 

% de l'écran à maintenir devant le bateau 

Le logiciel scrollera la carte dès que le bateau approche de moins de la distance saisie du bord de 

l'écran (en % de l'écran). Si vous mettez 50%, le bateau restera à peu près au milieu de l'écran. 
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Histo-graphe : durée par défaut 

Définit la durée sur laquelle porte l'historique lorsque vous ouvrez une fenêtre histo-graphe. 

 

Orientation nord sur départs 

Supprime la rotation de la carte en phase de départ qui permet d’afficher une ligne de départ 

horizontale 

 

Orientation nord sur parcours banane 

Supprime la rotation de la carte sur un parcours banane qui permet d’afficher l’écran dans l’axe du 

parcours 

 

 

 

Paramètres pouvant affecter les performances du logiciel 

 

Préchargement cartes 

A régler sur 1 de préférence. 

 

Qualité graphique 

Peut prendre les valeurs 0 à 4. 

0 préserve la puissance du PC, 4 optimise la qualité d'affichage.  

 

Cartes : niveaux de détails 

Permet d'augmenter ou de diminuer les détails affichés sur les cartes. Valeurs de 1 à 2 par pas de 0.25. 

La valeur 2 permet de voir plus de détails à l'écran, la valeur 1 diminue le nombre de détails et accélère 

l'affichage. 

 

Cartes C-Map : taille caractères. 

Permet d'augmenter ou de diminuer la taille des caractères affichés sur les cartes C-Map. 

Valeurs de 10 à 300% 

 

  10% : 10 fois plus petit que la taille par défaut 
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100% : valeur par défaut 

300% : 3 fois la taille par défaut 
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10.7.1.4 Unités 

Les informations de distance peuvent être affichées au choix en mètres, en milles ou en longueurs de 

bateau. 

 

 

Pour chaque type d'information (Distance à la ligne, Avantage ligne, Distance au comité et à la bouée, 

distances aux laylines et distances à l'écran), choisissez entre "Longueurs de bateau", "Mètres" et 

"Milles". 

Les distances à l'écran concernent les mesures de distance entre deux points ou sur une succession de 

points. 

Les unités de distance à l'écran peuvent également être paramétrées par le menu contextuel associé 

aux boutons de mesure de distance. 

10.7.1.5 FTP 

Pour paramétrer ces sites, lancez le menu "Paramètres→ Paramètres généraux", onglet "FTP". 
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Activez l'accès (case "Actif") et indiquez les paramètres d'accès qui vous ont été communiqués par le 

fournisseur du site : adresse du site, fichiers à lire, login et mot de passe. 

Le nom de fichier peut comporter des caractères génériques. "rep/*.txt", par exemple, va lire et traiter 

tous les fichiers se terminant pat ".txt" dans le répertoire "rep". 

Attention :  

respectez scrupuleusement les minuscules / majuscules dans tous les champs. 

sur FTP, le séparateur de répertoires est le caractère '/' et non le caractère '\' comme sous Windows 

("Imoca/*.txt" et non "Imoca\*.txt"). 

 

Test 

Après avoir saisi ces éléments, vous pouvez tester la connexion avec le site en cliquant sur "Test". 

La connexion est testée (Site, login, mot de passe). Si elle ne peut être établie, les messages d'erreur 

sont affichés ; si elle est établie, les fichiers concernés sont recherchés et leur liste est affichée. 
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10.7.1.5.1 Lecture du site 

La lecture du site se fait en lançant le menu "Outils→ Accès ftp1" (ou Accès ftp2).  

la connexion est établie (la liaison Internet doit être ouverte au préalable) 

L'ensemble des fichiers décrits dans le paramètre Fichier(s) et ayant été modifiés depuis le dernier 

transfert sont rapatriés en local et le répertoire de réception est ouvert pour vous permettre d'accéder 

aux fichiers (en double cliquant dessus en général)  

 

 

10.7.1.5.2 Synchroniser un site ftp en écriture  

(pour l'équipe à terre) 

 

10.7.1.5.3 Paramétrage 

Toujours dans le menu "Paramètres→ Paramètres généraux", onglet "FTP". 

Activez l'accès (case "Actif") et indiquez les paramètres d'accès qui vous ont été communiqués par le 

fournisseur du site : adresse du site, répertoire à alimenter, login et mot de passe. 

Attention :  

respectez scrupuleusement les minuscules / majuscules dans tous les champs. 

sur FTP, le séparateur de répertoires est le caractère '/' et non le caractère '\' comme sous Windows 

("Imoca/*.txt" et non "Imoca\*.txt"). 

 

Test 

Après avoir saisi ces éléments, vous pouvez tester la connexion avec le site en cliquant sur "Test". 

 

 

10.7.1.5.4 Ecriture sur le site 

L'écriture sur le site peut se faire en automatique (si la connexion Internet est permanente) ou en 

manuel. 
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Pour une écriture automatique, cochez la case "Ecriture auto" et remplissez le paramètre "fréquence" 

avec l'intervalle entre deux écritures (10 mn par exemple). 

Pour une écriture manuelle, ouvrez la connexion Internet puis lancez le menu "Outils→  Envoyer fichiers sur 

site FTP" chaque fois que vous souhaitez remonter les fichiers. 

 

10.7.1.6 Liaisons avec les instruments 

 

Les instruments connectables au logiciel sont : la centrale de navigation, le GPS et le récepteurs AIS. 

La liaison avec ces instruments se paramètre par le menu "Paramètres→ Paramètre généraux", onglet 

"Liaisons". 

D'autres instruments peuvent être ajoutés si nécessaire voir  
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Le protocole de communication utilisé pour la communication avec les instruments est le NMEA 0183. 

Certaines centrales utilisent un protocole de communication spécifique compatible avec Adrena, il 

s'agit de  : 

• H-Link de B&G 

• GoFree de B&G uniquement sur les centrales H5000 

• WTP3 de B&G à travers le logiciel Deckman Voir Réception des informations à travers un autre 

logiciel ("Deckman for Windows") 

• FDX de Garmin et Nexus 

• Tacktick  

• Bravo 

Le choix du mode de communication est paramétré dans Type de centrale 

 

10.7.1.6.1 Exemples de configurations 

De multiples configurations sont possibles, voici les plus courantes : 

 

 

Dans ces configurations le GPS et l'AIS sont connectés directement à la centrale ou à un 

multiplexeur qui centralise les données à envoyer au PC. 

La configuration des instruments est : 

• Centrale : sur entrée série ou réseau de la centrale de navigation ou du multiplexeur 

• GPS : "A travers la centrale" 

• AIS : "A travers la centrale" 

Centrale 
de 

navigation

PC

GPSAIS

PC

Multiplexeur

GPSAISCentrale de 
navigation
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Dans cette configuration tous les instruments sont reliés indépendamment au PC. Des connexions 

directes peuvent exister entre les instruments pour communiquer entre eux. 

La configuration des instruments est : 

• Centrale : sur entrée série ou réseau 

• GPS : sur entrée série ou réseau 

• AIS : sur entrée série ou réseau 

NB: La connexion directe du GPS au PC (exemple: antenne USB) est recommandée pour augmenter la 

précision sur une ligne de départ ou pour pointer les marques et calculer la distance à la ligne. 

 

 

Dans cette configuration seuls la centrale de navigation et l'AIS sont connectés au PC. 

La configuration des instruments est : 

• Centrale : sur entrée série ou réseau 

• GPS : "A travers la centrale" 

PC

GPS

AISCentrale de 
navigation

PC

AIS

Centrale de 
navigation

GPS
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• AIS : sur entrée série ou réseau 

 

NB : Dans cet exemple, si vous souhaitez utiliser le récepteur GPS de l'AIS comme source principale, 

paramétrez la configuration suivante : 

• Centrale : sur entrée série ou réseau 

• GPS : "lire le GPS de l'AIS" 

• AIS : sur entrée série ou réseau 

 

10.7.1.6.2 Type de centrale 

Le paramétrage du type de centrale permet de remonter des informations de performances (% de 

vitesse cible, angles target)  sur les centrales de performance. Voir le chapitre REMONTEE DE DONNEES 

SUR LA CENTRALE DE NAVIGATION 

Afin de pouvoir remonter la quasi-totalité des informations calculées par Adrena sur les afficheurs 

(B&G H-link, NKE–Gyrographique, Tacktick et centrales acceptant les phrases NMEA XDR), il est 

impératif de spécifier ici le type de centrale. 

 

10.7.1.6.3 Réception sur liaison série 

Cochez "Sur liaison série" puis sélectionnez le port COM correspondant à chacun d'entre eux.. 

Si vous ne connaissez pas ces liaisons, Adrena peut les détecter automatiquement. Pour cela : 

• connectez le GPS, la centrale et l'AIS au PC et mettez-les en route. 

• cliquez sur 'Détection automatique" 

 

 

Le logiciel affiche l'ensemble des liaisons présentes sur le PC et les données qui se présentent sur 

chacune d'entre elle, ce qui lui permet d'identifier la centrale, le GPS et l'AIS. Les différentes vitesses de 

liaisons sont scrutées (4800 dans un premier temps car c'est la vitesse standard NMEA, les autres 

ensuite). 
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Lorsqu'il a terminé, cliquez sur "Fermer". Le logiciel affichera les liaisons reconnues et paramétrera les 

liaisons en conséquence 

 

Caractéristiques des liaisons NMEA 

Les caractéristiques des liaisons série associées aux différentes liaisons NMEA peuvent être 

paramétrées individuellement. 

Pour modifier les caractéristiques d'une liaison, cliquez sur le bouton "rs232". 

 

 

 

Choisissez la vitesse, la parité, le nombre de bits et de stop bits. 

 

La case à cocher "Compatible NMEA" permet de forcer les valeurs sur les valeurs définies dans la norme 

NMEA (4800 bauds, pas de parité, 8 bits, 1 stop bit). 

Vérifier checksum 

Si vous cochez cette option, le logiciel vérifiera le checksum de chaque phrase NMEA (si elle en 

possède) et ignorera les phrases dont le checksum est invalide. 

 

10.7.1.6.4 Réception des informations à travers un autre logiciel ("Deckman for Windows") 

Si vous utilisez le logiciel "Deckman for Windows", Adrena pourra lire les informations de la centrale (et 

du GPS) à travers lui. Pour cela, cocher la case "Via DFW" et spécifiez, dans la zone "interface" 

l'emplacement du fichier J_vars.d qui décrit les données gérées par "Deckman for Windows". Pour 

trouver ce fichier, cliquez sur le point d'interrogation situé à droite de la zone. Adrena le trouvera 

généralement de lui-même. Si ce n'est pas le cas, spécifiez la bonne localisation. 

Si vous choisissez cette option, le logiciel Deckman devra être lancé lorsque vous utiliserez Adrena. 
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10.7.1.6.5 Réception des informations à travers un autre logiciel (UDP) 

Si vous utilisez un autre logiciel qui a lui aussi besoin des informations de la centrale et que ce dernier 

gère les ports UDP (technologie permettant à deux logiciels d'échanger des informations sur le même 

ordinateur ou à travers un réseau), vous pouvez lire les informations de la centrale (et / ou du GPS) sur 

le port UDP alimenté par ce logiciel. 

Paramétrez votre autre logiciel pour qu'il recopie les infos de la centrale (et/ou du GPS) sur un port 

UDP. Notez-le n° de ce port. Revenez sur "Adrena", cochez la case "sur liaison UDP" et indiquez le n° du 

port. 

 

"Port out" permet de spécifier le port UDP sur lequel le logiciel remontera les informations de 

navigation (cap et distance au waypoint, temps au waypoint, données spécifiques, ...) 

 

10.7.1.6.6 Réception des informations à travers un réseau  (UDP/TCP) 

Vous pouvez utiliser une liaison WIFI ou Ethernet provenant d’un appareil (centrale, multiplexeur…) 

faisant transiter le flux NMEA 0183 sur le réseau. 

Une fois l'ordinateur connecté au réseau : 

_ sélectionnez le protocole utilisé par l'appareil émetteur (TCP ou UDP) 

_ entrez le numéro de port correspondant (en entrée et sortie pour l'UDP) 

_ l'adresse IP de l'émetteur sur le réseau (uniquement pour le TCP) 

 Ces informations sont généralement disponibles dans l'interface de configuration de l'émetteur. 

 

10.7.1.6.7 Emission des informations de la centrale ou du GPS vers un autre logiciel 

Adrena peut recopier les informations reçues sur un port UDP et/ou TCP à destination d'un autre 

logiciel situé sur le même ordinateur ou sur un autre appareil du réseau comme une tablette ou un 

smartphone 

Pour cela, paramétrez "Adrena" pour qu'il lise les informations sur une liaison série puis : 

_ Cochez sur "recopier sur UDP" et sélectionner "All" (Broadcast) pour diffuser les données sur tous le 

réseau, "localhost" pour diffuser uniquement sur le même ordinateur (ex : vers un autre logiciel) sinon, 

choisissez l'ordinateur dans la liste proposée. Si nécessaire, modifiez le n° de port (>1024) 

_ Cochez recopier sur "TCP", notez le port proposé ou choisissez en un autre puis reportez cette valeur 

et l'IP de l'ordinateur sur lequel se trouve Adrena, sur le périphérique concerné. 
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10.7.1.6.8 GPS 

Spécifiez les caractéristiques de la liaison comme pour la centrale (série ou réseau). 

Indiquez ile type de GPS auquel est connecté le logiciel. Cela déterminera de quelle façon le logiciel 

peut remonter les informations de waypoint et de parcours. 

 

10.7.1.6.9 AIS 

Spécifiez les caractéristiques de la liaison AIS comme pour la centrale et le GPS. 

 

10.7.1.6.10 Visualisation des données (entrées/sorties) 

Outil de visualisation des données lues et envoyées par le logiciel avec les instruments. Permet de 

contrôler le contenu des échanges Logiciel/Instruments 

 

10.7.1.6.11 Liaisons supplémentaires 

D'autres liaisons peuvent être ajoutées si besoin : baromètre indépendant, récepteur "homme à la 

mer", ... Vous pouvez paramétrer jusqu'à 10 liaisons supplémentaires 

 

Choisissez le n° de la liaison à paramétrer (1 à 10), puis spécifiez les caractéristiques de la liaison 

comme pour la centrale ou le GPS (série ou udp, ...) 
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10.7.1.6.12 NMEA 2000 

Si votre installation comporte des instruments utilisant le NMEA 2000, il est nécessaire de convertir le 

flux de données en NMEA 0183 pour le rendre utilisable. Pour cela plusieurs solutions s'offrent à vous : 

• Certaines centrales de navigation utilisant le NMEA 2000 comportent des sorties et/ou entrées 

NMEA 0183, reportez-vous au manuel de la centrale pour les paramétrer 

• Certains fabricants de centrale de navigation fournissent des passerelles optionnelles pour 

effectuer la conversion NMEA 2000/NMEA 0183. Vous pouvez également en trouver auprès de 

fournisseurs spécialisés (Actisense, Digital Yacht, Amec…) 

• Les multiplexeurs dont la fonction première est de centraliser et diffuser les données de 

plusieurs instruments NMEA 0183 proposent pour certains des fonctionnalités supplémentaires 

comme la conversion NMEA et/ou Seatalk. (Shipmodul…) 

• Certains transpondeur AIS sont dotés de nombreuses fonctionnalités comme le multiplexage et 

la conversion NMEA 2000/NMEA 0183 (Digital Yacht, Vesper Marine…) 

 

10.7.1.7 Spécification du jeu de voiles ou de segments avec une application extérieure (Onboard Assistant) 

 

La création de segments et les voiles à poste peuvent être indiqués à l’aide d’un autre programme diffusant 

l’information via le protocole UDP.  

 

Pour cela indiquer le numéro du port UDP utilisé par l’application  dans Paramètres → Paramètres 

Généraux → Entrée voiles et segments 
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Les segments créés et les voiles spécifiés dans le programme tiers seront directement intégrés dans la trace 

enregistrée par Adrena. 

Spécification des voiles à poste  

SAILSUP=<nomGV>;nbRis;<nomFoc1>;nbRis;<nomFoc2>;nbRis;<nomSpi> Les champs peuvent être vides 

pour in,dqqiquer que la voile n'est pas à poste/  

Le nom des voiles doit être le même que celles utilisés dans Adrena (menu Performance -> Configuration)  

Ex : Gv (dont le nom Adrena est Grand-voile) 1 ris, 1 foc (dont le nom Adrena est Trinquette)  

SAILSUP=Grand-voile;1;Trinquette;;;  

  

Afin d'éviter toute perte d'information, il est recommandé d'envoyer le message à intervalle régulier (1 

minute) et pas seulement lorsqu'il y a un changement.  

Création d'un segment  

- Début du segment : PHASESTART=<noSegment>;<nomSegment>   

  

- Complément d'information sur le segment : PHASECOMMENT=<nomSegment>;<commentaire>  

  

- fin du segment PHASESTOP=<noSegment>  

  

- annulation du segment PHASECANCEL=<noSegment>  

  

Test de connexion  

TESTCONX=1;<noPortUdp>    

La réponse d'Adrena se fait sur le port spécifié. Elle a la forme : TESTCONX=2;7000 
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10.7.1.8 Remontées centrale 

 

 

 

Toujours remonter la position sur la centrale 

Par défaut, la position GPS n'est pas remontée sur la centrale si le GPS est lu à travers cette dernière. 

Dans certaines configurations (Figaro par exemple), il est nécessaire de remonter cette position à la 

centrale bien que le GPS y soit lu. Pour cela, cochez la case "Toujours remonter la position sur la 

centrale". 

Un certain nombre d'informations calculées par Adrena peuvent être remontées sur votre centrale. Le 

nombre et la nature de ces informations dépendent du type de votre centrale. 

Commutation des canaux 

Les canaux personnalisés sont définis en fonction du mode de navigation (départ, près, portant ou 

route directe) (voir le chapitre Remontées des infos centrales personnalisées). Par défaut, les données 

remontées sont fixe (sans commutation) mais le critère d'allure (près, portant, ou route directe) peut 

être évalué : 

• à partir de l'ange de vent pour se rendre au waypoint actif : cocher " Commutation des canaux 

selon allure au waypoint" 

• à partir de l'angle de vent (TWA) : cocher "Commutation des canaux selon allure du bateau" 
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Période de clignotement 

Si vous avez défini des canaux alternatifs à remonter sur la centrale, ceux-ci vont alterner avec les 

canaux principaux toutes les 2 secondes par défaut. Si vous souhaitez modifier cette valeur, précisez le 

ici. 

10.7.1.8.1 Données disponibles sur tous les types de centrales (NMEA 183) 

Position du bateau 

Dans le cas où le GPS n'est pas connecté directement à la centrale. Phrase GLL. 

 

Heure TU 

Dans le cas où le GPS n'est pas connecté directement à la centrale. Phrases GLL et ZTG. 

 

Vitesse et cap fond 

Dans le cas où le GPS n'est pas connecté directement à la centrale. Phrase VTG. 

 

Temps et distance à la ligne 

Pendant la procédure de départ, le temps nécessaire pour rejoindre la ligne est remonté sur la phrase 

NMEA "Time to waypoint". Phrase ZTG. 

La distance à la ligne est remontée sur la phrase NMEA "Distance to waypoint". Cette information est 

généralement donnée en milles nautiques. Pendant le départ, Adrena remonte l'information en 

longueurs de bateau, en mètres ou en milles selon paramétrage des unités. Phrase RMB. 

 

Temps pour rejoindre la prochaine marque 

Après le départ, Adrena remonte le temps pour rejoindre la prochaine marque sur la phrase "Time to 

waypoint". Phrase ZTG. 

 

Position et distance de la prochaine marque 

Après le départ, Adrena remonte la position de la prochaine marque et sa distance (en mille nautique) 

sur la phrase "Distance to waypoint". Phrase RMB. 

 

Cap de la prochaine marque 

Après le départ, Adrena remonte le cap fond de la prochaine marque sur la phrase "Cap to waypoint". 

Phrase RMB. 

 

Nom de la prochaine marque 
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Remonté sur les phrases ZTG et RMB 

 

Nom de la marque précédente 

Remonté sur la phrase RMB 

 

Erreur de route 

L'erreur de route par rapport à la prochaine marque est remontée sur les phrases "Cross track error" : 

RMB et XTE. 

10.7.1.8.2 Centrales NKE 

Les informations supplémentaires remontées sur les centrales NKE concernent : 

la vitesse cible pour le vent en cours : canal VIT_CIBLE  sur la centrale 

le pourcentage vitesse du bateau / vitesse polaire pour l'angle et la force de vent mesuré : canal 

REND_POLAIRE sur la centrale, 

le pourcentage VMG du bateau / VMG polaire pour la force de vent mesuré : canal REND_PRES sur la 

centrale. Il s'agit du VMG "upwind" lorsque vous naviguez au près et du VMG "downwind" 

lorsque  vous naviguez au portant, 

l'angle du vent réel pour le meilleur Vmg (au près ou au portant) : canal OPT_ANGLE_VENT sur la 

centrale, 

10.7.1.8.3 Centrales B&G (FFD NMEA versions 9 et supérieures) 

Les informations supplémentaires remontées sur les FFD NMEA V9 et supérieurs sont : 

la vitesse cible pour le vent en cours : menu PERFORM / TARG SPD sur la centrale. Phrase GTTBS. 

le pourcentage vitesse du bateau / vitesse polaire pour l'angle et la force de vent mesuré : menu 

PERFORM / POL PRF (ou REACHING PC) sur la centrale. Phrase GTTBS. 

l'angle du vent réel pour le meilleur Vmg (au près ou au portant) : menu WIND / TARG AWA sur la 

centrale. Phrase GTVMG. 

le cap magnétique de la layline en cours : menu NAVIGATE / TARG HDG NL sur la centrale. Phrase 

GTVMG. 

le cap magnétique de la layline opposée : menu NAVIGATE / TARG HDG FL sur la centrale. Phrase 

GTVMG. 

distance à la ligne (en mètres, dans l'axe du bateau) : menu WAYPOINT→ DIST TSL sur la centrale. 

Phrase GTSTR. 
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temps pour rejoindre la ligne : menu WAYPOINT→ TIME TSL sur la centrale. Phrase GTSTR. 

10.7.1.8.4 Centrales B&G H-Link 

Les centrale B&G acceptant le protocole H-Link (une partie de la gamme H3000) reçoivent les 

informations de position, de waypoint ainsi que les données personnalisées que vous spécifiez dans les 

'infos centrales personnalisées' (ci-dessous). 

10.7.1.8.5 Centrales B&G WTP2 et WTP3 

Sur ce type de centrale, la remontée d'infos ne peut se faire que par le biais des 'infos centrales 

personnalisées' (ci-dessous).  

Cette remontée peut se faire sous réserve d'interfacer la centrale via le logiciel B&G "Deckman for 

Windows".  
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10.7.1.8.6 Centrales NEXUS NX2 

Les informations supplémentaires remontées sur ces centrales sont le pourcentage de vitesse cible (canal 

TBS - vitesse cible du bateau) et l'angle target (canal CAD - données d'angle personnalisée). 

 

10.7.1.9 Remontées des infos centrales personnalisées 

Adrena permet de remonter sur certaines centrales, la quasi-totalité des informations calculées par le 

logiciel. 

Les centrales concernées sont actuellement :  

les afficheurs NKE "Gyrographic", 

les centrales B&G acceptant le protocole H-link (une partie de la gamme H3000), 

les centrales B&G WTP2 et WPT3 (à condition d'interfacer la liaison par le logiciel Deckman), 

les centrales Tacktick., 

les centrales Nexus NXR, 

les centrales Bravo System. 

Sur les autres types de centrale, les infos peuvent être remontées via des phrases NMEA "XDR". 

Consultez la notice de votre centrale pour savoir si elle peut traiter ce type d'information. 

 

Note : pour remonter les informations sur un afficheur NKE Gyrographic, la liaison NMEA doit être 

connectée directement sur le Gyrographic. 

 

Les informations remontées (à travers 4 canaux paramétrables sur les centrales NKE et Tacktick, 8  

canaux sur les centrales H-link, WTP, Nexus et XDR), sont pilotées par le logiciel et paramétrées en 

fonction de la phase de parcours (départ, près, portant, ...). Elles évoluent donc au fil de la course sans 

que vous n'ayez à intervenir, ni sur la centrale, ni sur le logiciel. 

 

Pour paramétrer les canaux à remonter sur les afficheurs, lancez le menu "Paramètres→ Paramètres 

Généraux→ Remontée centrale" et choisissez la phase à paramétrer. 
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Les canaux (C1 à C4 et éventuellement C5 à C10) se trouvent dans la partie "Remontée centrale". 

Pour modifier l'information remontée sur un canal, double-cliquez sur la zone correspondante et 

choisissez l'information souhaitée. 

Les canaux alternatifs (C1 à C4 ou C1 à C10) permettent de faire alterner deux informations sur un 

même afficheur. Pour mettre en œuvre cette possibilité, sélectionnez une donnée dans les canaux 

alternatifs concernés. Le clignotement intervient toutes les 2 secondes par défaut. Vous pouvez 

modifier cette valeur par le menu Paramètres→ Paramètres généraux, onglet " Remontées centrale". 

 

Note: Les utilisateurs de Multigraphic NKE pourront afficher indépendamment les données des canaux 

alternatifs dans les pages de la centrale. Ces données seront échangées sur le bus avec les autres 

afficheurs Multigraphic (voir le manuel d'utilisateur). 
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10.7.1.10 IDataNet® 

 

 

 

iDataNet® est une application disponible sur Itunes pour Ipad et Iphone permettant d’afficher des 

données envoyées par le logiciel Adrena via une connexion réseau (WIFI).  

 

L’application permet à chaque utilisateur de sélectionner, parmi les données envoyées par Adrena, 

celles qu'il souhaite voir affichées sur son écran. Ainsi chaque équipier, en fonction de son poste à 

bord, peut recevoir les données qui le concernent. 

 

Port : réglage du port à utiliser par le protocole UDP pour l’envoi des données. Il doit correspondre à 

celui paramétré dans iDataNet®. 

 

PC : sélection de l’adresse réseau de l’appareil recevant les données. Il est possible d’émettre vers tous 

les appareils du réseau (broadcast) en choisissant "all". 

 

Rafraichissement : Taux actualisation des informations envoyées en seconde 

 

Préfixe : Permet de rajouter un préfixe devant le libellé pour différencier les émetteurs lorsque les 

données de plusieurs bateaux sont collectées sur le même terminal 
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Libellé : Descriptif des données envoyées.  Les indications peuvent être complètes ou réduites à 6 ou 10 

caractères.  

 

Données : sélection des données numériques envoyées par Adrena. 

 

Un trop grand nombre de données envoyées sur le réseau serait préjudiciable à la fluidité du transfert 

des informations. C’est pourquoi toutes les données ne sont pas envoyées, mais seulement celles 

sélectionnées par l’utilisateur. 

 

10.7.1.11 Exporter des données vers un autre logiciel : sorties UDP 

 

Il est possible de recopier un certain nombre d'informations sur des liaisons UDP (10 liaisons au 

maximum). 

Ces interfaces permettent d'envoyer des informations vers d'autres logiciels au cours de la navigation. 

 

Les informations envoyées sur sorties UDP sont au format NMEA et concernent : 

• les données reçues du GPS (s'il est connecté en NMEA), 

• les données reçues de la centrale (si elle est connectée en NMEA), 

• les données de waypoint calculées par Adrena, 

• les données spécifiques sélectionnées pour être remontées sur la centrale. 

 

 

 

Choisissez le numéro de la sortie UDP (1 à 10), puis indiquez le port (ce numéro de port devra être 

indiqué sur le logiciel recevant la donnée) et le PC concerné : il s'agit généralement du même PC que 
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celui sur lequel tourne Adrena ("localhost") mais ce peut être un autre PC connecté sur le réseau ou 

tous les PC du réseau ("all"). 

 

Choisissez ensuite le type d'infos à envoyer (GPS, centrale, waypoints et / ou données personnalisées).  

Les données personnalisées sont les données destinées à remonter sur la centrale. 

 

 

Choisissez le numéro de la liaison (1 à 9) et précisez en les caractéristiques (liaison série ou UDP, ...) 

comme pour la centrale ou le GPS. 

Vous pouvez également recopier les informations reçues sur un port UDP pour en faire profiter un 

autre logiciel (cochez "Recopier sur port UDP" et spécifiez le PC et le port destinataire). 

 

 

10.7.1.12 Calcul de données par le logiciel 

 

Certaines centrales ne fournissent pas toutes les données nécessaires au logiciel. Si ce dernier détecte 

l'absence de certaines d'entre elles (force et angle vent réel, force et angle vent apparent, cap du vent 

ou VMG), il effectuera les calculs lui-même à partir des autres données reçues. 

 
Vous pouvez vous en apercevoir car l'affichage des données concernées se fait alors en italique 
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Il peut arriver qu'une centrale fournisse certaines données à des intervalles trop longs. Le 
logiciel alterne alors entre la donnée fournie par la centrale et la donnée qu'il aura calculée à 
sa place. Vous pouvez constater ce phénomène par l'alternance, sur l'écran principal, de la 
donnée en italique et en police normale. Cela est préjudiciable au bon fonctionnement du 
logiciel car, pour des raisons de temps de filtrage différents, les données fournies par la 
centrale et calculées par le logiciel ne sont généralement pas les mêmes. Si cela se produit, 
vous pouvez forcer le logiciel à ignorer certaines données en provenance de la centrale et à les 
calculer lui-même. C'est le rôle de l'onglet "Données à calculer". 

 

 

 

Pour forcer le calcul d'une donnée, cocher la case correspondante. 
 

Les calculs sont faits dans l'ordre affiché sur l'écran : par exemple : si vous cochez "Lire vitesse bateau 
sur le GPS" et "Forcer le calcul du vent réel", BSP sera d'abord évalué sur le GPS puis sera utilisé pour le 
calcul du vent réel. 

 
Option "Le compas fournit le cap en true" : force le logiciel à retirer la déclinaison des informations 
envoyées par le compas. Cette option n'est à utiliser que pour certains compas fournissant par erreur le 
cap vrai au lieu du cap magnétique ou pour le logiciel Deckman qui peut donner la valeur en 
magnétique ou en géographique.  

 
Option "Le GPS fournit le COG en magnétique" : force le logiciel à retirer la déclinaison des informations 
envoyées par le GPS. Cette option n'est à utiliser que pour certains GPS fournissant par erreur le cap 
magnétique au lieu du cap vrai.  

 
Note 1 : il n'est pas possible de calculer simultanément  le vent réel et le vent apparent puisque chacun 

d'entre eux doit être calculé avec l'autre. 
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Note 2 : le courant est toujours calculé par le logiciel. 

 

10.7.1.13 Amortissements 

Les données reçues sur les liaisons NMEA sont généralement très instables car elles suivent les données 

en temps réel sans amortissement. 

Pour amortir les données affichées sur l'écran, lancez le menu "Paramètres→ paramètres généraux 

onglet Amortissements" 

 

 

 

Vous pouvez indiquer, pour chaque type de mesure, l'amortissement désiré en secondes (valeurs 

possibles 0 à 99 secondes). 

Ces amortissements concernent les données affichées à l'écran. Ils n'ont pas d'effet sur les données 

enregistrées en trace : un amortissement pourra leur être appliqué ultérieurement lors de leur 

utilisation par "Adrena" (replay d'une course) ou "Optima" (calcul de polaires).  



386 
 

10.7.1.14 Paramètre Tactique Pro 

 

 

 

Bateau en taille fixe. Si l'option est cochée, le bateau aura toujours la même taille à l'écran, (comme dans 

le logiciel sans option TactiquePro). Sinon, lorsque cela est possible (zoom suffisamment important), le 

bateau sera affiché en taille réelle. 

 

Marques de parcours en taille fixe. Si l'option est cochée, les marques de parcours seront représentées par 

un icone approprié ayant toujours la même taille à l'écran (comme dans le logiciel sans option 

TactiquePro), sinon, elles auront une taille variable avec le zoom et seront représentées par un triangle de 

4m de base. 

 

Taille fixe  Taille variable 

 

 

Cercle de longueurs. Il est possible d'afficher, sur chaque marque, un cercle de N longueurs pour visualiser 

la règle d'engagement. Le rayon de ce cercle peut être paramétré ici (en longueurs de bateau). 
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Forcer le courant à 0 sur le départ. Si l'option est cochée, le logiciel ignorera le courant calculé sur la 

centrale pendant le départ le supposera nul (sauf si vous le forcez dans la barre de forçage). 

 

Forcer le courant à 0 après le départ. Si l'option est cochée, le logiciel ignorera le courant calculé sur la 

centrale après le départ le supposera nul (sauf si vous le forcez dans la barre de forçage). 

 

Ecartement laylines sur départ = 1 longueur. Si l'option est cochée les laylines de départ seront 

représentées toutes les 1 longueur de bateau, sinon 10 laylines sont représentées sur l'ensemble de la ligne 

(comme dans Adrena). 

 

Nb de laylines de part et d'autre de la ligne. Permet de disposer des laylines au-delà de la ligne 
de départ. Indiquer le nombre de laylines supplémentaires à placer de chaque coté. 
 

Durée affichage layline via point. Lorsque vous cliquez sur une zone de l'écran pour définir une trajectoire 

spécifique, la trajectoire calculée est affichée pendant le temps spécifié puis disparaît. 

 

Longueur de la chaîne du comité. Le calcul de trajectoire sur la chaine du comité permet de calculer la 

trajectoire pour passer bâbord amure au comité en évitant la chaîne de mouillage de ce dernier. Indiquer 

ici la distance en mètres entre le mat du bateau comité et l'endroit où vous pouvez passer devant lui 

compte tenu de la position de son mouillage et de votre tirant d'eau. 

 

Présence et largeur de porte. Pour les parcours banane. Permet de spécifier que la bouée sous le vent est 

une porte ainsi que sa largeur en mètres. 

 

Référence sur porte droite. Spécifie que la référence (marque pointée ou bouée sous le vent) sera le coté 

droit de la porte, sinon c'est le milieu de la porte. 

 

Nb de tours de parcours banane. Nombre de tours à effectuer sur un parcours banane. Permet au logiciel 

de savoir qu'on se trouve sur le dernier bord de portant et se diriger vers la ligne d'arrivée plutôt que vers 

la bouée sous le vent. 

 

Moyennage et filtrage vent. Paramètre de filtrage du "vent moyenné". La durée est la période pendant 

laquelle est moyenné le vent, le pourcentage est la part des données extrêmes éliminées (permet 

notamment de ne pas prendre en compte les données aberrantes rencontrées pendant des virements de 

bord). 
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Moyennage et filtrage laylines. Paramètre de filtrage du "laylines moyenné". La durée est la période 

pendant laquelle sont moyennées les laylines, le pourcentage est la part des données extrêmes éliminées 

(permet notamment de ne pas prendre en compte les données aberrantes rencontrées pendant des 

virements de bord). 

 

Tolérance marque de départ. Réservé, laissez la valeur 1. 

 

Tolérance passage à la ligne. Permet au logiciel d'accepter une trajectoire même si elle passe à l'extérieur 

de la ligne mais très près de celle-ci. La valeur 1, par exemple,  permet d'accepter une trajectoire qui passe 

à moins d'une longueur de la ligne. 

 

Offset pointage bouée. Permet de définir l'écart entre l'étrave et la position réelle de la bouée de ligne 

lorsque vous la pointez. Entrez une valeur positive si vous passez par l'intérieur de la ligne lorsque vous 

pointez la marque (+0.5 par exemple), entrez une valeur négative si vous passez à l'extérieur de la ligne. 

 

Offset pointage comité. Idem pour le pointage du comité 

 

Coef Vmg Up alternatif (pour bateaux à déplacement léger). 

Ne concerne que les départs au près. 

Lorsque Adrena fait des calculs de trajectoires pour rejoindre la ligne ou les marques, il essaie en priorité 

les trajectoires sur les angles target de meilleure remontée au près, c'est-à-dire pour lesquelles le vmg est 

égal au vmg théorique optimum. S’il n’est pas possible de rejoindre la cible par cette target, le logiciel va 

essayer d’autres trajectoires, plus près du vent en acceptant un vmg moindre que le vmg optimum. 

Le "coef Vmg up alternatif " est le pourcentage limite que vous acceptez pour le vmg. 80%, par exemple, 

signifie que vous acceptez les trajectoires pour lesquels le vmg est compris entre 80 et 100%. Dans ce cas, 

les trajectoires qui conduisent à un vmg de moins de 80% ne sont pas étudiées par le logiciel. 

 

Ligne de recul : Affiche une ligne repère à une distance choisie de la ligne de départ (en longueur de 

bateau). 

 

10.7.1.15  Affichage des trajectoires à l'écran 

Le choix des trajectoires à afficher se fait par le menu "Paramètres→ Paramètres généraux", onglet 

"Testit". 

La trajectoire par un point quelconque est systématiquement affichée lorsqu'on la provoque (clic sur un 

point de la zone de départ) et s'éteint automatiquement après un temps paramétrable dans la menu 

"Paramètres→ Paramètres généraux", onglet "TactiquePro", paramètre "Durée affichage via point". 
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Trajectoires à la ligne 

 

 

Trajectoires aux marques 
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Trajectoire par la layline et par un point quelconque 

 

 

Trajectoire au plus rapide 

Il est possible de mettre en évidence la trajectoire la plus rapide parmi toutes celles évaluées (menu 

"Paramètres→ Paramètres généraux", onglet "Testit"). 

Lorsque la mise en évidence est validée, la trajectoire concernée apparait en magenta. 

 

On y accède par le menu paramètres→ paramètres généraux, onglet AIS 
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10.7.1.16 AIS 

 

 

 

Afficher les navires émetteurs AIS : valide l'affichage sur l'écran des navires détectés par l'AIS. Si cette 

option est dévalidée, les options suivantes le seront aussi. 

 

Cacher les navires à plus de : spécifie la distance à partir de laquelle le logiciel n’affiche plus les cibles 

AIS 

 

Apres perte réception, afficher pendant : spécifie combien de temps le bateau restera présent sur 

votre écran après la perte de la réception radio de ce navire. 

 

Afficher la trace des navires : valide l'affichage à l'écran de la route parcourue par les navires 

émetteurs. 

 

Durée de la trace : Durée de la trace affichée derrière le bateau à l'écran. Ex : 3h affiche la route suivie 

par le navire au cours des 3 dernières heures. 

 

Afficher la route fond des navires : valide l'affichage à l'écran de la route fond des navires. Cette route 

fond prend la forme d'un trait pointillé devant l'étrave du bateau. 
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Durée de la route fond affichée : durée de la route fond qui sera affiché à l'écran. Ex : 2h va afficher la 

route qui sera suivie par le bateau au cours des 2 heures à venir (dans l'hypothèse où il ne modifie ni sa 

route ni sa vitesse, bien sûr). 

Note : la durée de cette route fond est la même que celle du bateau principal. Si vous modifiez  

la durée de la route fond des navires AIS, cela modifiera celle de votre bateau et inversement. 

 

Afficher toutes les informations des station fixes" : concerne les émetteurs AIS fixes tels que les  

bouées ou les stations côtières. Le survol avec la souris permet d’afficher toutes les informations 

émises par celles-ci. 

 

Zone d'alerte 

 

La définition de la zone d'alerte permet de mettre en évidence les bateaux qui passeront trop près de 

vous par un clignotement du bateau en cause, par l'affichage de ronds rouge clignotant sur l'écran et / 

ou une alarme sonore. 

Pour définir une alarme sonore, consultez le chapitre "alarmes". 

 

Distance de sécurité. Distance minimum de croisement afin d'être prévenu. 

 

Ignorer bateaux à plus de : les bateaux situés trop loin de vous ne déclencheront pas d'alerte. 

 

Clignotement des navires en route de collision : si un navire doit croiser votre route à une distance 

inférieure à la distance de sécurité définie ci-dessus, vous en serez prévenu visiblement sur l'écran par 

un clignotement en rouge du navire en cause. 

 

Cercles d'avertissement sur zones de collision : si un navire doit croiser votre route à une distance 

inférieure à la distance de sécurité définie ci-dessus, vous en serez prévenu visiblement sur l'écran par 

des ronds rouges concentriques autour de la zone supposé d'impact. Cette option peut charger l'écran 

de façon importante dans les zones de forte densité de trafic. Dans ce type de situation, il est 

préférable de se contenter de faire clignoter chaque bateau en cause ("Clignotement des navires en 

route de collision"). 

 

Surveiller uniquement les navires se rapprochant : si la case est cochée, les navire qui s'éloignent de 

vous ne clignoteront pas à l'écran et ne feront pas l'objet d'alarme sonore même s'ils sont encore à 

l'intérieur de la zone de sécurité. 
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Valider alarme reprend l'alarme accessible dans le tableau général des alarmes (voir Mise en place 

d'une alarme AIS) 

 

MMSI du bateau 

Si votre bateau est émetteur AIS, indiquez ici votre indicatif MMSI afin que le logiciel ne signale pas de 

collision potentielle avec vous-même. 

 

Stocker les données AIS en trace 

Les données reçues des navires seront stockées dans la trace pour pouvoir les rejouer lors du replay de 

la navigation. Les données sont stockées à raison d'une info toutes les 30 secondes et par navire au 

maximum. 

 

10.7.1.16.1 Affichage sur la carte 

 

 

 

Les différents navires AIS de la zone apparaissent en vert ainsi que la trace de leur route et la 

représentation de leur route fond. 
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En approchant la souris de chacun d'entre eux, vous pouvez faire apparaître ses caractéristiques : 

nom 

type de bateau 

no MMSI 

statut (en route au moteur, à l'ancre, au port, ...) 

route fond (cap et distance) 

distance à laquelle il croisera votre route au plus proche. 

le coté où il passera (devant ou derrière) 

 

Si vous avez défini une distance de sécurité et que la distance de croisement d'un navire AIS est 

inférieure à cette distance, le navire en cause clignotera en rouge ainsi que des cercles concentriques 

sur la zone de collision selon les options choisies en paramétrage. 

 

 

 

 

 

10.7.1.16.2 Emetteurs SART-AIS 

Certains équipements de secours ("AIS-SART" ou "émetteur AIS de recherche et de sauvetage") 

envoient des messages AIS pour signaler la présence de naufragés demandant une assistance. 

Lorsqu'un tel équipement est détecté par Adrena, il apparait sous la forme d'un sigle clignotant  sur 

la carte. 

 

10.7.1.16.3 Menu contextuel 

En effectuant un clic droit sur un navire AIS, vous pouvez accéder à certains paramètres d'affichage 
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afficher ou cacher  la trace des navires 

modifier la durée de la trace des navires 

afficher ou cacher la route fond des navires 

modifier la durée de la route fond des navires 

 

10.7.1.16.4 Liste des navires de la zone 

Vous pouvez consulter la liste des navires AIS de la zone par le menu "AIS→ Liste des navires émetteurs" 

1.1.1.1 Concurrents 

Voir le chapitre correspondant "Réception de la position des concurrents" pour le paramétrage 

 

10.7.1.17 Exporter des journaux a terre 

Il est possible, avec ces fonctions, de générer un journal de bord à destination d'un routeur ou des 

équipes à terre. 

Principe : Adrena alimente périodiquement un fichier avec les données de navigation (toutes les 10 mn 

par exemple). Ce fichier est ensuite envoyé à intervalle régulier (toutes les 2h par exemple). L'équipe à 

terre reçoit par exemple toutes les 2 h un fichier contenant 12 situations (une situation toutes les 10 

mn). 

 

Envoi par mail 

Paramétrez votre logiciel de mail pour envoyer le fichier généré par Adrena toutes les 2h (par 

exemple). Le fichier doit être vidé ou effacé après chaque transfert. 

 

Envoi par ftp 

Paramétrez simplement les caractéristiques ftp (voir ci-dessous). Adrena se charge ensuite des envois. 

 

Le fichier reçu peut être un fichier réduit (informations essentielles uniquement) ou un fichier complet. 

 

Pour paramétrer les journaux, lancez le menu "Paramètres→ Paramètres généraux, onglet "Journaux". 
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La partie du haut concerne l'envoi d'informations réduites (heure, position, vitesse bateau, 
vitesse fond, cap fond, vitesse vent, direction vent, angle vent réel et pression atmosphérique). 
La partie du bas concerne l'envoi d'informations complètes. 

 

 

10.7.1.17.1 Export d'informations réduites 

Vous pouvez les paramétrer sur la partie haute de l'écran et concernent : 

l'heure (TU),  

la position,  

la vitesse du bateau,  

la vitesse fond,  

le cap fond,  

la vitesse du vent,  

la direction du vent,  

l'angle de vent réel  

la pression atmosphérique (si le bateau possède un capteur connecté au logiciel) 
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Transférer le nom du bateau : Le nom du bateau sera rappelé en début de fichier. Cette fonction est 

particulièrement utile si le destinataire des informations reçoit des données de plusieurs bateaux. 

Pour valider l'alimentation du fichier, cliquez sur "Générer fichier". La localisation du fichier est définie 

dans la zone "nom et localisation du fichier". Précisez le fichier qui sera ensuite envoyé 

automatiquement par votre application de mailing. 

 

Fréquence : c'est la fréquence à laquelle Adrena alimente le fichier. Si vous précisez 10 mn, Adrena 

créera une ligne d'informations toutes les 10 mn. 

Générer en tête : permet de placer un en tête dans le fichier pour rappeler la fonction de chaque 

colonne. 

 

Exemple de fichier généré : 

TRT Paprec 

UT;POS;BSP;SOG;COG;TWS;TWD;TWA;PRES 

161107 081614;4715.620,N,00223.000,W;5.50;5.26;284;8.8;87;164;0.00 

161107 081806;4715.510,N,00222.790,W;5.55;5.53;124;8.0;89;322;0.00 

 

Amortissement. 
Chaque donnée générée peut être une "photo" instantanée des informations (Amortissement = 

"aucun") ou une moyenne des dernières informations reçues (Amortissement = "Spécifique"), vous 

précisez alors la durée de la moyenne à effectuer, 5 mn par exemple pour moyenner les 5 dernières 

minutes de navigation.  

Dans le cas d'un amortissement spécifique la durée de moyennage est la même pour toutes les 

informations (sauf l'heure, la position, le chrono, l'état de la mer, les données génériques  et la 

configuration du bateau qui sont toujours envoyés en instantané). 

L'option "Comme à l'écran" reprend le moyennage individuel des informations tel qu'il a été défini dans 

"Amortissements" 
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10.7.1.17.2 Export d'informations complètes 

 

L'export d'informations complètes permet d'envoyer toutes les informations de navigation à terre. 

Cette fonction est particulièrement utile, si votre équipe à terre dispose d'Adrena pour relire ces 

informations. 

Les paramètres concernant les exports complets sont les même que pour les exports réduits (voir 

"Export d'informations réduites") plus une option permettant de compresser le fichier (un export 

compressé ne pourra être relu que par le logiciel Adrena). 

Exemple de volumes générés : 

Un fichier alimenté toutes les heures et envoyé une fois par jour a une taille d'environ 5 Koctets en 

mode non compressé et de 1 Koctets en mode compressé. 

Un fichier alimenté toutes les 10 minutes et envoyé une fois par jour a une taille d'environ 28 Koctets 

en mode non compressé et de 5 Koctets en mode compressé. 

 

Exemple de fichier généré : 

TCT "CALIXTE" "OPEN 60" 18.28 6.00 1 

$TANAV,095923,A,4715.945,N,00222.247,W,A,4.00,A,25,A,3.80,M,100,A,40,C,320,A,9.2,A,299,C,6.7,C,6.0,A,1.86,C,I,16/11/2007,11:59:56,-

1,FFFFFFFF000,IIIIII,IIIIIIIII,II,0.000,N,0.00,N,16.20,A,,,0,0 

$TANAV,160212,A,4727.863,N,00256.971,W,A,5.30,A,162,A,5.30,M,138,T,0,N,289,T,10.4,T,0,N,0.0,N,9.3,T,0.00,N,I,16/11/2007,12:23:06,-

1,FFFFFFFF000,IIIIII,IIIIIIIII,II,0.000,N,0.00,N,16.20,T,,,0,0 

$TANAV,160818,A,4727.346,N,00256.769,W,A,5.40,A,170,A,5.40,M,138,T,0,N,289,T,10.4,T,0,N,0.0,N,9.3,T,0.00,N,I,16/11/2007,12:23:16,-

1,FFFFFFFF000,IIIIII,IIIIIIIII,II,0.000,N,0.00,N,16.20,T,,,0,0 

$TANAV,161424,A,4726.793,N,00256.644,W,A,5.60,A,172,A,5.60,M,138,T,0,N,289,T,10.4,T,0,N,0.0,N,9.3,T,0.00,N,I,16/11/2007,12:23:26,-

1,FFFFFFFF000,IIIIII,IIIIIIIII,II,0.000,N,0.00,N,16.20,T,,,0,0 

$TANAV,162032,A,4726.233,N,00256.564,W,A,5.60,A,179,A,5.60,M,138,T,0,N,289,T,10.4,T,0,N,0.0,N,9.3,T,0.00,N,I,16/11/2007,12:23:36,-

1,FFFFFFFF000,IIIIII,IIIIIIIII,II,0.000,N,0.00,N,16.20,T,,,0,0 

$TANAV,162638,A,4725.684,N,00256.476,W,A,5.20,A,164,A,5.20,M,138,T,0,N,289,T,10.4,T,0,N,0.0,N,9.3,T,0.00,N,I,16/11/2007,12:23:46,-

1,FFFFFFFF000,IIIIII,IIIIIIIII,II,0.000,N,0.00,N,16.20,T,,,0,0 

 

10.7.1.17.3 Envoi par FTP 

Activez l'accès (case "Envoyer par ftp") et indiquez les paramètres d'accès qui vous ont été 

communiqués par le fournisseur du site : adresse du site, login et mot de passe. 

Attention : respectez scrupuleusement les minuscules / majuscules dans tous les champs. 

 

Envoi automatique 

Cochez la case "Auto" et spécifiez la fréquence d'envoi (la connexion Internet doit être ouverte en 

permanence). 
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Envoi manuel 

Lancez le menu "Outils→ Envoyer journaux sur FTP" chaque fois que vous souhaitez remonter les 

journaux (la connexion Internet doit être ouverte au préalable). 

 

 

10.7.1.17.4 Réception des exports à terre 

 

Les fichiers reçus à terre peuvent être visualisés sur un traitement de texte ou un tableur. 

Ils peuvent également être chargés manuellement ou automatiquement dans le logiciel Adrena. 

La procédure d'intégration dans Adrena est la même que pour la réception des informations 

concurrents, voir "Réception de la position des concurrents". 

 

10.7.1.18 Données génériques 

Ce sont les données qui peuvent être lues via les phrases NMEA XDR, à travers le logiciel "Deckman" ou sur 

certaines centrales (H-link ou autres). On y trouve des informations non disponibles dans les données 

standards NMEA : angle de mat, tension d'étai, gite du bateau, etc. 

Pour être disponibles, ces données doivent être paramétrées au préalable. Pour cela, lancez le menu 

"Paramètres→ Paramètres généraux", onglet "Données génériques". 
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Chaque donnée générique est caractérisée par son code (qui permet de la référencer dans la phrase XDR ou 

dans les données Deckman), sa provenance (XDR, Deckman ou autre), son nom, ses noms raccourcis (10 et 

6 caractères) pour remonter sur les centrales (module remontée info centrale), son unité, le nombre de 

décimales à afficher et la symétrisation  (on ne retient que la valeur absolue). 

Le plus simple, pour créer ces données, consiste à en faire une recherche systématique : 

Initialisation des données  XDR et des données Deckman 

Connectez le PC à la centrale et allumez celle-ci et/ou Deckman si vous l’utilisez. Cliquez sur "Scruter les 

entrées". Vous verrez alors apparaître les différentes données au fur et à mesure de leur lecture sur la (les) 

liaison(s) Deckman, NMEA et/ou H-Link. Lorsque la liste a fini de s'alimenter, cliquez à nouveau sur le 

bouton (qui s'appelle maintenant "Stopper scrutation"). 
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Tri de la liste 

Après avoir initialisé la liste, vous pouvez supprimer les données inutiles : sélectionnez les lignes 

correspondantes puis cliquez sur "Supprimer Donnée(s)". 

Compléter les informations 

Il est utile de compléter les caractéristiques des données lues. Pour modifier les données, double-cliquez sur 

la ligne correspondante. 

 

Modifiez ensuite le nom, les noms réduits, l'unité et le nombre de décimales à afficher. Le code ne peut être 

modifié car le lien avec la source serait perdu. 

Le coefficient d'affichage (coef.Aff) permet d'appliquer un coefficient à la donnée lue avant de l'afficher.  

Ex : appliquez un coefficient 1000 si les données sont reçues en bars et que vous désirez les afficher en 

millibars.  

N'oubliez pas d'ajuster les unités lorsque vous appliquez un coefficient à l'affichage. 

10.7.1.18.1 E-penons 

La détection des e-penons (penons électroniques Mer Agitée®) fonctionnent de la même façon que les 

données XDR. Dans le paramétrage, ajoutez la voile ou configuration de voile (Ris) associée afin d'alimenter 

automatiquement la configuration des voiles pendant la navigation. 
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Dans les données numériques, l'affichage des e-penons prend trois états :  

• Inactif 

• Laminaire 

• Turbulent 

 

10.7.1.19 Routage 
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Pertes aux virements 

Lors des calculs de routage, le logiciel calcule une perte chaque fois que le bateau doit virer ou 

empanner. Par défaut, cette perte est de 5 longueurs. Avec le module routage Pro, vous pouvez 

indiquer ici quelle perte subit le bateau sur chaque virement ou empannage (en longueurs de bateau). 

 

 

Sauver automatiquement chaque routage 

Si vous activez cette case, chaque routage calculé sera automatiquement sauvé sur disque (comme 

avec la fonction manuelle "Routage→ sauver un routage) avec le nom que vous lui avez donné. 

La fonction est automatique et écrase le fichier sans demande de confirmation s'il existe déjà. 

 

10.7.1.19.1 Outil de prise en compte des changements de voiles dans le routage 

 

10.7.1.19.2 Tableau de données 

Ouvrir le menu Paramètres → Paramètres Généraux → Routage et choisir pour le près et/ou le 

portant : 

_ GV pour indiquer la perte pendant les prises de ris 

_ Voiles d’avant pour indiquer la perte pendant les changements de voiles d’avant  

_ Configuration pour indiquer la perte pendant le passage d’une configuration à une autre (GV + 

voiles d’avant, ballast + matossage…) 

Attention! : Les voiles et configurations disponibles dans le tableau correspondent aux sailect qui 

sont activées pour le bateau et associée à la configuration de voile du bateau. 

Par exemple : le Code 0 apparaitra uniquement si la sailect Code 0 a été créé et que la voile n’a pas 

été signalée comme " débarquée " dans la configuration du bateau. 
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Un double clic dans chaque case permet d’indiquer le temps correspondant à la manœuvre. Le 

sens du changement de voile va de la ligne vers la colonne. 

 

 

10.7.1.19.3 Utilisation dans le routage 

La prise en compte des changements de voiles se trouve dans l’onglet " Paramètres de calcul " de 

la fenêtre de routage. En cochant cette case, le calcul du routage utilisera la vitesse du bateau et le 

temps défini à chaque changement de voile détecté à l’aide des sailect. 

Une route générant moins de changement de voile pourra être ainsi privilégiée par rapport à une 

route plus rapide mais plus couteuse en temps de manœuvre. 
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10.7.1.19.4 Etat de la mer 

 

 

 

Etat de la mer – définition de la mer croisée 

Le descriptif de la mer croisée est une notion spécifique au logiciel Adrena. Elle est très relative et 

dépend beaucoup de votre bateau. 

La mer croisée est calculée en comparant la mer du vent et le 1er train de houle.  

Indiquez la hauteur minimum de mer du vent ou de houle en dessous desquels, la mer croisée n'a pas 

d'importance. Ex : si vous spécifiez 1 mètre, la mer ne sera pas considérée comme croisée si aucun des 2 

types de vague n'est supérieur à 1m. 

Indiquez la hauteur relative minimum de la houle. Ex : si vous spécifiez 50%, la mer ne sera pas 

considérée comme croisée si la, houle fait moins de 50% de la mer du vent. 

Indiquez la fourchette d'angle entre lesquels la mer sera considérée comme croisée. 

 

Exemple : 

hauteur minimum : 1 mètre 

pourcentage : 50% 

angle entre la houle et la mer du vent : 45 et 135° 

la mer sera considérée comme croisée si : la houle mesure au moins 1m ; la mer du vent mesure au 

moins 1 m ; la houle mesure plus de 50 % de la mer du vent et l'angle entre la houle et la mer du vent 

est compris entre 45 et 135 ° 
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Etat de la mer - tableaux correctifs de houle 

 

Les différents trains de vague affectent la marche du bateau (mer du vent, trains de houle). 

 

Mer du vent : au large, on considère que la mer du vent est en phase avec le vent (on ignore les effets 

de côte pour lesquels on n'a très rarement de grib de vague). La polaire du bateau prend donc en 

compte cette mer et aucune correction n'est à effectuer. Si ce n’est pas le cas de la polaire utilisée, 

cocher la case correspondante : "la polaire ne prends pas en compte la mer du vent". Ainsi les tableaux 

correctifs de houle seront appliquées y compris lorsque la mer du vent est présente seule dans le 

fichier grib. 

 

1er train de houle : les tableaux correctifs de houle décrivent la façon dont la houle affecte la marche 

du bateau. 

 

Trains de houle suivants : ils sont ignorés 

 

Tableaux correctifs de houle 

Chaque tableau donne, pour une force de vent donnée, le pourcentage à appliquer à la vitesse cible en 

fonction de la hauteur et de la direction de la houle par rapport au bateau. Ce pourcentage tourne 

autour de 100% (100% = aucune correction sur la vitesse cible brute). 

Vous pouvez créer le nombre de tableaux que vous souhaitez. Entre 2 forces de vent définies dans un 

tableau, Adrena effectuera une interpolation. 

Pour créer un tableau, cochez la case "validation", saisissez la force de vent décrite par le tableau et 

cliquez sur "Modifier". 

Pour une hauteur de 0m : la correction est toujours de 100% (pas de houle donc pas d'incidence sur la 

polaire). Pour les hauteurs plus élevées, le pourcentage est inférieur à 100% lorsque la houle vient de 

l'avant (le bateau est freiné) et généralement (mais pas toujours) légèrement supérieur à 100% lorsque 

la houle vient de l'arrière (le bateau est aidé). 
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Chaque ligne correspond à un angle d'orientation de la houle par rapport à la route du bateau : 0° 

correspond à une houle de face, 90°, une houle de côté au vent  et 180° à une houle se présentant par 

l'arrière du bateau. 

Les angles de  180 ° à 0° correspondent à un train de houle arrivant sous le vent, par exemple 270° est 

un train de houle arrivant de côté sous le vent du bateau. 

Cela permet de différencier l’impact de la houle au vent et sous le vent. 

 

Pour modifier la liste des hauteurs de houle  présentes en colonne, cliquez sur le bouton "Hauteurs". 

Pour modifier la liste des orientations de houle, cliquez sur le bouton "Orientations". 

Saisissez ensuite la valeur de correction dans chacune des cellules. 

Il est possible de modifier globalement un groupe de cellules en sélectionnant les cellules à modifier 

puis en cliquant sur les boutons de pourcentage qui vont affecter les cellules correspondantes. 

Une fois les modifications effectuées, cliquez sur "Valider". 
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10.7.1.20 Connexion internet 

 

Si votre connexion internet passe par l’intermédiaire d’un proxy, indiquez les caractéristique de ce proxy 

dans la fenêtre Paramètres → Paramètres généraux→ Connexion internet 

 

 

10.7.1.21 Coordonnées utilisateur 

Cette section permet de mettre à jour vos coordonnées dans le logiciel 
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10.7.2 Alarmes 
Les alarmes vous permettent d'être prévenu de tout changement intervenant dans les données lues sur 

la centrale et le GPS ou calculées par le logiciel.  

Adrena dispose de : 

10 alarmes paramétrables sur toutes les données lues sur la centrale et le GPS ou calculées par le 

logiciel, 

une alarme de proximité de la côte  

une alarme de proximité de zone dangereuse 

une alarme AIS  

une alarme de mouillage 

une alarme de réception d'information sur la position des concurrents 

une alarme de réception de mail 

 

Lorsqu'elle se déclenche, une alarme se présente sous la forme suivante, accompagnée ou non d'un 

signal sonore : 
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10.7.2.1 Paramétrage des alarmes 

Lancez le menu "Paramètres→ alarmes" 

 

 

 

 

La colonne "valide" permet de valider ou dévalider chaque alarme. 

Limite : valeur à surveiller. L'unité est automatiquement ajustée au type de donnée choisie. 

 

Tempo : permet d'éviter qu'une alarme ne se déclenche trop souvent. Si vous spécifiez 10s l'alarme ne 

se déclenchera que si la condition se réalise pendant plus de 10 s consécutives. 
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Son : lorsqu'une alarme se déclenche, elle se présente sous forme d'un message à l'écran accompagné 

ou non d'un son. Vous pouvez personnaliser le son de chaque alarme en choisissant parmi la liste 

standard (17 sons fournis) ou en intégrant un autre son. Pour intégrer un autre son, sélectionnez 

"autre" dans la liste et choisissez un fichier de type ".wav". Le son intégré sera ensuite proposé chaque 

fois que vous ouvrirez la liste de sons. 

 

nb sons : vous pouvez choisir le nombre de sons émis par chaque alarme lorsqu'elle se déclenche. 

Chaque son est émis une fois par seconde. Pour un son permanent, choisissez une valeur très élevée 

(10 000 par exemple). La valeur 0 rend l'alarme silencieuse 

 

exe : vous pouvez spécifier un programme à lancer lorsque l'alarme se produira. Tout programme 

Windows peut être lancé (déclenchement d'une sirène, action mécanique extérieure, etc...) Pour 

indiquer le programme, double cliquez sur la zone puis parcourez les répertoires pour spécifier le 

programme à lancer. 

Vous pouvez également spécifier un fichier de type .doc, .xls ou autre. Dans ce cas le fichier désigné 

sera ouvert avec le programme approprié (feuille Excel par exemple). 

Pour effacer le programme exécutable associé à une alarme, cliquez sur l'icône  situé à droite de la 

zone exe. 

 

Test : le bouton permet de provoquer une alarme fictive et de vérifier l'affichage et la sonorité de 

l'alarme. 

 

10.7.2.2 Les différents types d'alarmes 

10.7.2.2.1 Alarmes sur tous types de données 

La colonne "information" permet de choisir l'information à surveiller. Double cliquez dans la case pour 

accéder aux données. Vous avez accès à plus de 100 données différentes décrites dans les chapitres ci-

dessous : 

Annexe - Les données de vent 

Annexe - Les données de performance 

Annexe - Les données recherche de meilleurs VMG et CMG 

Annexe - Les données de navigation 

Annexe - Les données liées au départ 

Annexe - Les données liées aux laylines 

Annexe - Les données relatives au bord en cours 

Annexe - Les données relatives au bord suivant 
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Annexe - Les données diverses 

 

10.7.2.3 Alarmes sur les bateaux trackés 

Les alarmes programmées peuvent réagir sur les données que vous recevez des bateaux sur lesquels le 

tracking AIS est activé. Pour cela choisissez le bateau tracké dans la liste déroulante au moment de choisir 

la donnée de l'alarme. 

 

 

10.7.2.3.1 Surveillance des côtes 

L'alarme de surveillance des côtes se déclenchera lorsque la route fond du bateau le conduit à couper 

une côte dans moins de N minutes. 

 

10.7.2.3.2 Zones dangereuses 

L'alarme de dangers se déclenchera lorsque la route fond du bateau le conduit à couper une zone 

dessinée par vos soins et déclarée dangereuse dans moins de N minutes. Le dessin de ces zones se fait 

dans l'outil de RoadBook (voir LES ROADBOOKS). 

 

10.7.2.3.3 AIS 

L'alarme AIS est disponible si vous possédez ce module ainsi qu'un récepteur AIS. Elle se déclenchera si 

un navire émetteur AIS croise votre route à moins de N Milles de votre bateau (voir le chapitre "Mise 

en place d'une alarme AIS") 
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10.7.2.3.4 Informations sur les concurrents 

L'alarme de réception d'information "concurrents" se déclenchera lorsqu'un fichier (reçu généralement 

par mail) de positions des concurrents a été automatiquement lu par le logiciel. 

 

10.7.2.3.5 Zone de mouillage 

Au mouillage, on peut indiquer le rayon dans lequel le bateau peut éviter. Si Adrena détecte que la 

position GPS du bateau sort de cette zone, l’alarme est déclenchée. 

 

10.7.2.3.6 Réception de mails 

L'alarme de réception d'information de mail se déclenchera lorsqu'un mail ne comportant pas 

d'information sur les concurrents a été reçu dans le répertoire surveillé par le logiciel. Voir le chapitre 

Réception de la position des concurrents 

 

La colonne "conditions" permet d'indiquer la condition à surveiller :  

"inférieur à" : l'alarme se déclenchera lorsque la valeur passe en dessous de la limite spécifiée. Ex : 

distance à la layline inférieure à 10 longueurs. 

"supérieur à" : l'alarme se déclenchera lorsque la valeur passe au-dessus de la limite spécifiée. Ex : 

vitesse vent supérieure à 30 nds. 

"varie de plus de". l'alarme se déclenchera lorsque la valeur varie en plus ou en moins de la limite 

spécifiée. Ex : Cap vent varie de plus de 10° : si le vent est au 355° lors de l'activation de l'alarme, celle-

ci se déclenchera dès que le vent passe au-dessus de 05° ou en dessous  de 345°. 

 

10.7.2.4 Acquittement d'une alarme 

 

Lorsqu'une alarme se déclenche, elle se présente sous la forme suivante : 

 

 

 

Si elle est sonore, vous pouvez la faire taire en cliquant sur "Silence". Si vous cochez "dévalider 

l'alarme" avant de la fermer; l'alarme sera dévalidée jusqu'à ce que vous la revalidiez (menu 

paramètres→ alarmes). 
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Dans le cas contraire elle reste active. Dans le cas ci-dessus, l'alarme attendra silencieusement que le 

fond redescende en dessous de 10m puis recommencera la veille pour se déclencher à nouveau si le 

fond remonte au-dessus de 10m. 

Dans le cas d'une alarme relative ("varie de plus de"), la référence autour de laquelle est surveillée la 

valeur est remesurée au moment où vous fermez l'alarme. 

 

Alarme de côte : l'alarme de côte surveille la présence de côte en avant du bateau. Si vous programmez 

une alarme de côte à 30 mn, elle se déclenchera dès qu'une côte ou un danger est présent à moins de 

30 mn de votre bateau (en fonction de votre route fond). 

 

Les côtes surveillées par Adrena sont celles fournies dans le "Trait des côtes du Shom" livré en standard 

avec le logiciel. Ce trait des côtes possède une couverture mondiale mais ne référence pas tous les 

"cailloux" dangereux. 

MOB : force l'augmentation du volume du PC au maximum en cas de déclenchement d'un MOB 

 

BIEN QU'AMELIORANT CONSIDERABLEMENT LA SECURITE, SPECIALEMENT POUR UN COUREUR EN 

SOLITAIRE, CE N'EST PAS UN OUTIL INFAILLIBLE. IL CONVIENT DONC D'ASSURER UNE VEILLE 

SUFFISANTE EN TOUTE CIRCONSTANCE.  

10.7.3 Détection automatique des liaisons 
 

Si vous ne connaissez pas les ports de communication utilisés par vos instruments, Adrena peut les 

détecter automatiquement. Pour cela : 

connectez le GPS, l’AIS et la centrale au PC et mettez-les en route. 

cliquez sur 'Détection automatique" 
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Le logiciel affiche l'ensemble des liaisons présentes sur le PC et les données qui se présentent sur 

chacune d'entre elle, ce qui lui permet d'identifier la centrale, le GPS et l'AIS. Les différentes vitesses de 

liaisons sont scrutées (4800 dans un premier temps car c'est la vitesse standard NMEA, les autres 

ensuite). 

Lorsqu'il a terminé, cliquez sur "Fermer". Le logiciel affichera les liaisons reconnues et paramétrera les 

liaisons en conséquence. 

 

10.7.4 Réinitialiser les liaisons 
 

Permet de relancer la communication entre le logiciel et les instruments en cas de défaillance des ports de 

communications. 

 

10.7.5 Centrer sur anti-méridien 
 

Modifie l’affichage de la cartographie pour être centrée sur l’anti-méridien. La prise en compte de ce 

paramètre nécessite le redémarrage du logiciel. 

10.7.6  Sauvegarde  et restauration 
L’outil de sauvegarde permet d’exporter tout ou partie des paramètres et fichiers du logiciel pour les 

conserver ou les restaurer sur un autre ordinateur. 

 

10.7.6.1 Sauvegarde 

L’accès à l’interface se fait par le menu Paramètres → Sauvegarder Paramètres. Il est possible de choisir 

une sauvegarde sous la forme d’un fichier local ou dans le Cloud Adrena (compte premium uniquement). 
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Pour faire une sauvegarde complète cliquer sur "Tout sélectionner" ou bien de choisir les éléments à 

sauvegarder dans chaque catégorie. 

Par exemple, la sauvegarde des cartes C-Map peut être générée en choisissant dans la catégorie "Fichiers" 

l’option "Cartes C-Map" : 

 

 

 

Toutes vos cartes C-Map et vos codes seront sauvegardés et pourront être ainsi restaurés sur un nouvel 

ordinateur. 

A la fin de la création du fichier de sauvegarde compressé, le logiciel propose l’enregistrement du fichier à 

l’emplacement de votre choix (disque dur, clé USB, PC…) 
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Note pour les utilisateurs Premium: chaque élément sauvegardé sur le cloud remplace chaque élément du 

même type. Par exemple si un fichier waypoint.wp est déjà présent sur le cloud, il sera remplacé si on 

sauvegarde à nouveau les fichiers de waypoint.  
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10.7.6.2 Restauration 

La restauration peut être lancée à partir d’un fichier local ou du cloud Adrena (compte premium 

uniquement) en utilisant le menu Paramètres → Restaurer Paramètres. 

 

 

 

Il est alors possible de tout restaurer ou de choisir parmi les éléments disponibles dans la sauvegarde ceux 

que l’on veut importer 

 

 

 

Par exemple, la section " Fichiers " cette sauvegarde contient des cartes C-Map, on peut  choisir de les 

restaurer sans sélectionner les paramètres des autres sections. Les cartes C-Map seront alors recopiées et 

activées sur l’ordinateur. 



420 
 

Attention ! Chaque fichier restauré remplace chaque fichier déjà présent portant le même nom. Par exemple 

si un fichier waypoint.wp est déjà présent sur l’ordinateur, il sera remplacé si on restaure un fichier nommé 

waypoint.wp 

10.7.6.3 Partage de sauvegarde dans le cloud 

Une des fonctions du cloud est de permettre le partage de données entre utilisateurs. Pour cela il faut 

autoriser un deuxième dongle à accéder aux éléments sauvegardé sur son propre cloud. 

 

10.7.7 Configuration du cloud partagé 
Accéder au menu Paramètres → Configuration du cloud partagé→ Partage du cloud 

 

 

 

Activer le partage du cloud et cliquer sur "Ajouter" dans la section utilisateurs pour entrer l’identifiant 

matériel du dongle à autoriser. Cet identifiant se trouve sur la carte Premium du propriétaire du dongle. 

L’utilisateur du dongle autorisé peut alors télécharger et installer les données contenues dans la 

sauvegarde partagée. En revanche, il ne peut pas écrire dans la sauvegarde du cloud auquel il accède. 
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10.7.7.1 Restauration depuis une sauvegarde partagée 

 

Pour restaurer une sauvegarde partagée, procéder comme pour la restauration depuis son propre cloud et 

choisissez dans la section "Choix du cloud" le cloud à utiliser : 

 

Attention ! Chaque fichier restauré remplace chaque fichier déjà présent portant le même nom. Par exemple 

si un fichier waypoint.wp est déjà présent sur l’ordinateur, il sera remplacé si on restaure un fichier nommé 

waypoint.wp 
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10.7.7.2 Renoncer un accès au cloud 

Un utilisateur ayant un accès à un cloud partagé peut le désactiver en utilisant le menu Paramètres → 

Configuration du cloud partagé → Accès au cloud partagés 

 

 

 

Sélectionner le cloud partagé et cliquer sur "Renoncer". 

 

10.7.8 Reset Paramètres 
Le menu "Outil → Reset Paramètres" permet de réinitialiser tout ou partie des paramètres du logiciels. 

Cela peut être utile lors de disfonctionnement lié à de mauvais réglages ou pour retrouver la 

configuration par défaut.  

Pour réinitialiser un ou plusieurs paramètre(s), cochez les cases correspondantes et validez. Il vous sera 

demandé de redémarrer Adrena pour prendre en compte les modifications. 
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10.8 Le journal de bord 
Adrena tient un journal de bord en enregistrant toutes les minutes : la position, la vitesse et le cap du 

bateau (sur le fond) ainsi que la vitesse et la direction du vent. 

Vous pouvez y ajouter vos propres observations. 

 

10.8.1.1 Saisir une observation dans le journal de bord 

 

Lancez le menu "Journal de bord→ Saisir une observation".  

 

Saisissez le commentaire et validez. 

 

 

10.8.1.2 Visualiser le journal de bord 

 

Lancez le menu "Journal de bord→ Consulter".  
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Choisissez la période que vous souhaitez (une journée seule et entière ou une fourchette de dates et 

d'heures). 

 

 

Le journal de bord est affiché sur la période spécifiée.  

Vous pouvez ensuite changer cette période ("Autres dates") et exporter le journal vers un tableur 

("Export"). 

 

10.8.1.3 Imprimer le journal de bord 

Après avoir visualisé le journal de bord, vous pouvez l'imprimer avec le bouton "Imprimer". 

10.9 Outils 
10.9.1.1 Déclenchement de la procédure "homme à la mer" 

La fonction "homme à la mer" se déclenche avec l'icône  situé en haut de la toolbar d'outils (à 

gauche de l'écran) ou par le menu "Outils→ MOB→ Déclencher MOB". 

 

10.9.1.1.1 Recherche de l'équipier 

Lorsque vous topez cette fonction, un waypoint est automatiquement créé sur la position du bateau, 

une fenêtre d'information spécifique apparaît en haut à droite de l'écran et une alarme est générée. 
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La bouée située sur la carte désigne la position où est tombé l'équipier. 

La flèche noire (orientée ici à  l'est / sud-est) représente la dérive qu'est supposé avoir suivi l'équiper 

depuis sa chute.  

 

 

 

La fenêtre d'informations indique:  

L’origine du déclencheur (manuel, balise sart, instrument nmea, seabelt) 

le cap jusqu'au lieu de chute 

la distance en milles et en mètres jusqu'au lieu de chute 



426 
 

 

Note : la dérive est calculée par rapport au courant mesuré sur la centrale. Elle est donc très 

fortement liée à la calibration de votre centrale et doit être interprétée avec beaucoup de prudence. 

 

10.9.1.1.2 Annulation de la procédure "homme à la mer" 

Pour annuler la procédure, cliquez à nouveau sur l'icône  (qui est maintenant barré) ou lancez le 

menu "Outils→ MOB→ Fin MOB". 

 

Après avoir annulé la procédure la fenêtrez d'information disparaît de l'écran mais le waypoint MOB 

subsiste et il peut être géré comme les autres waypoints. 

 

Vous pouvez relancer la procédure en cliquant à nouveau sur l'icône, ce qui définira un nouveau lieu de 

chute ou en lançant le menu "Outils→ MOB→ restaurer MOB", ce qui réactivera le dernier lieu de 

chute. 

 

10.9.1.1.3 Emetteurs "homme à la mer" 

Certains équipements de détection d'homme à la mer peuvent être interfacés à Adrena à travers une 

liaison NMEA. Il s'agit des équipements NKE et "Man OverBoard Seabelt". 

Ces équipements déclenchent une alarme d'homme à la mer sur Adrena s'ils sont connectés par liaison 

NMEA. La liaison peut se faire soit par la liaison "Centrale" (voir Liaisons avec les instruments), soit par 

l'une des liaisons supplémentaires (voir Liaisons supplémentaires). 

 

10.9.1.1.4 Emetteurs SART-AIS 

Si vous disposez d'un récepteur AIS et qu'un émetteur SART-AIS est reçu par Adrena, une procédure 

d'homme à la mer sera automatiquement déclenchée. La position émise par l'émetteur rafraichit en 

permanence la position de l'homme à la mer. 

 

10.9.1.2 LES DATAGRAMMES 

Les datagrammes permettent d'anticiper la navigation entre le bateau et un point donné ou sur un 

parcours complet. 

Ils anticipent soit les effets de l'évolution du courant lus sur un atlas ("Datagramme") soit l'évolution du 

courant lus sur un atlas et du vent lus sur un Grib (Datagramme sur Grib). 

Les données affichées par un datagramme concernent le timing, la durée, le courant, la marée, le vent 

et les voiles à porter. 
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10.9.1.2.1 Datagramme jusqu'à un point du plan d'eau 

 

Pour afficher le datagramme du bateau jusqu'à un point donné, faites un clic droit sur le point à 

atteindre et choisissez "Datagramme→ <donnée à afficher>" 

 

 

Le datagramme affichera les données demandées du bateau au point cliqué : 

 

10.9.1.2.2 Timing    
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10.9.1.2.3 Courant 
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10.9.1.2.4 Marée         

  

 

10.9.1.2.5 Vent surface 

  

 

Pour connaitre la valeur d'une donnée ainsi que le timing associé à chaque point du datagramme, 

approchez la souris du point en question. 

 

 

Le datagramme sur grib est accessible dès lors que vous avez chargé un grib valide sur la zone et la 

période concernée. Procédez de la même manière que pour un datagramme sur courant (Menu 

"Datagramme sur Grib"). 
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10.9.1.2.6 Datagramme en cours 

Le datagramme en cours couvre la zone du bateau au waypoint actif ou le bateau et la portion de 

parcours restant à parcourir lorsqu'un parcours est actif. 

Pour afficher le datagramme en cours, lancez le menu "outils→ Datagrammes → Datagrammes en 

cours". 

Pour afficher le datagramme en cours sur Grib, lancez le menu "outils→ Datagrammes → Datagrammes 

en cours sur Grib". 

 

10.9.1.2.7 Datagramme sur parcours 

Le datagramme sur parcours permet d'anticiper une situation depuis un point donné et sur l'ensemble 

d'un parcours (qui n'est pas forcément actif). Cela peut être utile pour étudier les évolutions du vent ou 

du courant prévues pour le lendemain. On peut comparer un tel datagramme à un "routage en ligne 

droite". 

Pour afficher un datagramme sur parcours, lancez le menu "'Outils→ Datagrammes→ Datagramme 

parcours→ <donnée à afficher→". Sélectionnez ensuite le parcours et le 1er waypoint à passer. 

 

 

Choisissez ensuite la date et le lieu du point de départ '"maintenant" et "ici" si vous naviguez. 
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10.9.1.2.8 Effacer le datagramme à l'écran 

Pour effacer le datagramme présent à l'écran, lancez le menu outils→ Datagrammes → Effacer 

datagramme" ou faites un clic droit sur le plan d'eau et choisissez "Effacer datagramme". 

10.9.1.3 FTP 

Voir chapitre 10.7.1.15 FTP 

10.9.1.4 Simulation Centrale 

Permet de simuler la présence des instruments lorsque l’ordinateur n’est pas connecté à une centrale de 

navigation. 
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10.9.1.5 Le mode "estime" 

Le mode estime permet, si le GPS perd le contact avec les satellites ou que le logiciel perd le contact 

avec le GPS, de tenir à jour la position du bateau à partir de la vitesse speedo et du cap compas. Cela 

suppose bien entendu, que vous disposiez d'un speedo et d'un compas électronique (le compas 

électronique fait notamment partie des éléments du pilote automatique). 

 

10.9.1.5.1 Passage en mode "estime" 

Si le logiciel perd le contact avec le GPS, il passe automatiquement en mode "estime". Cela se traduit à 

l'écran, par l'affichage d'un avertissement clignotant orange en haut à droite de la cartographie. Les 

données numériques de position se mettent également à clignoter. 

 

10.9.1.5.2 Recalage pendant le mode estime 

Lorsque vous êtes en mode estime, vous pouvez recaler la position, soit en saisissant une position 

connue, soit en cliquant sur la carte. Pour recaler l'estime, lancez le menu "Outils→ Estime" 

 

 

 

Pour recaler sur une position connue (par exemple par rapport à un GPS portable non connectable au 

PC), saisissez la position lue sur le GPS. 

 

Pour recaler la position par rapport à une bouée ou un autre élément auprès duquel vous passez, 

cliquez sur le point d'interrogation (la boite de dialogue s'efface pour laisser place à la carte) et cliquez 

sur l'élément correspondant de la carte. 

 

10.9.1.6 Copie d’écran 

Permet de réaliser des copies l’écran complet (fenêtre entière) ou de l’écran actif (cartographie) et de les 

sauver : 

_ dans le presse-papier 

_ dans un fichier 

_ dans un email 
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10.9.1.7 Reinstaller les drivers du dongle (dépannage) 

Outil d’installation des drivers permettant la reconnaissance des dongles de licence Adrena  

10.9.1.8 Forcer la communication avec Deckman (dépannage) 

Permet de forcer la communication avec le logiciel Deckman lorsque ce dernier est utilisé pour 

communiquer avec la centrale de navigation 

10.10 Diagnostics 
 

10.10.1.1 Visualisation des données (entrées/sorties) 

Outil de visualisation des données lues et envoyées par le logiciel avec les instruments. Permet de contrôler 

le contenu des échanges Logiciel/Instruments 

10.10.1.2 Log NMEA 

Permet de créer un fichier à partir des données NMEA entrantes et de le sauver dans le répertoire : C : 

Program Data/ Adrena/ Bateau/ " nom du bateau actif " / Log NMEA 

10.10.1.3 Gestionnaire de licence 

Permet d’ouvrir le logiciel de gestion de licence (Adrenalink) afin d’afficher les informations de licence du 

dongle connecté.  

Adrenalink permet également de mettre à jour un dongle à partir d’un fichier type " erc " délivré par 

Adrena 

 

 

 

10.10.1.4 Test dongle (dépannage) 

A utiliser uniquement sur demande du support technique Adrena 

10.10.1.5 Répertoire Adrena 

Raccourci vers le répertoire d’installation du logiciel 

10.10.1.6 Répertoire bateau 

Raccourci vers le répertoire du bateau actif dans le répertoire d’installation du logiciel 
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10.10.1.7 Mise à jour des droits 

A utiliser uniquement sur demande du support technique Adrena 

 

10.10.2 Aide 
10.10.2.1 Manuel de référence 

Accès rapide au manuel du logiciel (également accessible avec la touche F1) 

10.10.2.2 Mises a jour 

A chaque démarrage, et si vous disposez d'une connexion Internet, le logiciel recherche la présence 

d'une nouvelle version sur le site Adrena. Si c'est le cas, il vous le signale et vous propose de l'installer. 

Vous visualisez la liste des évolutions entre la version dont vous disposez et la version disponible en 

téléchargement 

 

 

 

Si vous ne souhaitez plus être averti des nouvelles mises à jour, cochez la case "'Ne plus chercher les 

nouvelles versions". Ce choix pourra être rétabli par la suite en allant dans le menu "Paramètres→ 

Paramètres généraux", onglet "Divers". 

Pour installer la nouvelle version, cliquez sur "Télécharger". Le logiciel détectera alors les modules à 

télécharger en fonction de la version en cours et de la version à télécharger. 

Note : seules les mises à jour "importantes" sont automatiquement signalées. Si vous souhaitez 

consulter la dernière version disponible (même peu importante) ou si vous avez dé validé la recherche 

de nouvelles versions, vous pouvez lancer le menu "Aide→ Rechercher les mises à jour". 
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10.11 Demande d'assistance 

Pour demander une assistance au support Adrena, adressez un mail à l'adresse support@adrena.fr. 

Si vous disposez d'une messagerie connectée à Internet sur votre PC, Vous pouvez envoyer 

automatiquement votre mail depuis Adrena. Pour cela, lancez le menu "Aide→ Demande d'assistance" 

qui générera un e-mail et l'enverra au support technique Adrena. 

 

Joindre fichier de configuration : il est recommandé de joindre le fichier de configuration de votre 

logiciel qui nous permettra de connaître les paramètres utilisés. Cela nous aidera à résoudre le 

problème ou à répondre à votre question. Pour cela, laissez cochée la case "Joindre fichier de 

configuration". Adrena intégrera automatiquement le fichier dans l'envoi mail. 

Joindre fichier de logs NMEA : le fichier de log NMEA est la trace de toutes les informations reçues de 

la centrale et/ou du GPS. Il est disponible si vous avez validé l'enregistrement des logs NMEA lors de 

l'une de vos navigations (sur nos conseils en général). Ce fichier peut nous aider à résoudre certains 

problèmes de communication avec les instruments. 

Joindre un fichier de trace : il peut également être utile de joindre une ou des traces enregistrées au 

cours de vos navigations. Pour cela, cliquez sur le bouton "Joindre un fichier de trace". L'ensemble des 

fichiers enregistrés vous sera proposé. Ces fichiers sont de la forme "02_10_2008_a.trz", ce qui 

correspond à la date de début d'enregistrement (ici le 2 octobre 2008). 

Pour joindre plusieurs fichiers, cliquez successivement sur chacun d'entre eux en maintenant la touche 

ctrl enfoncée. 

Terminer en cliquant sur "Envoyer e-mail", le mail sera constitué et confié à votre messagerie. Il vous reste 

à poser votre question ou décrire le problème dans le corps du message et à envoyer l'e-mail. 
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11 ANNEXE 
11.1 Annexe - Phrases NMEA utilisées en entrée 
11.1.1 Phrases en provenance du GPS 
 

Position : GLL, RMA, RMC ou GGA 

Certains GPS permettent de paramétrer la précision (centièmes, millièmes ou plus). Si plusieurs phrases 

gèrent la position, Adrena choisira celle qui offre la meilleure précision. 

 

Route fond (cap et vitesse): RMA, RMC ou VTG 

 

Heure UTC : ZDA, GLL, RMC ou GGA 

Utilisé pour recaler l'heure (sert notamment au calcul des marées et des courants) 

 

Qualité réception (non, normal ou différentiel) : GGA 

 

Waypoint en cours : RMB 

 

Réception des waypoints: WPL 

 

Réception des routes : RTE 

 

 

11.1.2 Phrases en provenance de la centrale 
 

Vitesse bateau : VHW  

 

Cap compas : HDM ou VHW 

 

True wind dir (cap vent surface): MWD 

 

Angle vent réel : VWT ou MWV 
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Vitesse vent réel : MWD, VWT ou MWV 

 

Angle Vent apparent : VWR ou MWV 

 

Vitesse apparent : VWR ou MWV 

 

VMG : VPW 

 

Profondeur : DBT ou DPT 

 

Température de l'eau : MTW 

 

Température de l'air : MTA 

 

Pression atmosphérique : MMB 

 

Phrases Nmea manquantes 

Certaines phrases peuvent ne pas être fournies par la centrale : 

si la vitesse du bateau est absente, elle est recalculée sur la vitesse fond 

si le vent réel est absent, il est recalculé à partir de la vitesse du bateau, du cap compas et du vent 

apparent. 

si le vent apparent est absent, il est recalculé à partir de la vitesse du bateau, du cap compas et du vent 

réel. 

si la direction du vent surface (true wind dir) est absente, elle est recalculée à partir de la vitesse du 

bateau, du cap compas et du vent réel. 

si le VMG est absent, il est recalculé à partir de la vitesse du bateau, du cap compas et du vent réel. 

 

Ces calculs peuvent être forcés même si l'information est présente. Voir le chapitre "Calcul de données 

par le logiciel" 

 

Le courant est toujours calculé à partir de la vitesse du bateau, du cap compas et de la route fond.  

 



438 
 

11.2 Annexe - Liste des touches raccourci 
 

Scroll et zoom (carto, Sailect, polaires) 

 

flèches droite / gauche / haut / bas : scroll 

page avant / page après : zoom avant / zoom arrière 

les mêmes avec shift enfoncé : même effet mais atténué 

les mêmes avec ctrl enfoncé : même effet mais amplifié 

home : recentrage par défaut 

 

Touches de fonction simples 

F1 : aide en ligne sur le logiciel 

F2 : (carto) basculement entre carte / trait des cotes / trait des côtes du Shom / profil de côtes 

F3 : (carto) afficher / cacher les prévisions météo 

F4 : (carto) orienter carte au nord / orienter carte sur départ ou parcours (banane) 

F5 (carto) : prévisions météo : reculer d'un pas 

F6 : (carto) : prévisions météo : avancer d'un pas 

F7 : toper bouée sous le vent 

F8 : toper bouée ligne 

F9 : toper bateau comité 

F11 : recentre l'écran autour du bateau 

 

Touches de fonction avec touche contrôle enfoncée 

ctrl-F1 : recentrage de l'écran sur le globe 

ctrl-F5 : (carto) : prévisions météo : animation arrière 

ctrl-F6 : (carto) : prévisions météo : animation avant 

ctrl-F8 : copie écran (fenêtre active) vers le presse-papier 

ctrl-F11 : active l'affichage par défaut de la phase de parcours en cours 

Touches de fonction avec les touches contrôle et shift enfoncées 

ctrl-shift-F1 : lancement du replay de démo / fin du replay 

ctrl-shift-F8 : copie écran (application complète) vers le presse-papier 
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ctrl-shift-Z : affichage des timers de diagnostic 

 

11.3 Annexe - Nommage automatique des routages 
 

Pour nommer automatiquement les routages en fonction des paramètres utilisés : 

ouvrir le fichier Adrena\Adrena.ini 

dans la section [routage], chercher l'entrée de la forme nomAuto="XXXX" et modifiez là avec les 

conventions ci-dessous (on peut ajouter du texte ou des séparateurs entre les codes) : 

 

%g1 à %g10 : nom du Nième GRIB si présent (complet) 

%G1 à %G10  : nom du Nième grib si présent (alphabétique uniquement) 

%w1 à w10 : pourcentage vitesse vent du Nième grib si présent (y compris le caractère %) 

%P : nom polaire 

%p : pourcentage polaire (y compris le caractère %) 

%sY : année début routage (aaaa) 

%sy : année début routage (aa) 

%sm : mois début routage 

%sd : jour début routage 

%sH : heure début routage 

%sM : minute début routage  

%sS : seconde début routage 

%cY : année création (aaaa) 

%cy : année création (aa) 

%cm : mois création 

%cd : jour création 

%cH : heure création 

%cM : minute création 

%cS : seconde création 

%%  : % 
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11.4 Annexe - Les données de vent 
 

 

 

Vent surface - vitesse 

vitesse du vent tel que mesuré sur la centrale sans correction du courant. 

 

Vent surface - direction 

direction du vent tel que mesuré sur la centrale sans correction du courant. 

 

Vent fond - vitesse 

vitesse du vent corrigé de la valeur du courant 

C'est le vent qui serait mesuré par un bateau ancré sur le fond ou par une station météo située à terre. 

Le courant est  mesuré sur la centrale. 

 

Vent fond - direction 

vitesse du vent corrigé de la valeur du courant 
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C'est le vent qui serait mesuré par un bateau ancré sur le fond ou par une station météo située à terre. 

Le courant est  mesuré sur la centrale. 

 

Vent réel - vitesse et angle 

vitesse ou angle du vent 

Il s'agit de la même grandeur que le vent surface (même force) mais mesuré par rapport à l'axe du 

bateau et non pas par rapport au nord. 

 

Vent apparent - vitesse et angle 
vitesse ou angle du vent mesuré sur la centrale. 

C'est le vent réellement perçu par le bateau compte tenu de sa vitesse. 

 

Tendance vent 

C'est la différence (en angle) entre l'axe du vent et un angle de référence que vous définissez. 

Une orientation de 0° indique un vent neutre. Une orientation positive indique un vent venant de la 

droite de la référence, une orientation négative indique un vent venant de la gauche de la référence. 

 

Pour définir la référence, lancez le menu "Outils→ Recaler tendance vent" (voir chapitre Recalage de la 

tendance du vent). 

 

Vent GRIB 

C'est la valeur prévue par un fichier GRIB à la position du bateau à chaque instant. 

Cela permet de comparer (notamment dans un histo-graphe) le vent prévu et le vent mesuré. 

Si plusieurs GRIB ont été chargés, c'est le GRIB principal qui est utilisé, c'est à dire celui dont le nom est 

marqué par une étoile dans le menu des prévisions. 

 

 

Vent moyenné 
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En plus des différentes valeurs de vents proposées par Adrena (vent surface, vent fond, vent réel et vent 

apparent), Adrena propose les données de vent moyennées sur une période paramétrable. Les données 

concernent la vitesse et la direction du vent surface. 

Vous accédez à la vitesse et à la direction du vent moyen (il s'agit du vent surface) en valeurs moyenne min 

et max sur la période. 

Le calcul se fait par moyennage des valeurs rencontrées pendant la période dans lesquelles on retire les 

valeurs extrêmes qui pourraient perturber les valeurs (notamment pendant les virements de bord). 

Le paramétrage des valeurs de moyennage se fait par le menu "Paramètres→ Paramètres généraux", 

onglet "TactiquePro", zones "moyennage et filtrage vent". 

 

 

 

11.5 Annexe - Les données de performance 
 

 

 

Vitesse  

Vitesse lue sur le speedomètre (ou sur le GPS : voir chapitre Calcul de données par le logiciel), 
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% Vitesse cible (donnée comparative) 

vitesse du bateau mesurée sur la centrale 

vitesse cible pour le vent mesuré sur la centrale 

ratio des deux valeurs. Exemples : 100% = performances optimum, 85%, il faut améliorer la vitesse. 

 
VMG bateau. 
"Velocity made good". Mesuré sur la centrale. Le VMG reflète la façon dont le bateau remonte ou 

descend dans le vent et apprécie le compromis cap / vitesse réalisé. 

 

VMG cible 

VMG auquel le bateau peut prétendre en fonction de la polaire active et pour le vent mesuré sur la 

centrale (ou forcé par l'utilisateur). 

 

% VMG cible (donnée comparative) 

VMG du bateau mesuré sur la centrale 

VMG cible pour le vent mesuré sur la centrale 

ratio des deux valeurs 

 

CMG bateau. 
"Course made good". Le CMG reflète la façon dont le bateau se rapproche de la marque (en nœuds). 

N'est disponible que si un waypoint est activé (dès qu'on a pris le départ sur un parcours banane ou 

côtier, c'est la marque suivante). 

 

CMG cible 

meilleur CMG auquel le bateau peut prétendre en fonction de la polaire active et pour le vent mesuré 

sur la centrale (ou forcé par l'utilisateur). L'obtention de ce CMG nécessite éventuellement de s'écarter 

de la route directe (mais ce  n'est pas toujours le meilleur moyen pour arriver plus vite à la marque). 

 

% CMG cible (donnée comparative) 

CMG du bateau mesuré sur la centrale 

CMG cible pour le vent mesuré sur la centrale (ou forcé) 

ratio des deux valeurs 
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Les pourcentages afficher sous forme de jauge permettent d'afficher un comparatif graphique entre la 

valeur de référence et la valeur mesurée. "% Vitesse cible" par exemple, permet d'obtenir le comparatif 

entre la vitesse lue sur le speedo et la vitesse optimum calculée par la polaire : 

 

 

 

11.6 Annexe - Les données recherche de meilleurs VMG et CMG 
 

 

 

Targets 

Les targets sont les cibles à réaliser pour obtenir le meilleur VMG. Elles sont données par les polaires du 

bateau. 

 
Target Up. - Vitesse 
vitesse cible pour obtenir le VMG au près. 
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Target Up. - Angle 
angle de vent réel cible pour obtenir le VMG au près. 

 
Target down.- Vitesse 
vitesse cible pour obtenir le VMG au portant. 

 

Target down.- Angle 

angle de vent réel cible pour obtenir le VMG au portant. 

 

Target auto. - Vitesse 
Lorsque  le bateau navigue au près : 

vitesse cible pour obtenir le VMG au près. 

Lorsque le bateau navigue au portant : 

vitesse cible pour obtenir le VMG au portant. 

 
Target auto. - Angle 
Lorsque  le bateau navigue au près : 

angle de vent réel cible pour obtenir le VMG au près. 

Lorsque le bateau navigue au portant : 

angle de vent réel cible pour obtenir le VMG au portant. 

 

 

% vitesse bateau / vitesse au target  

ratio entre la vitesse du bateau mesurée sur la centrale et la vitesse cible pour le meilleur VMG 

 

% vitesse bateau / vitesse au target (curseur) 

vitesse du bateau mesurée sur la centrale 

vitesse cible pour le meilleur VMG 

ratio des deux valeurs 

 

% AWS / AWS au target  

C'est un comparatif basé sur le vent apparent. Cette fonction est souvent utilisée au portant dans le 

petit temps où on s'efforce avant tout de conserver un vent apparent suffisant et de "glisser" le plus 

possible sans perdre le vent apparent. Le fait de surveiller le vent apparent plutôt que la vitesse du 
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bateau permet de réagir beaucoup plus vite (lorsque la vitesse du bateau chute, il est déjà trop tard 

pour réagir) 

ratio vent apparent lue sur la centrale et de la vitesse vent apparent théorique pour le meilleur VMG 

(calculé sur la polaire) 

 

% AWS / AWS au target (curseur) 

vitesse vent apparent lue sur la centrale 

vitesse vent apparent pour le meilleur VMG 

ratio des deux valeurs 

 

Différence TWA / TWA au target 

ratio entre l'angle vent réel mesuré sur la centrale et l'angle vent réel pour le meilleur VMG (calculé sur 

la polaire). 

 

Différence TWA / TWA au target (curseur) 

angle vent réel mesuré sur la centrale 

angle vent réel pour le meilleur VMG 

différence entre les deux valeurs. C'est "l'erreur de route" ("B" = trop Bas "H" = trop Haut). 

 

CMG - avertissement 

Attention : la recherche du meilleur CMG (Cap Made Good) n'est pas toujours le meilleur moyen pour 

arriver plus vite à la marque. En particulier, si le bord est court et le vent stable. Ne recherchez pas le 

meilleur CMG si vous n'avez pas une idée précise de la raison pour laquelle vous le faites. 

 

Cible meilleur CMG - Vitesse 

vitesse du bateau s'il était sur le meilleur CMG 

 

Cible meilleur CMG - Angle 

angle du vent réel (TWA) pour se placer sur le meilleur CMG 

 

Différence angle vent réel / angle vent réel au CMG 

différence entre l'angle vent réel mesuré sur la centrale et l'angle vent réel pour le meilleur CMG. C'est 

"l'erreur de route" ("B" = trop Bas "H" = trop Haut). 
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Différence angle vent réel / angle vent réel au CMG (curseur) 

angle vent réel mesuré sur la centrale 

angle vent réel pour le meilleur CMG 

différence entre les deux valeurs. C'est "l'erreur de route" ("B" = trop Bas "H" = trop Haut). 

 

 

 

 

11.7 Annexe - Les données de navigation 
 

 

 

 

Route surface - Vitesse  

Vitesse lue sur le speedomètre (ou sur le  GPS : voir chapitre Calcul de données par le logiciel), 

 

Route surface - Cap 
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cap lu sur le compas. Si le compas est absent, le cap est lu sur le GPS (cap fond).. 

 
Route fond - Vitesse 

vitesse sur le fond (lue sur le GPS). 

 

Route fond - Cap 

direction sur le fond (lue sur le GPS). 

 

Route fond - Ecart cap au WP 

écart en degré entre la route fond et la route à effectuer pour se diriger sur le prochain 
waypoint. 5°G signifie que l'on se dirige 5° à gauche de la route directe. 

 
Route fond - Ecart latéral 
écart en milles entre la position du bateau et la route directe. C'est le "Cross track Error" (XTE) 
affiché par les GPS. 

 
Position - Latitude 

latitude de la position de l'étrave du bateau. 

 

Position - Longitude  

longitude de la position de l'étrave du bateau.  

 

Note : le calcul de la position de l'étrave fait intervenir : 

la position donnée par le GPS 

le cap du bateau donné par le compas (cap fond lu sur le GPS éventuellement) 

écart entre l'étrave et l'antenne GPS (dans les paramètres) 

écart latéral de l'antenne GPS (dans les paramètres, pour les multicoques) 

 

Position - qualité réception GPS 

indique la qualité de réception du GPS. Peut-être "invalide", "normal" ou "différentiel". Cette donnée 

provenant des phrases NMEA GGA, elle ne sera disponible que si votre GPS fournit cette phrase. 

 

Waypoint - distance 

distance (en milles nautiques) du bateau au waypoint en cours (la prochaine marque) 
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Waypoint - direction 

direction du bateau au waypoint en cours (la prochaine marque) 

 

Waypoint - temps au WP 

temps estimé pour parvenir au waypoint compte tenu des performances mesurées du bateau sur le 

fond (vitesse et cap).  

 

Waypoint – ETA 

heure estimée d'arrivée compte tenu des performances mesurées du bateau sur le fond (vitesse et 

cap). 

 

Waypoint - position 

position en latitude / longitude du waypoint en cours.  

 

From waypoint - Distance 

distance (en milles nautiques) du waypoint précédant (la dernière marque franchie). 

 

From waypoint - Direction 

direction du waypoint précédant (la dernière marque franchie). 

 

Voiles à utiliser 

La ou les voiles à utiliser compte tenu des conditions actuelles de vent. Les Sailect des voiles ont pu 

vous être fournies par votre voilier ou créées avec Adrena et Optima Pro. 

 

Ballasts 

Meilleure configuration de remplissage des ballasts pour les conditions de vent en cours et sur le cap 

actuel du bateau. 

 

Foils 

Meilleure configuration de hauteur de foils pour les conditions de vent en cours et sur le cap actuel du 

bateau. 
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Quille 

Meilleure configuration de position de quille pour les conditions de vent en cours et sur le cap actuel du 

bateau. 

 

Dérive 

Meilleure configuration de position de dérive pour les conditions de vent en cours et sur le cap actuel 

du bateau. 

 

Abaque 

Valeur de l'abaque sélectionnée pour les conditions de vent en cours et sur le cap actuel du bateau. 

 

11.8 Annexe - Les données liées au départ 

 

 

Chrono 

Décompte du chronomètre que vous avez lancé au signal préparatoire ou au signal d'attention. 

Exprimé en minute seconde pendant la procédure de départ, en heure, minute, secondes ensuite. 
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Avance à la ligne au plus proche  

valeur de l'avance ou du retard (en minutes : secondes). 

"tôt" ou "tard" selon que vous êtes trop tôt ou trop tard par rapport au timing. 

 

Avance à la ligne au plus proche (curseur) 

"tôt" ou "tard" selon que vous êtes trop tôt ou trop tard par rapport au timing. Avance ou retard 

correspondant 

 

Départ – Coté favorable de la ligne 

coté avantageux de la ligne ("neutre", "bateau" ou "bouée") 

angle de décalage par rapport à la perpendiculaire au vent (0° indique une ligne neutre) 

rappel du vent avec lequel la mesure a été faite (vent mesuré sur la centrale ou vent que vous avez 

forcé à la main) 

 

Départ - Avantage ligne 

Coté avantageux de la ligne ("neutre", "bateau" ou "bouée") 

Angle de décalage par rapport à la perpendiculaire au vent (0° indique une ligne neutre) / avantage que 

possède un concurrent partant du côté favorable par rapport à un adversaire situé à l'autre bout de la 

ligne (en longueurs de bateau, en mètres ou en milles selon paramétrage des unités) 

rappel du vent avec lequel la mesure a été faite (vent mesuré sur la centrale ou vent que vous avez 

forcé à la main).  

 

Départ  - Distance perpendiculairement à la ligne 

Distance du bateau à la ligne perpendiculairement à celle-ci (c'est à dire au plus court). Exprimé en 

longueurs de bateau, en mètres ou en milles selon paramétrage des unités. 

Après le départ,  la donnée affichée est fixe et correspond à la distance à la ligne qui a été mesurée au 

coup de canon. Cela permet d'évaluer à posteriori si un rappel individuel vous concerne ou pas. 

 

Temps perpendiculairement à la ligne 

Temps restant pour parvenir à la ligne compte tenu des polaires du bateau (les polaires utilisées sont 

les polaires spécifiques du départ si vous en avez). Ce temps peut supposer que vous viriez de bord 

pour aller chercher la ligne au plus court. Pour connaître le temps à la ligne sans virement, choisissez " 

Temps à la ligne en direct" 

 

Vitesse optimale 
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vitesse cible pour parvenir à la ligne au top chrono. 

 

% vitesse optimale 

Rapport de votre vitesse actuelle par rapport à la vitesse optimale. 120 % : vous êtes trop rapide (vous 

arriverez trop tôt sur la ligne). 80 % : vous êtes trop lent (vous arriverez trop tard sur la ligne). 

 

Distance au bateau comité 

Distance du bateau au bateau comité. Exprimé en longueurs de bateau, en mètres ou en milles selon 

paramétrage des unités. 

 

Temps au bateau comité 

Temps restant pour parvenir au bateau comité compte tenu des polaires du bateau (les polaires 

utilisées sont les polaires spécifiques du départ si vous en avez). 

 

Distance à la bouée ligne 

Distance du bateau à la bouée de ligne. Exprimé en longueurs de bateau, en mètres ou en milles selon 

paramétrage des unités. 

 

Temps à la bouée ligne 

Temps restant pour parvenir à la bouée de ligne compte tenu des polaires du bateau (les polaires 

utilisées sont les polaires spécifiques du départ si vous en avez). 

 

Temps à la ligne en direct 

Temps restant pour parvenir à la ligne en restant sur le même bord compte tenu des polaires du 

bateau (les polaires utilisées sont les polaires spécifiques du départ si vous en avez). Ce temps suppose 

que vous remontiez ou abattiez jusqu'à l'angle de meilleure remontée au vent si vous n'y êtes pas. 

 

Avance à la ligne en direct 

"temps à bruler" pour atteindre la ligne (en restant sur le même bord). Positif si vous êtes en avance (il 

faut "brûler" du temps), négatif si vous êtes en retard. 

 

Avance à la ligne en direct (curseur) 

temps restant pour atteindre la ligne (en restant sur le même bord) 
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"temps à bruler" pour atteindre la ligne (en restant sur le même bord). Positif si vous êtes en avance (il 

faut "brûler" du temps), négatif si vous êtes en retard. 

"tôt" ou "tard" selon le cas, différence entre les deux valeurs 

11.9 Annexe - Les données liées aux laylines 

 

 

Cap laylines up - tribord 

Cap de la layline tribord au près. 

 

Cap laylines up - bâbord 

Cap de la layline bâbord au près. 

 

Cap laylines down - tribord 

Cap de la layline tribord au portant. 

 

Cap laylines down - bâbord 

Cap de la layline bâbord au portant. 
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Cap laylines auto - tribord 

Lorsque  le bateau navigue au près :  

Cap de la layline tribord au près. 

Lorsque le bateau navigue au portant :  

Cap de la layline tribord au portant. 

 

Cap laylines auto - bâbord 

Lorsque  le bateau navigue au près :  

Cap de la layline bâbord au près. 

Lorsque le bateau navigue au portant :  

Cap de la layline bâbord au portant. 

 

Layline visée  - distance  

distance de la layline en face du bateau (au près ou au portant selon que le bateau navigue au près ou 

au portant). Exprimé en longueurs de bateau, en mètres ou en milles selon paramétrage des unités. 

 

Layline visée  - temps  

temps pour parvenir à la layline en face du bateau (au près ou au portant selon que le bateau navigue 

au près ou au portant) en fonction des polaires du bateau. 

 

Layline opp. - Distance 

Distance de la layline sur le bord opposé au bateau (au près ou au portant selon que le bateau navigue 

au près ou au portant). Exprimé en longueurs de bateau, en mètres ou en milles selon paramétrage des 

unités. 

 

Layline opp.  - temps  

Distance de la layline sur le bord opposé au bateau (au près ou au portant selon que le bateau navigue 

au près ou au portant). Exprimé en longueurs de bateau, en mètres ou en milles selon paramétrage des 

unités. 

temps pour parvenir à la layline sur le bord opposé au bateau (au près ou au portant selon que le 

bateau navigue au près ou au portant et après virement ou empannage) en fonction des polaires du 

bateau. 

 

Layline tribord  - Distance 
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Distance de la layline tribord (au près ou au portant selon que le bateau navigue au près ou au portant) 

. Exprimé en longueurs de bateau, en mètres ou en milles selon paramétrage des unités. 

 

Layline tribord - temps 

temps pour parvenir à la layline tribord (au près ou au portant selon que le bateau navigue au près ou 

au portant et après virement ou empannage éventuel) en fonction des polaires du bateau. 

 

Layline bâbord - distance 

Distance de la layline bâbord (au près ou au portant selon que le bateau navigue au près ou au portant) 

. Exprimé en longueurs de bateau, en mètres ou en milles selon paramétrage des unités. 

 

Layline bâbord - temps 

temps pour parvenir à la layline bâbord (au près ou au portant selon que le bateau navigue au près ou 

au portant et après virement ou empannage éventuel) en fonction des polaires du bateau. 
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11.10 Annexe - Les données relatives au bord en cours 

 

Les données relatives au bord en cours sont disponibles pour le bord allant du bateau à la prochaine 

marque ("Du bateau à la marque") et pour le bord allant de la marque précédente à la prochaine 

marque ("Bord complet"). Pour chacun des deux cas, on peut afficher : 

 

Distance à la marque 

longueur (en milles nautiques) du bateau à la marque ou entre les 2 marques. 

 

Durée (bâbord amure, tribord amure ou totale) 

temps estimé sur chaque amure (ou total) pour rejoindre la marque (ou entre les 2 marques), compte 

tenu des polaires du bateau, de la vitesse du vent actuel (mesuré ou forcé) et du courant estimé sur le 

bord (courant mesuré à l'instant t ou forcé par l'utilisateur).  

Cap fond (hors courant) 

cap géographique entre le bateau et la marque (ou entre les 2 marques). C'est le cap géographique réel 

qui n'est pas forcément celui à suivre (courant) 

 

Cap à suivre (courant inclus) 

cap à suivre sur le bord. Ce cap intègre le courant estimé (courant mesuré à l'instant t ou forcé par 

l'utilisateur). 
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Vent réel moyen (courant inclus) 

TWA moyen : angle du vent réel moyen du bateau à la marque (ou entre les 2 marques). 

AWA (au target) : angle du vent apparent moyen du bateau à la marque (ou entre les 2 marques). Cet 

angle est égal aux valeurs de meilleurs vmg du bateau si la marque n'est pas accessible d'un seul bord. 

AWS : vitesse du vent apparent. 

 

 

Sailect et abaques 

Données disponible si vous possédez le logiciel Optima ainsi que les "Sailect" ou les abaques 

correspondantes. 

 

Voiles à utiliser 

La ou les voiles à utiliser compte tenu des conditions actuelles de vent. Les Sailect de vos voiles ont pu 

vous être fournies par votre voilier ou créées avec Adrena et Optima Pro. 

 

Ballasts 

Meilleure configuration de remplissage des ballasts pour les conditions de vent en cours et pour se 

rendre à la prochaine marque (ou entre les 2 marques). 

 

Foils 

Meilleure configuration de hauteur de foils pour les conditions de vent en cours et pour se rendre à la 

prochaine marque (ou entre les 2 marques). 

 

Quille 

Meilleure configuration de position de quille pour les conditions de vent en cours et pour se rendre à la 

prochaine marque (ou entre les 2 marques). 

 

Dérive 

Meilleure configuration de position de dérive pour les conditions de vent en cours et pour se rendre à 

la prochaine marque (ou entre les 2 marques). 

 

Abaque 
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Valeur de l'abaque sélectionnée pour les conditions de vent en cours et pour se rendre à la prochaine 

marque (ou entre les 2 marques). 
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11.11 Annexe - Les données relatives au bord suivant 
 

 

 

Le bord suivant est le bord compris entre la prochaine marque et la marque suivante. Les informations 

disponibles sont les mêmes que celles du bord en cours, sauf en ce qui concerne le courant qui n'est 

pas estimé d'après les informations de la centrale (ou forcé par l'utilisateur), mais calculé sur les atlas 

de courant (si vous en disposez) et à l'heure estimée du bord en question. 

Voir le chapitre : ANNEXE - LES DONNEES RELATIVES AU BORD EN COURS 

 

11.12 Annexe - Les données diverses 
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Courant mesuré – vitesse  

vitesse du courant calculé par différence entre la route surface du bateau (speedo et compas) et sa 

route fond (GPS). 

 

Courant mesuré - direction 

direction du courant calculé par différence entre la route surface du bateau (speedo et compas) et sa 

route fond (GPS). 

 

Fond 

fond mesuré par le sondeur 

 

Fond / marée 

fond mesuré par le sondeur 

hauteur de la marée en mètres 
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hauteur de la marée en pourcentage du marnage total (0% : la marée est basse / 100% : la marée est 

haute) / tendance de la marée (monte / haute / descend / basse). 

 

Température -  air 

Température de l'air (si la centrale dispose d'un tel capteur) 

 

Température - eau 

Température de l'eau (si la centrale dispose d'un tel capteur) 

 

Pression atmosphérique 

pression atmosphérique en millibars (si vous disposez d'un baromètre connecté à la centrale) 

 

Temps - Heure TU 

Heure TU indiquée par le PC 

 

Temps - Heure locale 

heure locale indiquée par le PC 

 

Temps - Heure GPS 

Heure TU indiquée par le GPS (en provenance des satellites). 

 

Hauteur marée - absolue 

hauteur de la marée en mètres 

tendance de la marée (monte / haute / descend / basse) 

 

Hauteur marée - relative 

hauteur de la marée en pourcentage du marnage total (0% : la marée est basse / 100% : la marée est 

haute) 

tendance de la marée (monte / haute / descend / basse). 

 

Déclinaison 

déclinaison calculée à la position du bateau 



462 
 

 

Marche sous voiles 

reflète l'état du mode enregistrement que vous avez coché avec le bouton "marche sous voile" . 

 

Donnée générique 

 

Ce sont les données qui peuvent être lues via les phrases NMEA XDR ou à travers le logiciel "Deckman". 
Voir le chapitre "Données génériques". 
Choisissez dans la liste celle que vous désirez afficher ou effectuez une recherche à partir de son nom 

dans la barre de recherche. 

 

 

 

11.13 Annexe - Les données de configuration du bateau 
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Les informations de configuration du bateau reflètent les informations que vous avez 
spécifiées pendant la navigation (voiles à poste, remplissage des ballasts, ...) 
Pendant la navigation c'est un simple rappel permettant de vérifier que vous avez bien saisi la 
bonne configuration. 
Lors d'un replay, c'est une information précieuse sur la configuration du bateau lors des 
navigations passées. 

 
GV : nom de la voile à poste avec les éventuels ris qui ont été pris. 

 
Focs(s) : nom du ou des (2 maximum) focs à poste 

 
Spi : nom du spi à poste 

 
Synthèse : ensemble des voiles à poste. 

 
Les autres données permettent d'afficher l'état ou la position de la valeur considérée. 
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11.14 Annexe - Les données curseur 

 

 

Les informations curseur permettent de mesurer des informations liées à une position sur la carte : 

courant, prévisions météo, distance et temps du bateau au point mesuré. Elles évoluent au fur et à 

mesure que vous déplacez le curseur de la souris sur la carte. 

 

Position : latitude et longitude à la position du curseur 

 

Déclinaison : déclinaison en degrés à la position du curseur 

 

Vent : prévision de vent à 10m (vitesse et direction) à la position du curseur (au temps défini par le 

ruban de prévisions). 

 

Vent en altitude : prévision de vent en altitude (vitesse et direction) à la position du curseur (au temps 

défini par le ruban de prévisions). Il peut s'agir du vent à 850 hPa, à 950 hPa ou à une altitude donnée 

selon ce qui est disponible dans le grib affiché. 

 

Vent en altitude (delta) : même information que le vent en altitude mais calculé par différence avec le 

vent à 10m. 
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Rafales : prévision de vitesse (en nœuds) des rafales de vent à la position du curseur (au temps défini 

par le ruban de prévisions). 

 

Rafales (delta) : même information que les rafales mais calculé par différence avec le vent à 10m. 

 

Pression atmosphérique : prévision de pression atmosphérique (en hecto pascals) à la position du 

curseur (au temps défini par le ruban de prévisions) 

 

Pluie : prévision de cumul de pluie (en mm / heure)  à la position du curseur (au temps défini par le 

ruban de prévisions) 

 

Humidité : humidité en altitude (pourcentage) à la position du curseur (au temps défini par le ruban de 

prévisions). 

 

Courant : prévision de courant (vitesse et direction) à la position du curseur (au temps défini par le 

ruban de prévisions). Ces prévisions proviennent des atlas ou des grib de courant dont vous disposez. 

 

Mer du vent : prévision de la mer du vent  (hauteur, direction et période) à la position du curseur (au 

temps défini par le ruban de prévisions).  

 

Houle : prévision de la houle (hauteur, direction et période) à la position du curseur (au temps défini 

par le ruban de prévisions).  

 

Mer totale : prévision de mer totale (hauteur) à la position du curseur (au temps défini par le ruban de 

prévisions).  

 

Mer croisée (pourcent) : pourcentage entre la houle et la mer du vent à la position du curseur (au 

temps défini par le ruban de prévisions). 

 

Mer croisée (delta) : différence de hauteur entre la houle et la mer du vent à la position du curseur (au 

temps défini par le ruban de prévisions). 

 

Mer croisée (direction) : différence d'orientation entre la houle et la mer du vent à la position du 

curseur (au temps défini par le ruban de prévisions). 
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Température de l'eau : Température de l'eau à la position du curseur (au temps défini par le ruban de 

prévisions). 

 

Température de l'air : Température de l'air à la position du curseur (au temps défini par le ruban de 

prévisions). 

 

Distance et cap : distance (selon unité définie dans les paramètres généraux) et cap (en degrés) pour 

rejoindre le point du curseur depuis la position courante du bateau. 

 

Temps théorique depuis polaire : temps théorique pour rejoindre le point du curseur depuis la position 

courante du bateau, selon les polaires du bateau. Si nécessaire, le logiciel tiens compte du louvoyage et 

indique respectivement la durée bâbord amure et tribord amure 

 

Temps selon route fond : temps pour rejoindre le point du curseur depuis la position courante du 

bateau, selon la vitesse et le cap fond actuels. 

 

11.15 Annexe - Les données relatives au routage 
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Les données de routage permettent de comparer la navigation en cours avec le routage prévu. Ainsi on 

peut mesurer les écarts géographiques ou de timing.  

On estime si l’on peut continuer à "suivre" le routage ou s'il est nécessaire d’actualiser le calcul. 

 

SOG : Vitesse fond instantanée prévu par le routage à l’instant "T" 

 

COG : Cap fond instantané prévu par le routage à l’instant "T" 

 

% SOG : rapport entre la vitesse fond prévue et la vitesse fond actuelle 

 

Erreur COG : Différence en degré entre le cap prévu par le routage et le cap réellement suivi 

 

CMG sur le routage : Pourcentage de rapprochement (vitesse/cap) entre la route suivie et le routage 
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11.16 Annexe – Données relatives aux bateaux trackés 

 

 

 

Les données affichées dans cette section concernent exclusivement les bateaux pour lesquels le tracking 

est actif. Le choix du bateau concerné se fait par la liste déroulante dans le bas de la fenêtre. 

Il est également possible d’afficher les données des autres sections en activant " bateau tracké " dans 

l’onglet correspondant (navigation, performance, etc..) 

 

Note : la route surface d’un concurrent est calculée à partir de la route fond reçu et des atlas de courant si il 

sont présents 

 

Le nom du bateau tracké ou son numéro MMSI apparait dans le titre et les valeurs correspondantes sont 

précédées d’une cible : 
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Distance : écart de la distance entre son propre bateau et un bateau tracké 

 

Relèvement : valeur en degré de l’axe entre son propre bateau un bateau tracké par rapport au nord 

magnétique 

Ecart latéral : distance latérale séparant d’un bateau tracké 

 

Ecart longitudinal : distance longitudinale séparant d’un bateau tracké 

 

% vitesse surface : rapport entre la vitesse surface d’un bateau tracké  (SOG de l’AIS + courant de l’atlas si 

présent) et celle de son propre bateau. Une valeur inférieure à 100% indique que le bateau tracké est 

moins rapide et vice versa. 

 

% vitesse fond : rapport entre la vitesse fond d’un bateau tracké et celle de son propre bateau. Une valeur 

inférieure à 100% indique que le bateau tracké est moins rapide et vice versa. 

 

% CMG : rapport entre le CMG d’un bateau tracké et celui de son propre bateau. Une valeur inférieure à 

100% indique que le bateau tracké à un meilleur CMG et vice versa. 

 

Avantage au vent : perte ou gain au vent d’un bateau tracké par rapport à son propre bateau. La valeur est 

positive pour un gain et négative pour une perte 

 

TWD égalité : direction du vent réel pour laquelle un bateau tracké et son propre bateau ont le même 

avantage au vent 

 

 

 

11.17 Annexe - Format des données de courants de marée 
 

Extension du fichier 

Fichier texte avec extension .txt 

 

Descriptif du fichier 
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Descriptif et date  

exemple : Estuaire St Laurent 01/01/2013 

 

En tête (une seule fois) 

nom du port de référence de la marée, suivi de "PM", suivi du coef. "Vives eaux" et du coef. "mortes 

eaux" (par défaut 95 et 45) 

exemple : Weymouth 85 60 

 

Note : le port de référence doit être un port connu du logiciel en terme de marées (+ de 1000 dans le 

monde). Pour connaitre le port le plus proche d'un point, faire un clic droit sur la zone et consulter le 

menu "Infos ici" 

 

Données 

On peut décrire autant de points de courants que souhaité. Pour chaque point, le fichier comporte trois 

lignes : 

 

Position (WGS 84): 

Latitude (sDDMM.mmm) : 4452.123 (positive vers le Nord) 

Longitude (sDDDMM.mmm) : -118.568  (positive vers l’Est) 

 

 

 

2- Courants de vive-eau  en dixièmes de nœud, heure par heure 

(de PM -6  à  PM +6   par rapport au port de référence) 

 

Composantes Ouest-Est      *  Composantes Sud-Nord 

(positives vers l’Est)                   (positives vers le nord) 

-6  -5  -4  -3  -2  -1  PM +1 +2  +3  +4  +5  +6  *       -6  -5  -4  -3  -2  -1  PM +1 +2  +3  +4  +5  +6 

-11  -9  -5   3  12  13  10   8    3  -4  -10  -12 -11 *     -18 -21-17 -3  14  23  25  20 13    6   -1   -8  -16  

 

3- Courants de morte-eau (coefficient 45) en dixièmes de nœud, heure par heure 

(de PM -6  à  PM +6   par rapport au port de référence) 
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Composantes Ouest-Est   *  Composantes Sud-Nord 

(positives vers l’Est)         (positives vers le nord) 

-6  -5  -4  -3  -2  -1  PM +1 +2  +3  +4  +5  +6   *     -6  -5  -4  -3  -2  -1  PM +1 +2  +3  +4  +5  +6 

-5  -4  -2   1    5   6    5    4    1  -2    -5   -6   -5  *     -8 -10 -8  -1   7  11   12  10   6    3     0  -4   -8 
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   Exemple d’enregistrements : 

 

Estuaire St Laurent 01/01/2013 

Harrington-Harbourg PM 95 45 

5036.800 -225.850 

0 0 0 0 0 0 0 0 1 0 0 0 0 * -1 -1 0 0 1 1 0 0 -1 -2 -2 -2 -2 

0 0 0 0 0 0 0 0 0 0 0 0 0 * -1 -1 0 0 0 1 0 0 0 -1 -1 -1 -1 

5037.430 -224.250 

0 -1 -1 1 1 1 1 1 0 -1 -2 -4 -2 * -1 0 0 0 0 0 0 1 -1 -1 -1 0 -1 

0 0 0 0 0 0 0 0 0 0 -1 -2 -1 * 0 0 0 0 0 0 0 0 0 0 -1 0 -1 

5037.330 -219.600 

-10 -4 -1 1 3 4 10 3 2 -2 -4 -9 -12 * 2 1 0 0 -1 -1 -2 -1 0 0 0 0 2 

-5 -2 0 0 1 2 5 1 1 -1 -2 -5 -6 * 1 0 0 0 0 0 -1 0 0 0 0 0 1 

5036.810 -215.850 

-10 -10 -3 1 10 10 11 8 3 -1 -5 -11 -14 * 2 2 1 0 -2 -2 -1 -1 -1 0 1 2 1 

-5 -5 -1 0 5 5 5 4 1 0 -2 -5 -7 * 1 1 0 0 -1 -1 0 -1 0 0 0 1 1 
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